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Preface to the Third Edition 
 

This third edition has been thoroughly updated, keeping in mind the numerous 

suggestions and the fast changing IT scenario. A complete chapter on mobile computing 
 

 WML has been added. Latest advances in state-of-the-art hardware and software 

have also been addressed in this book. 
 

Techniques like Flow charting and Pseudo codes have been added. All these additions 

will fill the gap being felt by teachers and students, keeping the book well in line with 

latest changes in syllabi for both graduate and post graduate courses. 
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Preface to the First Edition  
 

This book has originated from the fact that both teachers and students have to refer to 

many different books for their course of study in Information Technology 

Fundamentals. Keeping this in mind, the syllabi of the BCA course of AP has been 

adopted as a guideline for the preparation of this book. 
 

Efforts have been made to provide the topics in a concise yet easily understandable 

manner. Revision exercises and questions have been given for the students to firm up the 

lessons and be prepared for the exams. The book in my opinion should serve the needs of 

the students doing a first course in computers in BCA or MBA. It will prove very useful 

to the practising industry Managers, who have to keep abreast of the strides being made 

in the Information Technology area, so as to apply them in their business area. 
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Chapter 1: 
 

INTRODUCTION TO COMPUTER BASICS  
 

INTRODUCTION  
 

Computers! Amazing machines! We are living in the computer age today. Most of our 

day-to-day activities cannot be accomplished without using computers. Sometimes 

knowingly and sometimes unknowingly we use computers. Whether we have to 

withdraw money from an ATM (Automated Teller Machine retranslated as Any Time 

Money), publish a newsletter, drive a motorbike, design a building or even a new 

dress, go to a grocery shop and buy anything, from cookies to tyres for our carðall 

involve computer in one way or the other. 
 

We are breathing in the computer age and the computer has gradually become 

such a dire necessity of life that it is difficult to imagine life without it. Computers are 

affecting every sphere of our lifeðbe it government, business, education, legal 

practice, entertainment, defense or homeðcomputers have become an indispensable 

and multipurpose tool. 
 

Whereas supercomputers can forecast weather, embedded computers make smart 

devices like washing machines that beep when washing is complete or automobiles 

that give you warning before breaking down. 
 

In this chapter we will see how computers affect our daily lives, its positive and 

negative effects, characteristics, history, the various types of computers and the tasks 

associated with them. 
 

NEED FOR COMPUTER LITERACY  
 

Computers have shaken up the world. They have made us dependent upon them. We 

expect them to be present at every place: be it the ticket reservation counter, the 

microwave or the car. Now that computers have moved into our society so rapidly, one 

needs at least a basic knowledge of computer skills to pursue oneôs career goals and to 

function effectively and efficiently. We can say that computer literacy is the need of 

today and the voice of tomorrow to survive in the fast changing world of computers. 
 

For most people computer literacy is restricted to using the keyboard for typing a 

document or making use of it for calculations. But this is not enough. One must know 

fundamental concepts such as what computers are constituted of and how they work. For 

example, you drive a motorbike and you take it for servicing. One way is to tell the 

service boy to service the motorbike and that you will collect it in the evening. Another 

way could be to tell him that, apart from servicing, please change the engine oil and clean 

the carburetor too. This way the service man would be more careful while 



working on your motorbike and you would be able to solve some of the small 

problems with your bike when the mechanic is not available. Lack of knowledge can 

sometimes be a cause of great trouble. Lack of knowledge can cause mistakes while 

using the computer. Lack of knowledge is also a cause of fear in some people. This 

fear is termed as CYBERPHOBIA. This is not a technical term. It is just used for 

people who are scared of using computers. 
 

COMPUTER: THE DEFINITION  
 

For most people, the computer is a machine used for calculations or computation, but 

actually it is much more than that. Precisely, ñThe computer is an electronic device for 

performing arithmetic and logical operationsò, or ñThe computer is a device or flexible 

machine to process data and convert it into informationò. 
 

Now, in the two definitions given above, there are three tricky words that need 

some explanation. Let us start with logical operations ï these are the type of 

operations in which decision(s) is/are involved. Data is simply raw facts or figures 

collected whereas information is what one gets after processing the data. Information 

is always useful and meaningful for the user. Let us consider an example in which the 

marks of various subjects are collected for a particular group of students. Now, these 

marks independently (data) are of no use as such for the class teacher, but once she 

adds the marks of all the students and calculates their respective percentages, this 

becomes information and it serves her in finding out the answer for the queries like ï 

óWho has stood first in the class?ô or, óhow many people have got distinctions in the 

class?ô or, ówhat is the overall performance of the class?ô 
 

Computers are not only used for the purpose of calculations. An accountant or a 

grocery shop owner or a bank or an ATM uses it like a computational device, an 

author uses it as a writing tool, a musician as a device for controlling music, kids as a 

machine for playing games and so on. 
 

Now, you must be wondering, what is so special about this machine that people 

from diversified fields can use it so flexibly for entirely different functions. The 

answer is that the computer is programmable, meaning that it all depends upon what 

program it is using for performing a particular function. 
 

Now, the next question that comes to mind is, what is a program? In very simple 

language, we can say that a Program is a set of instructions that tells the computer 

what to do. 
 

The computer hardware (actual machine) is designed in such a way that it does 

whatever the software (computer programs) tells it to do. We will be discussing the 

hardware and software of a computer in detail later in this chapter. 



There are four basic operations which a computer performs, irrespective of the 

program which is running on it. They are classified as: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 1.1 
 

 Input: This involves inserting or feeding data into the computer by means of an input 

device, like a keyboard.  
 Processing: Some kind of processing is done in the computer to take out or transform 

data in some way.  
 Output: The computer produces an output on a device, such as a printer or a monitor, 

that shows the result of the processing operations. 
 
 Storage: The computer stores the result of processing operations for future use in 

some storage device, such as a hard disk or a floppy disk. 
 

These operations are often referred to as the IPOS cycle. The four steps of the 

IPOS cycle ð input, processing, output and storage ð may not necessarily appear in 

the same sequence as they are defined. 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 1.2 
 

HISTORY OF COMPUTERS 
 

Electronic data processing doesnôt go back more than just half a century. It has been in 

existence barely since early there 1940ôs. The very first modern electronic computer 

became operational only in early the 1940ôs. In fact, it's only a little more than five 



decades ago since the first modern electronic computer was brought into existence for 

the purpose of business data processing. Computers before that were used only in 

scientific and technological fields. 
 

Although the present modern electronic computers are very recent, the idea was 

conceived far back. A brief outline of human history shows some interesting facts. In 

the early days when our ancestors used to live in caves, counting was a problem. They 

could, of course, count on their fingers, but gradually it started becoming difficult. As 

the belongings and possessions increased, the need for more counting tools grew. It 

was not possible to have more than 20 fingers (ten on hands and ten on feet). The 

record keeping system switched over to counting on a number of stones and scribbling 

on the walls of their caves. The inconvenience of being restricted to stones and walls 

forced them to look out for some other counting devices. In the mid-seventh century, 

adding tools and devices started being developed across the world. Thus we can say 

that the idea of computing is as old as civilization itself. It is very important to learn 

how people attempted to create early computers as they played a very important role 

in reaching this stage. 
 

When people started using stones to count their animals or their possessions, they 

never knew that this would lead to the computer of today. People started following a set 

of procedures to perform calculations with these stones, which later led to the creation of 

a digital counting device, which could be thought of as the predecessor of a computer. 
 

1450 B.C. Abacus (China) 
 

The abacus is the first known calculating device. It was invented by the Chinese and is 

still widely used in the Far East for commercial calculations. In its primitive form, it 

consists of a wooden frame with a number of wires with beads strung through them. 

The beads are used for counting and calculations. To show a number, beads are pulled 

down so that each rod represents a digit. 
 

1600 Napier ñBonesò 
 

This is another counting device invented by John Napier, a Scottish mathematician. 

The ñbonesò were strips of ivory with numbers written on them. When the bones were 

arranged properly, the user could read the numbers in adjacent columns to get the 

answer of a multiplication operation. 
 

Between the 16
th

 and 19
th

 centuries, Europeans contributed their bit by inventing 

several machines that used existing technologies like clockwise gears and levers. 
 

1642 A.D. Adding Machines (Blaise Pascal) 
 

The well known French scientist and mathematician, Blaise Pascal invented the first 



machine, which could add and carry digits automatically. He was only nineteen years old 

at that time. His machine was so revolutionary that the principle behind it is still used in 

most of the mechanical counters being used today. He became a great philosopher and 

mathematician in Europe. His father was a tax commissioner and he used to accompany 

his father to his office. There he felt the need for an automatic calculating device, which 

could save people like his father from that boring and tedious job of doing sums over and 

again. He came out with a machine ñPascalineò that worked with clockwise gears and 

levers. The machine was basically developed to perform addition and subtraction 

operations only. The machine rotated wheels to register values and the lever was used to 

perform the carrying operations from one wheel to another. Although the machine was 

not accepted by business, it, however, initiated a series of inventions. To give honor to 

Pascal, a computer programming language was named after  

him. This language, Pascal, is generally used to teach programming to budding 

programmers. 
 

1692 A.D. Multiplying Machine (Gottfri ed Leibnitz) 
 

Gottfried Leibnitz improved upon Pascalôs machine and introduced a mechanism to 

carry out automatic multiplication of numbers. Leibnitz is best known for his work 

with Sir Isaac Newton in developing a branch of mathematics known as calculus. The 

calculator invented by him could add, subtract, multiply and divide accurately. It could 

even perform the square root function, although not always accurately. 
 

1804 A.D. Jacquard Loom (Joseph Marie Jacquard) 
 

In the early nineteenth century, a French weaver, Joseph Marie Jacquard developed a 

programmable loom, which used large cards and holes punched in them to control the 

pattern automatically. The output was a thick rich cloth with repetitive floral or 

geometric patterns. 
 

Jacquard patterns are still produced to this day. Others adapted the punched cards and 

used them as the primary form of input. They were used till about 20-25 years ago. 



1822 A.D. Difference Engine (Charles Babbage) 

 

Since the early 19
th

 Century, Charles Babbage, an Englishman, had been working on the 

development of a machine, which could perform complex calculations. In 1822 A.D., he 

invented the óDifference Engineô, which could perform complex calculations and print 

them out as well. This machine was a steamïpowered machine. While Babbage was 

working on his doctorate, he had to solve many complex formulae and he found it 

difficult to cope up with them in the given time period. This led him to the invention. 
 

1862 ñArithrometerò (Charles Xavier Thomas) 
 

This was the first calculator with commercial prospects. Frenchman Charles Xavier 

Thomas (a.k.a. Charles of Colmar) developed it. He won a gold medal at the 

International Exhibition in London. The machine performed addition, subtraction, 

multiplication, division and square root functions accurately. 
 

1863 A.D. Analytic Engine (Charles Babbage) 
 

Babbage had been working on a very elaborate machine all this time. By 1863 he had 

all the plans ready for the machine, which he named the Analytic Engine. He had 

conceived of a mechanism, which could carry out long sequence of complex 

calculations under automatic control. It would have the ability to store 1000, 50-digit 

numbers in one second and multiply 20-digit numbers in three minutes. 
 

Babbage used a form of the punched card for inputting the data. That would have 

been a complete modern computer. However, technology at that time was not 

advanced enough to provide him with the hardware he required. He was thinking too 

far ahead of his time and his ideas could not be implemented. However, he was the 

first person to conceive the ñStored Programò concept. 
 

Babbage worked on his plans for years. He was accompanied by Augusta Ada 

Byron (daughter of the famous poet Lord Byron) herself a brilliant mathematician, 

whose contribution to Babbageôs work is tremendous. She is regarded as the first 

female computer scientist and programmer. A computer programming language, Ada 

has been named in her honor. 
 

Charles Babbage is recognized as ñThe Father of Computersò. Although his plans 

could not be materialized and his analytical engine could not be completed in his life 

span a working analytical engine was finally developed from his plans in the year 

1991, and is on display at the Charles Babbage Institute at Minnesota. 
 

1896 A.D. Punch Card Machine (Dr Hermann Hollerith)  



Dr Hollerith is also a great figure in the history of computers. Dr Hollerith used the 

idea of employing punched cards in speeding up the collation job of the American 

Census of 1880 (The US Constitution calls for a census of the population after every 

ten years so as to determine the representation in the US House of representatives). He 

devised a card in which holes would be punched to indicate the presence of a 

particular criterion in a respondent. Using wire brushes in his machine the hole 
punched earlier in the card, enabled a wire to touch a metal plate, which carried an 

electric charge. The charge was transmitted to respective electric counters which 

automatically incremented the numbers. After the census was completed, Hollerith 

perfected his punched card equipment and marketed it. He founded the Tabulating 

Machine Company in 1896 to continue his work. Although the machines were in great 

demand Hollerith was not happy as he could not pursue his research work. In 1911 the 

Tabulating Machine Company merged with other two companies to form the 

Computing Tabulating Recording Company. Then Hollerith again started 

concentrating on inventing better equipment. 
 

One of the partners, the marketing expert named Thomas Watson Sr., led the new 

company. Under his guidance, the company wrote great success stories. Finally in 

1924, the management decided on a new name for the company and the Computing 

Tabulating Recording Company got converted into the International Business 

Machines Corporation (IBM). 
 

His idea has been refined and improved further. Punched cards are still used for 

recording data items to be input to computers. During the Second World War, an acute 

need for fast calculating machines was felt to carry out complex defense calculations. 

The British and the American Governments sponsored a number of projects in major 

Universities for the development of fast and accurate calculators and computers. This 

proved to be a boon for the industry which has never looked back since then. 
 

EARLY ELECTRONIC  COMPUTERS 
 

1930 Turing Machine 
 

Alan Turing, an English mathematician, wrote a paper describing the capabilities and 

limitations of a hypothetical general - purpose computing machine called the ñTuring 

Machineò in the late 1930's. Turing also helped in constructing Robinson (the British 

Computer used during the World War II) to decode German messages that were 

encrypted by the German Enigma machine. In the year 1950, Turing also published a 

book titled ñComputer Machinery and Intelligenceò, in which he proposed the Turing 

test of Artificial Intelligence. That test is still used by scientists. Turing test basically 

explains that a computer is capable of ñinteractingò with its user. 



1939 John Atanasoff's ABC (Atanasoff Berry Computer) 
 

Professor John Atanasoff is remembered because of his contribution of some concepts 

which led to the development of electronic computers. He, along with a graduate 

student Clifford Berry, built an electronic calculating machine that could solve the 

problems of equations. ABC was the first special-purpose, electronic computer. 
 

1940 A.D. Mark-I (University of Pennsylvania ï USA) 
 

A group of scientists devised the Mark-I, which was the first electromechanical 

calculator in the world. It utilized the punch card concepts of Hollerith and functioned 

by a series of electromagnetic relays and mechanical arithmetic counters. 
 

During World War II American Military asked Dr John Mauchy of the University 

of Pennsylvania to develop a machine, which could quickly calculate the trajectories 

for missiles. A graduated student, Presper Eckert, helped him in building the device. It 

is another thing that the computer could not be completed until two months after the 

war ended. 
 

1943 A.D. ENIAC (Harvard University ï USA) 
 

Following closely on the heels of Mark-I, scientists of Harvard University brought out 

the Electronic Numerical Integrator and Calculator (ENIAC), which was the first 

electronic computer. It weighed nearly 5 tons and occupied space equivalent to 2 big 

rooms and could perform all the calculations that a small pocket calculator of today 

can perform. It used vacuum tubes and was able to do 300 multiplications per second. 

This was faster than Mark-I but the major problem of using this computer was that the 

staff had to rewire the machine completely for carrying out the new instructions. 
 

1944 Mark-II (Dr Howard Aiken)  
 

Dr Howard Aiken, who read the notes of Ada Byron, was keenly interested in 

constructing an ñAnalytical Engineò. He approached IBM. In spite of doing very well 

with punched card equipments, IBM hired Aiken and allocated $1 million for the 

research. Aiken, with his team members, came out with Mark-II. Mark-II was partly 

electronic and partly mechanical. It was bulky, 8 feet high and 55 feet long. It took 3 

to 5 seconds to perform a single multiplication operation. 
 

1947 A.D. EDSAC (Cambridge UniversityïEngland) 
 

Electronic Delayed Storage and Calculation was the name given to the first electronic 

computer in the world. It was the first one to implement the óstored program conceptô. 

Known later as the óVon Neumann Conceptô, it proposed the use of binary numbers 

and the internal storage of instructions in digital form. 



1951 A.D. Univac-I (USA) 
 

By now a number of commercial companies were working on the development of 

computing systems. Sperry Rand Corporation of USA introduced the first commercial 

computer to the world and named it UNIVAC-I. Its introduction was followed by the 

entrance of the IBM into the computer field with IBM-701 Computer. 
 

COMPUTER GENERATIONS  
 

In recent years, the computer industry has grown at a phenomenal pace. In a short 

space of 35 years or so computers have improved tremendously. In the last decade the 

speed of computer has increased 200 times. Not only that, the reliability curve has also 

taken a sharp surge ahead. The cost per unit of calculation has gone down by 500 

times. The storage capacity is increasing so fast that now it seems that nothing is 

impossible to store. Large data can be stored in very small devices. 
 

The term ñgenerationsò was initially introduced to distinguish between different 

hardware technologies. Gradually it shifted to both hardware and software as the total 

system consists of both of them. 
 

Computers can be divided in five past generations, i.e., depending upon the 

technologies used. The five generations of computer are: 
 

1
st
 Generation 

 

Until 1951, electronic computers were the exclusive possession of scientists and the 

military. Till then nobody tried to use them for business purposes. The idea of 

marketing them was conceived by Mauchly and Eckert, creators of ENIACôs. As the 

US Census Bureau was already using IBCP cards, they were the pioneers in buying 

this computer for the first time in 1951. The company created by M and ETS became 

the UNIVAC division of Sperry and Corporation (later known as UNISYS). 
 

The bringing of the first UNIVAC (Universal Automatic Computer) general-

purpose electric digital computer marks the beginning of the first generation of 

electronic computers. 
 

These computers used valves, and copper wires joined all the components. Due to the 

large size of the components and the fact that the components had to be spaced apart as 

the valves dissipated a lot of heat, the computers were very bulky and required huge 

electric power, air conditioners, maintenance and space for their installation. Further, the 

speed of operation was very slow and they had a very low reliability factor as vacuum 

tubes failed frequently. They were still given the name of ñelectronic brains ñ by 

journalists. They also said that these electronic brains would change the world one day. 

Later IBM Corporation developed IBM 701, IBM 702 and IBM 650 and a few 



other systems. These were called the first generation computers. The most popular 

brand of first generation computers was the IBM 650, which had a magnetic drum 

memory and utilized punch cards for input and output. This type of computer was of 

intermediate size and was designed to meet the requirements of business and for 

scientific applications. The available memory was as much as a few hundred thousand 

words of main storage. The instruction-cycle time was of the order of a few 

milliseconds. It was only after 1957 that magnetic tapes were introduced as a faster 

and more convenient storage medium. A single tape could hold approximately 1100 P 

cards (i.e. about 2 pages of information). 
 

IBM made 19 IBM 701 computers and at that time industry felt that these 19 

computers were sufficient to take care of American business. These computer required 

special facilities and highly trained personnel. 
 

The instructions given to FGC (First Generation Computers) were in machine 

language (i.e. 0ôs and 1ôs). As the machine language was tough and understood by 

very few people, there were very few personnel available. 
 

Computers belonging to this generation had the following characteristics: 
 

(i) 
 

Comparatively large in size as compared to present day computers 
 

(ii)  Generated lot of heat 
 

(iii)  
 

They were not consistent and reliable as the valves tended to fail 
 

frequently 
 

(iv) Low capacity internal storage 
 

(v) Individual non-related models 
 

(vi) Processors operated in the milliseconds speed range 
 

(vii)  Internal storage consisted of magnetic drum and delay lines 
 

2
nd

 Generation 
 

FGC were very unreliable, mainly because of vacuum tube components, which kept on 

burning out. Users had to be prepared all the time with dozen of extra tubes for 

replacement. The computers of the Second Generation were characterized by the use of 

Solid State Devices (transistors) instead of vacuum tubes. Transistorized circuits were 

smaller in size, generated little heat, were less expensive and consumed less power than 

vacuum tube circuits. Despite this they were much greater in processing capacity. Since 

transistors had a faster switching action, this generation of computers were significantly 

faster and smaller, and were more reliable too, than first generation computers. The use 

of magnetic cores as the primary internal storage medium and the introduction of 



removable magnetic disc pack, were other major developments of the second generation, 

although magnetic tapes were still commonly used. These computers had built-in error-

detecting devices and more efficient means were developed to input and to retrieve data 

from the computer. They were much easier to work with as compared to the earlier 

generation computers. More efficient programming methods and higher-level languages 

like FORTRAN and COBOL became available. They were easily understandable by 

people especially because no codes (like Assembly language) had to be remembered by 

the programmers. Moreover, unlike Assembly Language the high level languages were 

not machine specific i.e. the same set of programs could be used on computers produced 

by different manufactures. The instruction-cycle time dropped from several hundred 

micro-seconds of the first generation to tens of micro seconds. The main memory in these 

systems could store several hundred thousand words. 
 

This generation of computers could communicate among each other using telephone 

lines. Transmission of data from one computer to another was possible in this generation 

of computers. Although the processing was very slow, the idea was convenient, which 

was further developed in subsequent generations. The problem which second-generation 

computers faced was that the input and output devices were far too slow. Projects were 

started in second generation to solve these problems. Though these were second-

generation technologies, they appeared in third generation computers. 
 

Dr Daniel Slotnick, who worked out the first solution, was working with 

Burroughs Corporation at that time. He designed a computer for the US Department of 

Defence, and tried to solve the problem of machines sitting idle, waiting for input and 

output. The computer known as ILLIAC-IV was developed, which had four control 

units, and thus was able to perform input/output and processing (mathematical 

operation) at the same time. Slotnick was granted a patent for ñParallel Processingò. 

They were also called the first supercomputers. Another supercomputer was proposed 

at MIT (Massachusetts Institute of Technology) by a group of students and professors. 

The name of the project was MAC (Multiple Access Computer) and the concept of 

multi-programming was developed there. The system could concurrently process the 

various programs which were run by different users. 
 

Some of the popular models in this generation of computer systems are IBM-1401, 

IBM-1620, BURROUGHS B-200 SERIES, HONEYWELL H-400, NATIONAL 

CASH REGISTER NCR-315, 500 and UNIVAC-1004. Many of these computers 

were used for business applications. 
 

Computers of this generation had the following characteristics: 
 

(i) 
 

Smaller in size compared to the first generation computers 
 

(ii)  Generated less amount of heat as components were much smaller in size 



(iii)  Greater degree of reliability because of solid-state technology 
 

(iv) Higher capacity of internal storage 
 

(v) Use of core storage instead of magnetic drum and delay lines 
 

(vi) Related series of processors ï the family concept 
 

(vii)  Processor operated in the microsecond speed range 
 

(viii)  High cost direct accesses storage 



3
rd

 Generation 
 

A revolution in computer development took place with the development of Integrated 

Circuits (IC) on a single silicon chip. In 1958, Jack St Clair Kelby and Robert Noyce 

invented the first IC. The IC incorporated a number of transistors and electronic circuits 

on a single wafer or chip of silicon. ICs are called chips because of the way they are 

made. They are also called semi-conductors, as they combine layers of materials that 

have a varying capacity to conduct electricity. This development ushered in the third 

generation of computer systems in 1964. The integrated circuits enhanced the processing 

capability, improving the speed of the computer manifold. During the period 1964 to 

1970, the capability of placing 12 or more logic gates on a single chip was developed into 

a well-defined technology of Small Scale Integration (SSI). A logic gate is a circuit that 

performs arithmetic such as addition, subtraction, multiplication or division. 
 

In 1970 this technology was redefined to a point where hundreds or more gates 

could be placed on a chip of silicon, and could incorporate functional logic block in an 

overall system. This technology was termed as Middle Scale Integration (MSI). There 

was intense pressure on the semi-conductor manufacturers to provide greater densities 

of gates on a single integrated circuit chip. Consequently, more complex chips were 

developed with the ultimate goal of obtaining a central processor on a single physical 

circuits element. These circuits had higher reliability and lower power consumption 

and a substantially reduced size. Component densities of 1,000 to 10,000 gates on a 

single silicon chip became possible. The technology consisting of 1,000 gates per chip, 

termed Large Scale Integration (LSI), started to become commercially viable in 1975. 

The later technology consisting of more than 10,000 gates per chip is called Very 

Large Scale Integration (VLSI) or Grand Scale Integration (GSI). These circuits 

became very useful in assembling computers. Some of the popular third generation 

computers are ï IBM-360 series, IBM-370 series and ICL-2900 series. The large 

advanced computer systems are usually called óMainframeô. 
 

Integrated circuits technology is responsible for bringing the revolution in the 

computer industry. Scientists were aware that more powerful computers could be built 

by building more complex circuits; but as these circuits had to be wired by hand, these 

computers were too complex and expensive. IC solved this problem by introducing a 

computer that cost less than a first generation computer and offered more memory and 

faster processing. 
 

In 1962, a new company built a plant in ñSilicon Valleyò, near Sanjose, California. 

DEC (Digital Equipment Corporation) revolutionized the entire computer industry 

with its computers, called minicomputers, which used ICs. 



The first commercially available minicomputer was introduced in 1965. The PDB-

8 (Programmed Data Processor) could fit easily in the corner of a room and did not 

require any attendant. The computer could be accessed by a number of users from 

different locations of the building. This was actually implementing the concept of 

time-sharing, which was developed in the second generation. The price of the system 

was one tenth of the traditional mainframe, which made it possible for smaller 

companies to afford. 
 

IBM was dominant in the market by releasing 360 series of computers. They were 

of different sizes of mainframe computers. The main advantage of using this computer 

was the use of same machine language compatibility, thus making it easy and cost 

effective, specially when upgraded. 
 

By 1967, IBM decided to change its track as a number of programming languages 

appeared in the market. This was the beginning of the software industry. As the 

languages grew in number and kind, people who had the skills to translate user 

requirements into these languages were high n demand now. 
 

Another technological development, which took place at this point of time, was 

the launching of the first telecommunication satellite. The communication stations 

situated on earth were now in a position to send and receive data by means of satellite-

enabling communication between the computer systems around the world. 
 

Admiral Grace Nurray Hopper, also known as ñthe Mother of COBOLò and as 

ñAmazing Graceò, was sent to Harvard to work on the first large-scale digital 

computer. She attended various computer conferences and delivered lectures in 

various colleges about data processing insights. She wrote more than 50 papers and 

articles on software and programming languages. 
 

Dr Hopper writes about the origin of Bug and Debug in her book ñUnderstanding 

Computersò. It was 1945; the students were working on Mark-II and it stopped 

working. Programmers trying to figure out what was wrong with the computer finally 

discovered that there was a moth caught in one of the relays which was causing the 

whole trouble. They removed it and the computer started working fine. There the 

terms ñBugò and ñDebugò were introduced. The first bug can still be seen taped on a 

page in a logbook at the Naval Weapons Museum in DahIgren, Virginia. 
 

Computers of this generation had the following characteristics: 
 

(i) 
 

Smaller in size as compared to second generation computers 
 

(ii)  Higher capacity internal storage 
 

(iii)  Remote-communication facilities 
 

(iv) Multi -programming facilities 



(v) Reduced cost of direct access storage 
 

(vi) Processors, which operate in the nanosecond speed range 
 

(vii)  Range of computers with a common architecture in which models were upward 

compatible 
 

(viii)  Use of high-level languages such as COBOL 
 

(ix) Wide range of optional peripherals. 
 

4
th

 Generation 
 

The decade of 1970ôs marked the beginning of a new generation of computers, 

produced by computer giants like IBM, ICL, NCR and Burrough. From the design 

viewpoint, the new generation provided increased input-output capability, longer 

component-life as well as greater system reliability. From the functional viewpoint, 

new powerful languages were developed to broaden the use of multi-programming and 

multi-processing, which brought about a major shift from batch processing to online 

processing as well as remote interactive processing. 
 

The development of the microprocessor chip, which contains an entire Central 

Processing Unit (CPU) on a single silicon chip led to the mushrooming growth of 

inexpensive computers. Microprocessors are not computers by themselves but they can 

perform all the functions of arithmetic logic and control units of the CPU. When these 

microprocessors are connected with memory and input-output devices, they become 

microcomputers. Semi-conductor memories are also very small and very cheap. There are 

several types of memory chips. Three of the most commonly used are: 
 

(i) Random Access Memory (RAM), in which data can be read or written 

corresponding to the main memory of the conventional computer 
 

(ii)  Read Only Memory (ROM) and 
 

(iii)  Programmable Read Only Memory (PROM). 
 

In ROM chips, the data is óburntô into the chip at the time of manufacturing. It cannot 

be changed after that. These chips are used in systems where the data need not be 

changed. Even when power supply fails, the data remains in the memory. In case of 

PROM a user can program and even correct the data if necessary. The fourth generation 

of computers may be called the microcomputer generation. The input-output devices used 

with the fourth generation computers are quite advanced. Among the advanced input-

output devices employed in fourth generation computers are optical readers, by which 

whole documents can be fed into the computer; audio response terminals, by which an 

operator can vocally introduce data or instructions; and graphic display terminals, by 

which an operator can feed pictures into the computer. 



The use of Very Large Integrated Circuits (VLIC) has made the fourth generation 

(micro)computers very compact, much less expensive, faster, more reliable and with a 

much greater data processing capacity than equivalent third generation computers. 
 

Some computers belonging to the fourth generation are DEC-10, STAR-1000, 

PDP-11 and the APPLE Series Personal Computers. 
 

5
th

 Generation 
 

Till the fourth generation of computers, the major stress was on improving the hardware 
 

 from valves to transistors and then to integrated circuits - which resulted in the 
miniaturization and fast speed of computers. However, lack of thinking power in it 

forced the scientists to work further towards the fifth generation computers. The 

concept of ñArtificial Intelligenceò is being used in these computers and the Japanese 

call them ñKnowledge Processorsò. Automatic programming, computational logic, 
pattern recognition and control of robots (robotics), the processes needing skill and 

intelligence are examples of Artificial Intelligence. These computers, when developed, 

will be able to execute billions of instructions per second and will have unimaginable 

storage capacities. The present day high level languages will become obsolete on these 
machines and new computer languages and related software will be needed. 
 

The fifth generation gives the highest priority to making systems that are easy and 

natural to use. Other objectives relate to the types of technological support needed to 

support ñproblem solving systemsò according to the fifth generation committee. ñIn 

these systemsò, the Committee adds, "Intelligence will be greatly improved to 

approach that of a human being. When compared to conventional systems, the manï

machine interface will be closer to that of human behavior.ò 
 

The fifth generation has three functional requirements: 
 

 ̧ Easy to use computers with high intelligence and natural human input and output 

mechanism 
 

 ̧ Reliable and efficient software development by new languages, new computer 

architectures and systems software which overcome previous problems, and 

 

 ̧ Improved overall functions and performance aimed at making computers smaller, 

lighter, faster, of greater capacity, more flexible and more reliable. 
 

These objectives set the main themes for the future of computing, whatever 

techniques are used to achieve them. 
 

CLASSIFICATION OF COMPUTERS  
 

There is a computer in the car you drive. There could be a PC on your desk or your 



study table at home. The weather report you get daily also involves computer, but all 

of them do not fall into the same category. They are different in terms of hardware, 

software, built, purpose and everything. 
 

Initially computers were classified on the basis of their size, speed and cost, but 

now there are many more attributes attached to them. 
 

Each and every computer must fall into one of the four categories described below: 
 

 Supercomputer 
 
 Mainframe computer 
 
 Minicomputer 
 
 Microcomputer 
 

Whereas supercomputers are the most powerful and the largest, microcomputers are 

the smallest ones. Supercomputers are the most powerful computer available today. It is  

another thing that a microcomputer of the 21
st

 

supercomputer of yore. Today technology is 

difficult to predict anything for the future. 

 

century might be as powerful as of the 

developing so fast that it has become 

 

Although all the above ï mentioned (four) types of computers have been around 

for quite some time, the capabilities of each type have changed tremendously. 
 

Supercomputers are highly sophisticated computers used for very special tasks like 

scientific researches, etc. Mainframes are large and expensive and are designed to meet 

the needs of a large organization. Minicomputers, although smaller than mainframes, are 

still big enough to cater to a medium sized organization or a small-scale business. PCs or 

microcomputers cater solely to individuals. Microcomputers could be PCs or desktops or 

laptops or even notebooks. The computers around us, like those in microwave ovens, 

washing machines, automobiles, etc., are embedded computers, which are special-

purpose and are generally used to perform control functions. 
 

Supercomputers 
 

These are the most powerful computers designed till now. They are made to process huge 

amounts of data. Many users can access them at the same time. They are primarily used 

for mathematically intensive scientific researches such as in aerospace, satellite, 

chemical, electronics, petroleum and nuclear power industries. Supercomputers are used 

in weather forecasts. It would not have been possible to warn the people around the 

coastal areas about the advent of a hurricane but for a supercomputer. It is because of 

supercomputers alone that such a large-scale devastation can be controlled well in time 

saving human lives as well as financial and infrastructural resources. 



Supercomputers are also found in public, private and government research centers 

such as universities, government labs and R&D departments of organizations. 
 

One main area where supercomputers are used is in the nuclear field, especially 

when nuclear fissionable material approaches a critical mass, and researchers are 

required to know what is happening at every nanosecond of the nuclear chain reaction. 

A supercomputer can monitor the actions and reactions of million of atoms when they 

interact. 
 

Supercomputers were used to find out the pollution in Los Angeles. The model 

comprised of more than 5,00,000 variables including geographic elevation, 

temperature, airborne chemicals, etc., and it was required to create an accurate 

simulation of the Los Angeles Basin to decide upon various strategies to be used to 

control air pollution. This would have taken months with less powerful computers, but 

supercomputers did it in just half an hour. 
 

The first supercomputer was built in the 1960ôs for the US Department of Defense. 

That was supposed to be the fastest and most powerful computer of that time. Millions of 

dollars are being spent on R&D of the technology enhancement of supercomputers. 
 

The main feature of a supercomputer is multiprocessing, which enables the 

computer to perform a large number of operations simultaneously. The first 

supercomputer had 4 CPUs. Todayôs supercomputers have hundreds of processors. 

The speed of the supercomputer is measured in Nanoseconds and Gigaflops. A 

Nanosecond equals 10
-9

th of a second and a Gigaflop is 1 billion floating-point 

arithmetic operation per second. A supercomputer can perform up to 128 Gigaflops. 
 

Market and R&D leaders of supercomputers include IBM, Silicon Graphics, Cray 

Research Corporation, Fuifits, Intel, Thinking Machines, etc. 
 

Thinking Machines has produced a supercomputer called Connection Machine, 

which has over 64,000 processors. Its price is about $5million. Supercomputers are 

priced from $2million to $20million and they consume electricity enough to light 

about 100 homes. 
 

Mainframes 
 

Mainframe computers are used where many people in a large organization need 

frequent access to the same information, which is usually organized information of 

one or more large databases. 
 

After UNIVAC-I was sold in 1951, the mainframes caught the attention of the 

computer industry. IBM, the computer giant, captured the mainframes market in the late 

1950ôs and made their name and money in the mainframe market. A mainframe computer 

system is generally made up of several computers, called terminals, in addition to the 



mainframe or host processor. A terminal is a keyboard and a screen wired to the 

mainframe. It does not necessarily have its own CPU or storage it just has input and 

output devices that function as the windows of the computer placed elsewhere. The 

host processor is responsible for controlling rest of the processors, operations and the 

peripheral devices attached to it. A front-end processor is the one that handles 

communication to and from all the remote terminals connected to the computer 

system. At times, a backend processor is also used to the handle data retrieval 

operation. Although the host computer is capable of doing all the operations by itself, 

it is still better to have two processors to share the load, thereby saving time and 

increasing speed. 
 

The mainframe computer has a processor that handles input, controls the database 

and output needs of the terminals attached to it. Each user has access to the contents of 

the database. It is difficult to store such massive amount of data and it would also be 

too slow. Many modern mainframes have multiprocessing capabilities. However, they 

are generally limited to 8 or less processors. They are slower than supercomputers and 

their speed is measured in megaflops and not in gigaflops. 
 

Mainframes can cost anything above $35,000. It used to be common for 

mainframe computers to occupy an entire room or even an entire floor of a high-rise 

building. Typically, they were placed inside glass offices with special air conditioning 

support to keep them cool, and on raised floors to accommodate all the wiring needed 

to tie the systems together. This setup is not used anymore. Mainframes today, look 

more like a file cabinet although they still need the same type of environment. 
 

A mainframes can support up to several hundred users simultaneously. It does so 

by keeping a number of programs in primary memory and by rapidly switching back 

and forth between programs. These operations are so fast that users do not even come 

to know that it is working on others tasks. This property of processing many tasks 

concurrently for multiple users is called ñmultiprogrammingò. 
 

No one really knows from where the term 'mainframe' originated. Earlier IBM 

documents define the term frame as an integral part of a computer: ñthe housing é. 

hardware support structures, é. and all the parts and components thereinò. It was only 
when computers of various sizes and shapes came into existence, that the big computers 

began to be referred to as main frames and eventually became one word 'mainframe'. 
 

Minicomputers 
 

The advent of minicomputers or minis as they are sometimes called started in the 

1960ôs when DEC (Digital Equipment Corporation) began shipping its PDP series 

computers. The press named them minicomputers because of their small size as 

compared to other prevailing computers. 



The easiest way to describe minicomputers is by saying that they lie somewhere in 

between mainframes and microcomputers. They can handle a great amount of data like 

mainframes. They can also support a number of terminals just as mainframes do. 

Although they are designed for hundreds of terminals, they differ in speed, i.e. 

minicomputers are slower than mainframes and they cannot support as many terminals 

as mainframes can. They have less storage capacity and their printers too are slow. 

They are meant for smaller organizations, which can neither afford mainframes nor do 

they require such big computers. The cost ranges from $18,000 to $50,000. The major 

manufactures of minicomputers are DEC, Data General, IBM and Hewlett Packard. 
 

Workstations and Microcomputers 
 

When working on minicomputers and mainframes through terminals, users can just 

control the input and output of the computer. Whereas a single user computer gives 

you the power of controlling the total processing cycle i.e. input and output, 

processing and storage. You can select your own programs and do not need to be 

dependent on mainframes or minis for storage. They are designed to meet the needs of 

an individual and thus are also called as Personal Computers. PC and microcomputers 

are interchangeable as far as meaning is concerned. 
 

When we talk about computers today, we generally mean a PC or a 

microcomputer. Microcomputers have a great impact on the computer industry. Till 

1975, they did not even exist, and in 1995 the sale of PCs was as high as $16 billion. 

Microcomputers are the fastest growing segment of the computer industry. One of the 

sources of the PCôs popularity is the rate at which improvements are being made in the 

technology. As the technology is growing, microprocessor, memory, chips and storage 

devices keep getting faster and better and bigger. Today, a typical PC has 8 times as 

much RAM, 150 times more storage capacity and a microprocessor that is at least 100 

times faster than a PC 10 years earlier. Analysts believe that the pace of this growth 

will be the same for another 20 years. 
 

In 1981, IBM called its first microcomputer the IBM-PC. Within a few years there 

were many more companies in the race to design a computer compatible to IBM-PC. 

Thus the term IBM-PC became the name of a family of computer that included IBMs 

and IBM compatibles. The vast majority of computers falls in this family except 

Apple Macintosh, which is another family of microcomputers made by Apple 

Computer. It is appropriate to say that Macintosh is a personal computer but not a PC. 

Presently IBM commands over about 28 percent of the market where as Apple holds 

about 8 percent of market share. 
 

A few years ago, Apple Computers, IBM and Motorola joined to develop the 

Power PC chip, which enables Apple Computer to run IBM applications and vice 

versa. Most Apple Macintosh computers and compatibles are based on this chip. 



A single computer can actually fall into the category of either a microcomputer or 

a workstation. A workstation is a powerful desktop computer designed to meet the 

computing needs of engineers, architects and other professionals, who need graphic 

display. Workstations are generally used for CAD (Computer Aided Design) 

applications. For this type of complex programs the computer needs great processing 

power and much storage. They are also used as services for LANs (Local Area 

Networks). Workstations are sometimes called ñSupermicrosò. Although they look 

like desktops, the chip inside is different. Most workstations use RISC (Reduce 

Instruction Set Computer) microprocessors. RISC processors are used in special 

purpose applications, where speed is critical. 
 

Presently the boundary between workstations and PCs is becoming less distinct. 

Todayôs PCs are better than workstations of the past. Pentium-pro has multiprocessing 

capabilities. Most microcomputers support multitasking (enabling the user to switch 

between the tasks). Multitasking saves a lot of time. The user can open another 

activity while one task is being processed. For example while the computer is 

downloading one thing in the browser, the user can open another window for writing a 

mail or a calculator to perform some calculation. 
 

One style of PC is the desktop. This type of computer is small enough to fit on a 

desk but is too big to carry around. There are a number of models available in the 

desktop category. The cabinets come in flat (horizontal) and vertical (tower model) 

depending upon the space management of the user. 
 

Laptop Computers 
 

The first portable computers were known as ñluggableò. They weighed about 28 

pounds. As the size reduced further the term also changed to ñlaptopò. Laptops weigh 

about 10 to 12 pounds. The name was probably given because laptops are kept on the 

laps while users are on the move (in a car, an airplane or train). 
 

Notebook Computers 
 

As the name suggests, their size is about 8.5 by 11 by 2 inches, and can easily fit 

inside a briefcase. They were initially called laptops too, but gradually as the size 

decreased even further they started being called notebooks. They can be operated on 

batteries also. They are fully functional microcomputers. They can have input devices 

Hard Disk Drives, Floppy Disk Drives, a CD-ROM, a modem and an in-built mouse. 
 

Personal Digital Assistants (PDA) 
 

These are the smallest portable computers and are no bigger than chequebooks. They 

are also called palmtops. They are not as powerful as notebooks and laptops. They are 

used for some special applications like keeping record of phone numbers, dates, 



agendas and calculations. They can be connected to large computers to exchange data. 

They also come with an electronic pen, called stylus, that lets users write on a touch-

sensitive screen. The latest PDAôs can use infrared light to communicate with nearby 

computers. They may also have built-in capabilities for fax, cellular telephony and e-

mails. 
 

These are meant for the people who want to avoid carrying a lot of weight and do 

not need the full collection of applications while away from home or office. These 

computers use inexpensive batteries. They do not have any disk drivers. They use the 

PC card, a card of the size of a credit card, to store programs and data. Notebook and 

desktop computers also have now adopted these PC cards. PC cards are some version 

of smart cards (small cards developed in France). They were earlier used to pay 

highway tolls, make STD calls, pay bills etc. A smart card has a microprocessor and a 

memory chip. 
 

Embedded Computers 
 

Have you ever noticed that computers surrounds you everywhere? Be it your car, your 

kitchen, bathroom, entertainment or anywhere else. You start using computers the time 

you get up in the morning and keep using it till you go off to sleep. Such computers as 

these, which work inside other machines, are called embedded computers. 
 

Cars use embedded computer to control the engine. Alarm clocks use these 

computers to wake you up. VCR and TVs also use embedded computers for a variety 

of functions. The users do not even realize, while using these equipment, that they are 

using embedded computers. 
 

CHARACTERISTICS OF COMPUTERS 

A few notable features of computers are: 
 

Speed 
 

The computer was initially invented as a very high-speed calculator. It helped in 

completing many scientific projects that were previously impossible. The landing on the 

moon would not have been possible if computers had not been there, neither would we 

today take an umbrella, if saw a clear sky, if the weather, forecast did not tell us that it 

would rain in the afternoon. We would have taken a lot of time in making the 

arrangements for flying abroad if computers were not there to book our seats so easily 

and fast. The ability to get the answers fast enough so that one has time to take an action 

on them (to make alternative arrangements in case of reservations) makes real time 

computing possible. Electrical pulses travel at incredible speed and a computer, an 

electronic machine, works on electrical pulses, so its speed is virtually instantaneous. 

When talking about the speed of computers, we donôt talk in seconds or microseconds 



but in nanoseconds (10
ï9

 seconds) or even Pico seconds (10
-17

 seconds). You can very 

well imagine the speed of computer by the fact that a computer can add two 18-digit 

numbers in 300 to 400 nanoseconds: that means that it can do about 3 million such 
calculations per second. 
 

Storage 
 

The human mind acquires some knowledge and after it has used it, it might keep it in 

its subconscious mind or might even forget it after some time. But computers can store 

massive amounts of information. This information can be used and reused time and 

again for years (unless something goes wrong with the hardware). Todayôs computers 

have disks with a capacity of storing billions of characters. This is big enough to store 

the complete Britannica thesaurus, dozens of computer programs or the applications, 

thousands of songs, huge databases, all the projects we have ever done in our life and 

much more. 
 

Accuracy 
 

Computers are very accurate. They do make mistakes, but seldom. This is because of 

their physical circuit. They make mistakes because of faulty programs, some mistake 

made while feeding in the data or poor designing. Highly efficient error detecting 

techniques of computers prevent showing false results. 
 

Versatility  
 

Computers are capable of performing any type of task, provided the activity can be put 

into logical steps. It can be used from cooking (microwave oven) to spending a night 

on the moon (through satellites). In todayôs world it is difficult to imagine even a 

single field which is untouched by computer invasion. 
 

Automation 
 

A computer is much more than just a calculator in which we need to give the 

instructions at every step. It is an intelligent device and, if programmed for an activity, 

it keeps doing it till it finishes, without any human intervention. 
 

Diligence 
 

A computer, being a machine, does not show any signs of fatigue, tiredness, lack of 

concentration, or loss in interest. The speed, accuracy and the quality would be 

absolutely the same in the first and the last calculation, even if the computer does 

millions of calculations. It wonôt complain even once of boredom. Thus, it is best 

suited for monotonous and voluminous work although that may seem like a threat to 

the people who are working on the same kind of jobs. 



Reliability  
 

All the above qualities of computers make them reliable and also make us too 

dependent on them. They can be run for years and years without any loss of data or 

facing any other problem. 
 

Although computers can potentially solve all the problems when instructed 

appropriately, they are not creative. They are designed and run by humans only. They 

might make an exact copy of Picasoôs paintings but actually can not give the world 

their original creations. They might print out countless copies of Shakespeareôs 

Hamlet but can never write anything on their own. They might replicate the Taj Mahal 

but will never be able to produce architecture like that on their own. And we must be 

happy about that as we humans still are superior to computers. 
 

DISADVANTAGES OF COMPUTERS 
 

Until now we have discussed the good points of computers like making work easier, 

reducing the response time, facilitating the daily activities, dealing with large amounts 

of data and many more, but there are some bad effects too attached to computers. 

Some of the disadvantages include the following: 
 

 They are manufactured using hazardous chemicals that can harm the health of 

users, as also contributing to pollution.  
 They are failure prone. A failure in a nuclear power station, or airplane etc. can 

endanger many lives and resources.  
 Discarded computers are real junk and consume lots of space. 
 
 They are always a threat to personal privacy. 
 
 Working longer on computers gives the user back pain, nerve injuries etc. 
 
 Because of the automation brought about by computers, unemployment is on the 

rise. 
 

TASKS ASSOCIATED WITH COMPUTERS: THE MULTIPURPOSE TOOL  
 

In the 1950ôs computers were special purpose machines that could cater to only 

governments or huge industries due to their high cost. Initially they were being used 

only to perform complex numerical problems such as these required in astronomy, 

statistics, processing, for the Bureau of Census or deciding the trajectory of missiles. 
 

In the 1960ôs, modern computers brought about a revolution around the world. In 

1964, IBM brought its systemðthe 360 mainframe computerðinto the market and 

sold about 33 thousand of these machines. After this grand success, IBM became a 

standard for computer manufacturers. 



In early the 1970ôs, DEC (Digital Equipment Corporation) took a step ahead by 

introducing its PDP-II and VAX computers. These catered to various segments. Modern 

computers were of different sizes and prices. That was the time when computers started 

shrinking in size. Todayôs personal computers or PCs, which are much smaller than those 

earlier computers, provide much power to the user and are inexpensive too. 
 

Business 
 

Computers have become such an integral part of our lives that we use them day and 

night. They have become such an important part of our business that it is difficult to 

think about life without them. From typing a letter to taking out the balance sheets of a 

company and designing a building, the computer is present everywhere. Today, in the 

offices of any industry, you will see computers on every desk, from the receptionist's 

table to the CEO's desk. 
 

Clerical staff use it for writing letters, to keep a record of their day-to-day expenses 

and administrative work, sales people carry laptops and notebooks to transmit 

information from anywhere in the field or to give their presentations. Accounting 

departments of every organization use them for manipulating and playing with the figures 

and numbers, taking out budgets, analyzing financial records and keeping track of the 

profits and losses of the company whereas the department keeps track of the leaves, 

resume(s) and any other information of the employees of the organization. 
 

You can see a computer when you go to buy grocery, or to a bank, or to make an 

inquiry about a flight, or to take out money from an ATM or to get a prescription from 

a doctor, or any other thing you can think of. 
 

Medicine and Health Care 
 

In the health care industry, computers are very useful. They are used for diagnosing 

the illness of a patient, performing surgeries and even controlling the robots that work 

as assistants to the doctors. 
 

Not only this, many small special purpose computers are placed inside the body of 

a patient for performing specific tasks (such as pacemakers). Artificial internal organs 

are commonly used nowadays to replace defective organs inside the body. Computers 

can be used to see internal hemorrhages or clots without even putting a cut on the 

human body. Now, some computers are so tiny that they are swallowed to take and 

transmit photographs of very dense parts of the human body. In this way they act as 

wonderful diagnostic tools. 
 

Now, laser surgery is performed without even a cut on the human body while 

everything it monitored on screens. This kind of bloodless surgery can only be 

performed because of computers. Accuracy and efficiency has increased tremendously 



and the rate of successful operations has also risen sharply. 
 

Education 
 

Computers have brought about a revolution in the education industry too. They are 

present in classrooms, libraries, laboratories and museums. Even a child of three years 

of age uses them. 
 

For young children, self-learning tutorials are so interesting that they start doing 

them before they start going to school. Most important is that all age groups can use 

them, i.e. from a child to very senior or old people. 
 

The concept of paperless libraries is spreading very fast. This means that there is 

not a single book in the library. Only computers are present. Students can go to these 

libraries and enter the name of the book they want to read and the contents of the book 

appears on screen. 
 

In museums, computers help visitors by telling them about exhibits. Detailed 

textual, audio and video information is available on computers and human guides are 

not used any more. 
 

Students prepare their project reports, presentations and even their notes on 

computers. Today, small kids prefer doing their homework on PCs. In the USA, most 

universities require assignments to be submitted on computer. No paper sheets or hand 

written assignments are allowed. 
 

Computers are very commonly used as interactive tools. They are used for 

teaching, testing, re-teaching and retesting, to make sure that the student understands a 

topic as per his mental level and caliber. 
 

Encyclopedias nowadays come in the form of CDs and are very helpful. One 

doesn't need to go and search in the huge and heavy Britannica. Not only this, most 

magazines, journals and newspapers are available in soft copies and the records of past 

decades are also stored in very less space. 



Science 
 

It would have been almost impossible to explore this world, specially the solar system, 

so intricately without the help of computers. It would have also been difficult to 

predict natural calamities like earthquakes, hurricanes, volcanoes, etc., and warn 

people beforehand so that safety measures could be taken well in time. 
 

Scientists collect, test, transmit, analyze and exchange information electronically 

to widen the scope of research and bring in more accuracy. This way they can estimate 

the impact of an expected natural calamity so that precautions are taken against them. 
 

A man stepped on the moon and the whole world watched his activities on their TV 

sets through satellites (again, thanks to the computer!). Now, satellites and spacecrafts are 

launched and computers monitor their activities without any human intervention. 
 

Engineering 
 

An electronic engineer designing chips manually would obviously be less productive 

than if he designs the same on PCs. Similarly, an architect can create the best design 

by matching the few options available to him. If, while designing, a number of views 

are to be seen, manually one has to draw that many number of drawing or figures 

describing each view separately, whereas the computer can give him access to the 

same figure from various angles, thus preventing the tedious, error prone and boring 

job of making the same drawings again and again. 
 

One of the most extensive uses of computers is CAD (Computer Aided Design). It 

helps the engineers tremendously in designing the aircrafts, missiles or even small 

airplanes. It not only saves time but also physical effort. One more advantage of 

designing with the help of CAD is that it saves a lot of money in designing and 

redesigning the parts of expensive mobiles. 
 

CAE (Computer Aided Engineering) goes one step further. It helps designers to 

specify even the type of material to be used in respective parts and to estimate whether 

the part will be able to withstand the required stresses and temperatures. This type of 

testing is a very critical part of the total designing of planes. 
 

Manufacturing  
 

The use of computers is not restricted to just the field of designing; but is being 

increasingly extended into the manufacturing sector as well. Be it in generating power, 

in manufacturing automobiles or even doing some embroidery work on a piece of 

cloth, the computer literally controls everything. Just some settings are required, and it 

not only functions smoothly but also gives warning signals 



(if required). And when needed, it sometimes takes appropriate action as well. 
 

For all those electricity-generating machines, computers control power production. 

These are special purpose computers. They not only monitor but also regulate the 

temperature and pressure inside and outside the boilers. If they are not able to control 

something at some critical point, they set the alarm/warning bells ringing, so that 

somebody can just come and check. It is so convenient and safe that now all the 

electricity-generating stations are fully automated and computerized. Apart from the 

ease of the work, they reduce the chances of any mishap. 
 

They also help a lot in the industries where the work is hazardous for humans. 

There computerized robots get in! They do the work like welding, painting, and 

cutting in steel industries, and also in industries where there is work that involves 

acidic elements that are very bad for health. The robots are fully computerized and this 

type of manufacturing is called CAM (Computer Aided Manufacturing). Now it is 

being called CIM (Computer Integrated Manufacturing) meaning computers can be 

used to control the entire production process, right from designing to manufacturing. 
 

Computers are also used in automated fabrication in the garment industry, and are 

involved in activities ranging from cutting the fabric to stitching buttons on the 

finished garment. Not only this, they are used in customized tailoring, meaning that 

the size and measurements of the customer are fed into the computer. The computer 

then gives instructions to the various machines attached to it and the best-fit clothes 

are ready for the customer! Computers are also used in embroidery machines. A 

design is fed into the computer and it is embroidered by it automatically with the 

colors of threads specified by you. Modifications can also be made in the pre-designed 

patterns and thus, a customized product can be manufactured. 
 

Legal Practices 
 

Just imagine a lawyer mugging up all the acts and sections of the law or even going 

through them to find out what is required. It is not only difficult but also error prone. 

On the other hand, think about the same lawyer feeding in the details of the case in the 

computer and getting a list of all the acts and sections or, even more specifically, the 

exact act and section applying to that case. The difference is amazing! 
 

Today all those law books are already fed into the computer for quick references. 

Such databases are very helpful for easy and quick work, which has actually helped in 

reducing the research time from hours to microseconds. 
 

Such use of computers is available not only to individual lawyers, CAs or attorneys 

but also in a courtroom where the stenographer's text is immediately transformed into 

readable text, and the decision taken by the magistrate can not only stored in the 

computer but can also be transmitted across the country for easy reference. 



Lawyers have also started carrying laptops to the courtroom for the details of the 

case they are fighting, thus contributing to building a paperless office. 
 

Government 
 

The government also makes extensive use of computers in its work. It has started 

making a database regarding childbirths, deaths, income taxes, any other taxes etc. 
 

Government Passport Services are also online, which means passport forms can be 

downloaded, and even filled and submitted online sitting at home. 
 

The campaigning for the elections is also done online nowadays. The time is not 

far when the entire electorate will vote directly online, when people will fill up their 

income tax forms online, and the entire database of each citizen of the country will be 

computerized, thus improving the government's efficiency. 



Law Enforcement 
 

Computers help many departments like the police or the crime branch to function 

more efficiently. In America, there are MDTs (Mobile Data Terminals) in which a 

police squad simultaneously calls all computers, which have data regarding the car 

numbers, persons who own those cars, their license numbers, whether they have valid 

license or if the detained person was issued a warrant etc. The computer notes down 

the number of the car (of the person violating the rule or the law) and then provides all 

the above-specified information to the constabulary. This not only makes the process 

faster but also reduces the hassle of calling up the department and collecting the same 

information from various places. Thus with MDT's help, the police perform their 

duties efficiently, effectively and on time. 
 

Similarly, the DNA technique is very popular in the crime branch where 

fingerprints are used to get all the information about the criminal or the person 

concerned. A very simple cue about a criminal can be used to draw the exact picture of 

the person with the help of a computer. 
 

Defence 
 

In the mid 1940's the first large scale computer ever developed was created for the 

Army of US - ENIAC (Electronics Numbered Integrator and Calculators). It required a 

house to fit in, occupied space as big as 1800 square feet and contained about 18,000 

vacuum tubes. It was initially designed to compute internal shell trajectories for 

various distances and weather conditions. 
 

Now computers are used in airplanes, fighter planes, submarines, on the 

battlefields in weapons and satellites, in one way or the other. 
 

The army, uses it in its Human Resources Department, considered the biggest 

organization in the world. Computers are used to communicate by radio in air, under 

water and on surface with a land based network that is used to integrate the systems. 
 

Computer nowadays are also used as Smart Bombs, which are actually missiles 

but don't look like that. 



Music 
 

Computers are a great help to the musicians as well. They not only compose their 

tunes and music on computer but can also use them to find out the best setting 

automatically. The MIDI (Musical Instrument Digital Interface) is very commonly 

used for synchronizing hardware and software, to produce electronic notes. 
 

A musician can touch one synthesizer key for producing the sound of an accord, 

and another for the sound of the tabla. Not only that, the computer also translates the 

music into text form or musical notes automatically. 
 

Various settings of different instruments can be tested independently and then can 

also be combined together to get the best possible output. It enables the fine editing to 

add music and sound effects to human speech and vice versa, thus getting best possible 

result of complex compositions and their synchronization with the instruments. 



Theatre, Film and Television 
 

Have you ever noticed the computer's contribution to the serials you see on the TV, the 

advertisements that children watch with such great interest or the movies you see in the 

cinema halls? All these owe a lot to computers for the improvement in the performance 

and inculcation of special effects, which have a great impact on the audiences. Even in 

theatres, the use of computers has become a very normal phenomenon. 
 

In theatres the lighting system is totally computerized and the effects of light are 

coordinated and controlled automatically as per the demand of the situation. Artists 

even use some images and sounds to improve upon the performances. This not only 

enhances the enjoyment but also leaves a deep impact on the minds of the audience. 

Virtual images are shown dancing on the floor, which actually is nothing in reality. 
 

In movies also, fictitious characters are made to do whatever is wished from them. 

Sometimes they are even made to work as actual live actors and actress. The 

characters are animated as needed. For example, the dinosaurs of ñJurassic Parkò were 

a masterpiece of computer creation. 
 

At Home 
 

If computers are used everywhere how can homes be left untouched? Apart from PC's, 

most of the computers that we use are generally hidden, which means that they are 

embedded in household appliances. For example, the microwave oven which warms 

our dinner and even switches off automatically after the job is done, has a computer 

embedded in it. Similarly our TV has an embedded computer, which automatically 

tunes the image brightness and sound as per the surroundings. 
 

Washing machines, sewing machines etc. also use computers for running faster 

and more efficiently. Mummy prepares the monthly budget, Papa makes a database of 

his meetings, addresses and schedules, and sons/daughters do their homework or play 

games on the PC. Grandpa tries his hand at a game of chess with the computer and 

grandma researches recipes for the kids. 
 

Internet  
 

The field of communication is another area where the use of computers has greater 

enhanced its efficiency and made it cheaper too. The Internet is a World Wide 

Network of computers that connects the people together and reduces the distances. It 

can be used for receiving, sending and sharing information. 
 

ELEMENTS OF A COMPUTER  



The computers about which we have been discussing come in all shapes and sizes and 

can be used for various purposes. But all of them have certain characteristics in 

common. Two of the most important constituents of computers are ð hardware and 

software. 
 

Apart from these two main elements of the computer, i.e. hardware, which 

represent the physical parts of the computer, and software that represents the programs 

that instruct the computer what is to be done, computers also include processing. 

Processing transforms data into information and involves data, people and procedures. 

Thus all these together are the five elements of the computing process (as a whole). 

These five elements are: 
 

 Hardware 
 
 Software 
 
 Data 
 
 People 
 
 Procedures 
 

But all these elements have to be organized in such a way that each element works 

smoothly and efficiently, both individually and in coordination with others. During the 

computing process, computers integrate all these five elements. 
 

Thus we can say that the computing process includes everything and everybody 

necessary to accomplish an activity or to perform a task. All the five elements of 

computing process are explained below in detail. 
 

Hardware 
 

The term hardware refers to the physical parts of the computer or includes anything in 

the computer that we can touch. It consists of interconnected electronic device that 

control everything in the computer. 
 

Hardware can be divided into four major categories. They are: 
 

 Processor 
 
 Memory 
 
 Input and Output Devices 
 
 Storage Devices 

 

Processor 
 

The complex procedure that transforms data into information (useful and meaningful 



data) is called processing. This type of transformation mainly includes two 

components ðthe processor and the memory. 
 

The Processor acts like the brain of the computer. It organizes and carries out the 

instructions given to the computer by the user or the message passed on by the 

software. There are various types of processors available in the market. In PC, we use 

microprocessor(s) (a number of microprocessors can also be used in one PC), 

Microprocessors are made of silicon or some other material and are etched with many 

tiny electronic circuits. The microprocessor is plugged into the circuit board ï a hard 

rectangular board that contains the total circuitry used to connect the processor to the 

rest of the hardware. This circuit board is called the motherboard. The number of chips 

and circuit boards (on which the processors are plugged in) is increased when the 

computer is to be made more powerful. The term Central Processing Unit (CPU), in 

real terms, is the processor of the computer. This ñbrainò of the computer, without 

which nothing can be done is very small in size and occupies just a few square inches 

of space.  
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 1.3 
 

Memory 
 

The software is loaded into the memory of the computer and runs from there only. Not 

only the software or programs, but also all the data is loaded into the memory for easy 

access. This memory is called as RANDOM ACCESS MEMORY (RAM). When one 

talks about memory one often means RAM only. 
 

The main thing to be kept in mind while working on the computer is that RAM is 

a volatile memory and every things disappears if power goes off or is turned off 

abruptly in the middle of work. Thus, it is always advisable to frequently save the 

work on the storage disk while you are working. 
 

The amount of RAM in a computer tremendously affects the speed and power of 

the computer. The more the RAM, the greater is the power and speed of the computer. 

The measurement unit of memory is byte. The bigger units of bytes are: 
 

Kilobyte (KB) ~ 1000 bytes [2
10

 bytes = 1024 bytes to be precise] 



Megabyte (MB)~ 1000 KB ~ 10,00,000 bytes 

Gigabytes (GB)~ 1000MB ~ 10 óKB ~ 10ô bytes 

Nowadays PCôs have 8 to 128 MB of RAM. 
 

ROM 
 

Read Only Memory holds permanent data or instruction that can only be read, and 

nothing can be written on it. Information is permanently recorded in it. It is 

nonvolatile memory. ROM contains instructions to get the computer started when it is 

switched on. It also holds instructions for the control of the various peripheral units of 

the computer, such as graphic display, disk drive etc. The controls of ROM are built 

into it at the time of its manufacturing. 
 

Input and Output Devices 
 

The computer accepts the instructions and delivers the results to the user by means of 

some devices. There are two main types of devices. Input devices are used to enter the 

instructions whereas output devices are used to see the results of processing. The term 

device is generically used to refer to any piece of hardware. 
 

Thus, input devices accept the instructions or the data from the user and output 

devices return the processed data back to the user in the form of visual display or on 

paper. New types of input devices keep on coming as technology and the users' 

demands grow. The most commonly used input device is the Keyboard, which accepts 

numbers, alphabets and commands from the user. Another input device is the Mouse 

that works with the action of a click or by moving. The diagrams or some drawing is 

made on the screen by pressing its button and moving it on the surface. Even the 

commands are executed by clicking it on the commands displayed on the screen. The 

other commonly used input devices are trackballs, joysticks, scanners, lightpens, 

microphones, digital cameras etc. These will be discussed in detail later. 
 

Both the Mouse and the Trackball are used almost in the same way. Both of them 

allow one to draw or to execute some action on the screen by a click. The Joystick is 

generally used to play videogames. A scanner is used as a photocopying machine. It 

copies the photographs, drawings or the text as it is into the computer memory, thus 

saving time of drawing or keying in manually. 
 

Lightpen is used to directly draw the figures on the screen of the monitor. 

Microphones help in inputting our voice directly in the computer or inputting music from 

CDs or audiocassettes by attaching them to the computer. Digital Cameras are used to 

bring in live images onto the screen, where some changes can also be made thereon. They 

are generally used in the barberôs shops (to see the best hairstyle that suits the 



customer) or in the optical shops etc. 
 

The output devices are used to see the results of processed input. The title case 

output devices mainly used are the screen or VDU (Visual Display Unit) and the 

Printers. When the soft copy of the output is required it is seen on the screen of the 

monitor and if hard copy (on paper) is required, then the computer sends it to the 

printer. Apart from these two output devices, Speakers can also be used as output 

devices to produce sound, listen to audio CDs or music. 
 

There are some more devices that act as both input and output devices. One such 

device is the Touch Screen which is a type of monitor that displays virtual buttons 

which you can touch. 
 

Modem is an example of a communication device that is used to communicate 

through telephone lines. It performs both the functions. It is used to interconnect the 

computers. The process of interconnecting the computers is called networking. The 

network interface cards are used to connect the input of computers so as to share the 

data and the devices. 



Storage Devices 
 

Although the computer can be said to be complete with input and output devices, 

memory and CPU, and can function quite well, but when it comes to the need of 

storing data or even programs files for future use, some place is required to store them. 

Storage devices are used to store data permanently or semi-permanently. 
 

Storage holds the data and the software brings into the memory (RAM) a particular 

program or data required at that point of time. After you have finished with the work, you 

again put back the programs and data (new one or processed) into the storage. 
 

Storage can be differentiated from memory thus: 
 

 Storage is cheaper than memory  
 Storage has more space than RAM 
 
 Storage is not volatile whereas RAM is, i.e. data remains in the storage even if 

the power is switched off unlike RAM  
 RAM is faster than storage. 
 

The most widely used storage medium is the magnetic disk, which is round in 

shape and flat. Read and write heads (similar to the heads of cassette players or VCRs) 

float above and below the disk near the surface. The disk spins around their center. 
 

The device, which holds the disk, is called a disk drive. There are some drives 

which have built-in disks and these disks cannot be detached from them, whereas 

some drives are meant for removable/replaceable disks. Almost every PC uses non-

removable disks, but additional removable diskette drives can also be used. The non-

removable drive is the Hard Disk Drive (HDD) and the removable one is the Floppy 

Disk Drive (FDD). A computer can have any number of HDDs and FDDs as per the 

user's requirements. 
 

HDD can store far more data than a diskette can, so the HDD serves as the 

computer's primary filling cabinet. Diskettes are used to load new programs or data on 

to the HDD to transport the data or make the backup copies of the data of the HDD. 
 

The floppy diskette or the removable disks are made of plastic, and, to protect 

them from dust and scratches, are kept enclosed in vinyl cases. Initially, floppies 

measured 8 inches; they were reduced to 5¼ inches and now we use 3½ inches 

diskettes. The size of diskettes is decreasing in diameter, but its storage size is 

increasing. The capacity of the 8" diskette was 360KB, and that of the 5½ inch was 1.2 

MB, whereas the 3-½ inch diskette stores 1.44MB of data. The name floppy was given 

because the vinyl cover (on 8ò and 5" diskettes) used to be very flimsy or floppy. 



Other types of storage devices include CD-ROM drives, tape drives, optical drives 

etc. CD-ROM is the most popular type of drive after Hard Disk Drives and Floppy 

Drives. Compact Disks are optical storage devices similar to audio CDs and can store 

approximately 640MB. In personal computers we generally use CD-ROM (Compact 

Disk Read Only Memory). The information on CD-ROM cannot be changed. 
 

Since new writable CDs have come into the market, it has become very 

convenient to store large amount of data, making it easy to transport. 
 

Software 
 

Software brings life into the computer. It is nothing but instructions (or a program) 

required to run the computer. It guides the hardware on how to do its job. A computer 

is otherwise a general-purpose machine. It is the software which differentiates the 

various kinds of jobs a computer can perform. Software consists of electronic 

instructions. A specific set of instructions that drive a computer to perform a specific 

task is called a program. When a computer is using a particular program, it is said to 

be running or executing that program. 
 

Programming Language 
 

Software programs are written in programming language and the programmers are the 

people trained in the use of a programming language to write the programs. 
 

Before the 1950ôs the only language available to the programmers was machine 

language or low-level language. A machine language was recognized by only one type of 

computer processor. Machine language is the only thing that computers understand but 

for programmers such machine language was very difficult to understand use and develop 

programs. In 1952, assembly language was introduced, which again was a low-level 

programming language. In assembly language short codes were used for specific machine 

operations. A specially designed program called assembler, was used to translate these 

codes to machine language, so that the computer was able to carry out the programmerôs 

instructions. Assembly language was easier than machine language, but it was still 

difficult in itself, as the programmer had to remember a large number of codes. 

Moreover, the programmer had to have the knowledge of the working of the computer. 
 

Then, in the 1960ôs, high level programming language came into existence. It was 

(and is) comparatively easy to use, as it understands simple English words and 

mathematical expressions. The programmers do not need to memorize the details of 

the working of the computer. 
 

Although the number of programs available is large and varied, software can be 

classified mainly into two categories: 

 System software 
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pplication Software 
 

Computer literacy involves learning the use of both system and application 

softwares. 
 

System Software 
 

One main type of system software is the operating system that is required by the 

computer to function. System software integrates the computer hardware components, 

and also provides the tools to use the software components in the desired manner and 

for the day-to-day maintenance tasks like displaying the list of all the directories and 

files on the disk. 
 

Operating System 
 

When the computer is switched on, it takes several steps to prepare itself for use. The 

first step is a self-test, i.e. it identifies all the hardware devices that are attached to it 

and whether the memory is functioning properly or not. This routine test is initiated by 

a part of the system software located in Read Only Memory (ROM), i.e. a chip that 

contains brief permanent instructions for getting the computer started. Next, the 

computer looks in the diskette drive and then in the hard drive for a special program, 

i.e. operating system. This system tells the computer how to use the hardware devices 

such as the disk drive, keyboard, and monitor and how to interact with the users. 

When the computer finally finds the operating system it loads it into the RAM. It 

remains there till the computer is switched off. 
 

After the loading of the operating system, the computer is ready to accept the 

commands and instructions from the input device. There are different types of 

operating systems that are commonly used, such as MS DOS (Microsoft Disk 

Operating System), Microsoft Win95, Microsoft Win98, Microsoft Win NT, 

Macintosh operating system, Linux etc. 
 

Application Software 
 

It is the software which turns the computer into a tool for doing some specific tasks. 

These are the programs, which cater to various needs of the users. Application 

software is written for every type of task, i.e. from word processing to collecting 

information on the worldwide web. 
 

The complex programs, such as any word processing package (MS WORD), 

consist of many separate programs that are designed to run together. Such a collection 

of software programs is known as a software package. 
 

Application software can further be classified into: 



 Special Purpose Application Software 
 
 General Purpose Application Software 
 

Special Purpose Application Software 
 

They are used to perform a specific task, say for a single profession, e.g. nuclear 

energy scientists use special programs for exploding the nuclear bombs. If a person 

has no knowledge about the subject, he wonôt find it useful or interesting to learn. 
 

General Purpose Application Software 
 

These are the other type of application software used by millions of people for doing 

varied tasks. Commonly used General Purpose softwares are: 
 

Word Processing: We can say that the word processing programs are computerized 

typewriters. The difference is of the facilities available in the package. Editing in the text 

files is easy, spellings and grammar can be checked, and diagrams, figure, labels can be 

inserted very easily. It has become a very handy tool for writing books and as editing is 

done very conveniently thereon. All the legal documents and encyclopedia etc are typed 

on to the computer for easy reference. It also prevents wear and tear. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 1.4: Word Processing using Microsoft Word  
 

Desktop Publishing: Although most of the word processors have the facility of 

desktop publishing, these specially designed programs are very helpful in designing 

newsletters, magazines etc. Earlier it used to be a tedious task as it involved time 

consuming activities like cutting the papers, photographs, border designing and then 

pasting them to create an effective layout, but now it has not only become convenient but 

also gives a better and more pleasing layout. The attractive results can be taken out and 

this needs very little training and practice. Business organizations and media use DTP to 

design their advertisements and catalogues. Even the books that include creative graphs 

are taken out by using DTP. DTP produces output that is a combination of word 



processing and graphics, resulting in professional looking papers ready for printing. 
 

One of the commonly used DTP software is Quark Express. 
 

Spreadsheet: Imagine the days of calculating budgets, involving voluminous numbers 

checking either manually or by using calculators. In electronic spreadsheets, a series of 

rows and columns are displayed. One can view just a part of it and scroll the sheet as per 

requirement. The text, numbers or formulas can be put into cells to create a worksheet. 

Even logical computations are possible by using spreadsheets. Spreadsheets are also used 

to generate charts and graphs to establish a relationship among the data or to make an 

analysis of the data entered. One of the main advantages of this electronic spreadsheet is 

editing i.e. all the invalid data or the wrongly entered data can be modified. They are 

generally used in accounts section of an organization to take out the ledgers, in institutes 

to take out the results of the students or in the departments where statistical computation 

is done, etc. One can have a number of sheets in one file, and these can also be inter-

linked. Spreadsheets nowadays are generally three-dimensional. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 1.5: Automating Calculations using Microsoft Excel 
 

Database Management Systems (DBMS): Database Management System provides 

you with the ability to have well-organized collections of data (database) and to retrieve 

them in the order required. Tools are provided in DBMS to use the data in subsets, and 

relationships can be established to accomplish the required activity. For example, in an 

institution, the records can be sorted out either on the basis of the names or roll numbers 

or ages of the students, and you can refer to the sorted files for any information. 

Retrieving information has become childôs play by using DBMS, that is data can be 

sorted out on a number of fields or can be categorized, and they can even be combined 

together to get some typical information. For example, you want to know the address of a 

student but you do not know his full name. You just have an idea that his last name is 

ñSahniò and his age is between 14 and 16. Then DBMS can help you out by displaying 

the list of students whose surnames are ñSahniò and age is between 14 and  

 Only those records will be selected and displayed which meet the specified 

conditions. The commonly used DBMS are FoxPro 6.0, Microsoft Access, Oracle 8I, 

SQL Server etc. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 1.6: Watching Movie from a Site on World Wide Web 
 

Communications: The software programs that are used to work in combination 

with some other devices are called communication software. We use a number of 

communication software like fax, Internet, network etc. 
 

 Fax Software: The computer can work as a fax machine. A fax can be sent by and 

received on a computer like any other fax machine. Many online service providers 

like America Online (AOL), Microsoft Network etc, distribute this type of 

software. This software is freely available on the Internet and can be downloaded. 

Only a computer and a telephone line are required. 
 

 Network Software: Another type of communication software is network software, that 

allows users to create a network which is simply a number of computers connected 

together in one room, a building, a city, a country or the whole world. To connect the 

computers on a small scale one just needs computer, cables and software like Win NT, 

Unix, Linux or Novellôs NetWare. To connect to the whole world together by 

computer, i.e. to get connected to anywhere in the world with one PC, one needs just a 

modem and a telephone line, where the modem is used to translate the signals of the 

computer, and the telephone lines act as carriers of the data from one place to another. 

This multi-user transport system enables one to send emails, to chat with people sitting 

miles away, to talk to them with the help of a microphone and a speaker attached to 

the system, to make online bookings for airlines, hotels or even movies. This is very 

helpful in accessing the computer resources which are located elsewhere. You can 

even get your groceries delivered to your doorstep. This has made life very easy and 

convenient, as one can access almost anything one can think 



of, just sitting at home. 
 

Graphics, Multimedia and Presentation Application: The programs needed to play 

with images are known as graphics software. They can be used for tasks ranging from 

making simple drawings, to making animated movies that leave a great impact on 

audiences. Sometimes the viewers do not even come to know that it was a mirage 

created by the computer.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 1.7 
 

Using paintbrush software, simple painting or drawing can be done. Images can be 

edited with the help of software like imaging, whereas for bigger graphical software 

that includes multimedia, multimedia-authoring software is used. They include 

images, text, sounds, animation and videos etc. They help in combining all the above 

and blending them wonderfully. This software includes special tools for synchronizing 

the sounds with moving pictures, text and images. They are very commonly used to 

make computer animations, audio and video albums etc. The video games, which kids 

play with great interest, are all made with the help of these multimedia softwares.  
 
 
 
 
 
 
 
 
 
 
 

 

Figure 1.8 
 

CAD software is also a kind of graphics software, which is generally used by 

architects and engineers to design buildings or products before they are actually built 

or manufactured. 



Presentation graphics is another type of graphics software, which is very useful in 

preparing beautiful and attractive presentations that are easily understood by the 

audience. It include transparencies, computer presentations, etc., which can be 

displayed by using projectors. Handouts can also be designed by these presentation 

packages. Slides have a combination of text, image, clipart, sound and visual effects. 

Automatic slide show can also be set meaning the speaker doesnôt have to divert his 

attention on changing the slides but concentrate only on the speaking or the 

explanation of the contents of presentation. Animated slide shows with sound effects 

can also be designed to give a more professional look. Graphs and charts can also be 

imported from spreadsheets and included in the presentation software to give the 

audience a better understanding of the matter. A commonly used presentation software 

is Microsoft Power Point. 
 

Education and Entertainment Software 
 

From a child of three to a professor of 50 computer programs are used for the purpose 

of education. Children not only use them for their games but also for educational 

programs like encyclopedias, mathematical drawing and other subjects. In schools and 

colleges, students prepare their presentations and even make their notes on computers. 

In graduate schools, all assignments are submitted on the computer itself. 
 

Educational programs teach kids how to perform simple calculations, how to make 

words from alphabets, how to pronounce them etc. Children learn them in a fun 

atmosphere. They enjoy it and the purpose of giving them training is also solved. It is 

easy for students in higher classes or profession to learn through audio and video aids. 

Doctors can see and perform electronic surgeries for practice whereas an engineer can 

design products and can also find out the most suitable output before actually producing 

or manufacturing it. Astronomers can use them for finding out the correct position of 

stars and planets and the dates of eclipses etc., whereas crime branches in the police can 

teach the cadets the method of matching the fingerprints or even the faces of the 

criminals. Thus you can learn so many things while playing, as it is more interesting. 
 

Utilities 
 

This is the software, which generally comes with the operating system but is also 

available otherwise. The software provides tools for assisting the computer operations 

utilities including helping you out by taking up the backup of the data that has 

accidentally been erased, or by arranging the data and information required by the 

user. Nowadays most of the utilities come as a part of the operating system. Windows 

operating systems come with many tools that take care of your disks, anti-viruses, 

back up etc. Utilities help in solving the problems that keep creeping up every now 

and then, thus enabling your computer to function smoothly. 



Resource Discovery Software 
 

The latest and the most prevailing innovation in the area of IT is the widely spread 

Internet. It is like a seaðthe more you explore the more is there to know. The Internet 

is nothing but a global network of linked computer networks with the help of 

telephone links and satellites. To access the vast sea of knowledge on these networked 

computers some commonly and popularly used tools are Archie, Gopher and the 

World Wide Web which help the user in accessing the computer resources available to 

the people who are globally connected. 
 

PEOPLE 
 

Although it sounds odd, it is, however, a fact that people are a part of the computing 

process. By people we do not mean the direct involvement of people. The people are 

sometimes indirectly involved in the computing process. Even the fully automated 

computerized machines, which operate without human intervention (discussed earlier), 

are designed and manufactured by people, and even their maintenance is not possible 

without human intervention at times. Thus, the computer ultimately works under the 

human being and can never be the boss! 
 

People involved in the computing process can broadly be classified into users (or 

end users), power users, and computer professionals. 
 

People who operate the computers are called users or end user, whereas power 

users are the people who work on specified tasks. Knowledge of power users is more 

than that of the basic users and they (power users) work on advanced features of 

applications programs. They customize the applications as per the requirements. They 

are highly knowledgeable people. 
 

The last category is of the computer professionals. They have an in-depth 

knowledge about computers. They are specially trained for using the computer 

resources optimally. They, apart from working on the computer, take care of the 

performance and efficiency of computer systems. Programmers are one kind of 

computer professionals who create computer programs. They are the ones who do all 

the software-development work. Hardware engineers are also a part of computer 

professionals, and they look after the maintenance and hardware-related problems of 

the computers. 
 

PROCEDURES 
 

Procedures are basically the steps that a user follows to make the computer work, and 

these also include the steps the computer follows to accomplish the instructions given 

by the user. 



Take an example of using an ATM card. You go to the bank, insert your card, 

some instructions are displayed on the screen (like enter your PIN number), and you 

keep following the instructions which the computer gives to you. Finally, you achieve 

what you wanted to, like getting fast cash or depositing a cheque. You take back the 

card and go away. Another example could be setting a phone alarm or registering the 

complaint of your phone. You follow the instructions you are told to, like enter your 

faulty telephone number etc. These are examples of computer procedures. You will 

come across numerous such kinds of computer processes in your daily life. 



STRUCTURED ENGLISH 
 

The purpose of a Structured English business process definition language is to 

describe a process in unambiguous terms that can be easily read and understood by a 

non-technical business user. 
 

You can develop your own structured English style that suits your company. Some 

good style points to follow are: 
 

 ̧ Express all logic in terms of sequential structures, decision structures, or iterations 
 
 

 Use uppercase for keywords like IF, THEN, ELSE DO, WHILE, and lower case for 

everything else. This ensures that the logical structure of the process is easily 

visible 
 
 ̧

 
 ̧

 

Use indentation to reinforce the logical structure of the 

process Keep the description high-level 
 

The flow of structured English can be represented by the following Figure:  
 
 
 
 

 

The main difference between Structured English and Program is that syntax rule 

are not very strict and an English statement is used to specify an action. The main aim 

is to allow easy readability, which helps in documentation. The following conventions 

are used in writing structured English 
 

 Imperative Sentences: This consists of an imperative verb followed by the 

action to be performed on variables. For example: 
 

Store profit in revenue 
 

Subtract new price from old price 
 

are some examples of imperative sentences 
 

 Arithmetic and Relational Operations: Common symbols used in arithmetic 

are also used in Structured English. They are: 
 

 for Add; - for Subtract; * for Multiply; / for 

Divide Symbols used in relational operations are: 

          Ἃ ǔ             ǔ             ǔ             ǔ             ǔ             ǔ             ǔ             ǔ             ǔ Ἃǔ          Ἃ ǔ             ǔ             ǔ             ǔ             ǔ             ǔ             ǔ             e

qual to; > greater than; < less than; != not equal to; <= less than equal to; >= 

greater than equal to 



Symbols used for logical operations are: 
 

and, or, not 
 

Symbols used as keywords are: 
 

if, then, else, repeat, until, while, do, case, end ,for etc. 
 

 Decision Structure: There are two types of decision structure used in Structured 

English statement. One of them is if then else structure, where a condition is checked 

and the decision is given on the basis of the truth or falsity of the outcome. 
 

IF condition1 THEN 
 

block of steps1 
 

(ELSE IF condition THEN 
 

block of steps n) 
 

[ELSE 
 

block of steps otherwise] 
 

END IF 
 

The other structure is case structure where the condition being checked 

results in more than one output. Hence a number of cases arise as the result of 

condition checking, which are dealt with individually. 
 

SELECT expression 
 

CASE range of values 1 
 

block of steps1 
 

(CASE range of values n 
 

block of steps n) 
 

(ELSE 
 

block of steps otherwise] 
 

END SELECT 
 

 Repetition: This is one of the most powerful structures used in the computer 

programming. This structure based on a condition repeats itself for some stipulated 

iterations. There are basically two types of such structure: one in which the number 

of iteration is know. This is the For structure. If there are fixed iterations to be done, 

for example, to add the marks of a student in five subjects, the loop will be repeated 

five times, then this structure is used. The other type of repletion statement is when 



the exiting from the loop depends on the condition to be true or false. In the Do-

Repeat or the Do-While structure conditional statement the loop is terminated when 

the condition is false. The structure exits the loop when the condition becomes true. 
 

In the While-Do kind of structure the loop is iterated till the condition is 

true. For example if we have to print all the records in a file till the end of the file, 

we state the condition as: 
 

while (not end of file) 
 

print record 
 

move to next record 
 

do 
 

In the above the code will run till the file reaches its end. 
 

There are various forms in which we can implement Structure English to solve our 

problem. They are Algorithm, Flowchart and Pseudocode. We will deal with each one 

in the following section. 



INTRODUCTION TO ALGORITHMS  
 

Algorithms were used to solve everyday problems long before computers were even 

invented. The word algorithm comes from the name of the 9th century Persian 

mathematician Abu Abdullah Muhammad bin Musa al-Khwarizmi. The word 

algorism originally referred only to the rules of performing arithmetic using Arabic 

numerals but evolved into algorithm by the 18th century. The word has now evolved 

to include all definite procedures for solving problems or performing tasks. 
 

The first case of an algorithm written for a computer was Ada Byron's notes on the 

analytical engine written in 1842, for which she is considered by many to be the 

world's first programmer. However, since Charles Babbage never completed his 

analytical engine the algorithm was never implemented on it. 
 

Algorithms have been used for centuries to solve the most complex problems that 

humanity has encountered. One of the most famous algorithms was imagined in 

ancient Greece. Euclid's algorithm for calculating the greatest common divisor of two 

integers had and still does have impacts on the mathematical world. The importance of 

algorithms in today's society should not be underestimated. The computer, for 

example, would otherwise be useless since almost all programs are written using an 

algorithmic approach. 
 

Algorithm can be formally defined as: 
 

"A formula or set of steps for solving a particular problem. To be an algorithm, a 

set of rules must be unambiguous and have a clear stopping point. Algorithms can be 

expressed in any language, from natural languages like English or French to 

programming languages like FORTRAN." 
 

We use algorithms every day. For example, a recipe for baking a cake is an 

algorithm. Most programs, with the exception of some artificial intelligence 

applications, consist of 
 

algorithms. Inventing elegant algorithms -- algorithms that are simple and require 

the fewest steps possible -- is one of the principal challenges in programming. 



Properties of an Algorithm 
 

 Correctness - is a characteristic that is most necessary. An algorithm should be 

implementable on a computer and give a correct answer to a given problem (in a 

finite amount of time).  
 Efficiency - A good algorithm should make efficient use of the two main 

resources in a computer system, time and space. A good algorithm should make 

efficient use of time and space not only in the theoretical sense but also in its 

actual running time for the cases of interest to the user of the algorithm.  
 Ease - A good algorithm should be easy to implement (in terms of the number 

of times it will be run). 
 

In the above properties first is of course, the most essential. An algorithm must be 

implementable and correctly give the desired output. The rest of the properties are 

relative. An algorithm may use extra space (or memory) but give faster results. It may 

be that the algorithm will be used thousands of times once it is implemented, so we 

can choose a more efficient algorithm which is not so easy to implement. It may be 

that an algorithm makes efficient use of time and space in theory but is inefficient in 

practice or for the sizes of input we will be encountering. 
 

Here is a simple example of an algorithm. 
 

Imagine you have an unsorted list of random numbers. Our goal is to find the 

highest number in this list. Upon first thinking about the solution, you will realize that 

you must look at every number in the list. Upon further thinking, you will realize that 

you need to look at each number only once. Taking this into account, here is a simple 

algorithm to accomplish this: 
 

 When you begin, the first number is the largest number in the list you've seen so  
far.  

 Look at the next number, and compare it with the largest number you've seen so  
far.  

 If this next number is larger, then make that the new largest number you've seen 

so far. 

 Repeat steps 2 and 3 until you have gone through the whole list. 
 

FLOWCHART  
 

A flowchart (also spelled flow-chart and flow chart) is a schematic representation of a 

process. It is commonly used in business/economic presentations to help the audience 

visualize the content better, or to find flaws in the process. A flowchart illustrates the 



steps in a process. By visualizing the process, a flowchart can quickly help identify 

bottlenecks or inefficiencies where the process can be streamlined or improved. It 

allows one to break any process into individual events or activities, and to display 

these in shorthand form, showing the logical relationships between them. 
 

Examples include instructions for a bicycle's assembly, an attorney outlining a 

case's timeline, the diagram of an automobile plant's work flow, the decisions to be 

taken on a tax form, etc. 
 

How to Draw a Flowchart? 
 

A basic flowchart identifies the starting and ending points of a process, the sequence of 

actions in the process, and the decision or branching points along the way. Generally the 

start point end points, inputs, outputs, possible paths and the decisions that lead to these 

possible paths are included. Flow-charts can be created by hand or manually in most 

office software, but lately specialized diagram drawing software has emerged that can 

also be used for the purpose, such as Visio, Openoffice.org Draw and Dia. 
 

Four particular types of flow charts have proven useful when dealing with a 

process analysis: top-down flow chart, detailed flow chart, work flow diagrams, and 

deployment chart. Each of the different types of flowcharts tends to provide a different 

aspect to a process or a task. Flow charts provide an excellent form of documentation 

for a process, and are quite often useful when examining how various steps in a 

process work together. 
 

When dealing with a process flowchart, two separate stages of the process should 

be considered - the finished product or how to operate the process and the making of 

the product. 
 

Step-by-Step process of how to develop a flow chart: 
 

 Gather information on how the process flows: use conservation, experience, or 

product development codes 
 
 ̧

 
 ̧

 
 ̧

 
 ̧

 

Trial process flow 
 

Allow other more familiar personnel to check for accuracy 
 

Make changes if necessary 
 

Compare final actual flow with best possible flow. 
 

Flowchart Symbols 
 

Flowcharts use special shapes to represent different types of actions or steps in a 

process. Lines and arrows show the sequence of the steps, and the relationships among 

them. All the symbols are illustrated in the following Figure. 
 



Start/End: The terminator symbol 

marks the starting or ending point of 

the system. It usually contains the 

word "Start" or "End."  
 

Action or Process: A box can 

represent a single step ("add two 

cups of flour"), or and entire sub-

process ("make bread") within a 

larger process. 
 

Document: A printed document or 

report. 
 

Decision: A decision or branching 

point. Lines representing different 

decisions emerge from different 

points of the diamond. 
 

Input/Output:  Represents material 

or information entering or leaving 

the system, such as customer order 

(input) or a product (output). 
 

Connector: Indicates that the flow 

continues where a matching symbol 

(containing the same letter) has been 

placed. 
 

Flow Line: Lines indicate the 

sequence of steps and the direction 

of flow. 
 

Delay: Indicates a delay in the 

process. 
 

Merge: Indicates a step where two 

or more sub-lists or sub-processes 

become one. 
 

Collate: Indicates a step that orders 

information into a standard format. 
 

Sort: Indicates a step that organizes 

a list of items into a sequence or sets 

based on some pre-determined 

criteria. 
 

Subroutine: Indicates a sequence of 

actions that perform a specific task 

embedded within a larger process. 

This sequence of actions could be 

described in more detail on a 

separate flowchart. 



Manual Loop: Indicates a sequence 

of commands that will continue to 

repeat until stopped manually.   

Loop Limit:  Indicates the point at 

which a loop should stop. 
 

Data storage: Indicates a step 

where data gets stored. 
 

Database: Indicates a list of 

information with a standard structure 

that allows for searching and sorting. 
 

Display: Indicates a step that 

displays information. 
 

Off Page: Indicates that the process 

continues off page. 

 

There are five rules that should be considered while drawing a flowchart: 
 

Rule 1: Program flowchart should use conventional symbols. This helps to keep 

uniformity and understandability. 
 

Rule 2: The logic of a program flowchart should flow from top to bottom and from left 

to right. This allows Standard English convention and imposes consistency upto 

the drawing. 
 

Rule 3: Each symbol used in a program flowchart should have at most one entry point 

and one exit point. This will always lead to same solution and consistency. 
 

Rule 4: As far as possible, the instruction within the symbols of a program flowchart 

should be independent of any particular programming language. It is not always 

known in which programming language the actual code would be written. So 

the instruction should be written in simple English language. 
 

Rule 5: All decision branches should be labeled. The decision box gives two output: 

one is a true and the other is a false, or a yes and a no. Both branches should be 

correctly labeled according to the decision being made. 
 

Tips for Effective Flowcharts 
 

 Label each flowchart with a title identifying the process that it illustrates. (For 

example: "Order Entry Process"). 

 Clearly indicate the starting and ending points of the process, using the standard 



terminator symbols. 
 

 Keep the direction of flow consistent. Avoid confusion by keeping your flow 

lines moving from top to bottom and left to right. Don't reverse the direction in the 

chart unless the flow reverses itself in reality.  

 Break the steps down to a consistent level of detail. Don't 

include trivial sub-steps of one task while treating another equivalent task as a 

whole. If one step or task needs to be analyzed in detail, make a separate chart 

illustrating that sub-process.  
 Avoid crossing flow lines. In a well-designed chart, flow lines will not cross 

each other. By rearranging a chart you can usually get rid of crossed lines. If two 

lines must cross, use a "bridge" (also known as a "line hop") to show that the lines 

do not intersect. 
 

6. Make sure there are at least two outcomes from every decision diamond. 
 
 

 Label your flowchart components. Use active verbs to label activity steps and 

questions to label decisions. Clearly label the outcomes from a decision diamond 

in terms that answer the question. 



Advantages of Using Flowcharts 
 

The benefits of flowcharts are as follows: 
 

 Communication: Flowcharts are a better way of communicating the logic of a 

system to all concerned. 

 Effective Analysis: With the help of a flowchart, a problem can be analyzed in a 

more effective way. 

3. Proper Documentation: Program flowcharts serve as good program 

documentation, which is needed for various purposes. 

 Efficient Coding: The flowchart acts as a guide or blueprint during the systems 

analysis and program development phase. 

 Proper Debugging: The flowchart helps in the debugging process. 
 

6. Efficient Program Maintenance: The maintenance of an operating program 

becomes easy with the help of a flowchart. It helps the programmer to put efforts 

more efficiently towards that part. 



Limitations of Using Flowcharts 
 

1. Complex Logic: Sometimes the program logic is quite complicated. In such a case, 

the flowchart becomes complex and clumsy. 

2. Alterations and Modifications: If alterations are required the flowchart may need 

to be 

re-drawn completely. 
 

3. Reproduction: As the flowchart symbols cannot be typed, reproduction of a 

flowchart becomes a problem. 

4. The essentials of what is done can easily be lost in the technical details of how it is 

done. 
 

Let us now see some examples of flowcharts. 



Example 1: To draw a flowchart to find the sum of first 50 natural numbers.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Sum of first 50 natural numbers 



PSEUDOCODE 
 

Pseudocode is a kind of structured English for describing algorithms. It allows the 

designer to focus on the logic of the algorithm without being distracted by details of 

language syntax. At the same time, the Pseudocode needs to be complete. It describes 

the entire logic of the algorithm so that implementation becomes a rote mechanical 

task of translating line by line into source code. 
 

In general the vocabulary used in the Pseudocode should be the vocabulary of the 

problem domain, not of the implementation domain. The Pseudocode is a narrative for 

someone who knows the requirements (problem domain) and is trying to learn how the 

solution is organized. 
 

Each textbook and each individual designer may have their own personal style of 

Pseudocode. Pseudocode is not a rigorous notation, since it is read by other people, not 

the computer. There is no universal "standard" for the industry, but for instructional 

purposes it is helpful if we all follow a similar style. The format below is 

recommended for expressing your solutions in our class. 
 

Pseudocode uses the pattern of structured English. The basic constructs for flow of 

control are as follows: 
 

 SEQUENCE is a linear progression where one task is performed sequentially 

after another. 
 

 WHILE is a loop (repetition) with a simple conditional test at its beginning. 

 

 IF-THEN-ELSE is a decision (selection) in which a choice is made between two 

alternative courses of action. 
 

 REPEAT-UNTIL is a loop with a simple conditional test at the bottom. 

 

 CASE is a multiway branch (decision) based on the value of an expression. 

CASE is a generalization of IF-THEN-ELSE. 
 
 ̧

 

 ̧

 

FOR is a "counting" loop. 
 

SEQUENCE 
 

Here is an example to illustrate these constructs. 
 

READ height of rectangle 
 

READ width of rectangle 
 

COMPUTE area as height times width 
 

Here the common Action Keywords are as follows. 



Input: READ, OBTAIN, GET 
 

Output: PRINT, DISPLAY, SHOW 
 

Compute: COMPUTE, CALCULATE, DETERMINE 
 

Initialize: SET, INIT 
 

Add one: INCREMENT, BUMP 
 

 IF-THEN-ELSE 
 

The general form of this structure is 
 

IF condition THEN 
 

sequence 1 
 

ELSE 
 

sequence 2 
 

ENDIF 
 

The ELSE keyword and "sequence 2" are optional. If the condition is true then 

sequence 1 is performed, otherwise sequence 2 is performed. For example 
 

IF HoursWorked > NormalMax THEN 
 

Display overtime message 
 

ELSE 
 

Display regular time message 
 

ENDIF 
 

 WHILE 
 

The general form of this structure is 
 

WHILE condition 1 
 

sequence 1 
 

ENDWHILE 
 

The loop is entered only if the ñcondition 1ò is true. The "sequence 1" is 

performed on every iteration. At the conclusion of each iteration, the condition is 

evaluated and the loop continues as long as the condition is true. For example 
 

WHILE Population < Limit  
 

Compute Population as Population + Births - Deaths 



ENDWHILE 



 CASE 
 

There are four keywords, CASE, OF, OTHERS, and ENDCASE, and conditions 

that are used to indicate the various alternatives. The general form is: 
 

CASE expression OF 
 

condition 1 : sequence 1 
 

condition 2 : sequence 2 
 

... 
 

condition n : sequence n 
 

OTHERS: 
 

default sequence 
 

ENDCASE 
 

The OTHERS clause with its default sequence is optional. Conditions are 

normally numbers or characters indicating the value of "expression", but they can be 

English statements or some other notation that specifies the condition under which the 

given sequence is to be performed. A certain sequence may be associated with more 

than one condition. 
 

Example 
 

CASE Title OF 
 

Mr. 
 

: Print "Mister" 
 

Mrs. 
 

: Print "Missus" 
 

Miss. 
 

: Print "Miss" 
 

Ms. 
 

: Print "Mizz" 
 

Dr. 
 

: Print "Doctor" 
 

ENDCASE 
 

Example 
 

CASE grade 
 

OF 
 

A 
 

: points = 4 
 

 

C 

 

 

: points = 2 
 

D 
 

: points = 1 
 

F 
 

: points = 0 



ENDCASE 
 

 REPEAT-UNTIL 
 

Two keywords, REPEAT and UNTIL are used. The general form is: 
 

REPEAT 
 

sequence 1 
 

UNTIL condition 1 
 

The "sequence 1" in this type of loop is always performed at least once, because 

the test is performed after the sequence is executed. At the conclusion of each 

iteration, the ñcondition 1ò is evaluated, and the loop repeats if the ñcondition 1ò is 

false. The loop terminates when the ñcondition 1ò becomes true. 
 

FOR 
 

This loop is a specialized construct for iterating a specific number of times, often 

called a "counting" loop. Two keywords, FOR and ENDFOR are used. The general 

form is: 
 

FOR iteration bounds 
 

sequence 
 

ENDFOR 
 

In cases where the loop constraints can be obviously inferred it is best to describe 

the loop using problem domain vocabulary. For example 
 

FOR each month of the year (good) 
 

FOR month = 1 to 12 (ok) 
 

FOR each employee in the list (good) 
 

FOR empno = 1 to listsize (ok) 
 

 NESTED CONSTRUCTS 
 

The constructs can be embedded within each other, and this is made clear by use 

of indenting. Nested constructs should be clearly indented from their surrounding 

constructs. For example 
 

SET total to zero 
 

REPEAT 
 

READ Temperature 
 

IF Temperature > Freezing THEN 



INCREMENT total 
 

END IF 
 

UNTIL Temperature < zero 
 

Print total 
 

In the above example, the IF construct is nested within the REPEAT construct, 

and therefore is indented. 



REVISION EXERCISES 
 

Fill in the blanks 
 

 Portable computers that fit into a briefcase are called _________ . 
 
 _________ refer to the combination of hardware, software, data, people and 

procedures.  
 Electronic instructions that tell a computer what to do are called _________. 
 
 A _________ is a group of electronic devices used for processing data. 
 

5. A keyboard and a screen wired to a mainframe together are known as a 
 

________. 
 

 A program is a list of _________ guiding a computer on what to do. 
 
 A binary digit, called _________ has a value _________ or _________ 
 
 The machine and its components are called _________. 
 
 The irrational fear of computers is termed as _________. 
 
 Application programs that can be used to do many related tasks are called  

_________. 
 
 A group of programs designed to work together to perform a task is called a software 

_________.  
 _________ was the first Computer programer. 
 
 High-Level-language was introduced during the _________ computer generation. 
 
 A program flowchart  indicates  the_________  to  be  per  formed  and  the  

__________ in which they occur. 
 
 A program flowchart is generally read from _______________________ to  

________________ 
 

16. Flowcharting symbols are connected together by means of 
 

___________________ 
 

 A decision symbol may be used in determining the ________________ or  
___________ of two data items. 

 
 __________ are used to join remote portions of a flowchart 
 
 ____________ connectors are used when a flowchart ends on one page and 

begins again on other page 



 A ________ symbol in used at the beginning and the end of a flowchart. 
 
 The flowchart is one of the best ways of ________ a program.. 
 
 To construct a flowchart, one must adhere to prescribed symbols provided by the  

__________ . 
 
 The programmer uses a ____________ to aid him in drawing flowchart symbols. 
 

Answers        

1. Laptop 2. Computer systems 3. Programs 

4. Computer 5.  Workstation   

6. Instructions 7.  Bit, zero, one   

8. Hardware 9.  Cyberphobia   

10. General purpose software 11. Package  

12. Augusta Ada Byron  13. Second   

14. Operations, sequence  15. Top, down  

16. Flow line       

17. Equality, inequality  18. Connectors   

19. Off -page 20.  Terminal    

21. Documenting       

22. ANSI (American National Standards Institute)   

23. Flowcharting template      
 

Tick-mark the correct answer 
 

 What is the name of the cycle that describes the computer's processing of data: 
 

 Processing cycle 
 

 Cyber-phobia cycle 
 

 IPOS Cycle 
 

 Information cycle. 
 
 What are the two essential parts of the computer? 
 

 Keyboard and mouse 
 

 Hardware and software. 
 

 Printer and screen 



 None of the above 
 
 The purpose of the computer is to process the data into 
 

 Meaningful data 
 

 Information 
 

 Arithmetic operations 
 

 Formulas 
 
 How are software packages categorized? 
 

 Hardware and software 
 

 Word processing and spreadsheets 
 

 System software and application software 
 

 None of the above 
 
 The software can be divided into: 
 

 System software and application software 
 

 General purpose software and special purpose software 
 

 Operating system and application software 
 

 None of the above 
 
 The software required to run the computer is ..... 
 

 Application software 
 

 Microsoft word 
 

 Programs 
 

 Operating system 
 
 What is the other name for the personal computers: 
 

 Mainframes 
 

 Super computers 
 

 Desktop computers 
 

 Microcomputers 
 

Answers        

1. (C) 2. (B) 3. (B) 4. (D) 

5. (A) 6. (D) 7. (D)   



REVIEW QUESTIONS  
 

 Describe the IPOS cycle. 
 
 Name five everyday places where you encounter the computer, and describe 

how it is used at respective places.  
 Explain three types of software that can be used to publish a newsletter or a 

book. Write in detail how three of them can be useful.  
 What is the difference between memory and storage? Why do we require both 

to function properly?  
 What is the difference between data and information? Why are both of them 

important individually?  
 Describe the five types of computers. Write their differences in characteristics 

also.  
 What is the difference among users, power users and professionals? 
 
 Write down the configuration of a computer, you would like to buy for your 

personal purpose. 
 
 Write the five elements of the computing process. 
 
 Write the characteristics of useful and meaningful information. 
 
 Write the pros and cons of using a computer. 
 
 Vacuum tube based electronic computers belong to 
 

 First Generation 
 

 Second Generation 
 

 Third Generation 
 
 The _______ generation of computers was characterized by microcomputers. 
 

 First 
 

 Second 
 

 Third 
 

 Fourth 
 
 The second generation of computers was characterized by _____. 
 

 magnetic cards 
 

 artificial intelligence 



 transistors 
 

 transformers 
 
 Integrated circuits signified the beginning of the ______ generation of computers. 
 

 First 
 

 Second 
 

 Third 
 

 Fourth 
 
 The acronym ENIAC stands for ______. 
 

 Electrical Neon Infuser And Calculator 
 

 Electronic Numerical Integrator and Computer 
 

 Eulogistic Nuisance In A Cart 
 

 Electronic Number Interpreter And Calculator 
 
 The first counting tool was the __________. 
 

 Abacus 
 

 Slide Rule 
 

 ENIAC 
 
 __________ is known as the first woman programmer. 
 

 Charles Babbage 
 

 Lady Lovelace 
 

 Abacus 
 
 The difference between a calculator and a computer is that a computer can store 

data for long periods of time.  
 True 

 
 False 

 
 Computers use base two number system because 
 

 it is easier to do calculations than in a base 10 system 
 

 they are made of switches, which are either on or off 
 

 it was the first number system used by people 
 

 the first mechanical calculators used the same number system 



Answers      

12. (a) 13. (d) 14. (c) 

15. (c) 16. (b) 17. (a) 

18. (b) 19. (b) 20. (b) 



Chapter 2: DATA REPRESENTATION  
 

INTRODUCTION  
 

Even people who have been using computers for a few years still marvel at what they 

can do - how at lightning speed and with amazing accuracy they can sort a mailing list, 

balance a ledger, typeset a book, or create lifelike models of objects that have never 

existed. 
 

Just how a computer does all this may seem magical, but in fact it is a process 

based on simple concepts. All the words, numbers and images you put into and get out 

of the computer are manipulated in relatively simple ways by the computersô 

processing components. 
 

In this chapter you will learn what data is, how it differs from information, and 

what form it takes inside the computer. 
 

DATA AND INFORMATION  
 

Data 
 

We generally talk about data and information. Are they the same terms? And if not, 

what is the difference between them? Well, data is the raw material and information is 

what we get after processing the data. To be more precise, data is raw facts and figures 

and information is processed data, that is useful and meaningful. Data is the input to 

processing, and information is the output. 
 

How is data converted into information is explained in the Figure:  
 
 
 
 
 
 
 

 

Figure 2.1 
 

Data is a plural form. The singular form of data is ñdatumò which is rarely used. 
 

Information distinguishes itself from data, as it is more useful and meaningful. The 

marks of the subjects, as such are of no use for the teacher but then calculating the total 

helps him in finding out the ranks of the students. One information can be used as the 

data for taking out another information, i.e. one information becomes input for another 

type of output, e.g. the total marks calculated as shown above will serve as data to find 

out the percentage and hence the division of the students, to check how many students 

have scored distinction, first class, second class or failed. Information can be 



distinguished from data by some characteristics like whether it is relevant, timely, and 

accurate, concise and complete. Data should be accurate but may not necessarily 

possess rest of the characteristics. The characteristics of information are explained as: 
 

 Relevant: The information should apply to the situation or the query or problem. 
 

 Timely: Information should be presented as and when required. For example, 

there is no point receiving newspaper after two-three days. 
 

 Accurate: Input and output should be accurate, so that no wrong decisions take 

place. A small mistake can lead to hazardous results. 
 

 Reliable: It should be reliable, i.e. there should not be any doubt about the 

presented information. 
 

 Concise: It should not be unnecessarily lengthy, i.e. precision is an important 

characteristic of information. 
 

 ̧ Complete: All the important elements should be covered and nothing should be 

missed. 
 

It seems that computers understand us as we understand them. However, this is not 

true. They do not understand the language we normally use among ourselves. It is their 

own language which they understand. That language comprises of two distinct physical 

states produced by electricity, magnetic polarity, or reflected light. All they can 

understand is whether a switch is on or off. In fact the ñbrainò of the computer, the CPU, 

consists primarily of several million of tiny electronic switches, called transistors. 
 

A computer only appears to understand information because it contains so many 

transistors and operates at such phenomenal speeds, assembling its individual on/off 

switches into patterns that are meaningful to us. 
 

The term used to describe the information represented by groups of on/off 

switches is data. Although the words data and information are often used 

interchangeably, there is an important distinction between them. Data is raw facts that 

the computer organizes to produce information. 
 

Data can be explained more explicitly by taking an example. The letters G, O and 

D do not indicate anything individually but when combined together they do give you 

a word GOD, which has some meaning. Similarly, a few words can be combined 

together to form a sentence that might convey some meaningful message to you and 

thus become information to you. The computer converts the data into information by 

processing it in some way. 
 

REPRESENTATION OF CHARACTERS IN COMPUTERS  
 

To discuss how a computer processes data, we should first have an understanding of the 



form in which data is stored in the computerôs memory. There are two basic types of 

data which are stored and processed by a computer. They are characters and numbers. 

But to a computer everything is number. Numbers are numbers, letters are numbers, 

punctuation marks are numbers, sounds and pictures are numbers, even the computerôs 

own instructions are numbers. This might seem very strange. 
 

Characters and numbers are assigned different values by the computer. The output 

from a computer must be in the form that is understood by the users. Thus the computer 

translates those values into the form understandable by the normal users, which is again 

natural language consisting of numbers and characters. This constitutes EXTERNAL 

DATA REPRESENTATION. On the other hand, the values used by a computer to store 

and process the data is INTERNAL REPRESENTATION OF DATA. 
 

Let us see how external data representation is different from the internal data 

representation. For example, consider the following sentence: GOD IS 

EVERYWHERE. 
 

It may look like a sentence or a string of characters to you but for the computer it 

is a string of numbers (just zeros and ones). The computer interprets the sentence in 

the manner discussed below. 
 

Internal data representation in a computer looks strange because people are in the 

habit of using base 10 to represent numbers. The system is called base 10 or the 

DECIMAL SYSTEM (deci means 10 in Latin). This system uses 10 symbols, viz., 1, 

2, 3, 4, 5, 6, 7, 8, 9, and 0. When you need to represent a number greater than 9, you 

use two digits instead of one, as 9+1=10 and so on. Each symbol in a number is called 

a digit and, therefore, we can say that the number 10 is a two-digit number. 
 

In the computer all the data has to be converted into electrical switches. A switch 

has only two states: ñonò and ñoffò. And as they take only two numeric symbols they 

are said to function in base 2. This number system is known as BINARY SYSTEM 

(BI means two). 
 

When a computer needs to represent a quantity greater than 1, it does the same 

thing you do when you need to represent a quantity greater than 9 in decimal. It uses 

two or more binary digits. 
 

BITS AND BYTES 
 

When referring to computerized data, each switch whether it is on or off is called a bit. 

The term bit is nothing but the contracted form of Binary Digit. A bit is the smallest 

possible unit of data. To represent anything meaningful ï in the other words, to 

convey information ï the computer needs groups of bits. 
 

After the bit, the next larger unit is byte. The byte is a group of 8 bits. With one byte, 



the computer can represent up to 256 different values because it is possible to count 

from 0 to 255 with these 8 binary digits. 
 

The byte is a very important unit because there are enough different eight-bit 

combinations to represent all the characters on the keyboard including all the letters 

(uppercases and lowercases, punctuation marks, numbers and other symbols). The byte is 

basic unit for measuring the size of memory; although with todayôs memory sizes, it is 

more common to hear terms like kilobyte (KB) or megabyte (MB) or gigabyte (GB). 
 

1 Kilobyte (KB) = 1024 bytes ~ 1000 bytes 

1 Megabyte (MB) = 1024 kilobytes ~1000 KB 

1 Gigabyte (GB) = 1024 megabyte ~ 1000MB 
 

The number of adjacent bits that can be stored and manipulated as a unit is called 

a computer word. Some of the newer microcomputers have the ability to manipulate a 

32-bit word, whereas the older ones could process words up to 16 bits. The length of 

the word matters, as the longer the word (that registers can hold), the more would be 

the processing speed. 
 

TEXT CODES 
 

Characters are similarly represented as series of binary 1ôs and 0ôs. However, there 

must be some universally accepted standard coding scheme to do this coding. This 

way, all the values representing digits, characters, punctuation marks and special 

symbols can be coded uniquely in terms of binary digits. The three most popular 

systems developed for this purpose are EBCDIC, ASCII and Unicode. 
 

EBCDIC 
 

Binary Coded Decimal (BCD) system was designed by IBM for one of its early 

computers. It was one of the first complete systems to represent symbols with bits. 

BCD codes consisted of 6-bit codes, which allowed a maximum of 64 possible 

symbols. BCD computers could work only on uppercase letters and a very few other 

symbols. That was the reason of their not being in use for a long time. 
 

The need for more symbols led IBM to develop EBCDIC system. EBCDIC is 

pronounced as ñEB-SI-DICò and stands for Extended Binary Coded Decimal 

Interchange Code. EBCDIC is an 8-bit code that defines 256 symbols. EBCDIC is still 

used in IBM mainframes and mid-range systems. By the time small computers started 

getting developed the ANSI (American National Standards Institute) had started 

developing the standards for computers. 



ASCII  
 

ANSIsô defined ASCII character set used to represent the symbols, numbers, 

characters etc. ASCII stands for American Standard Code for Information Interchange. 

Today, the ASCII character set is the most common. 
 

In this scheme of coding characters 0 to 31 are control characters, 32 to 64 are 

special characters, 65 to 90 are uppercase alphabets, 97 to 122 are lowercase alphabets 

and 123 to 127 represent some common symbols. ASCII being a 7ïbit code specifies 

characters only up to 127. There are variations that specify different character sets for 

codes from 128 to 255. The ISO (International Standards Organization) offers 

different sets of charters for different language groups. 
 

Unicode 
 

A new standard for data representation, called Unicode Worldwide Character Standard, 

provides 2 bytes (16 bits) to represent each symbol. That means the range could be 

anything up to 65, 536 different characters or symbols. That means all the characters and 

symbols of the world can have the same standard, thus facilitating the interchanging of 

the data and programs written in any language without requiring any special programs. 
 

NUMBER SYSTEM 
 

Before we go any further we need to study the various types of number systems and 

also the transformation rules to inter-convert them (i.e., external representation of data 

into internal data and vice versa). 
 

Representation of Integers or Decimal Numbers 
 

We now know how characters and strings of characters are represented internally in a 

computer. Decimal digits are also considered as characters and codes are assigned to 

them. These codes for digits are primarily used when digits are used merely as symbols 

with no ñvalueò assigned to them. For example DL3C 3455 is the registration number of 

a car, which is a combination of both numbers and characters. Now if we want to store 

these numbers in the computer and perform calculations too, they are required to be 

converted into binary system that uses only ñoò and ñ1ò. The combination of zeros and 

ones can be used to represent the above given decimal numbers as we discussed earlier. 
 

For example, consider the decimal number 3455. The value of each digit is 

determined by the digit itself (face value). The position of the digit and the base or 

radix of the number system determines the actual value represented. 
 

The base of a number system is defined as the number of distinct symbols used to 



represent numbers in the system. The decimal system uses the ten symbols 

0,1,2,3,4,5,6,7,8,9, and 0. Its base is thus 10. 
 

To a decimal integer, we assign a value but before that we assign weights (place 

value) to each digit position. The weights are unity for the right most digit and changes to 

tens, hundreds, thousands etc. as we proceed towards the left digits of the number. 
 

We multiply the digits of the number by its respective weights and then add them 

all to get the value of that number. Thus, the value of 3455 is calculated as: 
 
 
 
 
 
 

 

The notation used above is called the positional system. 
 

Binary System 
 

As explained in the beginning of the chapter, if a number system has only two 

symbols then its base is 2. Such a system is called binary system. Numbers in this 

system are strings of bits. For example, 10011 is a binary number. 
 
 
 
 
 
 
 

 

The right most bit is called LEAST SIGNIFICANT BIT and the left most bit is 

called the MOST SIGNIFICANT BIT. Weights assigned to the bits are the powers of 

2 as 2
0
= 1, 2

1
= 2, 2

2
= 4, 2

3
= 8, 2

4
= 16, etc. 

 

As the powers of 10 are important in the decimal system, similarly the powers of 2 

play an important role when it comes to representation in the binary system. A table is 

given below which gives powers of 2 and their decimal equivalents. The abbreviation 

K stands for 1024 and is taken as 1000 (a kilo) approximately. Similarly the notations 

mega stands for 1024 x 1024 and so on. 
 
 

Powers Decimal Abbreviations   Powers Decimal Abbrevia tion s 

of 2 equivalent of 2 equivalent  

2
0 

1 211 2048 2K 

2
1 

2 212 4096 4K 

2
2 

4 213 8192 8K 

2
3 

8 214 16384 16K 

2
4 

16 215 32768ó 32K 



2
5 

32  216 65536 64K 

2
6 

64  217 131072 128K 

2
7 

128  218 262144 256K 

2
8 

256  219 524288 512K 

2
9 

512  220 1048576 1M 

210 1024 1K 221 2097152 2M 
      

 

Representation of fractions (L2) 
 

Decimal fractions are interpreted as:  
 
 
 
 
 
 

Negative powers of 10 (the base) are used as the weights for the digits in the 

fractional part of the number. 
 

A binary fraction is represented by a string of 1ôs and 0ôs on the right of a binary 

point. The bits are multiplied by negative powers of 2 to obtain the decimal value of 

the binary fraction as: 
 
 
 
 
 
 
 

= 13/16   

= 0.8125 (In Decimal)  

Examples    

1. (110101.11) = 1x2
5
 + 1x2

4
 + 0x2

3
 + 1x2 2 + 0x2

1 
+ 1x2

0 

  2  

 1x2
-1

 + 1x2
-2

 
 

 32+16+0+4+0+1+½ +¼¼ 
 

 53+¾ 
 

 53.75 
10 

 

2. (1011.011) = 1x2
3
 + 0x2

2
 +1x2

1
 + 1x2

0
 + 0x2

-1
 +1x2-2 

2 

+1x2
-3 



 8+0+2+1+0+0.25+0.125 
 

 11.375 
10 

 

Hexadecimal Representation 
 

Counting in the binary system is similar to that in the decimal system. In decimal we 

start from 0, add 1, obtain 1 and continue adding 1 successively till we get 9. That 

means in base 10 there are symbols from 0 to 9. Now when we add 1 to 9 we get 10.1 

gets carried to the tens position in the decimal system. Similarly we count 100 after 

reaching 99 and so on. Counting in binary proceeds exactly in the similar fashion: 
 

0, 1, 10, 11, 100, 101, 110, 111, 1000, 1001, é 
 

The table given below shows the binary counting sequence. Observe that we require 3 

bits to represent decimal numbers 0, and 7 bits to represent 8 and 9. Thus we can say on 

an average there are 3.2 bits (binary digits) required to represent a decimal digit [(8 x 

 + 2 x 4 )/10 =3.2]. That means, if we convert a large decimal number to obtain its 

binary equivalent, it would be approximately 3.2 times the number of digits of the 

corresponding decimal number. 
 

Thus the binary equivalent of a ten digit decimal number would be 32 bits long. 

Donôt you think that writing such long strings of 0s and 1s are a very cumbersome and 

error prone task? This problem is solved to a great extent by using the hexadecimal 

number system, which uses 16 as a base. There are sixteen symbols used by this 

system viz.: 1, 2, 3, 4, 5, 6, 7, 8, 9, A, B, C, D, E, F. Here the symbols A, B, é, F are 

used to represent the numbers 10, 11 12, 13, 14 and 15 respectively. We need only 4 

bits to represent a hexadecimal digit. The table below gives the hexadecimal systemôs 

symbols, their decimal and binary equivalents.  
 
 
 
 
 
 
 
 
 
 
 
 

 

A binary number can be quickly converted to its hexadecimal equivalent by 

grouping together 4 bits of the binary number, starting with the least significant digit 

and replacing each four bits group with its hexadecimal equivalent given in the table. 
 

Examples 



1. 
 

The binary number (1101111000101001)is converted into its hexadecimal 
2 

equivalent by first making groups of four bits, starting from the least significant 

digit and proceeding towards the most significant digits.  
 

 

2. 
 

The binary number (00111011100.10010100) is converted into its 
2 

hexadecimal equivalent by the same method as explained above but the groups are 

formed from left to right for the fractional part unlike in the integer part. One more 
thing to be noted is that, to complete a group of four bits, 0ôs are introduced at the 

left most position in the left most group in the integer part, and in the rightmost 

position in the right most group in the fractional part. 
 

CONVERSIONS 
 

All the number systems discussed above can be inter- converted to one another. The 

set of rules to convert them are discussed below. 
 

Decimal to other Number Systems 
 

Decimal numbers can be converted to other numbers by using either of the two 

methods given below: 
 

Power Method 
 

 Write the powers of the radix till it is less than the number to be converted. 
 
 Subtract the highest number, which is obtained by raising the powers of the 

radix from the number, which is to be converted. 
 
 Obtain the remainder, say R. 
 
 Subtract the next highest number from this remainder. 
 
 Repeat the process till the remainder is zero. 
 
 Now multiply the power, which have been used with one, and multiply the 

powers which have not been used by zero. 
 

Remainder Method 
 

This is the method commonly used for the conversions from the decimal number system 

to the binary number system. The conversion is carried out in the following order: 



divide the given number (decimal system) by the radix of the proposed system (in 

which the number has to be converted). Note down the remainder. 
 

Now the quotient will again be divided by the radix and the remainder will be 

noted down. 
 

The procedure goes on till zero comes as quotient. 
 

Fraction Conversion 
 

We have already discussed the remainder and the power methods to convert the 

decimal numbers to binary numbers. Now the fractional decimal numbers can be 

converted to binary numbers by following the steps given below: 
 

 Multiply the radix of the proposed system with the fraction to be converted. 
 
 Note down the resulting integer (if any), otherwise put down zero in that place. 
 
 Repeat the multiplication with the resulting fraction. 
 
 Keep repeating the procedure till the fraction vanishes or you encounter the 

recursive fractions. 
 

Examples 
 

1. By using the Power Method: 
 

(i) (220)10 
 

Radix of the binary system = 2 
 

Powers of radix which are less than 220  



 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

1 x 2
7 

1 

1 x 2
6 

1 

0 x 2
5 

0 

1 x 2
4 

1 

1 x 2
3 

1 

1 x 2
2 

1 

0 x 2
1 

0 

0 x 2
0 

0  

Thus, the binary equivalent of (220)10 is (11011100)2 
 

(ii)  (674)10 
 

Radix of the binary system = 2 
 

Powers of radix which are less than 674  



 
 
 
 
 
 
 
 
 
 
 

1 x 2
9 

1 

0 x 2
5 

0 

1 x 2
7 

1 

0 x 2
5 

0 

1 x 2
5 

1 

0 x 2
4 

0 

0 x 2
3 

0 

0 x 2
2 

0 

1 x 2
1 

1 

0 x 2
0 

0 
 

Thus, the binary equivalent of (674) is (1010100010) 
 10 2 

2. By using the Remainder Method 

(i) (220)10   
 
 
 
 
 
 
 
 
 
 
 

 

While writing the binary equivalent the digits are taken from the bottom 
to the top (as indicated by the arrow). The binary equivalent in the above 

example is (11011100) 
2 

 

(ii)  (674)10 



 
 
 
 
 
 
 
 
 
 
 
 

 

Thus, the binary equivalent of (674)10 is (1010100010)2 
 

3. Fraction Conversion 
 

(i) Converting (0.40) to binary form 
2 

 

Radix = 2  
 
 
 
 
 
 
 
 
 
 
 
 

(ii)  (12.25) 
10 

 

Radix =2 
 

Integer part = 12. 
 

Using the remainder method:  
 
 
 
 
 
 
 
 

 

Thus, the binary equivalent of (12) is (1100) 
10 2  

Fraction part = (0.25) 
10  



The binary equivalent of (0.25) is (01) 
10 2  

Thus, the binary equivalent of (12.25) is (1100.10) 
10 2 

 

Decimal to Octal 
 

Integer 
 

 ̧ (98)10 
 

Radix = 8  
 
 
 
 
 
 
 

 

Thus, the octal equivalent of (98) is (142) 
 10 8 

Fraction   

 ̧ (423.03125)  
 10  
 

Integer part = 423  
 
 
 
 
 
 

 

Thus, the octal equivalent of (423) is (647) 
10 8 

 

Fraction Part = 0.03125  
 
 
 

 

That is (0.03125) = (0.02)  
10 8  

Thus, the octal equivalent of (423.03125) = (647.02) 
 10 8 

 

Decimal to Hexadecimal 
 

Integer 
 

(8234) 
10 



 
 
 
 

 

Thus, the hexadecimal equivalent of (8234) is (202A) 
10 16 

 

Fraction 
 

(0.225) 
10  

 
 
 

 

Thus, the hexadecimal equivalent of (0.225)10 is (0.39)16 
 

Binary System to other Number Systems 
 

Binary to Decimal Number System 
 

Binary numbers can be converted to the decimal number system by multiplying each 

binary digit with its respective position weight and then adding all the results. Here are 

a few examples. 
 

 (10100011) 
2  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2. (1101) 
2 



 
 
 
 
 
 
 

 

Binary to Decimal (Fraction) 
 

Binary Fractions are converted to the decimal number system by multiplying each 

digit by its respective position weight (that is the negative powers of the base 2) and 

then adding them together. Here are a few examples. 
 

(1011.11011) 
2 

 

Consider the integral part first  
 
 
 
 
 
 
 
 
 

 

Consider the fraction part now: 
 

Fraction = (0.11011) 
2 

 

= 1 x 2
ï1

  + 1 x 2 ï2 + 0 x 2
-3

 + 1 x 2
-4

  x 1 x 2
-5 

 

= ½   + 1/4¼ +   0   + 1/16   +   1/32 

= (0.84375) 
 10  

Thus, the decimal equivalent of (1011.11011)  is (11.84375) 
2 10 

 

Binary to Octal Number System 
 

Binary numbers can be converted to the octal number system by two methods: 
 

 By converting the binary number first into the decimal number system, and then 

converting the number so obtained into octal number system. 
 
 By grouping three binary digits to produce a single octal number proceeding 

from the least significant bit to the most significant bit. 



Here are a few examples. 
 

1. Integer 
 

(110100101)2 
 

First, convert the above binary number to its decimal equivalent by multiplying 

each digit with its respective position weight: 
 

1 1  0 1 0  0 

1 0  1 2 8 2 7  2 6 

2 5  2 4 2 3 2 2 2 1 2 0  

256  128  0 32 0 0 

4 0   1    
 

 256 + 128+0+32+0+0+4+0+1 
 
 421 
 

Now convert this decimal to its equivalent octal form:  
 
 
 
 
 
 
 

 

Thus, the octal equivalent of (421)10 is 

(645)8 (110100101)2 = (421)10 = (645)8 
 

Convert the same number by the second method, that is by grouping the binary 

number. 
 
 
 
 
 
 

 

Therefore, the octal equivalent of (110100101)2 is (645) 8 
 

2. Fraction 
 

(110111001.100001)2 
 

Let us first convert the above given binary number to its decimal equivalent: 



Integer part: 
 

(110111001)2 = 1x 2
8
 + 1x2

7
 + 0x2

6
 + 1x2

5
 + 1x2

4
 + 1x2

3
 + 0x2

2
 + 0x2

1
 + 1x2

0 

 

 256+128+0+32+16 +8+0+0+1 
 

 (441)10 
 

Now convert this decimal form into octal form:  
 
 
 
 
 
 
 

 

Thus, the octal equivalent of integer part 442 is (671)8 
 

Fractional part: 
 

(0.100001)2 = ½ + 1/ 64 
 

 33/64 
 

 (0.515625)10 
 

Now convert this decimal form into octal form: 
 

Fraction = 0.515625 
 

Fraction Integer 
 

0.515625 x 8 = 4.125 4 

0.125 x 8 = 1.000 1 
 

Thus, the octal equivalent of (0.515625)10  = (0.41)8 
 

Therefore, (110111001.100001)2 =(441.515625)10 = (671.41)8 
 

Binary to Hexadecimal 
 

For converting a binary number into its hexadecimal equivalent, it should first be 

converted into groups of four bits, and then these groups should directly be converted 

into their hexadecimal equivalents. The following examples illustrates the method. 
 

(1110100010111100)2  



Thus, the hexadecimal equivalent of (1110100010111100)2 is (E8BC)16 
 

Even the fraction part is converted into a group of four bits, and then further converted 

to its corresponding hexadecimal number. The grouping starts from the very next bit 

after the decimal, and proceeds towards the right. Here are a few examples. 
 

(0.11001101)2 
 

1100 1101 
 

12=C 13=D 
 

Therefore, the hexadecimal equivalent of (0.11001101)2 = (0.CD)16 
 

Octal Number System to other Systems 
 

Octal to Decimal 
 

For converting the octal number to its decimal equivalent, each digit is multiplied by 

its respective position weight, and then added, to get the desired octal number. See the 

following example. 
 

(349)8  
 
 
 
 
 

 

 192+32+9 
 

 (233)8 
 

For converting the fractional octal number to its decimal equivalent, each digit is 

multiplied by its respective position weights (i.e. the negative powers of the radix 8), 

and then added together to get the result. See the following example. 
 

(0.265)8 
 

 2 x 8 -1 + 6 x 8 -2 + 5 x 8 -3 
 

 2/8 + 6/ 64 + 5/ 512 
 

 (0.353515625)10 
 

Therefore (0.265)8 = (0.353515625)10 
 

For converting the octal number to a binary number, it has first to be converted into 

decimal form and then to binary form. See the following example. 



(243)8 
 

Convert the above given octal number to decimal form first: 
 

(243) = 2 x 8
2
 + 4 x 8

1
 + 3 x 8

0 

8 
 

 2 x 64 + 4 x 8 + 3 x 1 
 

 128+32+3 
 

 (163) 
10 

 

Now convert this decimal equivalent to the binary form:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Thus, the binary equivalent of (163) = (10100011) 
  10 2 

Therefore, (243) = (163) = (10100011)  
8 10 2  

 

For converting the octal number to its binary equivalent, it has to be first converted 

into its decimal form. See the following example. 
 

(0.25) 
 8 

(0.25) = 2 x 8
ï1

 + 5 x 8
ï2 

8 
 

= 2/8 + 5/64 
 

= 21/64 
 

= (0.328125) 
10 

 

Now convert this decimal number to its binary equivalent: 



 
 
 
 

 

Thus, the binary equivalent of (0.328125) is (0.1101) 
 10 2 

Therefore, (0.25)  = (0.328125) = (0.1101) 
8 10 2 

 

Hexadecimal System to other Systems 
 

Hexadecimal to Decimal 
 

Each digit of the hexadecimal number is multiplied by its respective position weight, 

and then added, to get the number in the proposed system. See the following example. 

(E28B)16  
 
 
 
 
 

 

 57344 + 512 + 128 + 11 
 

 (57995) 
10 

 

Therefore, (E28B) = (57995) 
16 10 

 

Hexadecimal to Binary 
 

1
st

 Method 
 

A hexadecimal number can be converted to its binary equivalent by first converting it 

to the equivalent decimal number, and then further converting the resultant decimal 

number to the binary number. See the following example. 
 

(C3B1) 
16 

 

Convert (C3B1) to its equivalent decimal form: 
  16    

1 x 16
0 

= 16  

B x 16
1 

= 176  

3 x 16
2 
 = 768 



C  x 16
3 

=   49152 

  50112 

 Thus (C3B1)   = (50112) 
 16 10   

Now convert this decimal form to its equivalent binary form:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Thus, the binary equivalent of (50112) is (1100001111000000) 
 10 2 

Therefore, (C3B1)  = (50112)  = (1100001111000000) 
16 10 2 



2
nd

 Method 
 

The hexadecimal number is first converted into its decimal equivalent, and then the 

decimal number so obtained is further converted to a group of binary digits. It uses the 

group of four bits to represent a single number 
 
 
 
 
 
 
 
 

ERROR DETECTING CODES 
 

When a user types some data through the keyboard, typing errors may occur. 

Detection of errors during typing the data is essential to avoid delays and difficulties. 

Hence, it is necessary to design a code, such that, if there is an error in the code, it can 

be detected during data entry by a simple program. Practically it is not possible to 

design a code so that an arbitrary error is detected. A code can be designed if the types 

of errors normally committed in data entry are known. Then the code will be able to 

detect all such errors. 
 
 
 
 
 
 
 
 
 

 

If a code is designed which is able to detect the two types of common errors ï single 

transcription and transposition errors ï it would be good. Such a code has been 

designed which is known as modulus 11 code. 
 

Constructing Modulus-11 Codes 
 

Let us construct a modulus -11 code for 34718. 
 

 ̧

 

 ̧

 

 ̧

 

 ̧

 

 ̧

 

 ̧

 

 ̧

 

Multiply the least significant digit by 2. 
 

Multiply the digit to its left by 3. 
 

Multiply the digit to its left by 4 and so on. 
 

Add the products. 
 

Divide the weighted sum of digits by 11. 
 

Append 11 ï remainder to the right of the code. 
 

This is the newcode to be used. 



After operating this rule on the given code 34718:  
 
 
 

 

Now, 
 

85 mod 11 = 8 
 

So, append 11 ï 8 = 3 to the code and get the new code 347183. The remainder 3 

appended to the code is called check digit. 
 

If the remainder after division is 1, then 
 

11ï1=10 
 

In this case, the character 'X' is appended to the code. 
 

If the remainder after division is 0, then 0 is appended to the code. 
 

For example, 
 

If the given code is 45687, then 
 

4*6+5*5+6*4+8*3+7*2=111 
 

111/11 = quotient = 10 remainder = 1 
 

Digit to be appended ( 11 ï 1) = 10. Use X to represent 10 
 

45687 X 
 

Similarly, for the code 68748 
 

6*6+8*5+7*4+4*3+8*2=132 
 

132/11 = quotient = 12 remainder = 0 
 

Digit to be appended will be 0. 
 

456870 
 

The modulusïN check can be generalized for non-numeric codes. If a code is 

constructed with 10 decimal digits and 26 letters of the English alphabet, then the 

value of N should be a prime greater than 36. The number 37 is prime. Hence, 

modulusï37 check is suitable for alphanumeric codes. 
 

REVISION EXERCISES 
 

 Convert the decimal number 250.5 into octal and hexadecimal numbers. 
 
 Convert the following decimal numbers to binary 

ones: a. 12.0625 



 673.23 
 

 10000 
 

 1998 
 
 Convert (225.225)  to binary, octal and hexadecimal. 

10 
 

 Convert (11010111.110) to decimal, octal and hexadecimal. 
2 

 

 Convert (623.77)  to decimal, binary and hexadecimal. 
 8 

6. Convert (2AC5.D)  to decimal, octal and hexadecimal. 
 16  

 Convert the following binary numbers to decimal numbers: 
 

 10.10001 
 

 101110.0101 
 

 1110101.110 
 

 1101101.111 



 Add a modulus-11 check digit to the codes 
 

 48467 
 

 96432 
 

 87646257 
 

Answers 
 

1. a. (372.4)  
  8  

 b. (FA.8)  
  16  

2. a. 1100.0001 

 b. 1010100001.00111 

 c. 10011100010000 

 d. 11111001110 

3. (225.225) (11100001.001110011) 
  10 2 

 (341.16314) (E1.399) 
  0 H 

4. (215.75) 
10 

(11010111.110) 
  2 

 (327.6) (D7.C) 
 0  H 



5. (403.9843) (110010011.111111) 
 10 2 

 (623.77) (193.FC) 
 0 H 

6. (10949.8125) (10101011000101.1101) 
 10 2 

 (25305.64) (2AC5.D) 
 0 H 

7. (a)  2.53125 (b)  46.3125 

 (c)  117.75 (d)  109.875 

8. (a)  484673 (b)  964323 

 (c)  876462578  



Chapter 3: 
 

INPUT AND OUTPUT DEVICES  
 

INPUT UNITS  
 

Data must be entered into a computer before processing may take place. You can enter 

data into the computer in many ways. A device that allows the user to enter data into a 

computer is called an input device. Most commonly used input devices are keyboards; 

pointing devices such as mouse and track balls; and scanners. Many other special-

purpose input devices are also available. Computers often have more than one input 

device attached. For example, most personal computers have both a keyboard and a 

mouse. 
 

Keyed Input 
 

Most input data is entered into the computer by using a keyboard. This input method is 

similar to typing on a typewriter. 
 

Most typewriters and computer keyboards are QWERTY keyboards. The 

alphabetic keys are arranged in a manner so that the upper-left row of letters begins 

with the six letters Q W E R T Y. Designers of other keyboards claim that their boards 

are easier to learn than the QWERTY keyboard. The Dvorak keyboard is one example. 

It is not widely accepted, however, because most people have already learned the 

QWERTY keyboard. 
 

In different parts of the world, we find different keyboards. The coding used on 

the QWERTY and Dvorak keyboards works with an 8-bit code, which accommodates 

256 different characters. Asian languages have many more characters. The Kanji 

alphabet, for example, has 50,000 characters. Japanese keyboards have to work with a 

16-bit code to accommodate all the characters. 
 

Computer keyboards also include keys that are designed to perform specific tasks 

instead of entering characters only. These special keys include function keys, 

directional keys and special-purpose keys such as Alt, Ctrl, Enter, Ins, and Esc. These 

keys enable the user to perform complex tasks easily when using the application. For 

example, many applications use a function key to access online help for the user. 
 

Some new keyboards have even 110 keys, with three new keys designed to simplify 

working with Windows operating systems. Two of these keys, next to the Alt key, bring 

up the Start menu. The third key, next to the right Ctrl key, brings up a menu of functions 

that are frequently accessed in whichever application is currently being used. 
 

Prolonged keyboard use can cause wrist problems, sometimes so serious as to 



require surgery. To help prevent these problems, ergonomic keyboards have been 

introduced in the market. 
 

One special type of keyboard construction is the MEMBRANE-SWITCH 

KEYBOARD, in which a protective film covers the keyboard. Membrane-switch 

keyboards are reliable, durable and resistant to such hazards as liquids or grease. 

However, membrane keys require more pressure than keys on a standard computer 

keyboard. You have probably seen membrane-switch keyboards in fast-food restaurants. 

Membrane-switch keyboards are ideal in situations that require little actual keying. 
 

Many computer systems are designed for SOURCE-DATA AUTOMATION. 

These systems place keyboards and display units at the most convenient spot for data 

entry. An example is the use of Point-of-Scale (POS) cash registers in retail stores. 

POS registers send data directly to a computer file for later processing. This technique 

has an advantage, because most so-called computer errors are actually keying errors. 

Capturing data at the source minimizes errors, because the people who key in the data 

are doing a variety of tasks and are, therefore, less likely to make errors due to 

boredom or loss of concentration. 
 

A tiny chip, called the keyboard controller, detects that a key has been pressed. 

The keyboard controller places a code into a part of its memory, called the keyboard 

buffer, indicating which key is pressed. This code is called the keys scan code. The 

keyboard controller then signals to the computerôs system software that something has 

happened at the keyboard. It does not specify what has occurred, just that something 

has. The signal that the keyboard sends to the computer is a special kind of message 

called an interrupt request. The keyboard controller sends an interrupt request to the 

system software when it receives a complete keystroke. For example, it you type the 

letter óDô the controller immediately issues an interrupt request. 
 

When the system software receives an interrupt request, it evaluates the request to 

determine the appropriate response. When a key press has occurred the system reads 

the memory location in the keyboard buffer that contains the scan code of the key that 

was pressed. It then passes the key scan code to the CPU. 
 

Pointing Devices 
 

Wherever possible many people use pointing devices instead of keyboards . An input 

device is used to move the pointer (cursor) on screen. Pointing devices minimize the 

amount of typing (consequently, the number of errors). Movements of the pointing 

device are echoed on the screen by movements of the mouse pointer and by other 

visual changes. The many pointing devices available include the mouse, the trackball, 

the light pen, the digitizing tablet, the touch screen and the pen- based systems. Some 

of them are shown below. 



 
 
 
 
 
 
 
 
 
 
 
 
 

 

Major Pointing Devices: Clockwise from the upper left are the mouse, the 

trackball, the pointing stick (red tip) and the touchpad. 
 

Mouse and Track Ball 
 

The MOUSE is a palm-sized device with a ball built into the bottom. The mouse is 

usually connected to the computer by a cable (computer wires are frequently called 

cables) and may have from one to four buttons (usually two). A mouse may be 

mechanical or optical and comes in many shapes and sizes. When you move the mouse 

over a smooth surface, the ball rolls, and the pointer on the display screen moves in the 

same direction. Apple Macintosh, with its graphical user interface, made the mouse 

popular. Today, most microcomputer systems, regardless of the manufacturer, use a 

mouse. With the mouse you can draw, select options from a menu, and modify or 

move text. You can issue commands by pointing with the pointer and clicking a mouse 

button. In addition to minimizing typing errors a mouse makes operating on a 

microcomputer easier for the novice. The underside of the mouse houses a device that 

detects the movement of the mouse relative to the flat surface on which it sits. The 2D 

motion of the mouse is typically translated into the motion of a cursor on the display. 
 

A mouse is so called, primarily because the cord on early models resembled the 

rodentôs tail, and also because the darting motion of the pointer on the screen appears 

to be mouse like. 
 



Operating a mechanical mouse. 1. Pulling the mouse turns the ball. 2. The X and 

Y rollers grip the ball and transfer the movement. 3. The optical encoding disks 

include light holes. 4. The infrared LEDs shine through the disks. 5. The sensors then 

gather the light pulses to convert to X and Y velocities. 
 

How does a Mouse Work? 
 

The most common type of mouse has a ball inside it that extends just below the 

housing. When you slide the mouse around on a flat surface, such as the desktop or a 

mouse pad, the ball rolls. 
 

On two sides of the ball, at 90 degrees angle from each other, are two small rollers 

that touch the mouse and spin when the ball rolls. A sensor detects how much each 

roller spins and sends this information to the computer. The computer translates the 

information and changes the position of the on-screen pointer to correspond to the 

position indicated by the mouse. 
 

Like the keyboard, the mouse does not send a message directly to the program that 

the computer is running. Rather, it sends an interrupt request to the CPU. The program 

that is running checks regularly to see whether a mouse has been used; if it has, the 

program reads a memory location to see what has happened, and then reacts 

appropriately. 
 

Like all input devices, the mouse needs some connection to the host computer in 

order to transmit its input. Typically the mouse uses a thin electrical cord (e.g. an RS-

232, ADB or USB cable) for this purpose. It was most likely the combination of the 

tail-like cord, its size, and shape, which led the inventors of the mouse to name it as 

such. Cordless (ñtail-lessò) mice use wireless communication to transmit data via 

infrared, radio or Bluetooth. 
 

There are several other methods of using a mouse apart from the most basic 

movement of the device to make a cursor move. A mouse click is the action of pressing 

and releasing (i.e. óclickingô) a button on a mouse in order to trigger an action, usually in 

the context of a Graphical User Interface (GUI), as in pressing an onscreen óbuttonô by 

óclickingô on it, or in a computer game to fire a gun in a first-person shooter. The clicking 

noise is made due to the specific switch technology used nearly universally in computer 

mice. This switch, called a micro switch or a cherry switch, uses a stiff but flexible metal 

strip that is bent to actuate the switch. The bending of the metal makes a snapping or 

clicking noise in the same way as the safety button does on the lids of vacuum-packaged 

jars to indicate that they have been opened. 
 

Single Clicking 
 

It is the most common method of distinguishing mouse-based input. On a single-button 



mouse this involves using the mouseôs one button. On the multiple-button mouse, it 

involves any one of the buttons, and is usually characterized by which button is 

pushed (e.g. left-clicking, right-clicking). 



Double Clicking 
 

A double-click occurs when the user presses the button twice in quick succession. This 

triggers an action separate from that of a single-click. For example, in the Macintosh 

Finder, the user single-clicks to select a file, and double-clicks in order to open that file. 

Usability studies have found that the double-click can be confusing and hard to use  

ð for example, users with poor motor skills may not perform the second click fast 

enough, with the result that the action is interpreted as two single-clicks rather than a 

double-click. Ironically, the double-click was introduced because the previous solution 
ð separate mouse buttons for separate actions ð was also found to be confusing in 

user studies. Most multiple-button mice allow setting one button to emit a double click 

on a single press. 
 

Triple-click 
 

A triple-click occurs when the user presses the button three times in quick succession. 

This also triggers an action separate from that of a single click. It is most commonly 

seen in word processors to select a whole paragraph and in web browsers to select a 

whole line of text. 
 

Click-and-Drag 
 

A user ñdragsò a mouse by depressing and continuing to hold down a mouse button 

while moving the mouse across the surface. 
 

A TRACK BALL i s like an upside-down mouse. Used in the same way as the 

mouse, the trackball is frequently attached to or built into the keyboard. It is a pointing 

device consisting of a ball housed in a socket which contains sensors to detect the 

rotation of the ball on two axesðlike an upside-down mouse, but with the ball 

sticking out more. The user rolls the ball with his thumb, finger, or the palm of his 

hand to move the cursor. Trackerballs are common on CAD workstations for ease of 

use, and also on modern portable computers, where there may be no desk space on 

which to use a mouse. Some trackballs clip onto the side of the keyboard and have 

integral buttons, which have the same function as mouse buttons. The main advantage 

of a track ball is that it requires less desk space than a mouse. Some individuals in the 

computer industry believe that devices that do not require as much space to use will 

soon replace the mouse. 



 
 
 
 
 
 
 
 
 
 

 

Logitech Marble Mouse Trackball 
 

A mouse is not a practical option for people using a laptop computer in a small 

space. Early alternatives, such as trackballs clipped to the side of the keyboard, have 

not proved satisfactory either. The Apple PowerBook uses a central trackball. The 

IBM ThinkPad replaces the trackball with a red plastic button, called a trackpoint, 

located in the middle of the keyboard. You move the button with your thumbs. The 

newest Apple PowerBooks have a small square of plastic on the front of the keyboard 

which moves easily to control the pointer. 



Touchpad 
 

The TOUCH PAD is a stationary pointing device that many people find less tiring to 

use than a mouse or a track ball. The movement of a finger across a small touch 

surface is translated into cursor movement on the computer screen. The touch 

sensitivity surface may be just 1.5 ï 2 inch square, so the finger does not have to move 

much. Its size makes it most suitable for notebooks and laptops. 
 

Joysticks 
 

A JOYSTICK is a pointing device often used for playing games. It has a gearshift-like 

lever that is used to move the pointer on the screen. On most joysticks, a button on the 

top is used to select an option. In industry and manufacturing, joysticks are used to 

control robots. Flight simulators and other training simulators also use them. Most 

joysticks are two-dimensional, having two axes of movement, just like a mouse, but 

three-dimensional joysticks also exist. 
 

Joysticks are often used to control games, and usually have one or more push 

buttons whose state can also be read by the computer. Most I/O interface cards for PCs 

have a joystick (game control) port. Modern joysticks generally use a USB interface 

for connecting to the PC. 
 

An analog one is one that has continuous states, i.e., it returns an angle measure of 

the movement in any direction in the plane or the space. On the other hand, a digital 

joystick gives only on/off signals for four different directions, and for mechanically 

possible combinations (such as up-right, down-left). Additionally, joysticks often have 

one or more fire buttons, which are used to trigger some kind of action. These are 

digital. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Joystick elements: 1. Stick 2. Holder 3. Fire button 4. Extra buttons 5. Autofire 

switch 6.Throttle 7. Hat Switch 8. Sucker 



Touchïsensitive Screens 
 

Perhaps the easiest way to enter data is with the touch of a finger. TOUCH SCREENS 

enable the user to select an option by pressing a specific part of the screen. Touch 

screens are commonly used in grocery stores, fast-food restaurants and information 

kiosks. 
 

Penïbased Systems 
 

Penïbased Systems are especially useful for people who do not like to type or for 

those who are frequently on the move. PERSONAL DIGITAL ASSISTANTS (PDA), 

such as the Apple Newton, are designed for people on the go. The Newton can link 

entries with data on stored files. For example, if you write, ñCall Annie and Wish 

Happy Birthdayò, the Newton adds a line to your ñTo doò list and links Annieôs phone 

number from your telephone directory. If your friend Ken moves, you can simply 

change his address and phone number. The Newton serves equally well as a calendar, 

a calculator and a notepad. 
 

Pen-based systems are not perfectðthey do not always register handwriting 

correctly. Pen-based computing is just beginning to gain widespread acceptance. For 

example, many stores no longer ask you sign a carbon form to charge a purchase; 

instead you sign on a tablet that automatically records your signature. 
 

Many engineers and architects use a different type of pen called a LIGHT PEN. 

The light pen uses a photoelectric (light sensitive) cell to indicate the screen position 

to the computer. You operate the pen by touching it to the screen. Light pens are 

frequently used for Computer-Aided Design (CAD) applications. 
 

Another tool used in CAD and other graphics applications is a digitizing tablet. A 

DIGITIZING TABLET  consists of a grid on which designs and drawings can be entered. 

Most tablets are pressure-sensitive and the user draws directly on the tablet using a 

special pen called a STYLUS or a puck. Digitizing tablets are used to design cars, 

buildings, medical devices and robots. 



DATA SCANNING UNITS  
 

Optical Recognition Systems (ORS) 
 

Optical Recognition Systems provide another means of minimizing keyed input by 

capturing data at the source. These systems enable the computer to ñreadò data by 

scanning printed text for recognizable patterns. 
 

In the 1950s, the banking industry developed one of the earliest scanning systems 

for the purpose of processing cheques. The Magnetic Ink Character Recognition 

(MICR) system is still used throughout the banking industry. The bank, branch, 

account number and cheque number are encoded on the cheque before it is sent to the 

customer. After the customer has used the cheque and it comes back to the bank, all 

that needs to be entered manually is the amount. MICR has not been adopted by other 

industries because the character set has only fourteen symbols. 
 

Bar Code Readers 
 

Of all the scanning devices, you are probably most familiar with BAR CODE 

READERS. Many retail and grocery stores use some form of the bar code reader to 

determine the name of the item being sold and to retrieve its price from a computer 

system. The code reader may be a hand-held unit or it may be embedded in a 

countertop. The bar code reader reads the Universal Product Code (UPC), a pattern of 

bars printed on merchandise. The UPC has gained wide acceptance since its 

introduction in the 1970ôs. Initially, workers resisted the use of the code because the 

system was used to check their accuracy and speed. Today, bar codes are used to 

update inventory and ensure correct pricing. Federal Express uses a unique bar code to 

identify and track each package. Federal Express employees can usually tell a 

customer within a matter of minutes the location of any package. 
 

Many different types of barcode scanners are available. They can be distinguished 

in the following manner. 
 

 By light source: 
 

LED scanners, also referred to as CCD scanners ð even if the CCD is in 

fact the photo conductor. 
 

Laser scanners, much more expensive than LED scanners, but capable of 

scanning barcodes at a distance of up to 25cm (~10") 
 

 By housing: 
 

Hand-held scanner with a handle and, typically, a trigger button for switching 



on the light source 
 

Pen scanners (or wand scanners), a pen-shaped scanner that is swiped 

across a barcode 
 

Stationary scanners, wall or table-mounted, under or beside which the 

barcode is passed. These are commonly found at the checkout counters of 

supermarkets and other retailers. 
 

Optical Mark Readers 
 

You would probably be familiar with Mark Sense Character Recognition systems if 

you have ever taken a written examination of the ñfill in the bubbleò type. Such forms 

are called Scantron forms. They use a #2 lead pencil; you darken the circular area with 

the pencil creating input suitable for an OPTICAL MARK READER (OMR). A #2 

lead pencil works best because of the number of magnetic particles in that weight lead. 

The OMR senses the darkened marks, enabling the reader to determine which 

responses are marked. OMR is very helpful for researchers who need to tabulate 

responses to large surveys. Almost any type of survey or questionnaire can be 

designed to be suitable for OMR devices. An OMR unit can be attached to a 

microcomputer and the data transferred to a file directly. 
 

Optical Scanners 
 

OPTICAL SCANNERS can scan typed documents, pictures, graphics or even 

handwriting into a computer. Photographs scanned into a microcomputer appear 

clearly on the screen and can be displayed whenever desired. The copy that the 

computer stores never yellows with age. Early scanners could recognize only text 

printed in a special OPTICAL CHARACTER RECOGNITION (OCR) typeface. A 

scanner converts the image that it sees into numeric digits before storing it in the 

computer. This conversion process is known as DIGITIZING. 
 

Depending on the volume and type of material to be scanned, you can use a drum 

scanner, a flatbed scanner, a sheeted scanner or even a small handheld scanner. The 

small, handheld scanners (priced at about $150) are used most frequently with 

microcomputers; however, only 5 per cent of all microcomputer systems are equipped 

with scanners. In 1995, manufacturers responded to user-reluctance to scanners by 

releasing a number of new, small paper scanners priced between $200 and $500. In 

1994, full-page scanners cost between $500 and $700. Most of these new devices sit 

between the keyboard and the monitor and can interface with a fax machine, send e-

mail, and store documents on the disk for archive purposes. 
 

Voice Recognition Devices 



Voice input and control systems have the potential of revolutionizing the way we 

communicate with computers. Steady progress has been made in this area, although 

some problems still exist. The day may soon come when we will be able to talk to our 

computers the way the actors do in sci-fi movies like Star Trek. 
 

Computer scientists and linguists have been working on VOICE RECOGNITION 

SYSTEMS for two decades. The major difficulty has been that different people speak 

with different accents and intonations. For this reason, most successful voice 

recognition systems require a period of ñtrainingò for the system to get accustomed to 

an individualôs accent and intonation. 
 

The first few systems could recognize only a few dozen words. A system recently 

released by IBM, known as Voice Type, is capable of recognizing as many as 32,000 

words and is speaker-independent. 
 

Voice recognition has unlimited possibilities and will make computers much easier to 

use. Speech recognition systems are already being used in many types of settings. In 

factories, workers use speech recognition systems to control robotic arms when the 

workerôs own hands are busy. Speech recognition systems enable physically disabled 

people to use computers. A microcomputer Voice User Interface (VUI), capable of 

recognizing input from a variety of individuals, will be considered standard soon. 
 

VIDEO DIGITIZERS can capture input from virtually any type of video device, 

such as VCRs, television and camcorders. Audio digitizers can digitize music or voice 

from a microphone. It is fairly easy to capture a portion of a television show, add some 

music that complements the picture and play back the result on a microcomputer to 

create a multimedia presentation. 
 

OUTPUT UNITS 
 

Output devices are varied and as innovative as input devices. From traditional printed 

output to audio output and robots, there is a multitude of forms of computer output. 
 

Most output can be divided into two categories: soft copy and hard copy. Soft copy is 

ideal when you are writing a document, playing a game, watching a video clip, or reading 

the latest news. Soft copy is what you see on the monitor. It is temporary; after you have 

finished with it, there is nothing solid to hold. You can, however, transfer soft copy to a 

disk to transport it. Hard copy on the other hand, can be touched and carried. It is usually 

some form of paper output. It is especially helpful if you need to have a colleague look at 

your work or you need to give your work to a supervisor or a teacher. 



Monitors  
 

When you think about viewing computer  output, you probably visualize a monitor. 
 

Monitor output is soft copy; when you have finished viewing it, you cannot move it. 

Monitor displays are the most common form of soft copy. 
 

Sometimes when watching television, you may notice that the picture looks a little 

snowy. This condition occurs because the images are not solid but rather created by 

configurations of dots. These dots, or picture elements, combine to form the image 

you see. The more picture elements, also known as pixels, there are the better is the 

resolution of the image. The better the resolution, the clearer is the picture. Computer 

monitors are similar to television screens. 
 

The large monitors that you see connected to desktop computers are Cathode-Ray 

Tube (CRT). Monitors that are used on laptops and notebook computers are known as 

flat-panel displays. Flat-panel displays weigh less and consume less electricity than 

CRTs. Common types of flat-panel displays include Liquid Crystal Displays (LCDs), 

Electro Luminescent (EL) displays and Gas Plasma (GP) displays. Flat-panel display 

monitors are still more expensive than CRTs, but eventually their prices are expected 

to decrease. (PixelVision recently released a 16-inch flat-panel display that includes a 

two million-color palette and sells for $10,000.) Can you imagine monitor hanging on 

the wall like a painting? It may be common in a few years. 
 

Most new monitors are SVGA (Super Video Graphics Adapters), with a pixel 

configuration of 800 by 600 at low-resolution mode and 1024 by 768 at high-

resolution mode. The first number designates the horizontal pixel, count, and the 

second is the vertical pixel count. The higher resolution, with more pixels, provides a 

clearer, more detailed image. Each pixel displays a single color at a time. Each color is 

represented by a numeric code. For example, bright red could be 12. If the monitor 

displays only 16 colors, the numeric code can be represented with only four bits. To 

display 256 colors (each with its own code) requires eight bits. 
 

One monitor may look ñsharperò than another, even though they may have 
 

the same pixel configuration. This is due to the dot pitch, which is the distance 

between pixels. A .28 dot pitch gives a crisper image than a .30 dot pitch. The .28 dot 
pitch is fairly standard. You should consider dot pitch when purchasing a monitor. The 

dot pitch is built in by the manufacturer and cannot be changed. 
 

With users increasingly viewing video clips, animated objects and complex graphics, 

monitors have taken on a new importance. Users now must decide how large a monitor 

they need. Fourteen-inch to seventeen-inch monitors are commonly used with desktop 

microcomputer systems. Larger monitors are available, but are expensive. 



Display in black and white (monochrome) or color categorizes monitors. 

Monochrome monitors are rapidly becoming a thing of the past, as most applications 

today require color. In fact, a display of 256 colors is usually necessary for working 

with informational CD-ROMs and clip-art collections. 
 

In order to connect a monitor to a microcomputer, you must have a graphics 

adapter board (also known as a video card). Each type of monitor requires a different 

type of board. The graphics board plugs into an expansion slot inside the computer and 

the monitor plugs into the board. 
 

In order to run todayôs graphics-intensive programs properly and quickly, most 

graphic boards come with some memory capability, known as video memory. It is 

important to realize that Video RAM (VRAM) must meet higher performance 

specifications than regular RAM. It is recommended that instead of using RAM on a 

video card, the user should place VRAM or dynamic RAM (DRAM), which is slightly 

slower than VRAM, on a video card. 
 

The refresh rate of a monitor is also important and is affected by the video card. 

Even a steady image is constantly regenerated, or refreshed, from top to bottom. A 

slow refresh rate of 60 times per second (60Hz) can cause headache; 70Hz is a 

reasonable minimum. Some monitors, known as interlaced monitors, refresh every 

other line; non-interlaced monitors are easier on the eyes. The Motion Picture Expert 

Group (MPEG), has developed standards for video compression that improve the 

quality of the video on the monitor. MPEG drivers are available as software or as 

hardware (built-in video card). 



Audio Output  
 

Have you ever listened to a concert or watched a television show on a computer? 

Audio output is the second type of softcopy. New computer systems have such good 

audio systems that it is possible to listen to music while you work, have the computer 

tell you when the printer needs paper, play games that include sound, or compose 

music on the computer. In order to have high quality audio output, a good quality 

sound card as well as good speakers are needed. 
 

New sound cards even include the capability to have the computer read a text file 

to you while you continue working on a different application. Voice input and output 

has proved helpful to individuals with speech and vision impairments. People with 

speech impairment can key a message into a computer and have the computer repeat 

it. Of course, computer generated voices are not human; they are synthesized. Speech 

synthesis, having the computer speak, is a much simpler process than speech 

recognition. 



Printers 
 

The second most common form of computer output is the printed document. Although a 

computer can operate perfectly well without a printer, it is certainly helpful for the user to 

have one. Because you can hold printed output, it is considered a form of hard copy. 
 

Printers can be categorized by whether anything mechanical touches the paper; 

whether they do or do not produce a solid character or how many pages or a line, or a 

character they produce, at a time. 
 

When a part of the printer presses the paper to form the character, the printer is 

considered an impact printer. Impact printers can produce carbon copies and are fairly 

loud, although covers are available to muffle the noise. In contrast, non-impact 

printers are quiet. However, because nothing presses on the page, a non-impact printer 

cannot produce carbon copy. This fact is usually not a problem because it is easy to 

produce multiple originals, but sometimes carbons are required for legal purposes. 



Impact Printers 
 

Impact printers can produce a page, a line, or a character at a time. Large computers 

use line printers. The main drawback of line printers is that they can produce only text 

and no graphics. 
 

Many small computers use character printers. Although only one character can be 

produced at a time, many types of character printers can produce graphics as well as 

text. The most common character printers create images by using a dot pattern. These 

printers are known as dot matrix printers. If you use a magnifying glass to look at a 

report created with a DOT MATRIX PRINTER, you can see the small dots forming 

each character. 
 

LINE MATRIX is a type of line printer that uses an oscillating row of print 

hammers. The hammers form characters and graphics by impacting a ribbon and 

transferring dots of ink onto the paper. An impact printer is the one that prints a line at 

a time. Printronix pioneered this technology in 1974. 
 

BAND (LINE CHARACTER) is a type of line printer that uses a fixed set of 

characters attached to a continuously revolving metal band. A set of hammers (one for 

each column) hit the paper, pushing it into the ribbon and against the character image 

on the band. 
 

Non-impact Printers 
 

Non-impact printers are increasing in popularity largely because of improvement in 

print quality coupled with decreasing cost. Non-impact printers can produce both text 

and graphics. Because nothing actually strikes the paper, non-impact printers are fairly 

quiet. Some of the most popular non-impact printers are laser printers and inkjet 

printers. 
 

Laser Printers 
 

Laser printers work in the same manner as copy machines. A laser beam creates electrical 

charges that attract the toner to form an image and transfer it to paper. A printer uses the 

laser and the electrophotographic methods to print a full page at a time. The laser is used 

to ñpaintò a charged drum with light, to which the toner is applied and then transferred 

onto paper. Laser printers come in a variety of sizes; generally the larger and faster the 

printer, the more expensive it is. Large laser printers are used on mainframes and 

minicomputers where high quality graphic output is required. Small, ñpersonalò laser 

printers are suitable for home use. Hewlett Packard recently began production of wireless 

printers. The HP5P (IBM) and HP5PM (Mac) enable the user to 



beam a document from the laptop to an infrared receiver in the front of the printer. The 

laptop needs to have a built in infrared transmitter installed, but no cables or wires are 

required. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

The Laser Mechanism: The laser printer uses electrostatic charges to (1) create an 

image on the drum, (2) adhere the toner to the image, (3) transfer the toned image to 

the paper, and (4) fuse the toner to the paper. The laser creates the image by ñpaintingò 

a negative of the page to be printed on the charged drum. Where light falls, the charge 

is dissipated, leaving a positive image to be printed. 
 

Inkjet Printers 
 

Inkjet printers are also popular among microcomputer users. Although the resolution 

is lower on inkjet printers than on laser printers, it is higher than that of dot matrix 

printers. Inkjet printers are significantly less expensive than laser printers. 

Electronically charged ink is sprayed through a jet nozzle and passed through an 

electronic field, which deflects the ink to form a dot matrix character. Color inkjet 

printers, which use multiple nozzles, are available at very reasonable prices. Canon 

recently released a color inkjet printer that weighs 3 pounds and stands 2 inches high. 

The perfect choice of printer while traveling! 
 

A well-equipped office at home or at workplace includes an inkjet printer, a fax 

machine (with its own telephone), a copier and a full sheet scanner. A recent addition 

to the market is one device that does all four functions. The technology to print a 

document that has been faxed to you and the technology to copy a document are 

similar to the technology to print a document from a PC. All three technologies use 

similar digital patterns and the mechanical aspects are nearly identical. 
 

Other high quality printers include Thermal-wax printers, Dye-sub printers, Fiery 

printers and IRIS printers. 



The thermal-wax printers are primarily used for presentation graphics and handouts. 

They operate with a ribbon-coated pane of colored wax that melts and adheres to plain 

paper as colored dots passed over a focused heat source. As the paper and ribbon travel in 

unison beneath the thermal print head, the wax-based ink from the transfer ribbon melts 

onto the paper. When cool, the wax is permanent. This type of thermal printer uses a like-

size panel of ribbon for each page to be printed, regardless of the contents of the page. 

Monochrome printers have a black panel for each page to be printed, while color printers 

have either three (CMY) or four (CMYK) colored panels for each page. 
 

The dye-sub printer is a printer that produces continuous-tone images that look like a 

photographic film. It uses a ribbon containing an equivalent panel of dye for each page to 

be printed. Color printers have either three (CMY) or four (CMYK) consecutive panels 

for each page, thus the same amount of ribbon is used to print a full-page image, as it is 

to print a tenth of the page. Special dye-receptive paper is used, and the consumables 

(ribbon and paper) cost more than other printer technologies. 
 

The paper and ribbon are passed together over the print head, which contains 

thousands of heating elements that can produce varying amounts of heat. The hotter 

the element, the greater is the amount of dye released. By varying the temperature, 

shades of each color can be overlaid on top of each other. The dyes are transparent and 

blend into a continuous-tone color. 
 

Fiery printer servers are special type of computers that transmits documents to a 

digital color copier, where they are printed. 
 

IRIS printers are large-format color printers from the Iris Graphics division of 

CreoScitex, that are used for digital proofing. Iris printers use a patented continuous 

inkjet technology to produce consistent, continuous-tone, photo-realistic output on 

several varieties of paper, canvas, silk, linen and other low-fiber textiles. Iris prints are 

widely noted for their color accuracy and ability to match printing and proofing 

standards. They are also known for their low-cost consumables as compared to other 

technologies. 
 

Plotters 
 

A plotter, like a printer, produces hard copy output. Plotters, which produce high 

quality color graphics, are usually categorized by whether they use pens or 

electrostatic charges to create images. A continuous curve plotter is used to draw maps 

from stored data. Computer generated maps can be retrieved and plotted or used to 

show changes over time. Plotters are generally more expensive than printers, ranging 

from about $1,000 to $75,000 (or even more). 
 

A plotter uses a robotic arm to draw with colored pens on a sheet of paper. The 

instructions that a plotter receives from the computer consists of the color and the 



beginning and ending coordinates for a line. With this information, the plotter picks up 

the appropriate pen, positions it at the beginning of the coordinates drops the pen 

down to the surface of the paper and draws to the ending coordinates. The plotter draw 

curves by creating a sequence of very short, straight lines. 
 

REVISION EXERCISES 
 

Fill in the blanks 
 

1. ........... cannot produce multiple copies. 
 

 The capability of a computer to understand verbal instructions is called......... 
 
 ..........produces high-quality graphics. 
 
 ............ keyboard is most commonly used. 
 
 .......... can be used to input the picture in the computer. 
 
 ............displays the soft copy. 
 
 ...........printers use infra-red receiver to receive a document 
 

 The banking industry uses ............. 
 
 Personal computers use ......... and ......... input devices, most commonly. 
 
 .............keyboards are resistant to liquids and grease. 
 
 ............ are the smallest types of computers. 
 

Answers      

1. Non-impact Printers 2. Voice recognition 3. 

Plotter      

4. QWERTY 5. Scanner   

6. Monitor 7. Wireless   

8. MICR     

9. Keyboard, Mouse    

10. Membrance Switch    

11. Personal Digital Assistants    
 

REVIEW QUESTIO NS 
 

 List four types of output devices. 
 
 Describe various types of input devices and differentiate amongst them. 



 Write about various types of scanners. 
 
 What is the difference between impact and non-impact printers? 
 
 Write a note on trackballs. 
 
 What is an MICR? 
 
 Why are Personal Digital Assistants becoming popular? 
 
 Write a brief on all the types of input devices. 
 
 Write a note on scanning devices. 
 
 What do you think can come after voice recognition devices? 



Chapter 4: COMPUTER MEMORY  
 

THE MAIN MEMORY UNI T 
 

The main memory, also known as the primary memory, is a part of the central 

processing unit and is a combination of both RAM (Random Access Memory) and 

ROM (Read Only Memory). 
 

RANDOM ACCESS MEMORY  
 

The random access memory is a read-write memory i.e. information can be read as 

well as written into this type of memory. It is volatile in nature, i.e., the information it 

contains is lost as soon as the system is shut down, unless it is ósavedô by the user for 

further usage. It is basically used to store programs and data during the computerôs 

operation. 
 

RAM Basics 
 

A memory chip is an Integrated Circuit (IC) made of millions of transistors and 

capacitors. In the most common form of computer memory, Dynamic Random Access 

Memory (DRAM), a transistor and a capacitor are paired to create a memory cell, 

which represents a single bit of data. The capacitor holds the bit of information - a 0 or 

a 1. The transistor acts as a switch that lets the control circuitry on the memory chip 

read the capacitor or change its state. 
 

For dynamic memory to work, either the CPU or the memory controller has to 

come along and recharge all of the capacitors holding a 1 before they discharge. To do 

this, the memory controller reads the memory and then writes it right back. This 

refresh operation happens automatically thousands of times per second. 
 

This refresh operation is where dynamic RAM gets its name. Dynamic RAM has 

to be dynamically refreshed all of the time or it forgets what it is holding. The 

downside of all of this refreshing is that it takes time and slows down the memory. 
 

Memory cells are etched onto a silicon wafer in an array of columns (bitlines) and 

rows (wordlines). The intersection of a bitline and wordline constitutes the address of 

the memory cell. 
 

DRAM works by sending a charge through the appropriate column (CAS) to activate 

the transistor at each bit in the column. When writing, the row lines contain the state the 

capacitor should take on. When reading, the sense-amplifier determines the level of 

charge in the capacitor. If it is more than 50 percent, it reads it as a 1; otherwise it reads it 

as a 0. The counter tracks the refresh sequence, based on which rows have been accessed 

and in what order. The length of time necessary to do all this is so short 



that it is expressed in nanoseconds (billionths of a second). A memory chip rating of 

70ns means that it takes 70 nanoseconds to completely read and recharge each cell. 
 

Memory cells alone would be worthless without some way to get information in 

and out of them. So the memory cells have a whole support infrastructure of other 

specialized circuits. These circuits perform functions such as: 
 

 ̧ Identifying each row and column (row address select and column address select) 
 

 

 ̧

 

 ̧

 

 ̧

 

 

Keeping track of the refresh sequence (counter) 
 

Reading and restoring the signal from a cell (sense amplifier) 
 

Telling a cell whether it should take a charge or not (write enable) 
 

Other functions of the memory controller include a series of tasks that include 

identifying the type, speed and amount of memory, and checking for errors. 
 

Static RAM uses a completely different technology. In static RAM, a form of flip-

flop holds each bit of memory. A flip-flop for a memory cell takes four or six 

transistors along with some wiring, but never has to be refreshed. This makes static 

RAM significantly faster than dynamic RAM. However, because it has more parts, a 

static memory cell takes up a lot more space on a chip than a dynamic memory cell. 

Therefore, you get less memory per chip, and that makes static RAM a lot more 

expensive. 
 

So static RAM is fast and expensive, and dynamic RAM is less expensive but 

slower. So static RAM is used to create the CPUôs speed-sensitive cache, while 

dynamic RAM forms the larger system RAM space. 



Memory Modules 
 

Memory chips in desktop computers originally used a pin configuration called Dual 

Inline Package (DIP). This pin configuration could be soldered into holes on the 

computerôs motherboard or plugged into a socket that was soldered on the 

motherboard. This method worked fine when computers typically operated on a 

couple of megabytes or less of RAM, but as the need for memory grew, the number of 

chips needing space on the motherboard increased. 
 

The solution was to place the memory chips, along with all of the support 

components, on a separate Printed Circuit Board (PCB) that could then be plugged 

into a special connector (memory bank) on the motherboard. Most of these chips use a 

Small Outline J-lead (SOJ) pin configuration, but quite a few manufacturers use the 

Thin Small Outline Package (TSOP) configuration as well. The key difference 

between these newer pin types and the original DIP configuration is that SOJ and 

TSOP chips are surface-mounted onto the PCB. In other words, the pins are soldered 

directly to the surface of the board, not inserted in holes or sockets. 
 

Memory chips are normally only available as part of a card called a module. 

Youôve probably seen memory listed as 8x32 or 4x16. These numbers represent the 

number of the chips multiplied by the capacity of each individual chip, which is 

measured in Megabits (Mb), or one million bits. Take the result and divide it by eight 

to get the number of megabytes on that module. For example, 4x32 means that the 

module has four 32-megabit chips. Multiply 4 by 32 and you get 128 megabits. Since 

we know that a byte has 8 bits, we need to divide our result of 128 by 8. Our result is 

16 megabytes! 
 

The type of board and connector used for RAM in desktop computers has evolved 

over the past few years. The first types were proprietary, meaning that different 

computer manufacturers developed memory boards that would work only with their 

specific systems. Then came SIMM, which stands for single in-line memory module. 

This memory board used a 30-pin connector and was about 3.5 x .75 inches in size 

(about 9 x 2 cm). In most computers, you had to install SIMMs in pairs of equal 

capacity and speed. This was because the width of the bus is more than a single 

SIMM. For example, you would install two 8-megabyte (MB) SIMMs to get 16 

megabytes of total RAM. Each SIMM could send 8 bits of data at one time, while the 

system bus could handle 16 bits at a time. Later SIMM boards, slightly larger at 4.25 x 

1 inch (about 11 x 2.5 cm), used a 72-pin connector for increased bandwidth and 

allowed for up to 256 MB of RAM. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

From the top: SIMM, DIMM and SODIMM memory modules 



Common Ram Types 
 

SRAM 
 

Static Random Access Memory uses multiple transistors, typically four to six for each 

memory cell, but doesnôt have a capacitor in each cell. It is used primarily for cache. 
 

DRAM 
 

Dynamic Random Access Memory has memory cells each with a paired transistor and 

capacitor, requiring constant refreshing. 
 

FPM DRAM 
 

Fast Page Mode Dynamic Random Access Memory was the original form of DRAM. 

It waits through the entire process of locating a bit of data by column and row and then 

reading the bit before it starts on the next bit. The maximum transfer rate to L2 cache 

is approximately 176 MBPS. 
 

EDO DRAM 
 

Extended Data-out Dynamic Random Access Memory does not wait for the entire the 

processing of the first bit before continuing to the next one. As soon as the address of the 

first bit is located, EDO DRAM begins looking for the next bit. It is about five percent 

faster than FPM. The maximum transfer rate to L2 cache is approximately 264 MBPS. 
 

SDRAM 
 

Synchronous Dynamic Random Access Memory takes advantage of the burst mode 

concept to greatly improve performance. It does this by staying on the row containing 

the requested bit and moving rapidly through the columns, reading each bit as it goes. 

The idea is that most of the time the data needed by the CPU will be in sequence. 

SDRAM is about five percent faster than EDO RAM and is the most common form in 

desktops today. The maximum transfer rate to L2 cache is approximately 528 MBPS. 
 

DDR SDRAM 
 

Double Data Rate Synchronous Dynamic RAM is just like SDRAM except that is has 

higher bandwidth, meaning greater speed. The maximum transfer rate to L2 cache is 

approximately 1,064 MBPS (for DDR SDRAM 133 MHZ). 
 

RDRAM 
 

Rambus Dynamic Random Access Memory is a radical departure from the previous 

DRAM architecture. Designed by Rambus, RDRAM uses a Rambus 



In-line Memory Module (RIMM), which is similar in size and pin configuration to a 

standard DIMM. What makes RDRAM so different is its use of a special high-speed 

data bus called the Rambus channel. RDRAM memory chips work in parallel to 

achieve a data rate of 800 MHz, or 1,600 MBPS. Since they operate at such high 

speeds, they generate much more heat than other types of chips. To help dissipate the 

excess heat Rambus chips are fitted with a heat spreader, which looks like a long thin 

wafer. Just like there are smaller versions of DIMMs, there are also SO-RIMMs 

designed for notebook computers. 
 

Credit Card Memory 
 

Credit card memory is a proprietary self-contained DRAM memory module that plugs 

into a special slot for use in notebook computers. 



PCMCIA Memory Card 
 

Another self-contained DRAM module for notebooks, a card of this type is not 

proprietary and should work with any notebook computer whose system bus matches 

the memory cardôs configuration. 
 

CMOS RAM 
 

CMOS RAM is a term for the small amount of memory used by the computer and 

some other devices to remember things like hard disk settings. This memory uses a 

small battery to provide it with the power it needs to maintain the memory contents. 
 

VRAM 
 

VideoRAM, also known as MultiPort Dynamic Random Access Memory (MPDRAM), is 

a type of RAM used specifically for video adapters or 3-D accelerators. The ñmultiportò 

part comes from the fact that VRAM normally has two independent access ports instead 

of one, allowing the CPU and the graphics processor to access the RAM simultaneously. 

VRAM is located on the graphics card and comes in a variety of formats, many of which 

are proprietary. The amount of VRAM is a determining factor in the resolution and color 

depth of the display. VRAM is also used to hold graphics-specific information such as 3-

D geometry data and texture maps. True multiport VRAM tends to be expensive, so 

today, many graphics cards use SGRAM (synchronous graphics RAM) instead. The 

performance is nearly the same, but SGRAM is cheaper. 
 

Read Only Memory (ROM) 
 

The Read Only Memory (ROM) contains non-volatile or permanent information. As 

the name suggests, the information contained in this type of memory can only be read; 

it cannot be altered or overwritten. Information is entered into the ROM chip at the 

time of manufacturing. ROM chips are used for applications which require a 

permanent information, for example, a program for the functioning of the visual 

display unit, or a program for controlling the working of a washing machine etc. 
 

With the advent of technology, erasable ROMs have become available. We shall 

discuss these and other ROMôs in the following section. 
 

Types of ROM: 
 

 Programmable Read Only Memory (PROM): A PROM program is used to record 

information in the PROM chip. Information once programmed into the PROM chip is 

permanent and cannot be changed or erased. The process of entering the information 

into the PROM chip is known as ñburning the PROM.ò PROM chips are 



seldom used in modern day computers, but they still find their use in devices 

where a permanent ROM is required. 
 

 Masked Read Only Memory (MROM): In the masked ROM, the information is 

permanently recorded by the masking and metallization process. It is not easy to 

perform this process as a large infrastructure is required, and, therefore, it is 

usually the manufacturers who perform this process. 
 

 Erasable Programmable Read Only Memory (EPROM): An EPROM is an erasable 

PROM. An EPROM can be (re) programmed using an EPROM programmer. 

Exposing it to high intensity ultraviolet light for 30 minutes (approximately) can 

erase the contents of an EPROM chip. An ultra-violet source with a wavelength of 

2537A (angstrom) is used for this purpose. The process of changing the contents is 

not convenient, as the chip has to be removed from the board for exposure to the 

ultra-violet light source. Another disadvantage is that the user canôt erase the 

contents of a single memory location, and the entire memory contents have to be 

erased. The EPROM chip is cheap, reliable and widely available. 
 

 Electrically Erasable Programmable Read Only Memory (EEPROM): EEPROM is 

an electrically erasable PROM. The use of electrical signals can alter the 

information, and so the chip need not be removed from the board. One major 

advantage that this chip has over the EPROM is that even a single memory can be 

altered, i.e., the entire memory need not be erased and reprogrammed, unless so 

required. The change in the contents of the EEPROM chip is made in 

milliseconds, which is much less than the erasing time for EPROM. 
 

 Non-volatile RAM: A non-volatile RAM combines a static RAM and EEPROM. 

Such a device operates as normal RAM but, in case of power-failure, the entire 

contents of the RAM are stored in EEPROM. When the power is restored, the data 

from EEPROM is transferred back to the RAM. 
 

The main memory is a fast memory, i.e., it has small access time. It is because of its 

limited capacity that it is fast. The main memory contains the programs that are currently 

being worked on. It passes on this information to the control unit as and when required. 

In case the CPU wants to access some data that is present in a secondary storage device, 

this data is first transferred to the main memory and then processed. 
 

The main memory is for costlier than the secondary storage devices. Although the 

ROM ICôs of various computers do not vary much in their capacities, the RAM chips 

are available in wide ranges of storage capacities. In fact, the capacity of the random 

access memory is an important specification of a computer. 
 

A larger RAM means that larger programs (in terms of memory) can be loaded and 



executed. Suppose you want to run a 68-KB program on a machine with 64-KB. This 

means that the whole program cannot be loaded into the main memory, at once 

resulting in either the non-execution of the program or a very slow execution. 
 

A 64-K memory means that there are approximately 64000 (65,536 to be precise) 

storage locations which can store 1 bit of data each. 
 

Different memories can be classified on the basis of their concepts: 
 

 Access Mode: which means how easily they are accessible. 
 
 Access Time: the average time required to reach a storage location and obtain its 

content is called access time. 
 
 Transfer Rate: the transfer rate is the number of characters or words that a device can 

transfer per second after it has been positioned at the beginning of the record. 
 
 Capacity and Cost: the capacity and cost may depend upon the requirement and the 

budget. 
 

The main memory has a very low access time and a very high transfer rate. It is 

limited in capacity and costlier than secondary storage devices. 
 

The Cache Memory 
 

The cache memory lies in the path between the processor and the main memory. The 

cache memory has lesser access time than the main memory and is faster than the 

main memory. A cache memory may have an access time of 100ns, while the main 

memory may have an access time of 700ns. 
 

The cache memory is very expensive and is limited in capacity. Earlier, cache 

memories were available separately, but the latest microprocessors contain the cache 

memory on the chip itself. 
 

The need for the cache memory arises because of the mismatch between the 

speeds of the main memory and the CPU. The CPU clock as discussed earlier is very 

fast, whereas the main memory access time is comparatively slower. Hence, no matter 

how fast the processor is, the processing speed depends more on the speed of the main 

memory (the strength of a chain is the strength of its weakest link). It is because of this 

reason that a cache memory, having access time closer to the processor speed, was 

introduced. 
 

The cache memory stores the program (or its part) currently being executed or 

which may be executed within a short period of time. The cache memory also stores 

temporary data that the CPU may frequently require for manipulation. 
 

The cache memory works according to various  algorithms, which decide what 



information it has to store. These algorithms work out the probability to decide which 

data would be most frequently needed. This probability is worked out on the basis of 

past observations. 
 

Register 
 

A register is a combination of memory storage locations called flip-flops. Each flip-

flop is capable of storing one bit of information. An n-bit register contains ónô flip-

flops and is capable of storing ónô bits of information. 
 

Accumulator 
 

The accumulator is a register that is present within the arithmetic logic-unit. The 

accumulator stores data, which is either the result of an operation, or which is to be 

processed through arithmetic and logical operations. 



Memory Data Register 
 

The memory data register, like the accumulator, is used to store data. This register 

holds all data and instructions temporarily, as they pass in or out of the main memory. 
 

Memory Address Register 
 

The memory address register contains the address of the memory location (in the main 

memory) whose data is to be transferred into the memory data register. 
 

In the figure, the Memory Address Register (MAR) contains the address of the third 

memory location, the data of which is transferred to the Memory Data Register (MDR). 
 

We shall try to explain the functioning of the ALU with the help of an example. 
 

Suppose two numbers are to be subtracted. The following steps are involved: 
 

 Let the first instruction cause the number 13 to be placed in the accumulator. When 

the control unit receives this instruction it decodes it and performs the controlling 

and co-ordination function by sending the number to the accumulator. A special 

purpose register, that holds the instruction currently being processed by the control 

unit, is called the Current Instruction Register (CIR). 
 
 The second instruction asks the control unit to send the address of the second 

number stored in the main memory to the MAR.  
 The control unit then causes the contents of that specific address of the main 

memory to be copied to the MDR.  
 Once the numerical data has been passed on to the MDR, the control unit signals 

the ALU to perform the SUBTRACT Operation which causes the number in the 

MDR to be subtracted from the number in the accumulator. 
 

AUXILIARY STORAGE MEMORY  
 

The auxiliary storage memory, also known as the secondary memory, is an external (to 

the CPU) memory. The auxiliary storage devices store system programs, large data 

files, assemblers, compilers and other programs. In other words, the auxiliary storage 

devices are used for bulk storage of data. The storage capacity of these devices is 

unlimited, as an empty device can replace them once the existing device is completely 

filled. Even the individual storage devices, such as the magnetic tape, have more 

capacity than the main memory. 
 

The secondary memory is permanent in nature, i.e., the information stored in these 

devices is not lost unless specifically deleted. Therefore, secondary storage devices 

can also be used for transportation of data from one computer to another. 



These devices are cheaper as compared to the main memory. The information 

stored in them is first transferred to the main memory and then processed by the CPU. 

The final result may then be placed in the secondary memory. It is because of this that 

the access time of the secondary memory is comparatively high. Hence, the data stored 

in secondary storage devices take more time to process than the data already present in 

the main memory. In fact, the access time for data stored in the secondary memory is 

one thousand times that for data stored in the main memory. 
 

Secondary memories may also be considered as input and output devices, as they 

provide the information as input and store the final results in the output. 
 

Magnetic Tape 
 

The magnetic tape is one of the oldest forms of computer storage. First, and second-

generation computers used magnetic tape for most of their storage needs. Today, the 

magnetic tape is not used as often. The reasons are discussed in this section. 
 

Magnetic tape storage devices work in much the same way that a tape recorder 

works. Instead of 'play' and 'record', the terms 'read' and 'write' are used. The magnetic 

tape used by a computer is very much like the tape used on an audio tape recorder. 

Most mainframe computers use reel-to-reel tapes, minicomputers use cartridges 

(similar to VCR tapes), and microcomputers use cassettes. Like the tape used in a tape 

recorder, the computer tape can access what is stored on it only in the order in which 

the data has been recorded (sequentially). This limited SEQUENTIAL ACCESS, which slows 

down data access, is such a significant disadvantage that it is used primarily to back up 

data that is also stored on disk or that will not be needed frequently. 
 

There are some good reasons to use magnetic tape, despite the disadvantages 

mentioned. Tapes can be recorded, erased and reused many times, and they are 

inexpensive. Tapes are easily transported from one location to another, and tape drives 

can store large amounts of data quickly. Magnetic tape capacity is measured in bytes per 

inch (bpi), known as the tape density. Low-density tapes generally store 1,600 bpi and 

high-density tapes can store 6,250 bpi. The newest tapes, called R-DATs, can store more 

than 14 gigabytes on a single 90-metre tape. The speed, the storage capability and the 

cost of the tape are the reasons why it is still frequently used as a backup medium. 
 

Magnetic Disk 
 

Disk drives can not only store large amounts of data, but also have the capability to 

directly access a file or records. A MAGNETIC DISK, coupled with a disk drive that 

can store and retrieve data on the disk, is a RANDOM ACCESS STORAGE 

MEDIUM; that is, if you need the 189
th

 item, the drive head can go directly to that 

item and read it. The disk driveôs magnetic head is called a READ/WRITE HEAD. 



When you insert a disk into the disk drive, the disk fits on a rod that rotates the 

disk. The read/write head reads the magnetic impulses. It can move laterally above the 

surface of the disk, just as you would move a phonographôs arm to locate a specific 

track on an LP record. A different read/write head is used for each surface of each 

platter in a disk pack. All the read/write heads are mounted on a single arm, so that 

each head reads the same track and sector on its platter at the same time. It is 

important to remember that disk drives are mechanical devices. Problems can occur, 

so backup copies of important programs and data are essential. 
 

Before a disk can be used for storage, it must be prepared by means of a process 

called FORMATTING. In this process, the disk driveôs read/write head lays down a 

magnetic pattern on the diskôs surface. This pattern enables the basic tasks handled by 

the computerôs operating system. 
 

Data is recorded on a disk in concentric circular bands called tracks. The tracks on 

a disk are similar to the grooves on a phonograph record. Each track is divided into 

pie-shaped wedges called sectors. Two or more sectors combine to form a cluster. 
 

Most computers maintain on the disk a table with the sector and track locations of 

data. This table, called the File Allocation Table (FAT), enables the computer to locate 

data easily. 
 

There are two popular types of magnetic disks: floppy disks and hard disks. Most 

of todayôs personal computers are equipped with both. 
 

Floppy Disk and Disk Drives 
 

A floppy disk is a flexible circle of Mylar plastic. The 3.5-inch version is encased in a 

hard plastic cover. The 5.25-inch version is encased in a square jacket that is harder 

than the disk itself but is still flexible. The 3.5-inch disk is a newer design as 

compared to the 5.25-inch disk, which is rapidly disappearing. 
 

Most personal computers are equipped with one or two disk drives. A disk drive 

can perform two operations: read and write. A read operation is similar to playing a 

CD-ROM. The drive ñplaysò information from the disk and relays it to the processor. 

A write operation is similar to recording on a cassette tape. The drive records 

information on the disk. Unlike operating a cassette recorder, though, you donôt have 

to push buttons, these actions occur under the direction of the program you are using. 

Disks contain a write-protection tab that you can open, to protect data from being over 

written or deleted. 
 

The density of the magnetic particles on the diskôs surface determines the amount 

of information that can be stored on a floppy disk. Double-density disks store more 

than the single-density disks of a decade ago. But high-density disks are increasingly 



common today. 
 

Disks are inexpensive, usually costing less than a dollar each. The storage capacity 

of floppy disks is relatively limited. In addition, because floppy disks spin only about 

300 revolutions per minute, locating data (seek time), waiting for the disk to spin to 

the correct sector (rotational delay time) are comparatively longer. (The combination 

of seek time, rotational delay time and transfer time is known as the access time.) For 

this reason, all new personal computer systems are equipped with hard disks, which 

have much more storage and operate considerably faster. 



Hard Disks 
 

A hard disk is similar to a floppy disk, but the hard disk is made of rigid metallic 

platters, can hold much more data and operate much faster. Most hard disks are 

permanently encased in the disk drive, although some drives use removable cartridges. 

Removable disks, generally known as Bernoulli disks, consist of a single platter 

encased in a plastic cartridge. Some of the newer removable cartridges, called zip 

disks, can hold more than 125M on a single 3.5-inch cartridge. A hard disk pack, 

which is usually found in a desktop computer (or larger), consists of several platters, 

with data encoded on both sides of each platter. All tracks and sectors in the same 

relative location on a disk pack form a cylinder. (For example, track 20 sector 2 on 

platter s1 and track 20 sector 2 on all the other platters in the disk pack form a 

cylinder.) Many small notebook computers use a hard card, which is a small disk 

mounted on an expansion card, rather than a full disk drive and pack. 
 

Hard disks spin so rapidly that the read/write head does not touch the surface of the 

disk. Serious damage can be caused if the read/write head encounters an obstacle, such as 

dust or a smoke particle, causing the read/write head to bounce on the disk surface. 
 

Performance of hard disks is better than that of floppy disks because: 
 

 A single hard drive may have several platters, providing large data storage 

capacities. 
 

 Most hard disks are permanently encased within the disk drive in a sealed 

environment free from dust and dirt. The disk can spin very rapidly, with the 

read/write head ñfloating ñ above the diskôs surface. 
 

 Hard disks spin at an average of 33,600 revolutions per minute, making data 

retrieval very fast. 
 

Intense competition and technological innovation are driving hard disk prices 

down, even as storage capacities rise. Many personal computers have hard disks 

capable of storing a gigabyteðone billion charactersðor more. 
 

Larger computer systems are beginning to use a new type of hard disk storage. A 

RAID (Redundant Array of Inexpensive Disks) can be composed of more than one 

hundred 5.25-inch disks with a controller mounted in a single box. RAID storage first 

appeared on the market in 1993. A RAID can send data simultaneously over multiple 

data paths quickly. 
 

Hard Disk Interfaces 
 

To connect a hard disk to a microcomputer motherboard, you must have a hard disk 



interface. This component includes circuitry that conforms to a standard recognized by 

both the hard disk and the motherboard manufacturer. Common Standards are 

INTEGRATED DRIVE ELECTRONICS (IDE) and SMALL COMPUTER SYSTEM 

INTERFACE (SCSI). 
 

Optical Disk 
 

Imagine going into your favourite video store, asking for a movie that you want to see, 

and being told that you will just have to look around because the employees donôt 

know which movies the store has. If all of our data werenôt stored in some logical 

manner, the scenario might be just like this. To prevent such a situation, we have 

developed manual filing systems that store records on index cards, in file folders, and 

on other media. To answer such a query would be equally difficultðeven with 

computersðif we didnôt have some organized method for storing all the data. 

Fortunately, computer storage methods can produce the answer in just a fraction of a 

minute. In the following explanations , you will learn how a computer stores data and 

what storage methods are used in data processing applications. 
 

To understand how a computer stores data, you need to know about the storage 

media that the computers use. You know that the computer translates into binary form 

all the data and instructions stored internally. You have learned that letters, numbers 

and special symbols are represented as a group of bits, based on EBCDIC or ASCII 

coding. Because a computerôs memory (RAM) is volatile, you must save data by 

transferring it from memory to a storage device such as a disk. These storage devices, 

frequently called SECONDARY STORAGE, are not volatile. They can hold large 

amounts of data for as long as the user wants. This lesson explains how data is 

organized when it is saved to a storage device. 
 

Secondary storage is very inexpensive as compared to primary storage (memory). 

Most computers have a large amount of storage. However, storage devices do not 

transfer data as quickly as RAM does. When you finish working with an application, 

you save the results of your work on a secondary storage medium. 
 

CD-ROM works much like the compact discs used in CD players. Just as CDs 

have revolutionized the music industry, optical disks have the potential to change 

secondary storage media. Based on the same laser technology as CDs, optical disks 

offer a medium capable of storing extremely large amounts of data. The three main 

types of optical disks are CD-ROM, WORM CD, and MO technology. 
 

The most popular and least expensive type of optical disk is Compact Disk Readï 

Only Memory (CD-ROM). As the name indicates, these disks come prerecorded and 

cannot be altered; CD-ROM is, in other words, a read-only storage medium. Still, CD-

ROM provides an excellent way to distribute large amounts of data at low cost. CDs 



can store up to 650MB of data, yet they can cost as little as a dollar per disk. 
 

To use a CD-ROM, you must have a computer equipped with a CD-ROM drive. 

Double-speed drives achieve the minimum level of retrieval speed for multimedia 

applications. (A doubleïspeed drive is slower than a floppy drive). Eightïspeed drives 

are decreasing in cost and becoming common in new computer systems, and Ten-

speed drives are available at a higher price. CD-ROM towers, containing as many as 

256 CD-ROM drives, are frequently attached to CD servers so that all the computers 

on a network can share what is stored on the CD-ROMs. 
 

The CD-ROM has been used primarily to market large applications. For example, 

Infopedia is a single CD that holds a complete encyclopedia, a dictionary, a thesaurus, 

a world atlas, a dictionary of quotations, a world almanac and a biographical 

dictionary. The Total Baseball CD holds statistics of over 13,000 players, with 

photographs of their trading cards, and explanatory sound clips. You can tour the 

National Art Gallery on CD-ROM or play a variety of games. 
 

A WRITE ONCE, READ MANY COMPACT DISCS (WORM CD) is purchased 

blank from the manufacturer and encoded using special equipment. The disks canôt be 

altered after they are encoded and canôt be easily duplicated because the encoding 

process does not actually pit the disk. Many businesses use WORM CDs to store old 

data files. This practice, known as archiving, enables old files to be deleted from the 

hard disk, thus freeing space for new files. WORM CDs are used most frequently for 

document processing with complete image processing, including replication of photos, 

graphics, text and even signatures. 
 

Until recently, recording on a CD-ROM required separate, very expensive 

equipment. Now drives that can write to and read a CD, called CD-Recordable (CD- 

 drives, are available for less than $900, and the prices are reducing further rapidly. 

A blank disk costs about $15. CD-R is a WORM process. Any standard CD-ROM unit 
can read the disks. 
 

If you want to create a multimedia presentation and then play it back on any 

available computer equipped with a CD-ROM drive, CD-R is the tool you are looking 

for. With the large capacity of a CD-R (roughly 600 megabytes per disk), you can 

create and store an entire multimedia presentation on a single disk. (Floppy disks donôt 

have this capacity). 
 

CD-Rs look like standard CD-ROMs except that they are golden in colour, rather 

than the silver of ñmasteredò CD-ROMs. The blank disks are made with the spiral 

tracks impressed on the recording surface. Because CD-ROMs are read by refraction 

of light, a dye layer is discoloured in the recording process, which causes the area 

either to reflect light or to disperse it. 



The technology to make CD-Erasable (CD-E) disks became recently available. 

CD-E enables users to store, access and reuse disks in the same way that floppy disks 

can be used. Because of the large storage capacity of CDs, they will in all likelihood 

make magnetic tapes, and perhaps floppy disks as well, a thing of the past. 
 

MAGNETO-OPTICAL (MO) disks are erasable, and combine the magnetic 

principles used on tape and disk with new optical technology. MO disks measure 

storage capacity in gigabytes; they are removable, portable and durable. One of the 

newest MO systemsðOrray produced by Pinnacle Microðuses a storage method 

similar to that of RAID. Optical disks have a thirty-year shelf life and are ideal for 

graphics and audio-visual applications that require large storage capacity. 
 

Flash Memory 
 

Flash memory (sometimes called ñflash RAMò) is a type of constantly powered 

nonvolatile memory which means that it stores information on a silicon chip in a way 

that does not need power to maintain the information in the chip. It can be erased and 

reprogrammed in units of memory called blocks. It is a variation of Electrically 

Erasable Programmable Read-Only Memory (EEPROM), which, unlike flash 

memory, is erased and rewritten at the byte level, which is slower than flash memory 

updating. Normal EEPROM only allows one location at a time to be erased or written, 

meaning that flash memory can operate at effectively higher speeds when the system 

uses it to read and write to different locations at the same time. Flash memory is often 

used to hold control code such as the Basic Input/Output System (BIOS) in a personal 

computer. When BIOS needs to be changed (rewritten), the flash memory can be 

written to in block (rather than byte) sizes, making it easy to update. On the other 

hand, flash memory is not as useful as Random Access Memory (RAM) because 

RAM needs to be addressable at the byte (not the block) level. 
 

Flash memory offers fast read access times and solid-state shock resistance. These 

characteristics explain the popularity of flash memory for applications such as storage 

on battery-powered devices like cellular phones and PDAs. 
 

Flash memory is based on the Floating-Gate Avalanche-Injection Metal Oxide 

Semiconductor (FAMOS transistor), which is essentially an NMOS transistor with an 

additional conductor suspended between the gate and source/drain terminals. 
 

Flash memory is made in two forms: NOR flash and NAND flash. The names 

refer to the type of logic gate used in each storage cell. Flash memory is often used in 

MP3 players, digital cameras and mobile phones. 
 

Principles of Operation 
 

Flash memory stores information in an array of transistors, called ñcells,ò each of which 



traditionally stores one bit of information. Newer flash memory devices, sometimes 

referred to as multi-level cell devices, can store more than 1 bit per cell, by varying the 

number of electrons placed on the FG of a cell. 
 

In NOR flash, each cell looks similar to a standard MOSFET transistor, except 

that it has two gates instead of just one. One gate is the Control Gate (CG) like in other 

MOS transistors, but the second is a Floating Gate (FG) that is insulated all around by 

an oxide layer. The FG is between the CG and the substrate. Because the FG is 

isolated by its insulating oxide layer, any electrons placed on it get trapped there and 

thus store the information. When electrons are on the FG, they modify (partially 

cancel out) the electric field coming from the CG, which modifies the threshold 

Voltage (Vt) of the cell. Thus, when the cell is ñreadò by placing a specific voltage on 

the CG, electrical current will either flow or not flow, depending on the Vt of the cell, 

which is controlled by the number of electrons on the FG. This presence or absence of 

current is sensed and translated into 1ôs and 0ôs, reproducing the stored data. In a 

multi-level cell device, which stores more than 1 bit of information per cell, the 

amount of current flow will be sensed, rather than simply the presence or absence of 

current, in order to determine the number of electrons stored on the FG. 
 

A NOR flash cell is programmed (set to a specified data value) by starting up 

electrons flowing from the source to the drain. Then a large voltage placed on the CG 

provides a strong enough electric field to suck them up onto the FG, a process called 

hot-electron injection. To erase a NOR flash cell (reset to all 1ôs, in preparation for 

reprogramming), a large voltage differential is placed between the CG and source, 

which pulls the electrons off through Fowler-Nordheim tunneling, a quantum 

mechanical tunneling process. Most modern NOR flash memory components are 

divided into erase segments, usually called either blocks or sectors. All of the memory 

cells in a block must be erased at the same time. NOR programming, however, can 

generally be performed one byte or word at a time. 
 

NAND Flash uses tunnel injection for writing and tunnel release for erasing. 

NAND flash memory forms the core of the removable USB interface storage devices 

known as keydrives. 
 

NOR flash was the first type to be developed, invented by Intel in 1988. It has 

long erase and write times, but has a full address/data (memory) interface that allows 

random access to any location. This makes it suitable for storage of a program code 

that needs to be infrequently updated, such as a computerôs BIOS or the firmware of 

set-top boxes. Its endurance is 10,000 to 1,000,000 erase cycles. NOR-based flash is 

the basis of early flash-based removable media; Compact Flash was originally based 

on it, though the later cards moved to the cheaper NAND flash. 
 

NAND flash from Samsung and Toshiba followed in 1989. It has faster erase and 



write times, a higher density, and a lower cost per bit than NOR flash, and ten times 

the endurance. However its I/O interface allows only sequential access to data. This 

makes it suitable for mass-storage devices such as PC cards and various memory 

cards, and somewhat less useful for computer memory. The first NAND-based 

removable media format was SmartMedia, and numerous others have followed: 

MMC, Secure Digital, Memory Stick and xD-Picture Cards. 
 

One limitation of flash memory is that while it can be read or programmed a byte 

or a word at a time in a random access fashion, it must be erased a ñblockò at a time. 

Starting with a freshly erased block, any byte within that block can be programmed. 

However, once a byte has been programmed, it cannot be changed again until the 

entire block is erased. In other words, flash memory (specifically NOR flash) offers 

random-access read and programming operations, but cannot offer random-access 

rewrite or erase operations. When compared to a hard disk drive, a further limitation is 

the fact that flash memory has a finite number of erase-write cycles, so that care has to 

be taken when moving hard-drive based applications, such as operating systems, to 

flash-memory based devices such as CompactFlash. 
 

Interestingly, the Tungsten T5 PDA and the Treo 650 smartphone from PalmOne, 

released in late 2004, use NAND flash to back up the contents of main memory during 

normal operations. PalmOne names this technique ñnon-volatile file systemò (NVFS). 

It gives the illusion of a RAM storage pool that does not lose any of its data when 

power is removed. This PalmOne knowledge-based article explains how this technique 

works on the Treo 650. 
 

The cost per byte of flash memory remains significantly higher than the 

corresponding cost of a hard disk drive, and that has prevented flash from becoming a 

solid state replacement for the hard disk drive on most home and office computers. 
 

Because of the particular characteristics of flash memory, it is best utilized with 

specifically designed file systems which spread-write over the media and deal with the 

long erase times of NOR flash blocks. The basic concept behind flash file systems is: 

when the flash store is to be updated, the file system will write a new copy of the 

changed data over to a fresh block, remap the file pointers, then erase the old block 

later when it has time. 
 

JFFS was the first of these file systems, quickly superseded by JFFS2, originally 

developed for NOR flash. Then YAFFS was released in 2003, dealing specifically with 

NAND flash, and JFFS2 was updated to support NAND flash too. However, in practice 

most flash media is used with the old FAT filesystem for compatibility purposes. 
 

A special issue is flash memory booting. 
 

Common flash memory parts range widely in capacity from kilobits to hundreds of 



megabits each. Parts can be combined to provide even larger capacities within a 

package. 
 

Toshiba and SanDisk have developed a NAND flash part capable of storing 8 

gigabits of data. 
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Here are a few examples of Flash memory: 
 

Computerôs BIOS chip 
 

CompactFlash (most often found in digital cameras) 
 

SmartMedia (most often found in digital cameras) 
 

Memory Stick (most often found in digital cameras) 
 

PCMCIA Type I and Type II memory cards (used as solid-state disks in 

laptops) Memory cards for video game consoles 
 

REVISION EXERCISES 
 

Fill in the blanks 
 

1. Secondary storage can be organized into ............. that contain ............ 
 

2. Magnetic tape can store only ......... files. 
 

 An optical device that has both read and write capabilities is called ..........  
 Before a disk can be used for storage, it should first be ....... 
 
 The amount of information that can be stored on a floppy disk is determined by 
 

 ........ of the ................ on the surface of the disk. 

6. ......-density disks can store more than the ..... -density disks. 
 

 Data is recorded on a disk in concentric circular bands called ....... 
 
 The table that enables the computer to locate data easily is called ....... 
 

9. Each track is subdivided into .......... and two or more .......... combine together to 

 form a .......    

10.   Removable disks are also called ..............  

Answers    

1. Directories, files 2. Sequential files  

3. CD-ROM 4. Formatted  

5. Density, magnetic particles   

6. Double, single 7. Tracks  



8. File allocation table(FAT) 
 

9. Sectors, sectors, cluster 
 

10. Bernoulli Disks 
 

REVIEW QUESTIONS  
 

 List all types of secondary storage devices. 
 
 Compare all types of storage devices and explain why CD ROMs are grabbing the 

market fast. 
 
 Write down the evolution of floppy disks from the beginning till now. 
 
 How is a removable hard disk better than the hard disk and the floppy disk? 
 
 What is the term used to measure the capacity of the disks? 
 
 How is the read and write head able to pass the data to and from the surface of the 

disk?  
 Write a note on SCSI. 
 
 Jot down some of the advantages and disadvantages of CD-ROMs over the floppy 

diskettes. 
 
 Explain Read Only Memory. How is it different from the main memory? 
 
 What is RAM and EEPRAM? 
 
 Will adding more RAM make Internet browsing faster? 
 
 What is the difference between RDRAM AND SDRAM? 
 
 This is a general term for all forms of solid state memory that have a continuous 

source of power and do not need to have their memory contents periodically 

refreshed.  
 flash memory 

 
 random access memory 

 
 volatile memory 

 
 nonvolatile memory 



Chapter 5: PROCESSOR 
 

INTRODUCTION  
 

Someone who processes things is a processor. It is the part of a computer (a 

microprocessor chip) that does most of the data processing; the CPU and the memory 

form the central part of a computer to which the peripherals are attached. 
 

The processor sub-system of a data processing system processes received 

information after it has been encoded into data by the input sub-system. These data are 

then processed by the processing sub-system before being sent to the output sub-

system where they are decoded back into information. 
 

The two major types of digital processors are the Central Processing Unit (CPU) 

and the Digital Signal Processor (DSP). There are two main types of processors: CISC 

and RISC 
 
 
 
 
 
 
 
 
 
 

CENTRAL PROCESSING UNIT  
 

The part of a computer (a microprocessor chip) that does most of the data processing, 

the CPU and the memory form the central part of a computer to which the peripherals 

are attached. The Central Processing Unit (CPU) is the part of a computer that 

interprets and carries out the instructions contained in the software. 
 

DIGITAL SIGNAL PROCESSOR (DSP) 
 

A digital signal processor is a specialized microprocessor designed specifically for 

digital signal processing, generally in real-time. DSPs can also be used to perform 

general-purpose computation, but they are not optimized for this function. DSPs can 

also be purely software, and are usually used to re-encode audio for Internet radio 

stations in real-time. 
 

INTERRUPT STRUCTURE  
 

A signal informing a program that an event has occurred is an interrupt. When a 

program receives an interrupt signal, it takes a specified action. Interrupt signals can 

cause a program to suspend itself temporarily to service the interrupt. 
 

Interrupt signals can come from a variety of sources. For example, every keystroke 



generates an interrupt signal. Interrupts can also be generated by other devices, such as 

a printer, to indicate that some event has occurred. These are called hardware 

interrupts. Interrupt signals initiated by programs are called software interrupts. A 

software interrupt is also called a trap or an exception. 
 

PCs support 256 types of software interrupts and 15 hardware interrupts. Each 

type of software interrupt is associated with an interrupt handler ð a routine that takes 

control when the interrupt occurs. For example, when you press a key on your 

keyboard, this triggers a specific interrupt handler. The complete list of interrupts and 

associated interrupt handlers is stored in a table called the interrupt vector table, which 

resides in the first 1 K of addressable memory. 
 

The processor is a highly-tuned machine that is designed to do one thing at a time. 

However, we use our computers in a way that requires the processor to at least appear 

to do many things at once. In Windows 95, you may have been editing a document 

while downloading information on your modem and listening to a CD simultaneously. 

The processor is able to do this by sharing its time among the various programs it is 

running and the different devices that need its attention. It only appears that the 

processor is doing many things at once because of the blindingly high speed that it is 

able to switch between tasks. 
 

Most of the different parts of the PC need to send information to and from the 

processor, and they expect to be able to get the processorôs attention when they need 

to do this. The processor has to balance the information transfers it gets from various 

parts of the machine and make sure that they are handled in an organized manner. 

There are two basic ways that the processor can do this: 
 

 Polling: The processor can take turns going to each device and asking if they have 

anything they need it to do. This is called polling the devices. In some situations 

this technique is used; however, it is not used by the processor in a PC for a couple 

of basic reasons. One reason is that it is wasteful; going around to all the devices 

constantly asking if they need the attention of the CPU wastes cycles in which the 

processor could be doing something useful. This is particularly true because in 

most cases the answer will be ñnoò. Another reason is that different devices need 

the processorôs attention at differing rates; the mouse needs attention far less 

frequently than say, the hard disk, when it is actively transferring data. 
 

 Interrupting: The other way that the processor can handle information transfers is to 

let the devices request them when they need its attention. This is the basis for the use 

of interrupts. When a device has data to transfer, it generates an interrupt that says ñI 

need your attention now, pleaseò. The processor then stops what it is doing and deals 

with the device that requested its attention. It actually can handle many such requests 

at a time, using a priority level for each to decide which to handle 



first. 
 

MICROPROCESSOR HISTORY 
 

A microprocessor, also known as a CPU or central processing 

unit, is a complete computation engine that is fabricated on a 

single chip. The first microprocessor was the Intel 4004, 

introduced in 1971. The 4004 was not very powerful. All it could 

do was add and subtract, and it could only do that 4 bits at 
 

a time. But it was amazing that everything was on one chip. Prior to the 4004, 

engineers built computers either from collections of chips or from discrete components 
(transistors wired one at a time). The 4004 powered one of the first portable electronic 

calculators. 
 

The first microprocessor to make it into a home computer was 

the Intel 8080, a complete 8-bit computer on one chip, introduced 

in 1974. The first microprocessor to make a real splash in the 

market was the Intel 8088, introduced in 1979 and incorporated 

into the IBM PC (which first appeared around 1982). If you are 

familiar with the PC market and its history, you know that the PC 
 

market moved from the 8088 to the 80286 to the 80386, to the 80486, to the Pentium 

I, to the Pentium II, to the Pentium III, and hence to the Pentium 4. Intel makes all of 

these microprocessors, and all of them are improvements on the basic design of the 
8088. The Pentium 4 can execute any piece of code that ran on the original 8088, but it 

does it about 5,000 times faster 
 

PROCESSOR INSTRUCTION SETS 
 

The job of all processors is to execute instructions, which are the commands that make 

up the machine language that the processor understands. Most software programs are 

written in higher-level languages, but they must be translated into the processorôs 

machine language to enable the computer to run (execute) them. This is called 

compiling the program to machine language. 
 

Collectively, all of the various instructions that the processor can execute are 

called its instruction set. The instruction set determines what sort of software can run 

on the processor; in order for two processors to be compatible, they must (among other 

things) be able to execute the same instructions. 
 

Machine Language 
 

Computers represent instruction sets in a particular way, and this representation is 

what we call machine language. 



Machine language is a coding scheme which instructs the computer as to what to 

do. In the same way as we used different notations for representing numbers (2ôs 

complement, excess notation), we need a coding scheme which will allow us to 

represent each of our items in the instruction set in binary. We canôt just tell the 

machine ñadd together 2 and 4ò. It doesnôt understand our words. It also needs to be 

told where to fetch data from memory and where exactly to store the result. The 

machine uses strings of 1ôs and 0ôs. 
 

A typical machine language represents a certain instruction by way of a special 

code. These special codes used for representing instructions comprise of different 

sections (called fields), which describe different aspects of the instruction: 
 

 The first part of an instruction code is called the operation code (op-code for short). 

This indicates which operation is to be performed (e.g. addition, retrieval of a data 

item from memory etc.) 
 
 The second part is called the operand field. This part of the code fills in the details 

which are needed before the operation specified in (1) can be performed. For 

example, if the op-code field specifies addition, the operand fields will tell the 

machine which memory addresses hold the pieces of data which are to be summed. 
 

So what do these op-code and operand fields look like? Well, they are simply bit 

patterns - strings of 0ôs and 1ôs. (Remember - the computer only understands binary). 
 

So a computer may well store an instruction as:  
 

Operation Address Address Address  
Code Field 1 Field 2 Field 3  
A Typical Machine Language Coding For An Instruction 

 

The operations which we represent in the op-code fall into three categories. 
 

 Data transfer 
 
 Arithmetic/Logic 
 
 Control (sometimes divided into two separate categories of compare and branch) 
 

The Data Transfer group concern operations, which cause some movement of data 

from one location to another. This could be loading the contents of a memory cell in 

RAM into a register on the CPU; or it could be storing the results of an operation from 

a CPU register back into a RAM memory cell. 
 

The Arithmetic/Logic operations involve the usual mathematical type of operation 

such as addition, but also includes logical operations such as ñis X greater than Y?ò or 

ñis A equal to B?ò The condition codes are special registers which are used for storing 

the results of these logical operations and can be set to ñ1ò if the result of the logical 



operation is true, or ñ0ò if the result is false. 
 

The Control Operations are those, which somehow affect the execution of a program. 

Usually, this means that a logical operation is performed, and then, depending upon the 

results of that operation, the program execution follows one ñpathò or another. In other 

words, if X > Y then execute this set of instructions, otherwise execute this other group of 

instructions (The ñjumpò and ñhaltò instructions). 



Instruction Set 
 

It is a set of commands that a certain CPU understands. These are very basic 

instructions that are used into the logic of the CPU. 
 
 
 
 
 
 
 

 

PROCESSOR STRUCTURE 
 

Before we look at basic processor structure, we need to briefly touch on two concepts: 
 

von Neumann machines and pipelined, clocked logic systems. 
 

von Neumann Machines 
 

In the early 1950s, John von Neumann proposed the concept of a stored program 

computer - an architecture which has become the foundation for most commercial 

processors used today. In a von Neumann machine, the program and the data occupy 

the same memory. The machine has a Program Counter (PC) which points to the 

current instruction in memory. The PC is updated on every instruction. When there are 

no branches, program instructions are fetched from sequential memory locations. (A 

branch simply updates the PC to some other location in the program memory.) Except 

for a handful of research machines and a very small collection of commercial devices, 

all of todayôs commercial processors work on this simple principle. 
 

Basic Processor Structure 
 

Here we will consider the basic structure of a simple processor. We will examine the 

flow of data through such a simple processor and identify bottlenecks in order to 

understand what has guided the design of more complex processors. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Here we see a very simple processor structure - such as might be found in a small 



8-bit microprocessor. The various components are: 
 

Arithmetic Logic Unit (ALU)  
 

Arithmetic Logic Unit - this circuit takes two operands on the inputs (labelled A and 

B) and produces a result on the output (labelled Y). The operations will usually 

include, at a minimum: 
 
 ̧

 

 ̧

 

 ̧

 

Add, subtract 
 

And, or, not 
 

Shift right, shift left 
 

ALUs in more complex processors will execute many more instructions. 
 

Register File 
 

A set of storage locations (registers) for storing temporary results. Early machines had 

just one register - usually termed an accumulator. Modern RISC processors will have 

at least 32 registers. 
 

Instruction Register 
 

The instruction currently being executed by the processor is stored here. 
 

Control Unit  
 

The control unit decodes the instruction in the instruction register and sets signals 

which control the operation of most other units of the processor. For example, the 

operation code (op-code) in the instruction will be used to determine the settings of 

control signals for the ALU, which determine which operation (+, -, ^, v, ~, shift, etc) 

it performs. 
 

Clock 
 

The vast majority of processors are synchronous, that is, they use a clock signal to 

determine when to capture the next data word and perform an operation on it. In a 

globally synchronous processor, a common clock needs to be routed (connected) to 

every unit in the processor. 
 

Program Counter 
 

The program counter holds the memory address of the next instruction to be executed. It 

is updated every instruction cycle so as to point to the next instruction in the program. 

(Control for the management of branch instructions - which change the program counter 

by other than a simple increment - has been omitted from this diagram for clarity. 



Branching instructions and their effect on program execution and efficiency will be 

examined extensively later). 
 

Memory Address Register 
 

This register is loaded with the address of the next data word to be fetched from or 

stored into main memory. 
 

Address Bus 
 

This bus is used to transfer addresses to memory and memory-mapped peripherals. It 

is driven by the processor acting as a bus master. 
 

Data Bus 
 

This bus carries data to and from the processor, memory and peripherals. It will be 

driven by the source of data, ie the processor, memory or peripheral device. 
 

Multiplexed Bus 
 

Of necessity, high performance processors provide separate address and data buses. To 

limit device pin counts and bus complexity, some simple processors multiplex address 

and data onto the same bus: naturally this has an adverse affect on performance. 
 

EXECUTING INSTRUCTIONS  
 

Letôs examine the steps in the execution of a simple memory fetch instruction, eg 
 

101c16: lw $1,0($2) In  this,  and  most  following,  examples,  we'll  use  the  MIPS 
This instruction tells the  processor instruction set. 

to  take   the   address   stored in This is chosen because 
register 2, add 0 to it and load the · it's simple, 

word found at that address in main · it exists in one widely available range of machines 

memory into register 1.  produced by SGI and 
  

 · there is a public domain simulator for MIPS machines, 

  which we will use for some performance studies. 

As   the   next  instruction  to be For convenience, most numbers - especially memory addresses 

executed (our lw instruction) is at and instruction  contents  -  will be  expressed  in  hexadecimal. 

memory   address   101c16, the When orders of magnitude and performance are being discussed, 

program counter contains 101c. decimal numbers will be used: this will generally be obvious from  

the context and the use of exponent notations, eg 5 x 10
12

. 



Execution Steps 
 

 The control unit sets the multiplexor to drive the PC onto the address bus. 
 

 The memory unit responds by placing 8c41000016 - the lw $1,0($2) instruction as 
 

encoded for an MIPS processor - on the data bus from where it is latched into the 

instruction register. 
 

3. The control unit decodes the instruction, recognises it as a memory load 

instruction, and directs the register file to drive the contents of register 2 onto the 

A input of the ALU and the value 0 onto the B input. At the same time, it instructs 

the ALU to add its inputs. 
 

 The output from the ALU is latched into the MAR. The controller ensures that this 

value is directed onto the address bus by setting the multiplexor.  
 When the memory responds with the value sought, it is captured on the internal 

data bus and latched into register 1 of the register file. 
 
 The program counter is now updated to point to the next instruction and the cycle 

can start again. 
 

As another example, let's assume the next instruction is an add instruction:  
 
 
 

 The control unit sets the multiplexor to drive the PC onto the address bus. 
 

2. The memory unit responds by placing 00232020 - the encoded add $1,$3,$4 
16 

instruction - on the data bus from where it is latched into the instruction register. 
 

 The control unit decodes the instruction, recognises it as an arithmetic instruction 

and directs the register file to drive the contents of register 1 onto the A input of 

the ALU and the contents of register 3 onto the B input. At the same time, it 

instructs the ALU to add its inputs. 
 
 The output from the ALU is latched into the register file at register address 4. 
 
 The program counter is now updated to point to the next instruction. 
 

MULTIPROGRAMMING  
 

Multiprogramming is a rudimentary form of parallel processing in which several 

programs are run at the same time on a single processor. Since there is only one 

processor, there can be no true simultaneous execution of different programs. Instead, 

the operating system executes part of one program, then part of another, and so on. To 



the user it appears that all programs are being executed at the same time. 
 

If the machine has the capability of causing an interrupt after a specified time 

interval, then the operating system will execute each program for a given length of 

time, regain control, and then execute another program for a given length of time, and 

so on. In the absence of this mechanism, the operating system has no choice but to 

begin to execute a program with the expectation, but not the certainty, that the 

program will eventually return control to the operating system. 
 

If the machine has the capability of protecting memory, then a bug in one program 

is less likely to interfere with the execution of other programs. In a system without 

memory protection, one program can change the contents of storage assigned to other 

programs or even the storage assigned to the operating system. The resulting system 

crashes are not only disruptive, they may be very difficult to debug since it may not be 

obvious which of several programs is at fault. 
 

Virtual Memory  
 

Virtual memory is a common part of most operating systems on desktop computers. It 

has become so common because it provides a big benefit to users at a very low cost. 
 

Most computers today have something like 32 or 64 megabytes of RAM available 

for the CPU to use. Unfortunately, that amount of RAM is not enough to run all of the 

programs that most users expect to run at once. 
 

For example, if you load the operating system, an e-mail program, a Web browser 

and a word processor into RAM simultaneously, 32 megabytes is not enough to hold it 

all. If there were no such thing as virtual memory, then once you filled up the available 

RAM your computer would have to say, ñSorry, you can not load any more applications. 

Please close another application to load a new one.ò With virtual memory, what the 

computer can do is look at RAM for areas that have not been used recently and copy 

them onto the hard disk. This frees up space in RAM to load the new application. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Because this copying happens automatically, you donôt even know it is happening, 

and it makes your computer seem like is has unlimited RAM space even though it only 



has 32 megabytes installed. Because hard disk space is so much cheaper than RAM 

chips, it also has a nice economic benefit. 
 

Speed Concerns 
 

The read/write speed of a hard drive is much slower than that of RAM, and the 

technology of a hard drive is not geared toward accessing small pieces of data at a 

time. If your system has to rely too heavily on virtual memory, you will notice a 

significant performance drop. The key is to have enough RAM to handle everything 

you tend to work on simultaneously ð then, the only time you ñfeelò the slowness of 

virtual memory is when thereôs a slight pause when youôre changing tasks. When 

thatôs the case, virtual memory is perfect. When this is not the case, the operating 

system has to constantly swap information back and forth between RAM and the hard 

disk. This is called thrashing, and it can make your computer feel incredibly slow. 
 

The area of the hard disk that stores the RAM image is called a page file. It holds 

pages of RAM on the hard disk, and the operating system moves data back and forth 

between the page file and RAM. On a Windows machine, page files have a .SWP 

extension 
 

Configuring Virtual Memory  
 

Take Windows 98 as an example of a typical operating system that has virtual 

memory. Windows 98 has an intelligent virtual memory manager that uses a default 

setting to help Windows allocate hard drive space for virtual memory as needed. For 

most circumstances, this should meet your needs. But you may want to manually 

configure virtual memory, especially if you have more than one physical hard drive or 

speed-critical applications. 
 

To do this, open the ñControl Panelò window and double-click on the ñSystemò 

icon. The system dialog window will open. Click on the ñPerformanceò tab and then 

click on the ñVirtual Memoryò button. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click on the option that says, ñLet me specify my own virtual memory settings.ò 

This will make the options below that statement become active. Click on the drop-

down list beside ñHard disk:ò to select the hard drive that you wish to configure virtual 

memory for. Remember that a good rule of thumb is to equally split virtual memory 

between the physical hard disks you have. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

In the ñMinimum:ò box, enter the smallest amount of hard drive space you wish to 

use for virtual memory on the hard disk specified. The amounts are in megabytes. For 

the ñC:ò drive, the minimum should be 2 megabytes. The ñMaximum:ò figure can be 

anything you like, but one possible upper limit is twice the physical RAM space. 

Windows default is normally 12 megabytes above the amount of physical RAM in 

your computer. To put the new settings into effect, close the dialog box and restart 

your computer. 
 

Memory Allocation 



The amount of hard drive space you allocate for virtual memory is important. If you 

allocate too little, you will get ñOut of Memoryò errors. If you find that you need to 

keep increasing the size of the virtual memory, you probably are also finding that your 

system is sluggish and accesses the hard drive constantly. In that case, you should 

consider buying more RAM to keep the ratio between RAM and virtual memory about 

2:1. Some applications enjoy having lots of virtual memory space but do not access it 

very much. In that case, large paging files work well. 
 

One trick that can improve the performance of virtual memory (especially when 

large amounts of virtual memory are needed) is to make the minimum and maximum 

sizes of the virtual memory file identical. This forces the operating system to allocate 

the entire paging file when you start the machine. That keeps the paging file from 

having to grow while programs are running, which improves performance. Many 

video applications recommend this technique to avoid pauses while reading or writing 

video information between hard disk and tape. 
 

Another factor in the performance of virtual memory is the location of the page 

file. If your system has multiple physical hard drives (not multiple drive letters, but 

actual drives), you can spread the work among them by making smaller page files on 

each drive. This simple modification will significantly speed up any system that makes 

heavy use of virtual memory. 
 

REVISION EXERCISES 
 

 Virtual memory provides: 
 

 Automatic storage allocation 
 

 Protection 
 

 Shareability 
 

 All the above 
 
 On a 32-bit machine, what is the maximum size of the virtual address space? 
 

 4 Megabytes 
 

 2 Kilobytes 
 

 4 Gigabytes 
 

 All the above 
 

3. What is the significance of interrupts? 
 

4. Write a machine language program to add 3 numbers and output the required 

answer. 



5. What is the main task of a processor? How does it manage the mathematical 

computations? 
 

6. The Control Unit 
 

 Performs the arithmetic operations 
 

 Manages and co-ordinates the entire computer system 
 

 Executes the logic operations 
 

 Performs the actual processing on the data 
 

7. What are the advantages and disadvantages of developing a software package 

using a high-level language, an assembly language and machine language? 
 

Answers 
 

1. d 2. c 



Chapter 6: BINARY ARITHMETIC  
 

INTRODUCTION  
 

All the arithmetic operations (addition, subtraction, multiplication and division etc.) in 

binary system are performed in the same way as in decimal number system. The four 

arithmetic operations are described as below. 
 

BINARY ADDITION  
 

Rules for carrying out binary additions are: 
 

0+0=0 
 

0+1=1 
 

1+0=1 
 

1 + 1 = 0 with one 1 carry over. 
 

Here are a few examples. 
 

1. Add (101110) and (111101) 
2 2  

 
 
 
 
 
 
 

 

One can verify that (1101011) in binary system is equivalent to 107 in the 
2 

 decimal system.  

2. Add 100000 and 1011 
 2 2  
 
 
 
 
 
 
 

 

The binary equivalent of 43 in the decimal system is 101011. 
 

3. Add 101110 and 111101 



 
 
 
 
 

 

BINARY SUBTRACTION  
 

Rules for carrying out binary subtractions are: 
 

 0-0=0 
 
 0 - 1 = 1 with one borrow 
 
 1-0=1 
 
 1-1=0 
 

Here are a few examples. 
 

1. Subtracting 101110 from 111101 
2 2  

 
 
 
 
 
 
 

 

Thus 001111 in binary system is equivalent to 15 in the decimal system. 
 

2. Subtracting 1011 from 100000  
 
 
 
 
 
 
 

 

The binary equivalent of 21 in the decimal system is 10101. 
 

3. Subtracting 11 from 1001  
 
 
 
 
 
 
 
 
 
 

SIGNED NUMBERS 
 

To represent signed numbers as sequences of bits, the place-value notation used for 



unsigned numbers must be extended to indicate whether a number is positive or 

negative. There are two schemes for doing this ï sign ï magnitude representations and 

2ôs complement notation. 
 

Sign-magnitude Representation 
 

In sign-magnitude representations, the sign bit (also known as the high bit) of a binary 

number indicates whether the number is positive or negative, and the remainder of the 

number indicates the absolute value (or magnitude) of the number, using the same 

format as unsigned binary representation. N-bit sign-magnitude numbers can represent 

quantities from ï(2
(N ï 1)

 ï 1) to +(2
(N ï 1)

 ï 1). There are two representations of 0 in 

sign-magnitude notation: +0 and ï0. +0 has a value of 0 in the magnitude field and a 

positive sign bit. ï0 has a value of 0 in the magnitude field and a negative sign bit. 
 

Consider the following example. 
 

The 16-bit unsigned binary representation of 168 is 0000 0000 1010 1000. In a 16-

bit sign-magnitude system, -168 would be represented as 1000 0000 1010 1000. Here, 

the left most bit of the number is the sign bit and the rest of the number gives the 

magnitude. 
 

Sign-magnitude representations have the advantage that the negative of a number can 

very easily be taken by simply inverting the sign bit. Determining whether a number is 

positive or negative is also easy, as it only requires examining the sign bit. Sign-

magnitude representation makes it easy to perform multiplication and division on signed 

numbers, but hard to perform addition and subtraction. For multiplication and division, 

the hardware can simply perform unsigned operations on the magnitude portion of the 

inputs and examine the sign bits of the inputs to determine the sign bit of the result. 
 

Consider the following example of multiplying the numbers +6 and ï8, using 6-bit 

sign-magnitude integers. 
 

Binary representation of +6 = 000110 
 

Binary representation of -8 = 101000 
 

To multiply these numbers, their magnitude portions are multiplied as unsigned 

integers, giving 0110000(48). Then the sign bits of the numbers are examined, 

multiplied and thereby determined that one of them is negative. Therefore, the result 

of the multiplication must be negative, giving 1110000(-48). 
 

Addition and subtraction of sign-magnitude numbers require relatively complex 

hardware, because adding (or subtracting) the binary representation of a positive 

number and the binary representation of a negative number does not give the correct 

result. The hardware must take the value of the sign bit into account when computing 



each bit of the output, and different hardware is required to perform addition and 

subtraction. This hardware complexity is the reason why very few current systems use 

sign-magnitude notation for integers. 
 

Consider the following example of addition of +7 and ï2 using 8-bit sign-

magnitude representation. 
 

8-bit sign-magnitude representations of +7 = 00000111 
 

8-bit sign-magnitude representations of -2 = 10000010 
 

Addition = 10001001 
 

Adding these numbers, sign-magnitude systems interpret it as ï17 instead of 5 

(which is the correct result). 
 

2's Complement Notation 
 

In 2ôs complement notation, a negative number is represented by inverting each bit of 

the unsigned representation of the number and adding 1 to the result, discarding any 

overflow bits that do not fit in the width of the representation. The name twoôs 

complement comes from the fact that the unsigned sum of an n-bit 2ôs complement 

number and its negative is 2
n
. 

 

Hence, 2ôs complement can be formed by leaving all least significant 0ôs and the 

first 1 unchanged and then replacing 1ôs by 0ôs and 0ôs by 1ôs in all other higher 

significant bits. The 2ôs complement of 1001100 is 0110100. 
 

Example 
 

What is the 8-bit 2ôs complement representation of ï7 and what is the unsigned 

result of adding the representations of +7 and ï7? 
 

Solution 
 

8-bit sign-magnitude representation of +7 = 00000111 
 

Hence, 
 

8-bit negation of each bit of +7 = 

11111000 (known as 1ôs complement) 
 
 
 
 

 

Thus, the 2ôs complement representation of +7 is 11111001. 
 

Now adding +7 and ï7 



00000111 + 11111001 = 100000000 = 0 with 1 overflow bit. 

 

Example 
 

Add +5 and ï4 with the help of 2ôs complement. 

 

Solution    

4-bit binary notation of +5  = 0101 

4-bit binary notation of -4  = 1100 

2ôs complement notation of +5 = 1011 

2ôs complement notation of -4 = 0100 

Addition 1111   
 

1111 is 2ôs complement notation of ï1. 
 

Example 
 

Compute ï5 ï4 in 4 bit 2ôs-complement notation. 
 

Solution    

-5 ï4 = -5 + (-4).    

2ôs complement notation of -5 = 0011 

2ôs complement notation of -4 = 0100 

Addition 0111   
 

0111 is 2ôs complement notation of ï9. 
 

BINARY MULTIPLICATION  
 

The rules for this multiplication are: 
 

0 x 0 = 0 
 

0 x 1 = 0 
 

1 x 1 = 1 
 

Here are a few examples: 
 

Multiply 111101 by 1110 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Multiply 110 by 010 
 

Binary  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

BINARY DIVISION  
 

The rules for division are same in the binary system as those in the decimal number 

system. 
 

Example 
 

Divide 100100 by 110 
 

Solution  
 
 
 
 
 
 
 
 
 

This is the same as the division of the decimal number 36 by 6. Here, the quotient 

is 0110 and the remainder is 000. 
 

Example 



Divide 110111 by 1011 

 

Solution  
 
 
 
 
 
 
 
 
 
 

 

The quotient is 101 and the remainder is 000. 
 

REVISION EXE RCISES 
 

 Add the following binary numbers: 
 

 101 & 110 
 

 1001.1 & 1100.1 
 

 110.1101 & 100.1010 
 

 1000111 & 0010110 
 

 Subtract (10001)  from (100101) 
2 2  

 Subtract (10110)  from (110011) 
2 2 

 

 Add the following binary numbers: 
 

 10001 & 11101 
 

 101101 & 11001 
 

 1011001 & 111010 
 

 1110 & 1111 
 
 Solve the following: 
 

 1011011 - 10010 
 

 1010110 - 101010 
 

 1000101 - 101100 
 

 100010110 - 1111010 
 

 101001 ´ 110 
 

 10111 ´ 11 



 101010 ¸ 110 
 

 10000111 ¸ 101 
 

Answers    

1. (a) 1011 (b) 10110 

 (c) 1011.0111 (d) 1011101 

2. 10100    

3. 11101    

4. (a) 101110 (b) 1000110 

 (c) 10010011 (d) 11101 

5. (a) 1001001 (b) 101100 

 (c) 011001 (d) 10011100 

 (e) 11110110 (f) 01000101 

 (g) 111 (h) 11011 



Chapter 7: THE BASIC COMPUTER  
 

ARCHITECTURE  
 

THE BASIC COMPUTER ARCHITECTURE  
 

This chapter deals with providing an overview the internal components of digital 

computers. 
 

COMPONENTS OF A DIGITAL COMPUTER  
 

A digital computer can be broadly classified as a collection of four components. They 

are :- 
 

 Input unit 
 
 Output unit 
 
 Central Processing Unit 
 
 Memory (auxiliary) 
 

A block diagram representation of the above is shown in the figure:  
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 7.1: Basic Components of a digital computer 
 

The Input Unit  
 

The Input Unit provides an interface between the users and the machine, for inputting 

data and instruction etc. One of the most common examples is the keyboard. Data can 

be input in many more forms ï audio, visual, graphical etc. 
 

Some common input devices are listed below: 
 

 Keyboard 
 
 Mouse 
 
 Voice data entry 
 
 Joy stick 



 Light pen 
 
 Scanner 
 
 Secondary storage devices such as floppy disks, magnetic tapes etc. 
 

The data in any form is first digitized, i.e., converted into binary form, by the input 

device before being fed to the Central Processing unit (CPU). 
 

The Output Unit  
 

Like the Input Unit, the Output Unit also provides an interface between the user and 

the machine. A common example is the visual display unit (monitor) of a personal 

computer. The output unit receives the data from the CPU in the form of binary bits. 

This is then converted into a desired form (graphical, audio, visual etc.) 

understandable by the user. 
 

Some common output devices are: 
 

 Visual Display Unit (Monitor) 
 
 Printers 
 
 Speakers 
 
 Secondary Storage Devices 
 

The input and output unit collectively are referred to as óperipheralsô. 
 

The input and output units shall be discussed in more detail in the next chapter. 
 

The Central Processing Unit 
 

The central processing unit is the brain of the computer system. The input and output 

devices may vary for different applications, but there is only one CPU for a particular 

computer. The specifications of a computer are basically characterized by its Central 

Processing Unit. 
 

The central processing unit can be further divided into: 
 

 The Arithmetic Logic Unit (ALU) 
 
 The Control Unit 
 
 Main Memory 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 7.2: The Central Processing Unit 
 

The arrows in the above Figures may represent data as well as control information 

flow. 
 

The CPU processes the data it receives as input (either through input devices or 

through the memory). As mentioned earlier the CPU receives the data in the form of 

binary bits, which it can understand. 
 

The CPU performs many tasks, some of which are listed below: 
 

 The CPU can perform arithmetic calculations such as addition, subtraction etc. 
 
 The CPU can perform logical decisions. 
 
 The CPU with the help of other devices can perform data transmission. 
 
 The CPU can perform manipulating tasks such as word processing. 
 
 After performing the required task the CPU may place results in memory or send 

results to the output device according to the instruction given to it. 
 
 The CPU with the help of its control unit generates timing signals (also known as 

enable signals) which provide synchronization between the different devices and 

the CPU. 
 

As mentioned earlier, the central processing unit consists of: 
 

 The Arithmetic Logic Unit (ALU) 
 
 The Control Unit 
 
 The Main Memory unit 



The Arithmetic Logic Unit (ALU) 
 

As the name may indicate the arithmetic logic unit performs all arithmetic and logic 

calculations on the data it receives. 
 

Arithmetic Calculations 
 

The arithmetic calculations may be addition, subtraction, multiplication, division, 

exponentiation etc. 
 

Logical Calculation 
 

Logical calculations are basically decision making statements for example, A>B, 

decides whether is A is greater than B or not; If A is greater than B the statement is 

true and logical ó1ô would be generated, otherwise a logical ó0ô would be generated. 

Some logical decisions decide the further routing of the program. This will be further 

explained by the figure : -  
 
 
 
 
 
 
 
 
 

Figure 7.3: Part of a Flow Chart 
 

In the above Figure the decision box has split the flow chart into two. 
 

The functioning of the arithmetic logic unit would be better understood when we 

discuss the óaccumulatorô. 
 

The Control Unit 
 

The control unit controls the entire operations of the computer and the CPU. It controls 

all the other devices connected the CPU, i.e. Input devices, Output devices, Auxiliary 

Memory etc. Hence, the control unit acts as the nerve centre of the computer. 
 

The control unit upon receiving an instruction decides what is to be done with it. 

That is, whether it is to be sent to the ALU for further processing or to the output 

devices or to the memory etc. In other words the control unit coordinates and controls 

all hardware operations. 
 

The control unit has an electronic clock that transmits electronic pulses at equal 

intervals of time. The control unit gives instructions to other devices based upon these 

pulses. Suppose there are three instructions to be performed. Let the first instruction 

take three clock pulses to complete; when the fourth clock pulse is received the control 



unit would start processing the second instruction and so on. Suppose an instruction 

takes three and a half clock pulses to complete. In such a case the control unit could 

wait for the fourth clock pulse to complete and take up the next instruction with the 

fifth clock pulse. 
 

The clock pulse basically provides synchronization between the different parts of 

the computer. The control unit generates millions of clock pulses per second. The 

speed at which an instruction is executed depends upon the clock speed which is in 

MHZ (10
6
HZ). 

 

The Main Memory Unit 
 

The main memory also known as the primary memory is a part of the central 

processing unit and is a combination of both RAM (random access memory) and 

ROM (read only memory). We shall discuss the RAM and the ROM later but for now 

we shall define them as follows: - 
 

RAM 
 

The random access memory is a read write memory i.e. information can be read as 

well as written into this type of memory. It is volatile in nature, i.e., the information it 

contains is lost as soon as the system is shut down unless 'saved' for further usage by 

users. It is basically used to store programs and data during the computerôs operation. 
 

ROM 
 

The read only memory as the name may suggest contains information that can only be 

read, i.e., you canôt write on this type of memory. It is non-volatile or permanent in 

nature. It is basically used to store permanent programs such as program for the 

functioning of the monitor. 
 

The main memory is a fast-memory, i.e., it has small access time. It is because of its 

limited capacity that it is fast. The main memory contains the programs that are currently 

being worked on. It passes on this information to the control unit as and when required. 

In case the CPU wants to access some data that is present in a secondary storage device, 

this data is first transferred to the main memory and then processed. 
 

The main memory is much more costly than the secondary storage devices. 

Although the ROM ICôs of various computers do not vary much in their capacities, the 

RAM chips are available in wide ranges of storage capacities. In fact, the capacity of 

the random access memory is an important specification of a computer. 
 

A larger RAM means larger programs (in terms of memory) can be loaded and 

executed. Suppose you want to run a 68-KB program on a machine with 64-KB. This 

means that the whole program can not be loaded into the main memory at once resulting 



in either the non-execution of the program or a very slow execution. 
 

A 64-K memory means that there are approximately 64000 (65,536 to be precise) 

storage locations which can store 1 bit of data each. 
 

Different memories can be classified on the basis of there concepts: 
 

 Access Mode: which means how easily they are accessible. 
 
 Access Time: the average time required to reach a storage location and obtain its 

content is called access time.  
 Transfer Rate: the transfer rate is the number of characters or words that a device can 

transfer per second after it has been positioned at the beginning of the record. 
 
 Capacity and Cost: the capacity and cost may depend upon the requirement and the 

budget. 
 

The main memory has a very low access time and a very high transfer rate. It is 

limited in capacity and costlier than secondary storage devices. 
 

The Cache Memory 
 

Another important concept is that of the cache memory, which is also a part of the CPU. 
 

The cache memory lies in the path between the processor and the main memory. 

The cache memory therefore, has lesser access time than the main memory and is 

faster than the main memory. A cache memory may have an access time of 100ns, 

while the main memory may have an access time of 700ns. 
 

The cache memory is very expensive and hence is limited in capacity. Earlier 

cache memories were available separately but the latest microprocessors contain the 

cache memory on the chip itself. 
 

The need for the cache memory is due to the mismatch between the speeds of the 

main memory and the CPU. The CPU clock is very fast, whereas the main memory 

access time is comparatively slower. Hence, no matter how fast the processor is, the 

processing speed depends more on the speed of the main memory (the strength of a 

chain is the strength of its weakest link). It is because of this reason that a cache 

memory having access time closer to the processor speed is introduced. 
 

The cache memory stores the program (or its part) currently being executed or 

which may be executed within a short period of time. The cache memory also stores 

temporary data that the CPU may frequently require for manipulation. 



 
 
 
 
 
 
 
 
 
 
 

Figure 7.4: Cache Memory 
 

The cache memory works according to various algorithms, which decide what 

information it has to store. These algorithms work out the probability to decide which 

data would be most frequently needed. This probability is worked out on the basis of 

past observations. 
 

We shall discuss the ómemoryô later when we discuss the auxiliary memory. 
 

Functioning of the Arithmetic Logic Unit 
 

Register 
 

A register is a combination of memory storage locations called flip-flops. Each flip-

flop is capable of storing one bit of information. An n-bit register contains ónô flip-

flops and is capable of storing ónô bits of information. 
 
 
 
 

 

Figure 7.5: n-bit Register 
 

Accumulator 
 

The accumulator is a register that is present within the arithmetic logic-unit. The 

accumulator stores data, which is either the result of an operation, or which is to be 

processed through arithmetic and logical operations. 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 7.6: The Detailed A.L.U. 
 

Memory Data Register 



The memory data register like the accumulator is used to store data. This register holds 

all data and instructions temporarily as they pass in or out of the main memory. 
 

Memory Address Register 
 

The memory address register contains the address of the memory location (in main 

memory) whose data is to be transferred into the memory data register. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 7.7: Functioning of the MDR & MAR 
 

In the Figure, the memory address register (MAR) contains the address of the third 

memory location, the data of which is transferred to the memory data register (MDR). 
 

We shall try to explain the functioning of the ALU with the help of an example. 
 

Suppose two numbers are to be subtracted. The following steps are involved: 
 

 Let the first instruction cause the number 13 to be placed in the accumulator. When 

the control unit receives this instruction it decodes it and performs the controlling 

and coordination function by sending the number to the accumulator. A special 

purpose register that holds the instruction currently being processed by the control 

unit is called the Current Instruction Register (CIR).  
 The second instruction asks the control unit to send the address of the second 

number stored in the main memory to the MAR. 
 
 The control unit then causes the contents of that specific address of the main 

memory to be copied to the MDR.  
 Once the numerical data has been passed on to the MDR, the control unit signals 

the ALU to perform the SUBTRACT Operation which causes the number in the 

MDR to be subtracted from the number in the accumulator. 
 

Functioning of the Control Unit 



The control unit as said earlier is the nerve centre of the computer. Every instruction 

before being executed is first interpreted by the control unit. The sequence of 

operations involved in processing an instruction is known as the instruction cycle. The 

instruction cycle can be divided into two parts: 
 

 Fetch cycle 
 
 Execution cycle 
 

Fetch Cycle 
 

The control unit fetches the instruction from the memory data register and places it in 

the current instruction register. 
 

Execution Cycle 
 

The control unit then decodes this instruction in the current instruction register and sends 

the appropriate signal to the concerned device for the execution of the instruction. 
 

The flowchart in the figure describes the functioning of the control unit.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 7.8: Functioning of Control Unit 
 

Let us now turn our attention back to the memory devices. 



Memory 
 

Auxiliary Storage Memory 
 

The auxiliary storage memory, also known as the secondary memory is an external (to 

the CPU) memory. The auxiliary storage devices store system programs, large data 

files, assemblers, compilers and other programs. In other worlds the auxiliary storage 

devices are used for bulk storage of data. The storage capacity of these devices is 

unlimited as an empty device can replace them once the existing device is completely 

filled. Even the individual storage devices, such as the magnetic tape have more 

capacity than the main memory. 
 

The secondary memory is permanent in nature, i.e., the information stored in these 

devices is not lost unless specifically deleted. Secondary storage devices being 

permanent in nature can also be used for transportation of data from one computer to 

another. 
 

Secondary storage devices are cheaper as compared to the main memory. The 

information stored in the secondary memory are first transferred to the main memory and 

then processed by the CPU. The final result may then be placed in the secondary 

memory. It is because of this that the access time of the secondary memory is 

comparatively high. Hence, the data stored in secondary storage devices take more time 

to process than the data already present in the main memory. In fact the access time for 

data stored in secondary memory is one thousand times the data stored in main memory. 
 

Secondary memories may also be considered as input and output devices as they 

provide the information as input and store the final results in the output. 
 

The secondary storage devices would be discussed in detail in a later chapter. 
 

Memory Hierarchy  
 
 
 
 
 
 
 
 

 

Figure 7.9: Block Diagram Illustrating the Memory Hierarchy  
 

The Figure above is self -explanatory. 
 

Types of Memory 
 

Although various types of memory have been discussed in the previous sections the 

block diagram given below acts as a good visual aid for memorizing. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 7.10: Types of Memory 
 

As promised earlier we shall now discuss the random access memory (RAM) and 

read only memory (ROM) in detail. 
 

Random Access Memory (RAM) 
 

The RAM as mentioned earlier is volatile in nature. It retains the stored information as 

long as the power supply is on. Its contents are lost when the power supply is switched 

off. The power requirement of the random access memory chips is comparable to that 

of the microprocessor itself. It is also partially due to this reason, that the RAM is very 

fast. 
 

RAM is of two types: 
 

 Dynamic RAM (DRAM)  
 
 Static RAM (SRAM) 
 

We shall discuss each of these in detail: 
 

Dynamic RAM (DRAM): The dynamic RAM chips contain a transistor that acts 

as a gate to a capacitor, which is capable of storing electric charge. The charge on the 

capacitor indicates a ó1ô bit and no charge indicates a ó0ô bit. The charge on the 

capacitor leaks away after a few milliseconds. Therefore, a dynamic RAM has to be 

refreshed periodically after every two milliseconds. A D-RAM uses its contents in a 

very short time even though the power supply is ON. A D-RAM consumes less power 

and has higher packing density. It is cheaper than the static RAM. 
 

Static RAM (S-RAM): Static RAMôs are also volatile in nature but they need no 



regenerator to retain the data. They retain the data as long as they receive the power. 

The static random access memory consumes more power and is more expensive. The 

static RAM chips are more complicated and hence require more space. Static RAMôs 

are faster than the dynamic RAMôs Static RAMôs have an access time of 

approximately 85 to 90ns while the dynamic RAMôs may take 150 to 200ns to provide 

information. Static RAMôs are recommended for medium sized memories while 

dynamic RAMôs are recommended for large sized memories. 
 

Read Only Memory (ROM) 
 

The read only memory (ROM) contains non-volatile or permanent information. As the 

name suggests the information contained in this type of memory can only be read; it 

can not be altered or overwritten. Information is entered into the ROM chip at the time 

of manufacturing. ROM chips are used for applications which require a permanent 

information, for example, a program for the functioning of the visual display unit, a 

program for controlling the working of a washing machine etc. 
 

With the advent of technology erasable ROMôs have become available. We shall 

discuss these and other ROMôs in the following section. 
 

Types of ROM: 
 

 Programmable Read Only Memory (PROM): A PROM program is used to record 

information in the PROM chip. Information once programmed into the PROM 

chip is permanent and can not be changed or erased. The process of entering the 

information into the PROM chip is known as ñburning the PROM.ò PROM chips 

are seldom used in modern day computers, but they still find their use in devices 

where a permanent ROM is required. 
 

 Masked Read Only Memory (MROM): In the masked ROM, the information is 

permanently recorded by the masking and metallization process. It is not easy to 

perform this process as a large infrastructure is required, 
 

and therefore, it is usually the manufacturers who perform this process. 
 

 Erasable Programmable Read Only Memory (EPROM): An EPROM is an erasable 

PROM. An EPROM can be (re) programmed using an EPROM programmer. 

Exposing it to high intensity ultraviolet light for 30 minutes (approximately) can 

erase the contents of an EPROM chip. An ultra-violet source with a wavelength of 

2537A (angstrom) is used for this purpose. The process of changing the contents is 

not convenient, as the chip has to be removed from the board for exposure to the 

ultra-violet light source. Another disadvantage is that the user canôt erase the 

contents of a single memory location and the entire memory contents have to be 

erased. The EPROM chip is cheap, reliable and widely 



available. 
 

 Electrically Erasable Programmable Read Only Memory (EEPROM): EEPROM is 

an electrically erasable PROM. Using electrical signals can alter the information 

and that is why the chip need not be removed from the board. One major 

advantage that this chip has over the EPROM is that even single memory can be 

altered, i.e., the entire memory need not be erased and reprogrammed unless 

required. The change in the contents of the EEPROM chip is made in 

milliseconds, which is much less than the erasing time for EPROM. 
 

 Non-Volatile RAM: A non-volatile RAM combines a static RAM and EEPROM. 

Such a device operates as normal RAM but in case the power fails the entire 

contents of the RAM are stored in EEPROM. When the power is restored, the data 

from EEPROM is transferred back to the RAM. 
 

Now that you have an idea of the computer's internal architecture we shall discuss 

the RISC & the CISC. 
 

REDUCED INSTRUCTION SET COMPUTER (RISC)  
 

An important aspect of computer architecture is the design of the instruction set for the 

processor. The instruction set chosen for a particular computer determines the way that 

machine language programs are constructed. Early computers had small and simple 

instruction sets, forced mainly by the need to minimize the hardware used to 

implement them. As digital hardware became cheaper with the advent of integrated 

circuits, computer instructions tended to increase both in number and complexity. 

Many computers have instruction sets that include more than hundred and sometimes 

even more than 200 instructions. These computers also employ a variety of data types 

and a large number of addressing modes. The trend for computer hardware complexity 

was influenced by various factors, such as upgrading existing models to provide more 

customer applications, adding instructions that facilitate the translation from high-

level language into machine language programs and striving to develop machines that 

move functions from software implementation into hardware implementation. A 

computer with a large number of instructions is classified as a Complex Instruction Set 

Computer, abbreviated CISC. 
 

In the early 1980s, a number of computer designers recommended that computers 

use fewer instructions with simple constructs so they can be executed much faster 

within the CPU without having to use memory as often. This type of computer is 

classified as a Reduced Instruction Set Computer or RISC. 
 

CISC Characteristics 
 

The design of an instruction set for a computer must take into consideration not only 



machine language constraints, but also the requirements imposed on the use of high-level 

programming languages. The translation from high-level to machine language programs 

is done by means of a compiler program. One reason for the trend to provide a complex 

instruction set is the desire to simplify the compilation and improve the overall computer 

performance. The task of a compiler is to generate a sequence of machine instructions for 

each high-level language statement. The task is simplified if there are machine 

instructions that implement the statements directly. The essential goal of a CISC 

architecture is to attempt to provide a single machine instruction for each statement that is 

written in a high-level language. Examples of CISC architectures are the Digital 

Equipment Corporation VAX computer and the IBM 370 computer. 
 

The major characteristics of CISC architecture are: 
 

 A large number of instructions-typically from 100 to 250 instructions 
 
 Some instructions that perform specialized tasks and are used infrequently 
 
 A large variety of addressing modes-typically from 5 to 20 different modes 
 
 Variable-length instruction formats 
 
 Instructions that manipulate operands in memory 
 

RISC Characteristics 
 

The concept of RISC architecture involves an attempt to reduce execution time by 

simplifying the instruction set of the computer. The major characteristics of a RISC 

processor are: 
 

 Relatively few instructions 
 
 Relatively few addressing modes 
 
 Memory access limited to load and store instructions 
 
 All operations done within the registers of the CPU 
 
 Fixed-length, easily decoded instruction format 
 
 Single-cycle instruction execution 
 
 Hardwired rather than microprogrammed control 
 

A characteristics of RISC processors is their ability to execute one instruction per 

clock cycle. This is done by overlapping the fetch, decode and execute phases of two or 

three instructions by using a procedure referred to as pipelining. A load or store 

instruction may require two clock cycles because access to memory takes more register 

operations. Efficient pipelining, as well as a few other characteristics, are sometimes 

attributed to RISC, although they may exist in non-RISC architectures as well. Other 



characteristics attributed to RISC architecture are: 
 

 A relatively large number of registers in the processor unit 
 
 Use of overlapped register windows to speed-up procedure call and return 
 
 Efficient instruction pipeline 
 
 Compiler support for efficient translation of high-level language programs into 

machine language programs 
 

REVISION EXERCISES 
 

 The joy stick is a part of which unit 
 

 Memory 
 

 Control Unit 
 

 Input Unit 
 

 Output Unit 
 
 Why are the input and output devices referred to as óperipheralsô. 
 
 What are the functions performed by the CPU? 
 
 In a database management system which memory would be best suited to store the 

data: 
 

i) ROM 
 

ii)  Non-volatile RAM 
 

iii)  EEPROM 
 

iv) Auxiliary Storage Memory. 
 

v) RAM 
 

 Write a short note on the functioning of the control unit? Explain how the clock 

pulse provides synchronization among the different parts of the computer?  
 Define óaccess timeô? Which of the following has the shortest access time. 
 

 Cache Memory 
 

 RAM 
 

 ROM Non-volatile RAM 
 

 Main Memory 
 
 Which of the following memories is the costliest. 



 Main Memory 
 

 Ram Chip 
 

 Cache Memory 
 

 Secondary Memory 
 
 How does the cache memory decide what data it has to store. 
 
 Explain the functioning of the memory data register and the memory address 

register? 
 
 What does the current instruction register store? 
 
 Distinguish between dynamic & static RAM? 
 

Fill in the blank  
 

The process of entering the information into the PROM chip is known as ððððð 
 

PROM. 



Chapter 8: SOFTWARE CONCEPTS 
 

INTRODUCTION  
 

Software is a general term, which is used to describe the instructions that are given to 

a computer. These instructions can be either a single program or a group of programs. 
 

TYPES OF SOFTWARE 
 

Software is generally classified into three specific categories in the computer world: 
 

 System software 
 
 Application software 
 
 Utility software. 
 

System software: This consists of all the programs, languages and documentation 

supplied by the manufacturer of the computer. This type of software is required to use 

the computer efficiently and conveniently. These programs allow the application 

developer to write and develop their own programs. 
 

Application software: These programs are developed by the user in order to 

perform some specific function for the organization. For example a payroll system to 

compute the salaries of the employees of an organization is termed as an application 

software. 
 

Utility software: Utility software may be considered as an application software or 

a system software which is very often used in the development of a program. 
 

PROGRAMMING LANGUAGES  
 

A programming language consists of words, symbols and usage rules pertaining to the 

grammar that permits people to communicate with the computer. Understanding of 

computer software is imperfect without a basic knowledge of programming languages. 

Programming languages allow the programmers and end-users to develop the 

programs that are executed by the computer. Many programming languages exist in 

the world today. Each one of the languages has its own unique vocabulary, grammar 

and usage. Some of these languages have been created to serve a special purpose (for 

example controlling a robot), while others are more flexible and general purpose, and 

are suitable for many types of applications. However, in general, programming 

languages must cater to the following tasks: 
 

- input/output 
 

- text manipulations/calculations 



- logic/comparison 
 

- storage/retrieval 
 

CLASSIFICATION OF PROGRAMMING  LANGUAGES 
 

Machine Languages 
 

Machine language is the lowest form of computer language. Programs were only 

written in binary based machine level language in the first generation computers. The 

computer understands this language only at its lowest level. 
 

An instruction prepared in machine language has two parts: 
 

 Op-code: This is the first part and is the command or operation which tells the 

computer what function to perform. 
 
 Operand: The second part of the instruction is the operand and it tells the computer 

where to find or store the data or instructions that are to be manipulated. The 

number of operands in an instruction varies from computer to computer. In a 

single operand machine, the binary equivalent of ñADD 0184ò could cause the 

value in a storage location 0184 to be added to a value stored in the arithmetic & 

logic unit. The single operand format is popular in the smallest microcomputers, 

whereas the two-operand structure is found in most other machines. 
 

The set of instructions in a machine level language can be divided into four 

categories: 
 

 Arithmetic- add, subtract, multiply and divide 
 
 Controlled- load, store, jump instructions 
 
 Input/output- Read and write 
 
 Direct use- Halt, start and end 
 

No arithmetic or comparison operations are done in the primary memory of the 

computer. Instead, it is done in the ALUôs special register called accumulator. Thus, if 

we need to add two numbers, we require one instruction which will order the control 

unit to place a number in the accumulator, and another instruction to identify the 

operation of addition. 
 

Let us assume that operation codes of 01 to 08 are given for doing 8 basic 

operations of a computer. They are as follows: 



 
 
 
 
 
 
 
 

 

If we write 05 40 then the computer will place the number in the accumulator that 

is found in address location 40. If now we wish to add a value 35, that has been stored 

in another location, then we have to write 01 35. It has to be noted, that the addition 

command is on the assumption that a number is already stored in the accumulator. 
 

The above example illustrates that in machine language, the programmer has to 

remember the codes of the instruction and supply the numeric addresses. In addition to 

the above, he has to keep track of the storage locations of the data and instructions. In 

machine language the initial coding often took months; it was expensive, prone to 

errors and error correction was a tedious process. 
 

Symbolic/Assembly Languages 
 

The above-explained process of writing programs was cumbersome. In order to reduce 

the burden, symbolic language, commonly known as assembly language was 

developed in the 1950ôs for second generation computers. 
 

This language permits the use of symbols or mnemonics, which are two or three 

letter abbreviations, for the function to be performed by the instruction. These are then 

translated by using a symbolic equivalence table. Assembly language has many of the 

same features to control registers etc. However, the disadvantage of using binary has 

been removed. The table below shows some of the mnemonic codes for IBM 

mainframes. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

As is evident, machine language is used by the computer. Therefore, the assembly 

language software translates the specified operation code into its machine language 

equivalent before the program can be executed. 



Here is an example of a symbolic language program and its converted machine 

code. 
 
 
 
 
 
 
 
 
 
 
 
 

 

Functions of Assembler 
 

 The Assembler translates the function code into its machine code equivalent. 
 
 It assigns absolute addresses to any symbolic address or label names.  
 It places each instruction in central memory. 
 
 It identifies indirect addresses from direct addresses, and sets the appropriate bit in 

the address portion of the instruction.  
 It checks the syntax of each instruction and generates error messages. 
 
 It provides, optionally, a cross reference table between all symbolic names and their 

absolute addresses. 
 
 It instructs the control unit to execute the program after all errors have been 

corrected. 
 

Advantages of Assembly Languages 
 

 They save time and reduce detail as compared to machine language. 
 
 Lesser number of errors are made, and also errors are easier to detect. 
 
 Assembly programs are easier to modify than machine language programs. 
 

Disadvantages of Assembly Languages 
 

 Writing a code is time-consuming. 
 
 Assembly languages are machine-dependent. 
 

High Level Languages 
 

The disadvantages of using assembly language brought about the development of higher 

level languages. Unlike the assembly programs, high level language programs may be 

used with different makes of computers with little modification. High level languages are 

easier to learn than symbolic languages; they require less time to write, are easier to 



maintain, provide better documentation, and 4 or 5 low-level instructions are reduced 

to a single high level statement. Some of the popular high level languages are given in 

the table below. 
 
 
 
 
 
 
 
 
 
 
 

 

Classification of High Level Languages 
 

High level languages are sometimes classified as 
 

 ̧

 

 ̧

 

 ̧

 

Procedure oriented languages 
 

Problem oriented languages, and 
 

Interactive programming languages 
 

Procedure Oriented Languages 
 

Procedure oriented languages provides easy to use features which allow the programer 

to write processing steps required for a particular application. Examples of procedure 

oriented languages are COBOL, FORTRAN, PL/1, etc. 
 

Problem Oriented Languages 
 

These languages attempt to solve processing requirements with minimal programming 

effort; thereby, allowing the user to concentrate on the desired results, rather than on 

the individual steps needed to get these results. A typical example of a problem 

oriented language is RPG. 
 

Interactive Programming Languages 
 

These languages have features which allow the user to interact with the program in a 

conversational fashion. A typical example is BASIC language. 
 

Fourth Generation Languages 
 

Computer people refer to the machine language era as the first generation, the symbolic 

codes one as the second generation, and the advent of the high level languages as the 

third generation. Successive generations of languages brought about an increase in the 

programmersô productivity. These generations of software have now been followed by 

the emergence of software vendors, offering a variety of application development tools, 



aimed at further productivity improvements. These tools are collectively known as 4
th

 

Generation Languages (4GLs). 
 

Essentially, a 4GL tool interacts with a DBMS (Database Management System) 

software to store, manipulate and retrieve the data required to satisfy user requirement. In 

contrast to a high level language, which is procedural, a 4GL is a non-procedural 

language, in the sense that it allows the user to simply specify what the output should be, 

without describing all the details of how data is to be manipulated to get the results. 
 

A clear-cut definition of a 4GL is not possible, because each tool or language is 

vendor specific. In general, however, we have the following classification: 
 

i) End user oriented 4GLs: These are designed for applications that process low data 

volumes and run on mainframes, and may be used by users or programmers. They 

have their own internal data base management software, which in turn interacts 

with the organizationôs DBMS. Non-computer professionals use these products to 

query databases and develop their own applications, and generate reports with 

minimum training. 
 

ii)  These tools are offered by the same suppliers who also supply the complex DBMS 

packages to the organization. These tools offer a larger set of commands than the 

end user 4GLs. They are also able to handle larger volumes of data and are 

generally used by programming specialists. These include query languages, 

application generators and report generators. 
 

The following chart depicts some of the major differences between higher level 

languages and 4GLs: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Object Oriented Languages 
 

Object Oriented Programming (OOPS) has been around since the 1960ôs. However, it 

was only in the eighties that object oriented languages became a major consideration 

in software development. This was due to the increasing emphasis of users on being 

provided with an easier way of doing their computing, in which he wanted all his 

needs to be fulfilled through windows, buttons and menus (all objects). 



The basic philosophy of object oriented languages is to encapsulate the data and 

procedures (methods) together into an object, so that the conventional method of 

separating the data from the procedures is eliminated, and the programmer need not keep 

track of what is happening to the data each time a program is run. Once objects are 

programmed, they are reusable. Languages like C, C++, JAVA are examples of object 

oriented languages and have become todayôs programming languages by choice. 
 

LANGUAGE TRANSLATOR PROGRAMS  
 

These are programs that translate programs written in other languages into a machine 

language instructions code, which the computer can execute. There is also a program 

that can help a programmer to write his program by providing creation and editing 

facilities. 
 

Translation programs are known by various names: 
 

 Assemblers: An assembler translates the symbolic instruction code of programs 

written in assembly language into machine code .  
 Interpreter: An interpreter translates and executes each program statement, one at a 

time, instead of producing a complete machine language program, like assemblers 

and compilers do. 
 

With an interpreter, the source program is not assembled into an object 

program. The results are computed immediately after an instruction has been 

translated. This process allows very efficient use of computer and programmer 

time during the debugging of the application. 
 

The interpreter need not be a software program which is loaded from 

external sources. It may be permanently residing in a ROM program. Microsoft 

BASIC interpreter uses such a program. Some of the Interpretive languages are 

BASIC, LISP, FORTH, APL etc. 
 

 Compilers: A compiler is a program which produces a machine level program from 

the specifications of a high level language, by generating one or more than one 

machine instruction for each high level instruction, i.e. it translates the higher level 

program into machine code. 
 

The compilation process has several phases: 
 

 Parsing: Parsing is the process of breaking down 
 

i) a statement grammatically, in terms of its functions, syntactic relations, etc., 

and whereby 
 

ii)  
 

the statements of the source language are examined and analyzed, 
 

whereafter 



 the data dictionary comprising of data descriptions is built, and subsequently, 
 

 a coded representation of the statements is created. 
 

v) a copy of the source program is printed, and 
 

 if necessary, appropriate diagnostic messages are issued. 
 
 Mapping: in the second phase, a mapping process is performed. The dictionary 

entries are examined, and the declarations are mapped into the data formats of the 

object computer.  
 Generation of object code: in the final phase, the appropriate object code is 

generated to handle the expressed operation. 
 

GENERATORS 
 

The generator is a routine that performs a creative function: for example, a report 

generator, a program generator. A report generator creates a report requiring little or 

no calculations or complex logic. In this process the programmer writes specifications 

for the reports rather than the program instructions necessary to generate the report. 

The specifications may be the print positions in which the data fields have to be 

printed, totals required, etc. The specifications are subsequently converted into a set of 

specifications and interfaced with the report generator processor. The report generator 

then produces a report as per the format specified. 



THE EDITOR  
 

The editor is the most often used systems program. It is an interactive program that is 

stored in the memory and allows the user to write, to program, to generate text, or to 

make modifications to either of these. The editor is a systems program that is typically 

stored on the hard disk and, whenever needed, is called into the RAM. All source 

programs for assemblers and compilers are typically written with the editor. 
 

THE LOADER  
 

The loader is a short simple program that is used to load a program into the 

computerôs memory. The loader program is a sequence of instructions that transfer the 

program from the hard disk/floppy to the memory. The loader is, typically, 

permanently stored in the ROM of the computer. 
 

PROGRAM LIBRARY  
 

A library is a collection of programs which can be searched by a linking loader for 

requested programs. The loader first loads all the userôs supplied programs and then 

searches the library to find program names that match unsatisfied external references. 

Systems may allow any number of libraries to be specified. A linking loader will 

search each one in turn. 
 

THE MONITOR  
 

Almost all microcomputers use some form of monitor. Typically it is stored in ROM 

and performs some of performing functions: 
 

i) 
 

enter or load instructions and data 
 

ii)  
 

change contents of memory locations and registers 
 

iii)  
 

display contents of memory locations and registers 
 

iv) 
 

execute programs 
 

SOFTWARE: NATURE AND QUALITIES  
 

Any engineering activity ultimately results in some product. The product built by a civil 

engineer could be a building, while an electronic engineer comes out with a chip, an 

electrical engineer builds a circuit and an aerospace engineer finally lands up with an 

aeroplane or aircraft. Now what do you expect out of a software engineer? Well, the 

product of a software engineer is a ñsoftware systemò. Although it is not tangible, yet it is 

a product. This product is similar to the rest of the products in some ways and also very 

different in many other ways. The important property which distinguishes software 



from the rest of the products is in its being ñmalleableò i.e., the modification in the 

design of the product is comparatively easier as compared to the other tangible 

products. 
 

This property is often misused by people. Actually, it is not as easy as it seems. It 

is possible to make modifications in the rest of the products also, for e.g., changing the 

basement of the building. But by considering the enormity of the task, it is generally 

not taken lightly and attempts are not made to first change its design and then the 

product itself. The impact of changes are shown very extensively. Whereas, when the 

changes are to be made in software, these types of attempts are made very easily and 

software engineers are simply asked to make the modifications. But in practice, 

making the necessary modification in software is not an easy task to do. 
 

The code can be changed easily in the editor, but meeting the targets might not be 

as easy. Here comes the need for treating software as any other engineering product. 

The enormity of changes in software should also be studied as deeply as we do in rest 

of the products. Instead of taking this property merely as change in text editor, it 

should be considered as the change in design first. Then the impact of the change 

should be analyzed, and only then should the task of modification be started. The 

whole story is narrated just to emphasize one point and i.e., ñdisciplineò. That means 

the malleability property should be exploited, but in a disciplined manner. 
 

One more characteristic that distinguishes software from the rest of the 

engineering products is in its being human intensive. That means the emphasis is on 

engineering, rather that on manufacturing, unlike other engineering products. In most 

of the engineering products special attention is given to manufacturing, as it is the 

factor that determines the cost of the product. The process has to be managed and 

monitored carefully to lessen the defects. The same holds true for computer hardware 

products, but not for software. Manufacturing is merely a process of duplication for 

software. The process of software production is concentrated on designing and 

implementing. The goal of the whole process is to meet certain criteria, and thus the 

production of a ñhigh qualityò product. 
 

Any engineered product is supposed to meet some needs and fulfill certain 

requirements. These are generally clear in most of the engineering products. For e.g., a 

building is supposed to perform the function of a residential place, and have the ability 

to accommodate the number of people it is built for. It is expected that it will not 

collapse with the weight, and that it should have strong window panes that can 

withstand the onslaught of that strong winds. Similarly, an airplane is expected to 

complete the flight smoothly and not crash because of some faculty design or some 

manufacturing problem. We do not have such distinct sets of specifications for a 

software product. The qualities that are expected out of a software product are often a 



combination of specifications and the qualities of the design. 
 

This chapter will discuss the qualities that a software product and the production 

process should possess. These qualities ultimately become the benchmarks of software 

engineering. 



Software Qualities 
 

When we talk about the qualities expected from a software the list becomes very long. 

These qualities can be expected by the user, by the producer or by the leader of the 

project. The qualities can also be expected from both the product and the production 

process. 
 

The user would like the product to be reliable, easy to use, efficient and accurate, 

whereas the producer would want it to be maintainable, portable, extensible and 

verifiable. At the same time the manager of the software project would want the 

software project process to be productive and easily controllable. 
 

The qualities of software can broadly be dividend into: 
 

 External vs Internal Qualities 
 
 Product vs Process Qualities 
 

 External: The qualities a software should possess can be divided into internal and 

external qualities. Internal qualities deal with the qualities from the developers' 

point of view, whereas the external qualities are the qualities expected by the user. 

The internal qualities are the ones which are responsible for the structure of the 

software and, in fact, these are the ones which help developers in achieving the 

external qualities. Users are generally not bothered about the internal qualities, 

whereas the developers concentrate on internal qualities to achieve the target of 

external qualities; e.g., the internal quality of verifiability is responsible for 

achieving the external quality of reliability. However, sometimes it is difficult to 

differentiate between internal and external qualities as the distinction is not very 

clear.  
 Product: The product and process qualities are also very closely related as in some 

cases of internal and external qualities. There are some properties that apply to 

both product and process. For example, the careful planning of the test data in the 

process of design and development of the product will increase the reliability of 

the product, whereas a quality like efficiency is expected from both product and 

process. 
 

When we talk about 'product' the definition that comes into our minds is ñWhat is 

delivered to the customerò. This definition, when considered broadly seems fine, but not 

when seen from the customer's and developer's perspectives individually. This is true 

from the customer or user's point of view, but the developer includes the requirement 

specification, design, source code, test data, the object code and also the users manual in 

the product. That means all the parts that are produced during the production process 



are the constituents of the product. It is also possible to combine the different subsets 

of the same product to cater to various customers. 
 

For example, the object code of hardware can be sold to a company which is 

installing the machine, whereas the source code and design could be sold to the software 

vendor who can make modifications in the same to produce some other model of the 

same hardware. At the same time the manual and the object code could be sold to the 

software dealer. Thus, all the four people, i.e., the developer, the company installing the 

hardware, the software vendor and the software dealer, see the same product from four 

different angles and use them for different purposes altogether. 
 

This type of dealing comes under configuration management, which is again a part 

of the software production process. Configuration management checks the 

maintenance and control of the relationships among all the related pieces of the 

various versions of a product. 
 

Representative Qualities 
 

We will now talk about the qualities of software products as well as the process. We 

call them ñRepresentative Qualitiesò. We will be analyzing, the ñRQò in terms of the 

classifications discussed above: 
 

 Correctness, Reliability, and Robustness: Although all these three terms can be 

used interchangeably to find out whether the software is performing its functions 

as per requirements, they are sometimes used with different connotations by 

different people. Let us discuss them in more detail. 
 

A program is said to be correct if it functions as per the specifications or the 

requirement. That means it is doing whatever was expected out of it. 
 

Although there is no specified set of specifications available, whatever 

specifications we talk about are written in natural language and are often full of 

ambiguities. Regardless of the ambiguities present, the definition of ñcorrectnessò 

holds true and is the most desirable property for software systems. 
 

Correctness depends solely upon comparison ï that is, the comparison 

between the set of specifications and the product itself. Higher degree of 

correctness can be easily achieved by being more systematic and precise in 

specifying the requirements. There are various methods available for assessing the 

correctness, depending upon the needs and requirements of the 

user/developer/customer /project leader. They include the experimental approach 

and the analytical approach. The correctness can also be enhanced by using high 

level languages that support extensive static analysis or standard algorithms. 
 

A software is said to be reliable if the user can depend upon it. A reliable 



software is defined in terms of probability i.e., the software will function (as 

expected) for a specified time interval. 
 

Whereas software ñcorrectnessò is an absolute quality term, "reliability" is a 

relative term. This means that if the system deviates from its specifications even a 

bit (be that for better or worse) the system is labeled as ñincorrectò, whereas when 

we talk of its reliability such type of deviations do not matter i.e., as far as it is 

giving expected and correct results we call it reliable. Software products are 

commonly released along with a list of ñKnown Bugsò. Users of the software take 

it for granted that ñRelease of a product is ñbuggyò. This is one of the most 

striking symptoms of the immaturity of the software engineering field as an 

engineering discipline. 
 

In other engineering disciplines, a product is not released if it has ñbugsò. 

One cannot expect the release of a building with a warning not to put nails in the 

ceilings. Design errors are extremely rare and are worthy of coming on the front 

page of newspapers. If a building collapses, the engineers and designers have a 

good livelihood of being prosecuted in court. 
 

In contrast the mistakes made by software engineers are generally treated as 

unavoidable. In spite of having apprehensions about these mistakes, we expect 

them. Where we get guarantee cards for most of the engineering products, with 

software we get a disclaimer saying that the software manufacturer is not 

responsible for manufacturing defects. The day we achieve the same degree of 

reliability for software as for other engineering products, we will be in a position 

to put software in the category of engineering discipline. 
 

The Figure below illustrates the relationship between reliability and 

correctness. It says that the set of correct programs are the subsets of reliable 

programs, but this doesnôt hold true vice-versa. It doesnôt hold true in practice 

either. Actually, the specification is a model of what the user wants, but the model 

may or may not be giving an accurate statement of the userôs needs and actual 

requirements. What all a software can do is to meet the specified requirements of 

the model but cannot guarantee the accuracy of the model. 
 

That shows that the Figure below is of an idealized situation that might or 

might not be achievable in practice. This is only to be expected as there are 

uncountable obstacles in achieving this target. It can be explained by realizing that 

though sometimes the applications might be "correct" the designing could have 

been based on "incorrect requirements." In such a case the software cannot be 

guaranteed to satisfy the customer. 



 
 
 
 
 
 
 
 
 
 
 
 

Figure 8.1: Relationship between Correctness and Reliability 
 

A program is said to be ñrobustò if it behaves ñreasonablyò even in 

unanticipated circumstances. For example, when a program encounters incorrect 

input or some other problem, and it generates a run time error as soon as the 

function is performed, then the program cannot be called robust. 
 

Robustness is a difficult quality to define. As a set of actions cannot be 

specified for various problems like incorrect data etc., it is close to ñcorrectnessò 

and ñreliabilityò. 
 

When the question of measuring robustness comes in, the code written 

depends upon the application area. An application developed for first time users 

should be prepared keeping in mind all types of input errors, whereas when talking 

about a system prepared for an aircraft, extra care and robustness is required. 
 

We can say that correctness and robustness are closely related, without any 

single measure to distinguish them. We can say that if the source requirement is 

put in the specification the final product becomes a matter of correctness, whereas 

if the requirement is not specified explicitly the matter is of robustness. Now here 

reliability comes in, as, even incorrect systems give perfect or at least good enough 

results. 
 

Correctness, Robustness and Reliability are also applied to the software 

production process. A process can be said to be robust, if it takes care of 

unexpected changes in the environment. A process is reliable if it constantly leads 

to the production of high quality products. 
 

2. Performance: Any engineering product lays stress on the performance of a product. 

But in software engineering, the performance is expected along with efficiency. A 

software system can be called efficient only if it uses the resources economically. 
 

Performance greatly affects the usability of system. Say, for example, if the 

software system is too slow, it reduces the productivity of users, making the task 

cumbersome; if the software system is using too much of disk space, then its cost is 



increased, thus reducing the viability; if it uses too much of memory, then it not 

only affects other applications but also gives errors. It also becomes slow, as the 

operating system will be busy in maintaining a balance between memory usage 

and the applications. 
 

Performance also decides the suitability of a software system. An algorithm 

can be used very nicely for small inputs but does not work for larger inputs at all. 
 

Performance of a software system can be evaluated in many ways. One way 

is to measure its efficiency by analyzing the complexity of the algorithms. 

Analysis of the complexity of the algorithms only provides an average or the worst 

case of information and not the specific information about a particular system. 
 

For specific information, techniques of performance evaluation are used. 

The three basic approaches for evaluating the performance of a software system 

are ñmeasurementò, ñanalysisò and ñsimulationò. While using ñmeasurementò, the 

actual performance of the system is monitored by collecting data while the system 

is working, and then finding out the bottlenecks of the system. In ñanalyzingò a 

model of the system is built and then analyzed; whereas in ñsimulationò, a model 

that simulates the product is built. 
 

An analytical model is not as expensive as a simulation model could be. The 

analytical models are easy to build and are generally based on querying the theory, 

but they are less accurate as compared to simulation models, which are difficult to 

build but are very accurate. For getting best results the two techniques can be 

combined together i.e., in the beginning of the project an analytical model can be 

applied that gives a general understanding of the project, and later on the simulation 

technique can be used on the critical areas of study, pointing out the problem areas . 
 

Performance is also applied in the process. But while applying in process we 

call it productivity and is regarded as an independent quality. 
 

 User-friendliness: A system is said to be user-friendly if the users find it ñeasy to 

useò. This ñease of useò may vary from user to user. A novice might find the 

verbal messages user-friendly, an expert programmer ignores them without even 

reading them. Similarly, a new programmer or a non-programmer may find the 

use of commands very difficult, whereas a programmer may find the use of 

commands easier. 
 

ñThe user interface" constitutes an important component when we talk about 

user-friendliness. A novice may find the use of the mouse a better option when 

working with a window interface, rather than typing down a command; whereas an 

experienced user will find it more convenient to type down the command, rather than 

navigating through the window, to find out the command he wants to execute. 



User-friendliness is not restricted to user interface only. It also depends upon 

the user operator interfaces. Not only that, it also depends upon properties like 

correctness, performance, etc., as mentioned above. The system producing 

incorrect output can never be user-friendly, no matter how nice its interface is. 

Similarly, a beautiful interface with a perfect color combination, back ground, 

graphics but with very slow processing can never be called user-friendly. 
 

When we talk about embedded systems, there is no such thing as 

ñinterfaceò. The interaction is between the hardware and the other software 

systems. In these cases user-friendliness is measured in terms of its adaptability to 

the environment and the configuration of other software systems. 
 

 Verifiability: This property holds true if its properties can be verified easily. As 

correctness and performance are the properties which we would like to verify, the 

properties can be verified by means of analysis or testing. 
 

Modular designs, disciplined coding practices and the use of appropriate 

programming languages help in making the system verifiable. 
 

Although verifiability is an internal quality it is sometimes used as an 

external quality too. 
 

 Maintainability: By ñsoftware maintenanceò we generally mean the modifications 

required after the release of the software in the market. 
 

Earlier maintenance meant only removing the errors and the bugs. A 

considerable amount is spent on this simple word ñbugò. But now maintenance adds 

on this ñbug fixingò. It includes the additions or enhancements to the products which 

were introduced, there, when the project started or which were incorrectly stated. 
 

The word ñmaintenanceò does not go with the word ñsoftwareò. By 

maintenance we generally mean the maintenance of wear and tear of the product. 

But in software there is nothing termed as wear and tear. However, since this is the 

ñinò thing, now we are forced to use it. 
 

Maintenance cost sometimes exceeds 60% of the total cost of software. To 

take preventive measures to reduce this high maintenance cost, we divide 

maintenance into three types: corrective, adaptive and perfective maintenance. 
 

Corrective maintenance takes care of the removal of the errors present at the 

time of delivery of software. 
 

Adaptive maintenance looks after the adjustment of application to changes 

in the environment. 
 

Perfective maintenance is bothered about the changes in the qualities of the 



software. 
 

Maintainability can be broadly classified into repairability and evolvability. 

The former takes care of fixing up the defects, whereas the latter makes sure that 

changes can be incorporated as per new requirements. 
 

Repairability is generally a product quality, and mainly affects the reliability 

of the software, i.e., as the reliability increases, need for repairability decreases. In 

as much as evolvability is a product and a process quality, it is directly related to 

the cost of software production. That means that as the cost of software production 

increases and complexity grows, its evolvability gains more importance. The 

process must be able to accommodate new management and organizational 

techniques. 
 

6. Reusability: Reusability is quite similar to evolvabilty. In evolvability 

modifications are made in the product to take out a new version of the product, 

whereas in reusability the same product is reused with some modifications. 

Although it seems easy, it is very difficult to build variable products. While 

reusability is an important tool for reducing software production costs, examples 

of reusable software are very rare. 
 

Reusability is applied to the process as well. The same process can be reused 

for building up different products. 
 

7. Portability: Software is said to be portable if it can be run in different 

environments. By ñenvironmentò we mean the hardware platform or a software 

environment such as a particular operating system. 
 

Portability refers to the ability to run a system on different hardware 

platforms. As the money spent on software and hardware increases, portability 

gains more importance. 
 

For most applications, it is important for the software to be portable across 

operating systems, or we can say that the operating system should provide for 

portability across different hardware platforms. 
 

 Understandability: Some software systems are easy to understand whereas others 

are not. For example, a program written to launch a missile would be difficult to 

understand no matter how simply it is written. 
 

This is an internal product quality and helps in achieving evolvabilty and 

verifiability. Whereas, taking it as an external quality, it is a component of user-

friendliness. 
 

 Productivity: This is a quality of the software production process and is used to 

measure the efficiency of the process. An efficient process results in a faster 



delivery of the product. 
 

Productivity of software is of great interest due to the increasing cost of 

software, yet it is difficult to measure. As in other engineering disciplines, we will 

see that efficiently of software is strongly affected by automation. 
 

 Timeliness: It is again a process-related quality which talks of timely delivery of 

software. This timeliness is generally lacking in software production processes. 
 

It is related to other qualities of software also. For example, a timely delivery 

of software that lacks reliability, or is incorrect, is of no use. 
 

Timeliness requires careful scheduling, work estimation and predefined 

milestones. 
 

One reason for late deliveries is the ever-changing user requirement at 

various stages of software production. 
 

 Visibility: A software development process in said to be visible if the 

documentation of all its steps is done properly and clearly. ñTransparencyò and 

ñopennessò can be inter-changed with the term ñvisibilityò. It is both an internal 

and external quality. Visibility requires not only the documentation of all the 

processes, but also the current status of intermediate products. A product is visible 

if it is clearly structured, such as a collection of modules, with clearly 

understandable functions and easily accessible documentation. 
 

PROGRAMMING LANGUA GE EXAMPLES  
 

A large number of high level languages have been developed  for specific requirements. 
 

Some of the commonly used languages for various applications are: 
 

 Scientific and Engineering: 
 

BASIC 

FORTRAN 
 

 Business and Commercial purpose 
 

COBOL 
 

BASIC 
 

 Text Processing 

Lisp 
 

SOSL 
 

IV. General Purpose 



PASCAL 
 

ADA 
 

C 
 

 Artificial Intelligence (AI) 
 

PROLO

G LISP 

COMPUTER FILES  
 

When we examine the way we do our office work, we discover that data or 

information is either written by us on paper or is received on a paper by us. After 

reading the contents and taking necessary action the paper is then filed in a file. This 

file has a name or number which has been assigned by us. This name is given keeping 

in mind that if we wish to refer to this paper, say after six months, we are able to 

remember and correlate this name with the paper. Alternatively the files could be 

according to the various departments/functions of our organization, and a list of names 

could be maintained centrally for easy reference. 
 

The computer also has to store data and programs in its secondary memory, which 

is brought to its primary memory, where the program acts on the data in order to give 

intermediate or final outputs for our consumption. The computer also requires a 

methodology for storing and retrieving this data and programs. Like, in the physical 

world, we store data into files and place them into a filing cabinet, similarly we store 

data into computer Files and store them in the Hard Disk or any other secondary 

storage. In the physical world, if we require to read the data, we open the filing 

cabinet, locate the file name, pull out the file, and then read it. In the computer also, 

whenever data is required to be read or acted upon, it will be brought out of the hard 

disk by referring to its name and then opening it in the RAM or primary memory. 



Types of Computer Files 
 

Depending on the computer application and its design, computer files are normally of 

the following types: 

1. Master Files: This term generally represents a file in which up-to-date information 

about various data items are available along with other data items. In this sense, it 

becomes a master file for referring and for updating, whensoever the status of the 

data changes. For example, the year ï to ï date earnings of an employee are 

usually available in the master file of the Payroll application. Likewise, the present 

balance of an item in the stores will be available in the master file of the Inventory 

Management Application. 
 

 Transaction Files: Daily transactions occur in an organization, which have to be 

recorded, so that the master file information can be updated periodically, as per the 

demand of the Application to which the transaction data is relevant. For example, 

in a store management system application, goods are being received daily and are 

being issued also as per the issue requests from the manufacturing department. All 

issues and receipts are entered into a file, pending master file updation, or to be 

processed for other reports. These files which contain transaction data in its raw 

form are called transaction files. Necessary programs will use these transaction 

data in order to calculate item balances in the master file or to produce a daily 

issue/ receipt statement, etc.  
 Program Files: Data entered into a transaction file has to be processed .i.e. 

manipulated and transformed in order to produce reports or give answers to ad-hoc 

queries. This processing is done through the use of programs written by 

programmers. The programs are written in a computer language using the editor 

available with the operating system, or alternatively, an editor bundled with the 

compiler/interpreter of the language being used to write the program. These 

programs are then saved with a file name having an extension as per the language 

norms. These Files are called Program Files.  
 Backup Files: All computer files in normal circumstances are stored on the hard disk 

of your computer. These files are accessed whensoever needed for insertion, deletion 

or updation, or for queries and report generation, and/or for printing. However, every 

user of an application, with due passage of time becomes reliant on the computer to 

fulfill his information needs. As such he has to protect his information resource from 

any unforeseen happening. This could range from a Hard disk crash ï to a virus 

attack ï to wrong feeding of fresh data ï to file corruption and to the ultimate 

destruction of the computer due to a natural or unnatural calamity. 
 

As such, a prudent user will normally take a backup of his data, at pre- 



determined intervals of time, on to a removable media like a floppy disk or a CD 

or a magnetic tape, and store it separately. The files thus stored on these media are 

called backup files and are created using a special backup software, usually 

provided along with the operating system. In case of a mishap these backup files 

can be restored back on to the hard disk using the restore facility of the software. 

 

 Specialized Files: In addition to the above main files, every computer center will 

also have certain specialized files to help with the routine computer centre 

operations, system maintenance and so on. These files are quite varied. Some of 

them are log files, index files, history files, data dictionaries, etc. 
 

Types of Processing 
 

As mentioned above transaction data being generated at every transaction is used to 

update the master data. This updation is achieved by using suitable commands or 

programs. There are various options available to do this activity depending upon the 

computer environment available, the volume of transactions and the need of the 

application for which the updated data is required. Some of the common processing 

types are discussed below: 
 

1. Batch Processing: Consider a typical Payroll system in a medium sized 

organization. The payroll system requires to capture the attendance of every 

employee during the month, the leaves availed by him with pay and without pay 

and so on. At the end of the month, keeping this attendance record as the basis, the 

salary of each employee is calculated and a salary slip is generated. Since the data 

(leave record) is required at the end of the month, it is advisable that all leave 

forms/attendance records be clubbed into a batch or batches and a transaction file 

of the same, containing records on staff/employee number basis be created . At the 

end of the month this file could be used to update a master file, containing the 

salary structure of the employee and his salary computed for the present month, 

after considering his leave record. 
 

Some of the main reasons for choosing the Batch Processing mode are: 
 

 Processing time is reduced since data entry on terminal is slow, and if done 

offline, the transaction file so obtained can be directly used when processing is 

to be done. This will considerably improve processing speed.  
 In the batch processing scenario , master files need not be online all the 

time. This solves many security and privacy issues.  
 Batches of data can be input by outsourcing. This can lead to significant 

cost savings. 



 Another significant advantage of this mode of data processing is that it 

allows the raw data to be validated by separate validation programs before 

being used for actual processing. 
 
 Real Time Processing: In this environment the master file records are updated as soon 

as a transaction is entered into the system. As is evident, no transaction file will be 

created separately. The obvious advantage of this type of data processing is that a 

more current master is maintained than in the batch processing mode. 
 

For instance in the stores management systems application, a storekeeper or 

a materials manager will be able to see the availability status of any item as soon 

as it is entered. Of course, a slight delay between receipt of the item in the store 

and the actual data input always exists in real time processing. Validation rules are 

inbuilt in real time environment data entry programs. For example if an item 

number is wrongly typed in, the system may respond with an error message 

,forcing the data entry operator to correct the mistake. 
 

The drawback of a real time environment is that it is an expensive way of 

setting the infrastructure and maintaining it. For example backup procedures have 

to be more elaborate, unwarranted access by unauthorized personnel will have to 

be guarded against and, finally, human errors are more difficult to detect in the 

real time environment. 
 

REVISION EXERCISES 
 

 Mark True or False. 
 

 A linker is a program which links all unsatisfied external references in the 

program with program libraries. 
 

 A loader program typically resides in the hard disk of the computer. 
 

 A compiler examines and executes the program one instruction at a time. 
 

 COBOL is a high level language used for scientific applications. 
 

 Machine language is written in binary code. 
 

 C language uses mnemonics. 
 

 Application software is written using system software. 
 

 Operating system is a system software.  
 Report Generators are generally classified as 4GLôs since they require the 

programmer to specify all the instructions and specifications to create a report. 

 4 GLôs are both user oriented as well as machine oriented. 
 
 Compare higher level languages of the third generation with 4th generation 



languages. 
 

 What are the steps in the compilation process of a program. 
 
 Match the following: 
 

a. BASIC a. Mathematical computations 

b. Assembler b. French Philosopher 

c. Editor c. Write programs 

d. PASCAL d. Teaching 

e. Loader e. Translate to object code 

f. Compiler f. Symbolic code 

g. FORTRAN g. Booting 



Chapter 9: OPERATING SYSTEMS 
 

Computer hardware provides us with the means of processing and storing information. 

However, the óbareô machine on its own is virtually useless. In order to make the 

computer perform useful work for us, it is has to be ódrivenô by means of programs-

software which specify the tasks to be done. The combination of hardware and 

software provide a total usable system. Software can be classified into two distinct 

groups: system software and application software. 
 

Application software, as the name suggests, consists of the programs which carry 

out the specific processing required for users applications, such as an accounting 

system or an engineering computer-aided design package. System software is not 

application specific; it is oriented to the needs of the hardware and facilities the 

development and running of applications. The most significant part of system software 

is the operating system, which is present in all computers except for a few very 

specialized applications. 
 

The role of the operating system is to complement the hardware by providing a 

layer of services which manage the resources of the hardware and permit the users to 

drive the system. In general, the user will not be aware of the union in effort. Indeed, 

many system facilities could be implemented by either hardware or software, a 

common example being floating point processing. (In many computers, there is no in-

built hardware available to perform floating-point computations, which therefore has 

to be implemented using software routines). The situation is further complicated by 

the existence of firmware which is a program encoded in a hardware form, usually in 

Read-only Memory (ROM). Firmware is often used to provide very basic services at a 

functional level just above the hardware (eg. The bios in PC). Again, the boundary 

between hardware and firmware is imprecise and in any case, is not important for most 

users. 
 

HISTORY AND EVOLUTION  
 

The evolution of operating systems has been driven by technological advances and by 

the demands and expectations of the users. An examination of this evolutionary 

process helps us to understand the workings of modern systems and to better 

appreciate their essential principles. 
 

The very earliest computers, provided little in the way of support for their users; 

switches and lights were the first input and output devices. Programs were entered by 

using a set of switches to define a memory address value, then using another (or possibly 

the same) set of switches to specify an instruction word which was then entered into the 

memory location. This was repeated for each word of the program. The 



program was started by setting the program counter to the first instruction word and 

pressing a start button. The first step towards improving and simplifying computer use 

was to address the problem of loading the program. Reducing the human involvement 

in this process implied preparing the program in some offline form, then transferring 

this into the computer memory via an input device such as a card or paper tape reader. 
 

In order to read from a card or paper tape reader, a loader program ( is a program 

which read from the input device and set up a program in the memory) had to be 

established in the computer memory. In the first place, which prompts the question-

how do you load the loader! One solution, of course, is simply to enter the loader 

manually, as before. However the idea was born of building into the computer a 

facility whereby, on startup, the computer automatically read a primitive loader 

program written on, for example, a single card. This basic loader then executed and 

read in a larger, more extensive, loader program, which could then load any user 

program. This arrangement was referred to as boot strapping, derived from the idea of 

pulling oneself up by the bootstraps; the technique and the term survive to the present 

day, although boot strapping is generally reduced nowadays to booting. 
 

In the 1950s , computer were very expensive, certainly in relation to their 

throughput measure in today's terms. The early pre-occupation, therefore, was to get 

as much use out of them as possible. This drive toward 100% utilization of the 

processor has not entirely disappeared today but is now much less important than 

usability and peak processing power. 
 

As the hardware steadily improved, the execution time of programs fell. This trend 

had two very critical consequences, which were to span on rapid development of early 

operating systems: 
 

The set up time - i.e the time between jobs spent loading the next program and 

data-become disproportionate to the run time of the job. 
 

The input-output devices were seen to be much slower than the processor speed. 
 

The processor spent most of its time idle, waiting for a card to be reader punched 

or a character to be printed. 
 

Around 1960, a revolutionary new computer, called ATLAS, was designed by a 

team from Manchester University and the Ferrants company. This is reputedly the first 

computer to be designed with the requirements of an operating system in mind. Atlas 

introduced many more features including interrupts and a virtual memory system. 

While the idea of virtual memory took some time to make a broad impart, the interrupt 

mechanism made an immediate impression in computer and operating system design, 

since it made the job of managing several programs and peripheral devices 

simultaneously much easier. It made it possible for the operating system to oversee the 



progress of several programs and I/O activities simultaneously. In 1964, IBM produced 

the system 360 series of computers, which consequently evolved into system 370 and 

then the 303X machines in use today. This range of computers has probably been the 

most significant in computings history, not so much from a technological point of view, 

but because it provided a wide range of computing facilities within a compatible series of 

machines, supported by the manufacturer through many revisions and enhancements. 
 

Single Stream Batch Processing 
 

In order to reduce the set up time between jobs, the simple program loader concept 

was elaborated to allow for a continuous series of jobs to be loaded automatically from 

an input device (usually a card reader, but later magnetic tape). This early form of 

operating system was often called a supervisor, executive or monitor before the term 

operating system itself came into common use. However, we can see that these 

systems were indeed basic operating systems. The term batch processing was applied 

to this mode of working because jobs were submitted in batches to the computer. 
 

Multiprogramming  
 

Continued improvement hardware meant that the computer could cope with more 

work that a single batch stream could produce. The answer was- multiprogramming ! 

If the computer were asked to run several programs at the same time, the processor 

could be kept busy for most of the time by switching its attention from one program to 

the next in rapid succession. Additionally, I/O transfers could overlap with processor 

activity, i.e. while one program has to pause awaiting on I/O transfer, another program 

could use the processor. 
 

In a batch multiprogramming system, a series of jobs was loaded into the memory 

at the same time, if sufficient memory space were available. While one job was held 

up waiting for an I/O transfer, another job was started. A job was selected (from those 

ready to run), on the basis of an operation assigned priority number. It was found 

advantageous to mix jobs which differed in the balance of processor to I/O activity. 
 

Spooling 
 

The acronym stands for simultaneous peripheral operations on-line. Essentially, this 

technique absorbs surplus process or time by performing I/O transfers for other jobs. 

Input and output date were routed via disk files so that there jobs were only required to 

communicate with disk systems which are, of course, much faster. 
 

Another benefit of spooling was that access to the slow peripherals was restricted to 

the one program, namely the spool print program. This facilitated the sharing of devices 

such as printers between several running programs, avoiding the need for these programs 

to compete for possession of the printer. It must be remembered that the 



spooling operations run when no other jobs are available and hence use processor time 

which would otherwise be lost. While the real I/O incurred by the jobs use the much 

faster disk system. Overall, the thoroughput of the system was improved. 
 

Real Time Systems 
 

The range of applications into which computers were drawn has risen dramatically 

since the very earliest days of computing. A specific case in point was a class of 

applications referred to as real-time systems. A real time system was defined as one 

which responds sufficiently fast that it can influence the environment in which it was 

working. The term real time was usually applied to systems where the feedback is 

more immediate or direct, such as process control systems in factories or missile 

tracking systems for defence. Another valid application would be an airline seat 

reservation system where the availability of a seat was checked, reserved and booked 

where the operator is dealing with the customer. The essence of these systems was the 

immediacy of the interaction between the computer and the application environment. 

Hence, the operating systems for computes working in this fashion were to be 

designed to cope with the necessary speed of response. Security and safety were also 

of paramount importance in many of these systems. 
 

User Interface 
 

The user interface is the users gateway into the computer, enabling the required 

human-computer interaction to take place. Considering its critical nature, it is a 

surprise that the topic has been awarded relatively little attention in the past. 
 

The range and diversity of computer users is such that a complete listing of 

distinct types would be difficult, so we will introduce here a very broad categorization 

which encompasses most users. They are programmers, operational and end users. 

Note that these categories define roles and not individuals; one person can at different 

times perform tasks within each of these categories. Programmers produce software, 

for the use of themselves or others. The software can be broadly classed as system or 

application. The former case refers to software such as operating systems, compilers 

etc, while the letter refers to Spreadsheets, Databases, Management Information 

Systems etc. An operational user is concerned with the provision, operation and 

management of computing facilities for others, possibly for other users. This would 

include mainframe computer operators, installation management and system engineers 

concerned with system efficiency, software installation etc. This would also include 

any person who performs housekeeping operations on a computer, such as setting up 

directories, deleting old files, checking on free disk space and taking backups etc. An 

end-user is someone who applies the software to some problem area. We can identify 

within this group varying levels of expertise or sophistication; at one extreme, we have 



the cash machine user who is perhaps unaware of his or her interaction with a 

computer. At the other extreme, a personal computer user could have a substantial 

understanding of the computer. In between these extremes, might come clerical staff 

using a data entry program. 
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There are 4 different types of user interface:- 
 

System calls 
 

Command language 
 

Job control language 
 

Graphical user interface 
 

System Calls 
 

To a programmer, invoking a system call is very similar in nature to calling any other 

procedure or function. The essential difference, however, is that in the case of a 

conventional subroutine, the object code is part of the calling program, while the 

system call code is within the operating system. An operating system will only have a 

limited number of available system calls and in general these will be supplemented by 

standard subroutine libraries. Many of these standard subroutines, which provide 

additional and/or higher level facilities for the programmer, will themselves use 

system calls. These higher level subroutines are generally organized into application 

programming interface or APIs. 
 

Command Language 
 

Command languages are designed to allow a user to interact directly with the 

operating system from a terminal and the principal use of the command language is to 

initiate the execution of the programs. Hence, it is a facility for on-line users rather 

than batch processors although command languages often contain some provisions for 

batch working. 
 

Job Control Language 
 

Job control languages or JCLS are used to define the requirements and parameters of 

work submitted to a batch system and would generally be used by computer operations 

staff in a mainframe environment. 
 

Graphical User Interface 
 

A graphical user interface or GUI ( pronounced goo-ey) provide means of interacting 

with the system using a windows and mouse driven environment. The concept arose 

primarily from work done in the Palo Alto Research Centre (PARC) of the Xerox 



Corporation, but was commercially exploited and popularized by Apple Corporation. 

When the Apple Macintosh first appeared in 1984, its (then) unique feature was that 

its graphical interface was its only means of interaction with the operational or end 

user. Since that time, many other GUIs have been developed, though usually they are 

layered on top of an existing command based interface, as in the case of windows for 

MS-DOS and X Windows for UNIX. 
 

Scheduling 
 

The processor at any instant can only be executing one instruction from one program 

but several processes can be sustained over a period of time by assigning each process 

to the processor at intervals, while the remainder become temporality inactive. What 

do we mean by the phrase assigning a process to the processor? Simply that the 

processor execution is directed in to the program code corresponding to the process , 

so that the path of execution now moves through this code. At this point, the process 

thus started has complete control of the processor and will continue to have this 

control until something happens. It is, of course, essential that the operating system 

regains control at some time, so that the processor can be reassigned to another 

process. These somethings can be either the process issues an I/O request by means of 

a system call or an interrupt occurs. Both of these events cause the processor execution 

to be diverted into the operating system, enabling it to regain control and to decide on 

its next cause of action. At any instant, only one process will be running while the 

others will be ready, waiting for the processor or in some other wait condition. The 

operating system has the task of determining the optimum sequence and timing of 

assigning processes to the processor. This activity is called scheduling. 
 

Memory Handling by Operating System 
 

Main memory is essential within a computer first and foremost to enable processes to 

exist. It is within main memory that instructions reside which are interpreted by the 

processor. However, in addition, to holding program code, the memory is also a work 

space and transient storage repository for various kinds of data. Consequently, the 

memory of a typical computer is occupied by a wide range of different objects such as 

operating system code, operating system data (process tables, file description tables 

etc), user program code and date etc. 
 

Historically a number of memory management techniques have been used, and, in 

the process of evolution, have been superseded by superior methods. The operating 

systems memory manager provides the memory space to enable several processes to 

be executed at the same time and protect each process from each other. 
 

In order to execute a process, the program code has to be transferred from 

secondary storage to main memory; this activity is called process loading. 



In some systems, the reverse operation is also used, i.e. the transfer of a process 

from memory to secondary store. This is done in order to accommodate and 

consequently execute another process, the overall effect therefore being a swap of two 

processes; hence this activity is called swapping. 
 

File Management 
 

The majority of computer applications use storage facilities provided by magnetic disk 

and other media such as optical memory. Such systems, termed secondary storage, are 

used to provide non-volatile and relatively cheap storage, at the expense of access time  

 as compared with semi-conductor storage). In its broadest usage, the term file is 

applied to anything held on secondary storage. This would encompass programs (source 

and executable), text files such as word processing documents, saved spreadsheets and 

data files employed in an application such as stock control. In a narrower usage of the 

word, it would refer specifically to the last of these, i.e. to application data only. The 

view of the file data as presented to the user by the operating system necessarily hides 

some major complexities. Problems of physical addressing, blocking, error checking, data 

input/output etc are effectively masked from the user. 
 

When a new file is created on disk, the decision as to where to locate the file, in 

terms of a cylinder, track and block address, has to be made. In earlier system, this 

was the responsibility of the user. Very often , this allocation was made with a view to 

optimizing performance of programs accessing the file, the file would use a 

contiguous area of disk, or possibly aligned vertically (ie. On the same cylinder) with 

another file which had to be accessed at the same time, the intention being to minimize 

head movement. The user was required to estimate the maximum space necessary for 

the file; an underestimate could cause a program to fail with an out of disk space error. 
This technique has given way in more recent times to numerical allocation of disk 

space. The operating system allocates disk space on demand by user programs. 

Generally space is allocated in units of a fixed size, called an allocation unit (or a 

cluster) which is an implement multiple of the disk physical sector size, usually 512 

bytes. Typical sizes are 512, 1024 and 2048 bytes. When a file is first created, it 

consists solely of one cluster. Note that this is the minimum space assigned to a file, 

been though it consists only of a few bytes. As the file is extended by the appending of 

more data, eventually the cluster will be filled. More clusters are assigned to the file as 

the need arises. Clusters can be released as well as assigned to files. This would 

happen if the file were deleted or simply contracted in size. 
 

Security Techniques 
 

The operating system can significantly contribute to the security of the resources of a 

computer. Operating system can provide security in many ways like passwords, access 



control, encryption, etc. 
 

A password mechanism is often the first and most significant line of defence in a 

multi-user system. In order to gain access to the system, the user enters an personal 

identification name together with a password associated with that ID name. The 

password can be assigned by an administrator or devised by the individual user. In 

principle, the password technique ought to provide a satisfactory level of security 

against unauthorized access to the system, but in practice it has been found on 

occasions to be suspect. The main problem associated with passwords is that users 

tend to use easily remembered words which consequently are more readily guessed by 

a potential hacker. File access control is another level of security in which operating 

systems generally include facilities for the protection of files. Encryption is the 

conversion of data in some intelligible format into an unintelligible format to prevent 

the data from being understood if read by an unauthorized party. A reverse operation, 

decryption, converts the encrypted data back to its original form. 
 

A BRIEF HISTORY OF LINUX  
 

Linux is not strictly speaking a UNIX system, since it doesnôt contain any of the 

licensed code of real unix systems, but has been designed from scratch as a look alike 

and placed in the public domain. It is strongly POSIX-based, ensuring compatibility 

with POSIX-compliant systems. It can run an a number of different platforms, but 

possible its most important aspect is that it can be used on a PC. 
 

Although many people might refer to Linux as the operating system and included 

software, strictly speaking, Linux is the operating system kernel, which comes with a 

distribution of software. Linux was first released in 1991 by its author Linux Tovvalds at 

the University of Helsinki. Since then it has grown tremendously in popularity as 

programmers around the world embraced his project of building a free operating system, 

adding features and fixing problems. Linux is popular with todayôs generation of 

computer users for the same reasons. Early versions of the unix operating system enticed 

fans more than 20 years ago. Linux is portable, which means youôll find versions running 

on name-brand or alone PCs, Apple Macintoshes, Sun workstations or Digital Equipment 

Corporation Alpha based computers. Linux also comes with source code, so you can 

change or customize the software to adapt to your needs. Finally, Linux is a great 

operating system, rich in features adopted from other versions of Unix. 
 

A BRIEF HISTORY OF MS -DOS 
 

In 1979, a small company called Seattle Computer Products, which manufactured 

memory boards, decide to write its own operating software to test some of its Intel 

based products. This system, called 86-Dos, was bought by IBM. IBM then enlisted 

the help of Microsoft to develop it into a commercial product. The IBM PC was 



announced in August 1981, with version 1.0 of MS-DOS, referred to by IBM as 

simply DOS and later as PC-DOS. In 1983, version 2.0 of MS-DOS appeared, which 

was a major advance in design of the system version 2.0 was designed to meet the 

needs of a newly- announced IBM computer, the PC/XT, which had a built-in 10mb 

hard disk. To simplify management of this vast storage, version 2.0 introduced a 

hierarchical file directory structure based on the unix model. 



A BRIEF HISTORY OF WINDOWS SYSTEM  
 

There are essentially three main types of Microsoft Window Systems: Original MS-

DOS based version, Windows 95, Windows NT. 
 

The MS-DOS based version was layered on top of MS-DOS, which primarily 

provided support for the disk system development of this line terminated at version 

3.11. Windows 95 was derived from the original windows but is base on 32 bit code 

(mostly). 
 

It is intended as the natural successor to Windows 3.11 for personal and smell 

system use. It provides pre-emptive scheduling, 32 bit addressing with memory 

protection and has a graphical user interface distinct from version 3.11. While being 

independent of MS-DOS, MS-DOS applications are executed directly using modified 

MS-DOS code and hence can execute any programs written  

for MS-DOS. The latest of them is Windows 98. Microsoft came out with an 

Operating System for network called as Windows NT. Windows NT was designed as 

a completely new product. Windows NT has built-in provision for net working. 



REVISION EXERCISES 
 

 Write a short note on the history and evolution of operating system. 
 
 "User Interface with the computer is not complete without an operating system". 

Do you agree with the statement. Give reasons.  
 Explain the concept of Single Stream Batch Processing. 
 
 What are the benefits obtained by the user from the spooling technique. 
 

5. How does the user interface make the human-computer interface a smooth 

interaction? 
 

 What are the different types of user interfaces? Highlight the differences between 

them. 
 
 Explain briefly the term scheduling. 
 
 Write a short note on memory handing by the operating system? 
 
 How is a file structure managed by the computer's operating system? 
 
 Briefly explain the security techniques in an operating system. 
 
 Give a brief history on: 
 

 Linux 
 

 MS-DOS 
 

(c) Windows System 



Chapter 10: 
 

DOS: DISK OPERATING SYSTEM 
 

DOS was developed by Microsoft primarily as a single user operating system working 

on Personal Computers. From 1981 till now many versions starting from Ver 1.0 till 

6.2 have been released. Each successive version had its enhancements aimed at 

improving the management of the computer resources available to the users. 
 

As has been explained earlier it is essential for the operating system programs to 

be resident in the memory of the computer. The process of loading 

these programs into the memory is termed as Booting the computer. In DOS these 

programs are MSDOS.SYS, IO.SYS and COMMAND.COM. However MSDOS.SYS 
and IO.SYS are hidden programs and cannot be seen in the Directory listing. 
 

Loading of these programs is done either by inserting the systems floppy (the 

floppy containing the above three programs) in the floppy drive and switching on the 

computer. The loader program resident in the ROM reads these programs and loads all 

the instructions in the memory. The screen of the monitor displays the A prompt 

(A:\>), thereby signalling to the user that the computer is ready to be used. 
 

Alternatively, if the system is not available, the computer can be booted from the 

hard disk. 
 

The only difference is that the screen will now show the C prompt (C:\>) instead 

of the A prompt. 
 

In order to load the DOS files from Floppy to Hard Disk the following command 

is used: 
 

A:> SYS A: C: 
 

If one needs to make a system Floppy from the Hard Disk the DOS command used 
 

is: 
 

C:> SYS C: A: 
 

DIRECTORIES  
 

In the DOS environment, each disk is organised into directories. Each Directory holds 

files. The default directory is the Root Directory and contains the minimum DOS 

Files. The Root Directory has no name in the DOS terminology. 
 

The Root Directory cannot show more than 132 files in its directory listing. 
 

Todays computing environment consists of using various computer languages and 

packages in order to satisfy our computing needs. If all these packages, languages and 



associated data, program files etc. are kept together in the same directory, file 

managing and handling becomes extremely inefficient. In order to tackle this 

inefficiency, DOS allows users to create subdirectories within the Root Directory and 

within subdirectories as well. 
 

Commands to Create a Directory 
 

In order to create a directory named DEEP in the Root Directory, type in the following 

command: 
 

C:\> MD\DEEP 
 

or type 
 

C:\>MKDIR\DEEP 
 

Changing Your Working Directory  
 

In order to work with files in the directory DEEP type the following command: 
 

C:\>CD\DEEP 



Removing a Directory 
 

To remove a directory, please ensure that the directory is empty and enter the command: 
 

C:\>RD\DEEP 
 

The DIR Command 
 

This command enables us to view the contents of a directory. 
 

C:\>DIR ï This gives a complete listing of files and directories. 
 

C:\>DIR/P - This command pauses the directory listing at every screen. 
 

C:\>DIR/W - This command shows the listing width-wise on the screen. 
 

FILES 
 

The most common requirement of a computer user are commands to manage his 

files.DOS has a naming convention for all files which states that: 
 

Files can have names upto 8 characters. This can be followed by a (.)dot and 

an extension of upto 3 characters. However, special characters like commas, 

slashes, blanks etc. are not allowed in a file name. Hence 
 

MYFILE is a valid file name. 
 

MYFILE.BAK is a valid file name. 
 

MY FILE is invalid because a blank space has been given. 
 

MY,FILE is invalid because of the comma. 
 

Creating a File Using Editor 
 

DOS has an inbuilt editor which allows you to create a file.In order to create a file 

named ANYFILE enter the command 
 

C:\DOS> EDIT ANYFILE  
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 10.1 



DOS will present a screen as shown above. You can then enter your program or 

text in the box and exit out of the editor by using the ALT+F key and then press X. 
 

Commands to Copy Files 
 

C:\>COPY ANYFILE A: (This command will copy the file named ANYFILE in the 

Root Directory to a Floppy) 
 

C:\>COPY ANYFILE \DEEP (This command will copy the file ANYFILE from 

the Root Directory to the DEEP directory.) 
 

WILD CARDS  
 

DOS supports two wild cards ó?ô and ó*ô, which allow you to specify whole groups of 

file names. The ó?ô stands for any single character in their specified position within the 

file name and the ó*ô stands for any set of characters, starting at the specified position 

within the name and extension and continuing till the end of the filename or extension. 
 

For example, DIR A:??001.* will list all files having any character values in the 

first two position of the filename followed by 001 and any three characters in the 

extension. 
 

C\:> COPY *.* A: COMMAND will copy all files in the Root Directory on to a 

floppy. 
 

THE ATTRIB COMMAND  
 

C:\> ATTRIB ïR ANYFILE : This command is used for making your file ANYFILE 

as read and write, i.e. you can both read as well as write from and to the file. 
 

The following notations can be used with the ATTRIB command: 
 

+R : Makes the file read only 

+H : Suppresses the file in the directory listing, i.e. makes it hidden 

-H : Unhides the previously hidden file 

+A : Changes file settings to Archived 

-A : Changes file settings to Not archived 

+S : Marks file as  DOS system file 

-S : Removes DOS system file setting 
 

RENAMING A FILE  
 

C:\>RENAME ANYFILE MYFILE 
 

This command allows us to rename the file named ANYFILE to MYFILE. 



DELETING A FILE  
 

C:\> DEL ANYFILE 
 

The above command will delete the file named ANYFILE. 
 

Erase can also be used to delete files. 
 

THE DELTREE COMMAND  
 

If you wish to remove unwanted directories and their contents (files and 

subdirectories) use the DELTREE command. 
 

C:\>DELTREE C:\deep 
 

PRINTING ON SCREEN 
 

C:\>TYPE ANYFILE 
 

This command will output the contents of the file ANYFILE on the screen. 

However, it will pause at the end of the text. As a result, you will not be able to view 

the total contents. In order to view screen by screen, use the Piping feature of DOS. 



Piping 
 

If you desire to reprocess the output obtained from a DOS command by another DOS 

command then one way to do this is to redirect the output to a disk file and then send 

the contents of the file as input to the next command. 
 

However, DOS allows you a more convenient method in which you can combine 

multiple commands on a single line. This technique is called piping and uses the pipe 

character | to combine the DOS commands. 
 

For instance, in the previous example if we wished to pause at every screen to 

view our output, we would enter the following command: 
 

C:\> TYPE ANYFILE| MORE 
 

MORE forces DOS to display output one screen at a time. 
 

REDIRECTION OPTIONS IN DOS  
 

Output can be redirected to various devices by using the > symbol for output and < 

symbol for input. 



Standard target device names are as under: 
 

CON 

 

The screen or console 
 

PRN 
 

The default printing device 
 

LPT1 
 

Parallel printer port 
 

COM1 
 

Communication serial port 1 
 

COM2 
 

Communication serial port 2 
 

AUX 
 

Auxiliary output device 
 

NUL 
 

Null device (Suppresses output from device) 
 

C:\> TYPE MYFILE >PRN 
 

The above command will redirect output of the screen to the printer. 
 

SOME DISC COMMANDS 
 

The Format Command 
 

Formatting or initializing floppy or disk is the technique of creating tracks and sectors 

on the floppy which are ultimately used for reading and writing data from and to the 

floppy. The command provided by DOS for this important task is as follows: 
 

C:\> FORMAT A: Formats the floppy in drive A. 
 

C:\> FORMAT A:/S Formats the floppy and also transfers the systems files to the 

floppy. 
 

The Scandisk Command 
 

C:\>SCANDISK /ALL 
 

This command available in DOS 6.2 version analyses and repairs logical and 

physical disk errors. If DOS version is lower than 6.2 use CHKDISK/F command 

instead. 
 

THE CONFIG.SYS FILE  
 

This is a user defined file in DOS and contains additional information for the 

operating system regarding the environment in which the user desires to work. For 

instance a config.sys file may contain the following DOS commands: 
 

DEVICE=\DOS\HIMEM.SYS 



FILES=100 
 

BUFFERS=40 
 

DOS=HIGH 
 

The device command tells DOS to look for extended memory. DOS would, by 

default, assume that your computer has the primary conventional memory of 640 KB 

only. However, HIMEM.SYS will check for extra memory. 
 

The FILES command tells DOS that upto 100 files can be open at a given point of 

time. Otherwise the default of 8 files is applied by DOS. 
 

DOS=HIGH tells DOS to load the operating system files in upper memory area 

leaving the conventional memory area free for applications which require more of 

conventional memory. 
 

When the computer is booted, the operating system first reads the CONFIG.SYS 

file in order to configure the environment before bringing up the C prompt. 
 

THE AUTOEXEC.BAT FILE  
 

This is also a user defined file, which contains DOS commands to be executed before 

the user actually starts his session on the computer. For instance, if the user desires 

that the computer should check for any viruses on his hard disk the following 

command should be written in the AUTOEXEC.BAT file. 
 

MSAV C: 
 

We have so far discussed some of the very common and necessary commands and 

files of the disk operating system which must have given you an idea of the DOS 

environment & which must have illustrated some important features of DOS. We shall 

now discuss the commands. 
 

COMMANDS  IN DOS 
 

DOS commands can be divided into two categories: 
 

 Internal commands: Internal commands are those commands that can be entered 

once the DOS prompt is available, i.e., they do not need any special files for their 

execution. For example 
 

A:/> CD\DOS 
 

is an internal command that changes the directory. 
 

 External commands: External commands are those commands that need separate files, 

containing their source codes, to invoke them. The external commands basically are 

accessories to the operating system that increase its extensibility. 



A:/DOS > FORMAT C: 
 

The above command would format the drive C:. The file FORMAT.EXE should 

be present in the DOS directly of drive A: for the command to be executed as desired. 
 

Given below are some of the common commands with their function and syntax. 
 

Break 
 

Type: Internal command. 
 

Function: When the óBREAKô command is invoked, (i.e., BREAK ON), the 

computer checks to see if Ctrl.C would stop the execution of the current DOS 

command. 
 

Syntax: BREAK ON or OFF. 
 

CD 
 

Type: Internal command. 
 

Function: The CD command is used to the change the directories which may be on 

the same or other drives. 
 

Syntax: CD drive:\path. 
 

CHKDSK  
 

Type: External Command. 
 

Function: The CHKDSK command analyses, diagnoses and optionally corrects 

comman hard disk errors. CHKDSK can also be made to work on a specific file to 

check whether it is contiguous (stored in adjacent areas of the disk) or 

noncontiguous (scattered over separate areas of the disk). 
 

Syntax: CHKDSK drive:\path\file\switches. 
 

CLS 
 

Type: Internal command 
 

Function: The CLS command clears the screen and only the operating system 

prompt on the top left corner is displayed. 
 

Syntax: CLS 
 

Copy 
 

Type: Internal command 
 

Function: As the name suggests the COPY command is used to copy files from one 



destination to another. 
 

Syntax: COPY source_drive:\path\file(s) target_drive:\path\file(s). 
 

CTTY  
 

Type: Internal command 
 

Function: The CTTY command redirects a console input or output to a distant 

input/output device (eg. printer). 
 

Syntax: CTTY device-name. 
 

Suppose the device is the printer connected to LPT1. The appropriate command 

would be. 
 

CTTY LPT1 
 

Date 
 

Type: Internal command. 
 

Function: If the DATE command is used without any parameters, DOS displays 

the current system date & prompts the user to enter another. If after the DATE 

command, the date is included, DOS changes the date. 
 

Syntax: DATE date. 



DBLSPACE 
 

Type: External commands. 
 

Function: The DBLSPACE command is used to compress the data files. It can 

also be used to compress the entire drive. The DBLSPACE has very vast 

applications which are beyond the scope of this book. 
 

Syntax: DBLSPACE/Switches drive: 
 

DEFRAG 
 

Type: External command. 
 

Function: The DEFRAG command is used to arrange the files in contiguous 

sectors. Files become fragmented over a period of time. Hence, the DEFRAG 

command should be perodically used to increase the performance of the system 
 

Syntax: DEFRAG drive:/Swithces. 
 

DEL (ERASE) 
 

Type: Internal command. 
 

Function: The DEL command is used to delete files. 
 

Syntax: DEL drive\path\file(s)/switches 
 

ERASE drive:\path\file(s)/switches 
 

DELTREE  
 

Type: External command. 
 

Function: the DELTREE command is used to remove an unwanted directory, plus 

all files on it, and all subdirectories nested below it, in a single command. 
 

Syntax: DELTREE/switch drive:\path. 
 

DIR 
 

Type: Internal command. 
 

Function: The DIR command displays a list of files in a directory. The DIR 

command without parameters displays the list of files in the currently logged drive 

and subdirectory. 
 

Syntax: DIR drive:\path\file(s)/switches. 
 

DISKCOMP  



Type: External command 
 

Function: The DISKCOMP command compares the contents of two floppy disks 

on a track to track basis, reporting which track numbers are not identical. 
 

Syntax: DISCOMP source; target:/switches. 
 

DIScopy 
 

Type: External command 
 

Function: The DISCOPY command copies the contents of one floppy disk to 

another on a track to track basis. 
 

Syntax: DISCOPY source: target:/switches. 
 

DOSHELP 
 

Type: External command 
 

Function: The DOSHELP command provides instant help to the user when invoked. 
 

Sytax: DOSHELP Command 
 

or 
 

Command /? 
 

When executed instant help is provided on the 'Command Name' entered. 



DOSkey 
 

Type: External Command. 
 

Function: Once invoked the DOSKEY command introduces a special buffer space 

in which the DOS commands being entered are stored. Each time a command is 

entered it is added to the DOSKEY's Command buffer. These commands can be 

recalled. 
 

Syntax: DOSKEY. 
 

EDIT  
 

Type: External Command. 
 

Function: The EDIT command provides a text editor for the editing of text files or 

batch files. 
 

Syntax: EDIT drive:\path\file/switches. 
 

FC 
 

Type: External command 
 

Function: The FC command matches the contents of two files or sets of files and 

reports the differences between them. 
 

Syntax: FC/switches drive:\path\file(s) drive:\path\file(s) 
 

FDISK  
 

Type: External Command. 
 

Function: The FDISK command is used to partition the hard disk. This command 

should be used on a formatted hard disk, otherwise it may erase or overwrite the 

existing files. 
 

Syntax: FDISK/switch. 
 

Find 
 

Type: External Command. 
 

Function: The FIND command is used to find all occurrences of a specified 

character string in a file. This command is case-sensitive, i.e., it distinguishes 

between upper case and lowercase letters. 
 

Syntax: FIND/switches "string" drive:\path\file. 



FORMAT  
 

Type: External Command. 
 

Function: The FORMAT command prepares a blank disk for storing, or creates a 

new blank disk from a used one. In other words, the disk is formatted. 
 

Syntax: FORMAT targetdrive:/switches. 
 

HELP 
 

Type: External Command. 
 

Function: The HELP command is synonmous to the DOSHELP command. It 

displays the syntax summary of the command name entered. 
 

Syntax: HELP Command. 
 

KEYB  
 

Type: External Command. 
 

Function: This command when invoked loads a non-standard keyboard 

configuration into memory. 
 

Syntax: KEYB keyboard codepage drive:\path\library file. 
 

The Library file usually is KEYBOARD.SYS 
 

LABEL  
 

Type: Internal Command. 
 

Function: Every disk has the option of having a volume label which can be used 

for its identification. The LABEL command adds or modifies the volume label. 
 

Syntax: LABEL target: Labelname. 
 

MD 
 

Type: Internal Command. 
 

Function: The MD command is used for creating a new directory or subdirectory. 
 

Syntax: MD drive:\path directoryname. 
 

MK DIR can also be used in place of MD. 
 

MEM  



Type: External Command. 
 

Function: The MEM command displays the information on the allocation of the 

random access memory. 
 

Syntax: MEM/switches. 
 

MORE 
 

Type: Internal Command. 
 

Function: The MORE command when used displays the output one screen at a 

time instead of continuous scrolling. The MORE command is used to display the 

contents of a data file or to display the coutput of a program. 
 

Syntax: MORE < drive:\path\file(s) 
 

or 
 

Command (parameters) | MORE 
 

For eg., 
 

MORE < STUDENT.TEXT 
 

or 
 

TYPE STUDENT.TXT | MORE 



Move 
 

Type: Internal Command. 
 

Function: The Move Command Moves files from one location to another. This 

command is quite identical to the copy command the only difference being that the 

source files remain intact in the case of the copy command while they are delated 

in the case of the Move command. 
 

Syntax: Move Source:\path\file(s) target:\ path\file(s) 
 

MSAV 
 

Type: External Command. 
 

Function: The MSAV (Microsoft anti-virus) command scans the memory for the 

presence of computer viruses. 
 

Syntax: MSAV drive:\path\switches 
 

NLSFUNC 
 

Type: External Command 
 

Function: The NLSFUNC command when invoked loads national language 

support functions which allows the user to switch to international character set 

tables in RAM. 
 

Syntax: NLSFUNC drive:\path\country file 
 

PATH 
 

Type: Internal Command 
 

Function: The path command searches in a list of subdirctories (specified in its 

syntax) for executable program files. 
 

Syntax: PATH drive:\path1; drive\path2 
 

For Example, 
 

PATH C:\DIR1 ; C:\DIR2 
 

would look for all executable files on DIR1 & DIR2 subdirectories. 
 

PROMPT 
 

Type: Internal Command 



Function: The PROMT Command is used to change the appearance of the Dos 

prompt. 
 

Syntax: PROMPT prompt starting 
 

The prompt may one or a combination of the following. 
 

$ $ Dollar Sign ($) 
 

Sb Piping Symbol (I) 
 

$d Current date 
 

$g Greater than symbol (>) 
 

$\ Less than symbol (<) 
 

$q Equel sign (=) 
 

$t Current time 
 

$v DOS version number 
 

$p Currently logged drive and directory 
 

$n Current drive 
 

$e Escape character 
 

RD 
 

Type: Internal Command 
 

Function: The RD Command is used to remove directories. The directory to be 

removed should be empty. 
 

Syntax: N drive:\path\country file 
 

RMDIR can also be used in place of RD. 
 

Rename or REN 
 

Type: Internal Command. 
 

Function: The REN command is used to change the file names. 
 

Syntax: REN drive:\path\oldfilename drive:\ path\newfilname 
 

RENAME can be used in place of REN. 
 

Replace 
 

Type: External Command. 



Function: The REPLACE command is used to replace and files with new files of 

the same name. This command is used update data files. 
 

Syntax: REPLACE source:\path\file(s) target: \path\switches. 
 

The above statement replaces the files in the target directory with that of the 

source directory. 
 

Sort 
 

Type: Internal Command. 
 

Function: The SORT command sorts data in character based files or sorts the 

output of DOS commands. 
 

Syntax: SORT/Switches < drive:\path\file. 
 

or 
 

Command : SORT/Switches. 
 

for eg. 
 

TYPE STUDENT.TEXT : SORT 
 

TIME  
 

Type: Internal Command. 
 

Function: The TIME command us used to display or change the system time. 
 

Syntax: TIME (displays the current system time) 
 

TIME hh:mm:ss a/p 
 

a & p stand for a.m. or p.m. 
 

TREE 
 

Type: Internal Command. 
 

Function: The TREE command displays the subdirectory structure of a drive. 
 

Syntax: TREE drive:\path/switches. 
 

TYPE 
 

Type: Internal Command. 
 

Function: The TYPE command displays the contents of a file. 
 

Syntax: TYPE drive:\path\file 



The following statement. 
 

TYPE STUDENT.TXT > PRN directs the output to the printer. 
 

UNDELETE  
 

Type: External Command. 
 

Function: As the name suggests the UNDELETE command is used to UNDLETE 

files that have previously is not always successful in recovering the deleted files. 

A file may be undeleted if the disk area it occupied has not been overwritten by 

another file. 
 

Syntax: UNDELETE drive:\path\file(s) /Switches 
 

UNFORMATED  
 

Type: External Command. 
 

Function: The UNFORMAT command is used to recover files which were lost 

when the disk was formatted. 
 

Syntax: UNFORMAT drive:/swithces. 
 

VER 
 

Type: Internal Command. 
 

Function: The VER command displays the version number of DOS. 
 

Syntax: VER. 
 

VOL  
 

Type: Internal Command. 
 

Function: The VOL command displays the volume label of the disk. 
 

Syntax: VOL drive 
 

Not all the commands have been covered, due to the scope of the book. We have 

tried to cover the most commonly used commands. 
 

REVIEW EXERCISES  
 

Multiple Choice Questions 
 

 Which of the following commands is correct if we wish to copy a file named 

ANYFILE in the root directory to a directory named MYDIRECT? 
 

 C:\> Copy anyfile mydirect 



 C:\>copy anyfile \mydirect 
 

 C:\>copy \mydirect anyfile 
 

 C:\>copy anyfile /mydirect 
 
 Formatting of a floppy disk is done by 
 

 physically cutting tracks & sectors 
 

 logically dividing the surface into tracks and sectors through software 
 

 the manufacturer of the floppy 
 

 copying the system files 



 The CONFIG.SYS file is 
 

 a user made file 
 

 a system file 
 

 a file containing application program 
 

 none of these 
 
 Bootstrapping is 
 

 the process of loading the OS programs 
 

 the process of loading OS into the RAM programs into Hard Disk 
 

 the process of copying OS to floppy 
 

 none of these 
 
 Mark True or False 
 

 Renaming a file named ANYFILE to MYFILE can be done by the command  
COPY ANYFILE MYFILE. 

 

ii. Deleting a file named ANYFILE can be done by the command DEL 

ANYFILE. 
 

 The command C:\>Copy *.* A: may not be able to copy all the files in the 

hard disk if the files in the hard disk occupy more than 1.44 MB.  
 DOS always assumes that your computer has 640 KB of memory unless 

and until you tell DOS otherwise.  
 DOS is a multi-user operating system. 

 
 The SCANDISK command checks your computer for viruses. 

 
 Piping is the technique of using the output of a DOS command as the input 

of another DOS command. 
 

 Output redirection to PRN is the only way to print a document in DOS. 



Chapter 11: FEATURES OF THE UNIX OPERATING 

SYSTEM 
 

SALIENT FEATURES  
 

The Unix operating system offers many features. Some of these important features are 

discussed below: 
 

Multi -tasking Capability 
 

This capability allows the operating system to perform several tasks simultaneously. 

For instance, Unix can print one document, edit another and sort a list of files at the 

same time. Multiple tasks can be carried out by placing other tasks in the background 

while you work on one task at a time. The current tasks are said to be in the 

foreground. Normally the tasks that do not require active interaction from the user are 

placed in the background. The more tasks are run in the background, the lower will be 

the system response. 
 

Multi -user Capability 
 

Multi -user operational system permits several users to use the same computer to carry 

out their job. Several terminals are connected to a single powerful computer and each 

user of the terminal can be a programmer, program access files and prints document at 

the same time. Need for the multi-user environment arises when several programmers 

work on developing module of the same software. Multi-user environment ensures 

complete coordination and compatibility and saves a considerable amount of time by 

allowing several users on a set of information at a time. Buying single multi-user 

computer is far more economical and efficient than buying several single users 

computers. 
 

System Portability  
 

The Unix operating system can port itself to another installation without any major 

changes. This ability to adapt itself to different computers has made Unix very 

popular. Unix runs on more brands of computers than any other operating system. 
 

Communications 
 

Unix supports two major types of communication: 
 

 Communication between different terminals connected to the same computer. 
 
 Communication between users of one computer at a specific location to the users of 

another type and size of a computer located elsewhere. The two computers may 



be located in different offices or different countries or continents. These type of 

communication is achieved by a mail system based on wide area and may be 

connected through telephone lines or satellites. 
 

System Security 
 

The user data is highly secure in the Unix operation system. There are several levels of 

security in Unix. The first level is system security. The standard login procedure 

before Unix starts running on the system ensures that not just anybody can start 

running Unix on your system. 
 

The next level of security is incorporated when it comes to accessing files. Three 

permission namely, read, write and execute can be assigned by the owners of file to 

each of his files. All these permissions can be individually cancelled or denied to all 

other users of the system. 
 

The third level of security allows users to encrypt data files on the disk so that even if 

someone does manage to access them he cannot make much sense of it. 
 

 

THE UNIX CONNECTIONS  
 

Unix being a multi-user operating system, has to support a large number of users 

without any bias. This means that Unix has to make the right connections using the 

right priorities and right links. 
 

At the heart of the Unix installation is the host machine. This is the powerful 

computer that can support many terminals. The number of terminals being supported 

is limited by the hardware used and resources available in the host machine. Users are 

connected to the host and are provided with terminals to work on. These terminals 

consist of a keyboard, display along with the associated hardware such as ports and 

cables. A terminal may be connected to the host either directly or through telephone 

lines. There are different types of terminals and modes of connected to the host also 

differ. A few types of terminals that users of Unix often use are: 
 

Dumb Terminals: These terminals consist of minimum components that every 

terminal must possess ï a keyboard and a display. 
 

Intelligent Terminals: These terminals have a mind of their own. They have their own 

memory and a few enhanced features. Yet all the processing and execution of 

programs is carried out only in the host machine. 
 

Terminal Emulation: Terminal emulation allows a PC to act as a terminal. In this case, in 

spite of having a microprocessor the PC performs no processing at all. It transmits its 

processing jobs to the host computer. This PC can be used as a stand-alone computer 



once the Unix session has ended. 
 

Dial-in Terminals: These terminals use telephone lines to communicate with the host. 
 

The Console: The console is connected directly to the host. Every Unix installation 

has only one console which is used by the System Administrator, in order to 

administer the system. 
 

LOGGING INTO THE SYSTEM  
 

In the Unix operating system, the booting or the startup procedure which is explained 

in detail in this module can be done only at the console. No other terminal can be used 

until the console is started. 
 

After switching on your computer (the console), you encounter a 'Login' prompt 

on the screen which is followed by 'password' prompt. 
 

Login 
 

The purpose of this prompt is to identify the user and allow access to the system only 

after verifying the identity of the user. The login prompt requests the user for a name 

or an ñidò which is given to the user by the system administrator. After entering the 

login name the system further requests for a password. 
 

Password 
 

The prompt requires the user to key in the password that he has been assigned or he 

has selected. The password is not echoed on the screen to protect the privacy of the 

user. If the user fails at this stage the Unix session never takes off. The login name and 

password should always be entered in lower case because Unix is case sensitive. All 

the Unix commands are in lower case. 
 

COMPONENTS OF THE UNIX OPERATING SYSTEM  
 

The Unix operating system is functionally classified into the following components: 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 11.1: Components of a Unix Operating System 
 

The Kernel 
 

It is the core or skeleton operating system program. It performs all the low-level jobs 

necessary to control all the tasks and hardware devices, schedule all the processes and 

carries out all the crucial functions of the operating system. All operating systems 

have a kernel that contains many routines to carry many tasks that the operating 

system has to handle. 
 

Utility programs written as software tools perform all other typical operating system 

functions. Use of software tools, instead of a single large operating system program 

distinguishes Unix from other operating systems. What makes the kernel utility structure 

work is the interface to the kernel called the SYSTEM CALL INTERFACE. 
 

A system call is call to an operating system service routine used in the kernel. This 

call can be made in ñCò or Assembly Language program. When you make a system 

call, the portion of kernel with the relevant programming is run. The system calls are 

the basic building blocks upon which Unix commands are based. 
 

The Shell 
 

It is the command interpreter of the operating system. It accept commands from the 

user at the ñ$ò prompt and analyses and interprets these commands. All Unix 

commands are executable C programs. The shell starts executing the appropriate 

executable file and then requests the kernel to carry out the data transfer which finally 

leads to the output that is displayed on the terminal. Hence the shell acts as the 

middleman between the kernel and the user of the operating system. 
 

UNIX TOOLS AND APPLICATIONS  



The outermost layer of the Unix operating system is its Tools and Applications. Tools 

vary from one implementation of Unix to another. Some versions of Unix are decked 

with more than 400 tools. 
 

These tools can be involved from the command line itself and help to perform 

day-to-day as well as complex tasks of the system. Unlike shell and kernel these tools 

are not mandatory. Tools on the other hand, are programs which are not necessary for 

the computers basic operation, but provide significant additional value to Unix when 

available. These tools include many application programs, which may be purchased 

separately, such as electronic spreadsheet and sophisticated word processing packages. 



PROCESS 
 

In Unix, each particular task or program that the kernel is currently undertaking is called 

a process. A process in short is a running program. For example if you are running the 
 

date command, it is one process. If it is run again, it is a new process. 
 

THE UNIX SCHEDULER  
 

The scheduler is a program in the kernel that allows more than one person to use the 

computer at the same time. It shares the computer resources among various users, 

allowing each a small slice of the computerôs processor. This concept is known as 

Time-Sharing. 
 

Let us consider the example of a hotel bearer to understand the concept of Time-

Sharing. Every Hotel Bearer is assigned the job of serving a section, which comprises 

of a certain number of tables. The bearer cannot practically handle all the tables at the 

same time. He instead concentrates on only one party at a time. He task orders from a 

party seated at a table, then moves to another and so on. He thus allots a time slice for 

each table in his section. When it comes to serving, first on the priority list is the party, 

which had placed its order first. Thus time slots are allotted for serving different 

tables. Every party is thus given an impression of being the only party being served, 

because the bearer is available when the need arises. 
 

Similarly, if three people want to run different programs a, b and c, the scheduler 

copies these three programs from the disk and stores them in the computer memory. 

These programs are now referred to as processes. In this way, program is defined as a 

file, which resides on the hard disk, where as a process resides in memory doing things. 
 

The scheduler allows process ñaò to run for a fraction of a second and do a little 

work that it was designed to. After this time slice is over, process ñaò is temporarily 

stopped or suspended, and process ñbò is allowed to run. When the time slice of 

process ñbò is exhausted, process ñcò gets its chance to run. 
 

When each process has had a chance to run for a while, the scheduler comes back 

to process ñaò and starts ñaò where it left off when it was suspended at the end of its 

time slice. The Unix scheduler can keep track of several hundred processes. 
 

The overall effect of timesharing is to give users the impression that they all are 

being served at the same time. 
 

Round Robin Scheduling 
 

Every scheduling uses a different Scheduling Algorithm. One of the oldest, fairest and 

most widely used algorithms is Round Robin. In this algorithm, each process is assigned 



a time interval, called its quantum, which is allowed to run. If the process is still 

running at the end of the quantum, the CPU is preempted and given to another process. 

If the process has blocked or finished before the quantum has elapsed, the CPU 

switching is done. All the scheduler needs to do is to maintain a list of runnable 

processes. When the quantum runs out on a process, it is put on the end of a list. 
 

Swapping 
 

The simple model of scheduling works fine for a few process but sooner or later, all 

the computersô memory gets filled with running processes. At this point, if the user 

wants to run a process, there must be a way out. It is here that the concept of swapping 

comes into picture. In swapping, when memory is full and a new program needs to be 

run, the scheduler copies a process from memory to disk and thus creates space in the 

memory for a new process. It then places a new program in memory and allows it to 

run. Later, the process is copied back to the disk and the process on the disk is copies 

back into memory. 
 

For instance, say there are three processes A, B and C in the memory. Now a 

request is made by a user to run program D. Since there is no space in the memory for 

process D, process A is copied to the disk. After A is copied to the disk, a copy of D is 

then put is memory where A resided. After a few time slices, the scheduler will again 

exchange process A with the process that has been in memory the longest. 
 

DIFFERENT SHELLS USED IN UNIX  
 

There are four shells in Unix out of which three are commonly used: 
 

The Bourne Shell 
 

It is most widely used shell in the Unix world.  It was developed by Steve Bourne of AT 
 

 T Bell Laboratories in the late 1970ôs. It is a primary Unix command interpreter and 
comes with every Unix system. The ñ$ò prompt on the Unix installations is a 

trademark of the Bourne Shell. 
 

The C Shell 
 

Bill Joy created this shell at the University of California at Berkeley. The C shell is the 

default shell in the Berkeley version of Unix. 
 

The Korn Shell 
 

This shell was developed by David Korn of AT & T and was designed to be much 

bigger than the Bourne Shell. It includes all the enhancements available in the C shell 

and offers a few more features which make it more versatile and efficient. It can 

completely replace the Bourne Shell in a system. 



The Restricted Shell 
 

This shell is almost the same as the regular shell but it is designed to restrict the userôs 

capabilities by disallowing certain actions that the standard shell allows. 
 

ENTERING A COMMAND  
 

The appearance of a ñ$ò prompt in Bourne Shell and a ñ%ò prompt in C shell is an 

indication to the user that he can now type in his commands. A command typed at the 

shell prompt asks the Unix system to do something. Letôs start with some simple 

commands: 
 

date 
 

This command tells the Unix system to print the system date and time. Every Unix 

command must be ended with a RETURN. RETURN informs the system that the user 

has finished typing in. 
 

who 
 

This command can be used to get information about all users who are currently logged 

onto the system. 
 

echo 
 

This is a very simple and straightforward command. It displays on the screen whatever 

is typed after the command echo on the command line. 
 

ps 
 

The ps command makes a process status report. Try typing ps at the $ prompt. You 

will get an output that looks something like this : 
 
 
 
 

 

The first column is the process identification number, PID. Each time a process is 

initiated the kernel assigns it a unique PID. This is how the kernel keeps track of different 

processes. In our example the only two processes are ï the shell itself (sh) and the ps 

command. The sh process in this example is called the parent, and the ps process 

spawned by the shell is the child. In the Unix world, a process is said to be ñbornò when 

it starts executing and ñdeadò when it terminates. A new process can be born only if 

another process starts it. The new process is called a ñchildò and the process that starts it 

is called the ñparentò. You can start up a new shell by typing the command sh at the $ 

prompt. The TTY column identifies the terminal or other input device that you are using. 

The TIME column tells how much computer time the process has used so far. The 



command column gives the name of the command corresponding to the process. 



clear 
 

This command will clear the screen and leave no trace of the command you just typed. 
 

THE UNIX FILE SYSTEM  
 

A file system in its simplest form is a collection of files stored on a storage device like 

a disk. Whenever data is to be stored onto the disk it is recorded on a particular section 

of the disk, in a predefined format. It is the operating system which takes care of 

recording files. Generally operating systems have their own ways of organizing data 

for storage. Before a file system can be formed on a disk, the disk storage is logically 

divided into smaller units like sectors or blocks. The first few blocks within a file 

system are used as system blocks or the area is called as system area. This area is 

mainly used by the host operating system to record the information about the file 

system, which is updated from time to time whenever any manipulations are done with 

the files of the file system. The rest of the block storage is used as data area, where the 

files are stored. 



Multiple File Systems 
 

A single disk system may have the disk partitioned into subsections, each 

subsection (or partition) housing a file system. 
 

The entire Unix set of system files which include, the operating system, system 

utilities and system accounting programs etc. use these file system unit called root file 

system. Apart from root file systems, some user file systems can be created on the 

disk. One such file system is created during UNIX installation, which is called user. 

This file system is used to house user files, utilities and libraries etc. 
 

Additional user file systems can also be created, as per the usersô requirement. In 

that case for every file system a new portion will have to be assigned on the disk at the 

time of installation. A user can even create file systems on portable disks like floppies. 
 

Before a file system can be used for any operations, it should be Mounted. 

Mounting involves reading of the system area of that particular file system into the 

memory. After successful mounting, a file system is treated as a directory. The root 

file system is mounted at the time of system start up. All the other file systems are 

treated as sub-directories under the root directory after being mounted. 
 

Visiting a Typical File System 
 

The Unix file system has the following structure: 
 
 

 

 ̧

 

 ̧

 

 ̧

 

The System Area: 
 

Boot block 
 

Super block 
 

Inode block 
 

The Data Area: 
 

 Data blocks 
 

 The Boot block: This block occupies the beginning of a file system, typically the 

first block and contains the boot strap program that is read into the memory during 

booting. The main job of bootstrap program is to load operating system program 

(Unix) from the disk. Every file system has a boot block, but it is only used in the 

root file system. In other file systems this block remains empty, reason being that 

the ROM ï BIOS system start up routine looks for the boot strap program only in 

the boot block of root file system. 
 
 The Super block: The super block follows the boot block. This block contains 



information about that particular file system. This information comprises of: 
 

 ̧

 

 ̧

 

The size of the File System. 
 

The size of the i-list section of the file system which follows the super block. 
 

 The number of unallocated blocks in the data portion of the file system 

which follows the i-list. 
 

 ̧

 

 ̧

 

 ̧

 

The block number of the unallocated blocks. 
 

The last time the super block was written to the disk. 
 

The file system type that tells the size of the logical block in the file system. 
 

 The Inode blocks: The super block is followed by the inode block. Each inode 

block is an array of inode numbers, where each inode defines the properties of a 

file. The system administrator specifies the size of inode list when configuring a 

fi le system. The information in the inode is stored in given format. 
 
 The Data block: They start at the end of the inode list and contain file data and 

administrative data. An allocated data block can belong to one and only one file in 

the file system. The block which are not yet allocated to files also are present here. 
 

The Unix file system is a device independent structure that resembles an upside 

down rooted tree, made from the following types of files: 
 

Ordinary Files 
 

These files contain information stored in some format. 
 

Directory Files 
 

Directory files are modes that tie the file system together. Every file in the Unix file 

system is assigned to a directory. 
 

Fifo Files 
 

These are files that allow unrelated processes to communicate with each other. Fifo 

files are typically used in applications where the communication path is only in one 

direction and where several processes need to communicate with a single process. 

Each process writes a message to the fifo file and the Unix system guarantees that 

each individual message will not be overwritten by messages from other processes. 
 

Special Files 
 

Special files represent physical devices. Every device connected to the computer, for 

example, a printer or a terminal is treated as a file. When the process writes to a 

special file, the data written is sent to the associated physical device. Likewise, when 



process reads from a special file, the data is read from the associated device and 

returned to the process. 
 

THE HIERARCHICAL FILE SYSTEM OF UNIX  
 

The Unix file system begins with a directory called ñrootò. The root directory is 

denoted by a slash (/). From the root originate several directories namely ñbinò, ñetcò, 

ñusrò, ñdevò, ñlibò, ñtmpò and an ordinary file named ñUnixò which is the kernel 

program itself. This is the file which is loaded into memory during system startup. 
 

These directories are called subdirectories of the root and conversely the root 

directory is called the ñparentò directory of these directories. Each subdirectory in turn 

can contain other directories and files, which give rise to the branching, upside down 

tree structure. 
 

/root : 
 

/bin  /etc /dev /usr /lib  /temp 
 

Each subdirectory of the root in the Unix file system is assigned a particular task: 
 

/ : The root directory where all other directories originate. 

/dev : All the device files are kept in this directory. 

/bin : The ñbinò directory contains the executable files for most Unix. 

/etc : It contains a mixture of files and subdirectories. The list of users 

 and groups plus a description of each terminal is in this directory. 

/lib : The ñlibò directory consists of the libraries provided by Unix for 

 programmers. 

/usr : The ñusrò directory contains subdirectory in which the user work 

 area is provided. 

/tmp : The ñtmpò directory is the temporary directory in which most of 

 the temporary files are kept. Files stored in this directory are automatically 

 deleted when the system is shutdown and restarted. 
 

BASIC DIRECTORY COMMANDS  
 

PWD 
 

The command pwd (print working directory) tells you what directory you are in 
 

E.g. $pwd 
 

Output is : /usr/user1 



This command returns the pathname of current directory. The/denotes the root 

directory of the Unix file system. Within the root directory is a subdirectory called usr, 

within which there is another directory called user1 that is where we are now. 
 

After logging in , user is taken into his own directory called HOME directory. 

HOME directory is assigned to each user of the system. It is the userôs authorized 

workplace. 
 

mkdir  
 

To create a directory, Unix provides a mkdir command, which is a mnemonic for 

ñmake directoryò. At the shell prompt, type the command 
 

$ mkdir dirname 
 

rmdir  
 

A directory can be removed using the rmdir command, which is a mnemonic for 

ñremove directoryò. At the shell prompt, type the command 
 

$rmdir dirname 
 

cd 
 

When a user creates a directory, he would obviously like to change to the directory. 

The user can change to the given directory by typing in the following command at the 

shell prompt 
 

$ cd dirname 



BASIC FILE COMM ANDS 
 

ls 
 

The command ls lists the file in the directory. The command ls with no argument, lists 

the contents of your current directory as shown below: 
 

$ls 
 

Output is: abc 
 

report1 
 

report2 
 

We can get a detailed information by adding arguments to the ls command. For 

example, the option l, when added, gives the following results: 
 

$ls -l 
 

Output is : total 6 
 

drwxv-xðx 3 user1 group 80 Sept 20 18:11 abc 

-rw-rðrð 1 user1 group 110 Sept 1 2:11 report1 

-rw-rðrð 1 user1 group 32 Aug 1 9:45 report2 
 

The first line of the display is a count of the total number of blocks of storage that 

the listed files use. The first character on each line indicates the type of file. 
 

 : directory 
 

-: ordinary 
 

b,c,p : special 
 

The next nine characters on the line are how every user on the system can access 

the file. These access modes apply to the file owner (the first three characters), other 

users in the same group (the next three characters) and finally to all other users of the 

system (the last three characters). 
 

There are three different access modes: 
 

ñrò for read 
 

ñwò for write 
 

ñxò for execute 
 

The next entry gives the number of links to the existing file. The two successive 



entries on the right are the names of the user and group respectively. These are 

followed by the size of the file in bytes. The date and time when the file was last 

changed comes next and the entry on the extreme right is the name of the file. 
 

cat 
 

Letôs create a file on the system. Call the file ñfirstò and store the given text exactly as 

shown: 
 

$cat > first 
 

I am enjoying doing Unix. 
 

Unix is a wonderful OS. 
 

Ctrl-d (ctrl and d keys pressed simultaneously). 
 

$ 
 

This sequence creates a file called ñfirstò containing the two lines. We can 

examine the contents of the file by using the cat command. The argument to the cat 

command is the name of the file whose contents have to be examined. 
 

$ cat first 
 

Output is : I am enjoying doing Unix. 
 

Unix is a wonderful OS. 
 

$ 



rm 
 

No system that allows us to create files would be complete without a command that 

also allows removing a file. Under the Unix system this command is called ñrmò. The 

name of the file(s) to be removed : 
 

$ rm first 
 

cp 
 

In order to make a copy of a file the ñcpò command is used. The first argument to the 

command is the name of the file to be copied (known as the same file), and the second 

argument is the name of the file to place the copy into. We can make a copy of the file 

ñfirstò and call it ñsecondò as follows: 
 

$cp first second 
 

mv 
 

We sometimes need to change the name of a file. This is accomplished easily with the 

mv command. The argument to the ñmvò command follows the same format as the 

ñcpò command. The first argument is the name of the file to be renamed, and the 

second argument is the new name. So, to change the name of the file ñfirstò to ñthirdò, 

the following command is executed: 
 

$mv first third 
 

chmod 
 

This command alters the modes of the indicated files and directories. A file mode, as 

discussed earlier, specifies who has to read, write and execute permissions. ñchmodò 

sets permissions separately for each class of users, i.e. the user, group and others. 
 

$chmod 777 first 
 

The file permissions are described by a three digit octal number such as 

777,711,536, etc. 
 

where, 1 is for execute 
 

2 is for write 
 

4 is for read 
 

777 means it is read, write and execute for owner, group and world. Here 7 means 

4+2+1 i.e. read, write and execute. 



THE UNIX EDITOR  
 

In an operating system, an editor assumes a good amount of importance; it is the 

ultimate authority which helps create and modify user files and data. Hence, when you 

begin a new operating system, it is a good rule to get familiarized with the editor, so 

that creating and modifying files becomes an effortless process. 
 

An ASCII text file, such as a document or a program may be created or modified 

using a text editor. There are two text editors available under the Unix operating 

system: vi and ed. 
 

Ed is merely a line editor like edlin in DOS. Being a line editor, ed however, limits 

the user options because he can work only on one line at a time. We therefore, take a 

plunge into the vi editor straightaway. 
 

As a matter of saying, vi stands for ñvisualò. Creating a file becomes a lot easier 

with the vi editor. Vi was the first full screen editor that allowed the user to view the 

entire document at the same time instead of navigating line by line. 
 

Vi was created and written at the University of California at Berkeley by a man 

known as the ñjoy of Unixò, Bill Joy who is also one of the cofounders of the Sun 

Microsystems. 
 

The vi editor can be invoked in different ways. A few of these are as shown below: 
 

Vi : edits an empty editing buffer. 
 

Vi name: edits a file with a specified name. 
 

Vi+3 name: opens a file with a specified name and goes to the third line in the file. 
 

Vi +/bye name : searches for the first occurrence of ñbyeò in the file. 
 

Modes of Operation of the VI Editor 
 

Vi works in three basic modes of operation: 
 

Command Mode 
 

In the command mode, all the keys pressed by the user are interpreted to be editor 

commands. No text is displayed on the screen in this mode, even if the key is pressed 

on the keyboard. 
 

Insert Mode 
 

A user can enter the insert mode by typing any of the VI insert, append, open, substitute, 

change or replace commands. Once the vi editor is in the insert mode, letters typed in at 



the keyboard are echoed in the editing buffer. 
 

The Escape Colon Mode 
 

It is also known as the ex escape mode. Ex has single line commands that are 

terminated with the ñReturnò key. Vi however, has commands which can be invoked 

with the press of a single key. 
 

The bottom line of the vi screen is called the command line. Vi uses the command 

line to display messages and commands. When the user enters the escape colon mode, 

the command typed in is echoed at the command line at the bottom of the vi screen. 

There are no error messages in vi. Whenever the user makes a mistake, vi emits a 

meek beep in protest. 
 

Important keys in the VI Editor  
 

ñEscò: This key returns vi to the command mode. 
 

ñReturnò: It executes commands entered in the ñex Escapeñ mode and starts a new 

line in the insert mode. In the command mode, it simply takes the cursor to the next line. 
 

ñ/ò: It is used to specify the string to be searched in the existing file. The string 

appears on the status line following the ñ/ò character which echoed at the beginning of 

the command line. 
 

ñ?ò : When this key is used instead of ñ/ò, the search for the string proceeds in the 

backward direction. 
 

ñh or Backspaceò: Left cursor movement. 
 

ñl or Spacebarò: Right cursor movement. 
 

ñj or + or Returnò: Down cursor movement. 
 

ñk or -ò: Up cursor movement. 
 

ñ#wò: Move forward a word. 
 

ñ#eò: Takes you to the last character of the word. 
 

ñ#bò: Move back a word. 
 

ño or ^ò: Move to the beginning of a line. 
 

ñ#$ò: Take to the end of a line. 
 

ñCtrl fò: To move a screen forward. The last two lines of the previous screen are 

displayed to maintain continuity. 
 

ñCtrl bò: To move a screen backward.  The last two lines of the previous screen are 



displayed to maintain continuity. 
 

ñCtrl R or Ctrl Lò: To redraw the original screen and clear any error messages that 

vi has displayed or even the system messages that appear on the screen. 
 

ñCtrl Gò: Displays the status on the status line. It displays the name of the file that 

is being edited, the current line number, the number of lines in the file and the 

percentage of the file (in lines) that precedes the cursor. 
 

ñIò: I makes the insertion mode. Text is inserted at the current cursor position. 
 

ñOò: O makes the insertion mode by opening a blank line above the current line. 
 

ñJò: To join two lines of text in a file, position the cursor at the end of the line and 

press J. This command causes the line below the current line to join with the current 

line. 
 

ñ#xò: Deletes the character at the cursor position. 
 

ñ#ddò: Deletes the current line where the cursor is positioned. 
 

ñ#dwò: Deletes the word from the cursor position to the end of the line. 
 

ñ:q!ò: Quit from vi editor and abandon changes. 
 

ñ:wqò: Quit and write changes to file. 
 

COMMUNICATING WITH OTHER USERS  
 

Unix has state-of-the-art communication utilities that added some life to this otherwise 

block and desolate Operating System. It is like a joyride that will make life in Unix for 

more pleasant and enjoyable. 
 

The ñMesgò Command 
 

The information displayed on the terminal comes from a ñttyò file is the/dev directory. 

If a message is to be sent to another usersô terminal, it implies that the message is to be 

written to his terminal file. This requires that a write permission be assigned to the 

terminal file for which, you have to be a superuser first. 
 

All these problems can be avoided by using the ñmesgò command to set the 

terminal to receive messages from other users. For example, if you are expecting from 

some other user, use: 
 

$ mesg y 
 

This command will alter the mode of your terminal file, so that messages from other, 

users can be written onto your file. Setting a write permission to your terminal can also 

be very annoying at times. For example, when you are editing an important file in VI, 



and some else writes on your screen, it is quite disgusting. This permission can be set 

off by using the command. 
 

$ mesg n 
 

Now all the other users except for the superuser will be denied permission to write 

to your terminal. 
 

The ñWriteò Command 
 

This is an easy way to communicate with other users who are logged in at the 

same time as you provided the terminal files are granted ñwriteò permission. The 

syntax of the write command is as follows: 
 

$ write user [tty] 
 

User is the logname of the user you want to communicate with. The óttyô number 

is optional, so long as the user with that logname is logged onto only one terminal. To 

communicate with a user with logname ñbb8ò, the command is: 
 

$ write bb8 
 

I will meet you tomorrow at 10 : 30. 
 

ðð user 

1 (Ctrl ï d) 

$ 
 

The user bb8 will hear a beep on his/her, terminal followed by the display of the 

message. 
 

The ñnewsò command 
 

It permits users to read messages published by the System Administrator. The 

important news is saved as a file in the /usr/news directory so that it may be available 

to all users. To see any messages that the System Administrator has typed, use: 
 

$ news 
 

The news appears here. 
 

Mail : The heart of Unix Communication 
 

Mail in the computer world, refers to textual information that can be electronically 

conveyed from one user of the system to another. A portion of mail that was sent or 

received at one stretch is referred to as a message which may be a single line of text or 

a program containing several hundred lines of code. The conventional mail system of 

Unix accepts only textual ASCII files that are acceptable to standard editors. Binary 



files, executable files and other special files cannot be sent. 
 

There are two forms of the mail command. The first form sends mail to users with 

the indicated login names. The second form reads mail sent to you. Just as a postman 

drops all the mail in your mail box, all incoming mail in Unix is stored in a file in the 

/usr/mail directory, with one file for each user. 
 

To send mail to other users, the format of the command is: 
 

$ mail name (s) 
 

where names are the login names of the users. Now, type your message 

terminating it by typing (Ctrl ïd). Instead of typing your message, you can also use 

redirection to send input from a file, as in 
 

mail user 1 < new infor 
 

Redirection 
 

Redirection changes the assignments for standard input and standard output. That is, 

whenever data is to be read in from a file other than the standard input or sent to a file 

other than standard output, Redirection is used. It is always specified on the command 

line and is handled by the shell. Redirection is further classified into input and output 

redirection. 
 

Under the Unix system, the output from a command intended for standard output 

or monitor (stdout) can be diverted to a file. This capability is known as output 

redirection. The operator used for output redirection is shown below: 
 

 :This operator makes the filename following it, become the new standard output. 
 

 

Eg. Cat file1 file2 >file3 
 

The operator > declares file3 to be the standard output. Thus the output produced 

by cat is sent to file3 and not to the screen. If a file with the name ñfile3ò already 

exists, it is over written with the new data, otherwise, it is created. 
 

Now, letôs take a look at input redirection. Just as the output of a command is 

redirected to a file, the input for a command can be redirected from a file. The 

operator used for input redirection is described below: 
 

< : This operator makes the files following it, the new standard input. 
 

Only the commands, that normally take their input from the standard input, can 

have their input redirected from a file in this manner. 
 

Eg. $ cat < example 



C++ is more powerful than C language 
 

$ 
 

The file ñexampleò became the standard input and its contents were reported to the 

screen by cat. 
 

Pipes 
 

The Pipe is one of the most important tools available in the Unix Operating System. A 

Pipe is a mechanism by which, the standard output of one program or command can 

be channeled into the standard input of another program or command. 
 

A pipe can be made between any two commands or programs under the Unix 

system, provided the first writes its output to the standard output and the second reads 

its input from standard input. 
 

FILTERS  
 

Many Unix commands are designed as filters. A filter is a program that can take a 

flow of data from standard input, process or filter it, and send the result to the standard 

output in a particular format. The use of filters makes connecting the commands a very 

natural process. 
 

wx 
 

Counts lines, words and characters 
 

This command is used to count the lines, words or characters in the file. 
 

The syntax is: 
 

Wx - [option (s)] [filename(s)] 
 

Option Action 

-l count lines 

-w count words 

-c count characters 
 

pg 
 

The paginator 
 

This filter is a paginator that allows you to view one screenful at a time. The pg 

command displays a prompt that pauses for the user to strike the ñenterò key to 

continue scrolling. At the End of the File, it displays ñ(EOF):ò and waits for the user 

to terminate the process by striking the ñenterò key. 



grep 
 

Global regular expression printer. 
 

This command is used to search and print specified patterns from a file or the standard 

input. The word ñglobalò specifies that the entire file or standard input is scanned to 

search for the pattern. The term ñregular expressionò specifies that meta-characters can 

also be used to facilitate pattern searching. And finally, the word ñprintò suggests that the 

lines that contain the pattern will be displayed on the standard output. The syntax is 
 

 grep pattern 

filename E.g. $cat 

data canada 
 

china 

argentina 

india 

japan 

Lets say the pattern ñinò is to be searched in the file. The command and output 

will be follows: 
 

$grep in data 
 

china 
 

argentina 
 

india 
 

tr  
 

Character transliteration 
 

tr replaces characters in one list with the corresponding characters in the second 
 

list. 
 

E.g. $ cat data 
 

canada 
 

china 
 

argentina 
 

india 
 

japan 
 

Now let us replace character ñnò by ñ#ò and character ñIò by ñ%ò. 
 

$ tr in % # data 



ca#ada 
 

ch%#a 
 

arge#t%#a 
 

%#d%a 
 

japa# 
 

Sort 
 

The sort command sorts and merges files. 
 

E.g. $ sort file1 file2 >file3 
 

The contents of file1 and file2 are merged, sorted and redirected to file3. 
 

cut 
 

This command is used to cut out selected fields from a file and display them. It is useful 

with documents like financial reports and statements that contain data in a tabular format. 

Two formats can be used with the cut command. Fields can be cut by specifying the 

number of columns or by specifying the number of fields using a delimiter. 
 

The syntax is: 
 

 cut option file-name 
 

OptionAction 
 

-clist 
 

passes the columns indicated by list. For example, -c10-15 means 

ñpass columns 10 thru 15ò. no spaces are allowed in typing the 

option. 
 

-flist 
 

passes the fields indicated by list. 
 

-f1, 3 means ñpass fields 1 and 
 

3ò. 
 

Paste 
 

The paste command merges the contents of multiple files and displays them side by 

side on the screen. This filter is useful to generate output in a columnar format. The 

syntax is: 
 

$ paste option filename 
 

WORKING WITH THE BOURNE SHELL  
 

Shell Environment 
 

Each process in the Unix system has available to it, an array of strings called the 



Environment. The Shell Environment is defined as a set of parameters which affects the 

functioning of a shell. Whenever you log onto your system, you are given your own copy 

of the shell. You are set up in your own little world known as your environment. 
 

Most computer languages have variable and so does the shell. Shell variables 

come in two variables namely: 
 

Common Environment Parameters or System Shell Variables: 
 

The shell maintains itôs own set of shell variables. Your own system may add to or 

subtract from this list. Here the some standard shell variables found on many systems: 
 

 Home: 
 

Home is an environmental variable, that is already defined to contain the path for 

your HOME directory. When you simply type the command 
 

$ cd 
 

the value of HOME is appended to this command and you are automatically taken 

back to your HOME directory. 
 

 pwd 

/usr/ashish 

Try printing the value of this variable at your terminal and see what 

happens: $ echo $HOME 

/usr/ashish 
 

$ 
 

 PATH: 
 

This variable names the directories that the shell has to search to find the 

commands that you execute. When you log in, your PATH variable is set to some 

default value. See what it is set to now: 
 

 echo $PATH 
 

:/bin: /usr/bin 
 

$ 
 

It contains a list of all directories that will be searched whenever you type in the 

name of the program to be executed. It also specifies the order in which the search will 

be performed. The directories listed in the PATH variable will be searched by the shell 

from left to right. A colon (:) separates one path from the next is the list. A colon at the 

start of the list means that the current directory is to be searched first. 



The value of the PATH variable above indicates that three directories are to be 

searched whenever a command or program is to be executed: first the current directory, 

then the directory /bin and finally the directory /usr/bin. As soon as the shell finds the 

program in one of these directories, it executes it. For example, if you give the command 

ócatô, the shell first searches your current directory for an executable file named ócatô. If it 

does not find one there, then it searches in /bin. If it still hasnôt found cat, it looks in 

/usr/bin. If cat is still not found, the shell reports back that it cannot find the command. 

This particular sequence means that, if you have an executable file in your current 

working directory, that cat is executed rather than the standard system cat. 
 

 MAIL: 
 

This variable defines the path and the name of the file in which the user's mail 

should be stored. In other words, the value of this variable is the name of the directory 

in which the electronic mail addressed to you is placed. The shell checks this directory 

very often and when something new is found, you are notified that new mail has 

arrived for you. 
 

 LOGNAME: 
 

This variable contains the usersô login name which was assigned to the user when 

his account was created on the system. 
 

User ï defined Parameters or Shell Variables 
 

A shell variable can be created by typing the following form of command at the 

shell prompt: 
 

$ x = 10 
 

Local and Global Shell Variables 
 

Ordinarily, any shell variable is known only to the shell to which it is a created. It is 

hence a local variable. This implies that whenever you start a new shell, the new shell 

is ignorant of the old shell's variables. It is often required that the new shell knows 

about the variables of the old shell. This can be accomplished by using the export 

command. Any shell variable used as an argument for this command, will have copies 

of the variable and its value presented to all shells descending from it. This kind of 

variable is called as a global variable. Subsequently, the value of the copy can be 

changed, but when the subshell dies, so does the variable. To find what variables are 

already exported, type export without any argument. 
 

Modes of Command Interpretation 
 

The modes of command interpretation in Unix can be classified as follows 



 The Interactive Mode 
 

An Interactive program user for input by asking a question and then reads the 

userôs answer. The shell is an interactive program, it prompts with $ and reads the 

commands you type at the command line. The command line approach or the 

interactive mode is powerful and flexible but not exactly user-friendly. In this 

approach, the script accepts arguments from the command line. These arguments come 

directly after a command name. Most Unix commands works this way. In cat names, 

names is a command line argument which tells cat which file to process. 
 

 The Batch Mode 
 

In this mode of command Interpretation is through shell scripts. In this approach, 

the user writes an interactive script that requests the information it needs from the 

user. The interactive shell scripts are based on the UNIX shell commands read and 

echo and shell variables. 
 

SHELL PROGRAMMING  
 

The kernel is the heart of Unix operating system. It is the master program which controls 

the computer resources allotting them to different users and to different tasks. However, 

kernel does not directly deal with the user. Instead, it starts up a separate interactive 

program, called shell, for each user when he logs in. The shell then acts as an interface 

between the user and the system. In its role as command interpreter, the shell takes in a 

command and sets it up for execution. But it is the kernel which decides exactly when 

each requested program is to be run by looking in to the demands of the different shell 

users. The shell and the kernel work together to provide Unix services. In fact only one 

process goes on as the processor is so fast that it can switch from one process to another 

dedicating itself to one process at a time. This gives an illusion of simultaneous action. 



Characteristic of the Shell 
 

Acts as interface to the Unix operating system. 
 

Acts as a command interpreter. 
 

Provides a programming language with concise but powerful syntax. 
 

Standard I/o can be redirected to files. 
 

Process can communicate through pipes. 
 

What Makes Shell Powerful as a Programming Language 
 

Shell scripts can take arguments like most commands. These arguments can be 

symbolically represented with the script. Thus, we can provide values, filenames and 

the like to be used as arguments for commands inside the script. 
 

The shell allows us to create shell variables and allows us to assign values to them. 

They can be used by shell scripts for many purposes. Most important of all, it provides 

control structures such as if ..else constructs and for loops which are very much 

similar to any other programming language. 
 

A shell script built upon standard Unix commands is highly portable from one 

Unix system to another. Scripts take up very little space. 
 

SHELL META -CHARACTERS 
 

File name expansion is the ability to expand shorthand notation for groups of filenames to 

a complete set of explicit filenames. The shell uses a set of special characters called 

metacharacters to produce patterns to match various classes of filenames. 
 

ó*ô : This metacharacter stands for any combination of one or more Characters 
 

E.g. $ls s*n 
 

Output is : sun 
 

Sin 
 

Son 
 

Seen 
 

S*n stands for all filenames beginning with ósô and ending within ónô. If there are 

files whose names are sun, sin, son, seen, etc. then, on giving the above command, you 

will see the names displayed as above. 
 

ó[]ô : This metacharacter lets you choose one character out of a range of characters 



enclosed within the square brackets. 
 

E.g. $ ls d[io]g 
 

Output is : dog 
 

Dig 
 

D[io]g refers to the names of all files which start with d, end with g and have 

either i or o at the second position in the name. 
 

SHELL VARIABLES  
 

A variable is a name associated with a value. It offers a symbolic way to represent and 

manipulate data. Two of shell variables are: 
 

User Created Shell Variables 
 

E.g. $bookname=oracle 
 

$weight = 72 
 

So, above are created two variables, bookname and weight with values ñoracleò 

and ñ72ò stored in them. 



System Shell Variables 
 

The system maintains its own set of shell variables. Some standard shell variables are: 
 

HOME : to set pathname of your home directory. 
 

LOGNAME : the user login name. 
 

MAIL : this variable value is the name of the directory in which the electronic 

mail addressed to you is placed. 
 

PATH : this is the name of the directories, which the shell will search to find the 

commands that you use. 
 

Shell Scripts 
 

It can be created by placing Unix commands into a text file. This can be executed by 

typing sh followed by the filename. 
 

E.g. Let us consider a file named ex1 which contains the following three commands: 
 

Exe1: example of shell script 
 

Ls 
 

Cat file1 
 

Cp file1 file2 
 

The command ñ$sh exe1ò will run the shell script. As a result of execution of the 

commands in the file exe1 we get a list of files in the current directory (because of ls). 

This is followed by contents of file file1 (cat file1) followed by contents of file file1 

being copied to file2. 
 

Interactive Shell Scripts 
 

Interactive shell commands are based on the Unix shell commands read, echo and on 

using shell variables. 
 

E.g. Consider the file named exe2 containing the following lines. 
 

#exe2: interactive script 
 

echo enter your name \? 
 

Read name 
 

Echo glad to meet you, $name 
 

The command ñ$sh exe2ò will respond: enter your name? 



Peter (userôs response) 
 

Glad to meet you peter. 
 

In the script, the ó\ô is used to remove the special meaning of ?, the read statement 

assigns your typed input to the variable name. The echo $name command, causes this 

value to be printed out. 
 

Shell Scripts Arguments: Positional Parameters 
 

Consider the example 
 

$ cp file1 file2 
 

Here file1 and file2 are first and second arguments to the command ócpô. Similarly 

in a script, arguments may be used. They are referred as $1, $2, $3 and so on for the 

first, second arguments respectively. The special argument $0 means the command or 

the script itself. 
 

S* 
 

Stands for all arguments from $1 up 
 

S# 
 

parameters 

 

Stands for the total no of arguments. $1, $2 etc. are called positional 

 

 ̧

 

Set 
 

This command is used to assign values to positional parameters. 
 

E.g. 
 

$ set one two three 
 

$ echo $2 $1 
 

Output is : two one 
 

In the above example, by giving the first command we are assigning the values 

óoneô, ótwoô, óthreeô to the first, second and third positional parameters. The second 

command echoes the values stored in the second and first positional parameters. 
 

 ̧ Command Substitution 
 

 echo 

date date 

$ set ódateô 
 

Sat Oct 23 10:47.31 IST 1999 
 

Set is often used in conjunction with metacharacter ó (Back quote). When a 

command is enclosed in back quotes the command is substituted by the output of it. 

This is called command substitution. 



Special Command Line Characters 
 

Word Separator 
 

These are characters used to separate one word from the other. Normally these are 

space, tab and new line character. IFS is the internal field separator. 
 

If you give the command 
 

 IFS = Q <CR> 
 

then a command 
 

$cp defoe friend 

<CR> would look like 

 cp Qdefoe Qfriend <CR> 
 

The space between the words is substituted with the IFS. 
 

Sequential Commands: 
 

Semicolon (;) is used to separate commands in a line. 
 

Eg. $ cat file; cp file1 file2; mv file2 file3 
 

The three commands in the line are separated from one another by ó ; ô 
 

Background Process 
 

When a job is run in the background the process is launched and control returns to the 

shell immediately. 
 

 spell story story.spell R 

Output is : 4562 
 

This tells the job has been launched is the background and it has been given a 

process Identify No 4562. The result of execution will be redirected to the file 

story.spell. This leaves your terminal free for any foreground processing. Had we not 

used the redirection symbol to route the results of the background processing to the 

file names story.spell then they would have flooded your screen since your screen is 

the standard output for background processes also (may be you were in the middle of a 

heavy editing task and you would not want to be disturbed). 
 

Command Grouping 
 

Parenthesis are used to group more than one commands together. 



Eg. $ (date; cat results) >data <CR> 
 

And 
 

$ date; Cat results >data <CR> 
 

The above two commands are not the same. The second command may be 

interpreted as a series of two commands like: 
 

$ data <CR> 
 

$ Cat results < data <CR> 
 

In the first case, the result of execution of the, ódateô command as well as ócat 

resultsô will be redirected to the file named data. Where as in the second command, 

only the result of executing ócat resultsô will be redirected to the file named data. 
 

Redirection : Standard Error, 2>, >& 
 

The standard error is the terminal. It can be redirected to a file by preceding the name 

of the destination file with 2. 
 

0, 1, 2 are file descriptors assigned by the system to standard input, standard 

output and standard error. 
 

Eg. $ cp file1 file2 <CR> 
 

Output is : cp : Cannot open file1. 
 

Here we got the error message on our terminal. 
 

If we give the command as follows order to redirect the error message to a file 

named err: 
 

$ cp file 1 file2 2>err <CR> 
 

Then, seeing the contents of file named err will show the same error message that 

we had seen on our standard terminal. 
 

$ cat err <CR> 
 

Output is : Cannot open file file1 
 

Standard error redirection are applied mostly in background jobs. We can give for 

example 
 

$ sort data file >sorted 2 >sorterr & <CR> 
 

Here we have given the command to sort a huge data file and to store the sorted 

output on a file named sorted and any error messages or errors in another file named 

sorterr. We are fixing the job in the background since it is a huge file and it may take 



long time. 
 

To redirect the standard output as well as the standard error to the some file we can 
 

use. 
 

2 >1 or 1 >2 

 

Conditional Execution : && and ||: 
 

These symbols are used to execute a command based on the condition that some other 

command has failed or succeeded. 
 

&&  : To execute the second part of a sequence of commands only if the first part 

succeeds. 
 

|| 
 

: 
 

first part fails. 

 

To execute the second part of a sequence of commands only if the 

 

Every Unix command provides on exit status which is: 
 

0 
 

: 
 

If the command runs successfully without any error. 
 

Non zero value 
 

: 
 

If the command goes wrong. 
 

Eg. $ grep rose flowers && echo beautiful flowers !! 

<CR> $ grep rose flowers || echo no rose !! <CR> 
 

The first example tells that if grep finds a string óroseô in the file flowers then the 

echo command following it is executed and you see óbeautiful flowersô. The second 

example tells that the grep command tries to find the string rose in the file flowers. If 

it does not find (i.e. its exit status is non zero) then the following command is executed 

and you see óno roseô. 
 

Command Terminators 
 

The following are used as command terminators: 
 

Ą newline <CR> 
 

Ą ; 
 

Ą & 
 

eg. $ cd work; ls ïl <CR> 
 

$ spell book >sp & ed opera <CR> 
 

In the first command line, the first command is terminated by ó;ô and the second 

command is terminated by a new line character which is <CR>. 



In the second command line, the first command is terminated by firing the job in 

the background (the command preceding the ó&ô) and the file named 'opera' is opened 

for editing. (The first command is terminated with an ó&ô and the second command is 

terminated with a new line character). 
 

Special Shell Variables 
 

$# : the no of positioned parameter 

$? : the exit status of last command executed 

$$ : the process no. of the current shell 

$! : the process no. of the last background job 

$0 : the name of the command being executed 

$* : list of positioned parameters 

$- : shell options 

 eg. $date >> datelog <CR> 

  $ echo $? <CR> 
 

Output is: 0 
 

The above command appends the result of execution of the ódateô command to the 

file named datelog. The second of the above command echoes back the exit status of 

the first command, which is '0' i.e. it was successful. 
 

Eg. $ date >> datelog & <CR> 
 

Output is: 4321 
 

 echo $! <CR> 
 

Output is : 4321 
 

Here the date command is executed in the background. The second command 

gives back the PID no of the last job executed in the background which is 4321. 
 

Looping 
 

The significant aspect of shell as a programming language is its ability to control flow 

of a program. 
 

For loop 
 

A loop in programming device that lets cycle through the same steps several times. 
 

General format: 



For variable in value1 value2¼. 
 

Do 
 

Commands 
 

Done 
 

E.g. Consider the script exe3 containing the following lines: 
 

For I in 1 2 3 
 

Do 
 

Echo $I 
 

Done 
 

$sh exe3 
 

output is : 1 
 

2 
 

3 
 

While Loop 
 

Unlike the for loop which executes for a list of values until it is exhausted, the while-

until loops execute until the control command fails. During each loop the control 

command is first executed. If it succeeds (returns 0 exit status), then the commands 

between do and done are executed. This goes on until the command returns a non-zero 

exit status. 
 

Syntax of while loop: 
 

While condition 
 

Do 
 

Commands 
 

Done 
 

Until Loop 
 

This is similar to while loop. But the sequence of commands between do and done 

here are executed as long as the control command is not true (has a non-zero exit 

status). When it attains a zero exit status, the loop terminates. 
 

Syntax of until loop is: 
 

Until condition  

Do 
 

Commands 
 

Done 



Case Statement 
 

The case statement lets a shell script choose from a list of alternatives. General format 

is: 
 

Case value in 
 

Choice 1 command;; 
 

Choice 2 command;; 
 

Choice 3 command;; 
 

Esac; 
 

If the variable has the same value as choice 1 then the commands following choice 1 

are executed. If it is the same as choice 2 then those following it are executed and so on. 



Conditional Statement 
 

The if Statement 
 

The if statement is concerned with the status of commands like while and until. 
 

The syntax is: 
 

If control command 
 

Then 
 

Commands 
 

Fi 
 

First the control command is executed. If it has a zero exit status i.e. it is 

successful then the commands between then and fi are executed. The words if, then 

and fi must come at the beginning of a command line or just after a semicolon. 
 

IF..THEN..EL SE 
 

The syntax is : 
 

if control command 
 

then 
 

commands 
 

else 
 

commands 
 

fi  
 

If the control command has a zero exit status then commands following ñthenò are 

executed, else if it has a non zero exit status then commands following ñelseò are 

executed. 
 

The Test Command 
 

Supposing we want to know whether an argument is a file or a directory, or whether a 

script has got the right no. of arguments or whether the correct code word has been 

entered or not. For this we use the Test Command. 
 

Eg. Suppose we want to see if a shell variable called name has value robin, we test 

for equality by using text command. 
 

$ name = robin <CR> 
 

$ test $ name = robin <CR> 



Here the test command although did not produce any output it has produced an exit 

status. The test command produces a '0' exit status if it is successful and '1' if it is 

unsuccessful. If we give the command to know the exit status of the previous command. 
 

$$? <CR> 
 

Output is : 0 
 

Eg. Consider the script test sc containing the following lines: 
 

# testsc : test statement 
 

echo what is the best operating system \? 
 

read OS 
 

if test $OS = unix 
 

echo it is correct 
 

else 
 

echo who said that \? 
 

fi  
 

Eg. Consider the script inpass6 containing the following lines. 
 

Inpass6 : Checks password file for login and failing that checks the group 
 

file. 
 

 = /dev/null 

for name in 

$@ do 
 

if test ógrep $name /etc/group >$BB2 >$BBô 
 

then 
 

echo $name is in group file elif test ógrep $name /etc/ password >$BB2 >$BBô 
 

then 
 

echo $name is in password file 
 

else 
 

echo $name is not in either 
 

echo password or group file 
 

fi  



exit 0 
 

$ chmod u + x inpass6 <CR> 
 

 inpass6 user1 user2 user3 

<CR> User1 is in the group file 

User2 is in the password file 

User3 is in the password file 
 

Here ótestô returns true if grep return true, or false if grep returns false. If grep 

returns true for sawita, then test returns true. Hence the command following it will get 

executed. 
 

 

Whether a file has read, write or execute permission, whether it is a directory, if it 

exists, all these can be checked by the test command with appropriate options. 
 

-r file : If the file exists and readable. 
 

-w file : If the file exists and writable. 
 

-x file : If the file exists and executable. 
 

-d file : If the file exists and is a directory 
 

-s file : If the file exists and has size greater than 0. 
 

Eg. Suppose we want to find out whether we have permission to change file or not. 
 

 test ïw wfile <CR> 
 

 echo $? <CR> 
 

Output is : 0 
 

String Checking 
 

Suppose we want to compare two strings, then it can be done in this way : 
 

String1=string2 true if string1 is equal to string2. 
 

String1!=string2 true if string1 is not equal to string2. 
 

Numerical Comparisons 
 

N1-eq n2 ( n1 equal to n2) 
 

N1-ne n2 ( n1 not equal to n2) 
 

N1-gt n2 ( n1 greater than n2) 



N1-lt n2 (n1 less than n2) 
 

N1-ge n2 ( n1 greater than or equal to n2) 
 

N1-le n2 ( n1 less than or equal to n2) 
 

Logical Operator 
 

 negates the following 

expression -a binary and operator 

-o binary or operator 
 

Using Arithmetic Computations: Expr 
 

To find the sum of two numbers 
 

E.g. $ expr 5 + 6 
 

11 
 

$expr 12/6 
 

2 
 

$expr 4-1 
 

3 
 

UNIX SYSTEM ADMINISTRATION  
 

Under normal conditions Unix system does not require much attention, but for security 

reasons certain jobs like maintaining user accounts, installing software, system startup 

and shutdown, cannot be automated. Also, under certain abnormal conditions, system 

may crash due to faulty hardware, runaway user programs, faulty disk etc. In such cases, 

some administrative commands are available to aid the system administrator. 
 

Some of the responsibilities of a system administrator are: 
 

System startup and shutdown 
 

Maintaining file systems 
 

Taking regular backups 
 

Disk usage maintenance 
 

Adding and removing users 
 

System security. 
 

For accomplishing all the above functions many system administration commands 



are available with the Unix system. Most of these commands are run by a special user 

knows as ósuperuserô. The logname of super user is the root. It has all the privileges 

that the other users donôt have like modifying, deleting or running any file regardless 

of permissions associated with them. 
 

How to become a óSuper Userô? 
 

There are two ways to become a ósuper userô: 
 

 Login as root : At login prompt type, 

Login : root <CR> 

Password :// type the root password. 
 

 At the ó$ô prompt, type ósuô command followed by enter key: 

$ su 

Password :// Type the root password. 
 

Knowing about Devices attached to your system: 
 

In Unix system every device is treated as a file. These files are known as óspecial 

filesô. 
 

Each device connected to the Unix system is represented by a file in the ó/devô 

directory. These files are usually referred to as óDevice Filesô (or) óSpecial Filesô. To 

look at some of the devices connected to your system, change your directory to ó/devô 

directory and give óls ïlô command. 
 

How does the kernel distinguishes between regular files and device 

files? Suppose you give the following two commands $ cast temp and $ 

cat /dev/tty/15 
 

Before interpreting the above two commands first let us loot at what exactly the 

physical directory contains. 
 

Each physical directory (Internal representation) entry contains two columns 

namely. 
 

Files name and pointer to 
 

Each inode contains the 
 

The Inode list 
 

following information 
 

Filename Inode 
 

Inode mode, start file, date 
 

no. entry, file size of creation 
 

Temp1 120 
 

ééé 



The Inode list entry consists of Inode number, mode entry, start file, file size, file 

created, etc. For 'special files' instead of the file size it contains the major and minor 

numbers. 
 

When you issue the command like ócat tempô the kernel looks for the Inode 

number in the current directory and looks for the mode entry (for special files it is 

either ócô or óbô) and learns that ótempô is an ordinary file and as usual it looks for the 

corresponding blocks in the inode entry and prints their contents. 
 

When you issue the command ócat /dev /tty 15ô the kernel as usual looks for inode 

number in the current directory and looks for the mode entry and learns it is a device 

file. It then checks for major and minor numbers and identifies that it is a terminal. It 

then makes an appropriate I/O connections with the Terminal and the kernel I/o 

subroutines transmit keyboard generated bytes (the characters you type) to ócatô 

program. Finally when you type ctrl ïd at the beginning of a line the program finishes 

up its work and terminates. Ctrl ïd identifies the end of the input. 
 

The ógettyô Process 
 

Each terminal has one ógettyô process running even if some one has not logged in. The 

ógettyô process does nothing until a terminal is connected to the port. When you switch 

on the terminal the ógettyô process sends óloginô prompt to the terminal, then it waits 

for your response. When you type in your login ïid, the ógettyô process starts up a new 

process known as óloginô process and gives it whatever login ïid you have typed and 

goes away. The óloginô process then sends ópasswordô prompt and gets password from 

you. If either of these are not correct then it goes into the cycle. After successful 

verification of your login ïid and password it then starts up our familiar process 

known as shell and goes away. The shell then sits between you and the kernel and 

executes your commands. When you press óCtrlô and ódô (or exit) at the ó$ô prompt, 

the shell then dies and ógettyô process resumes. 
 

STARTING THE UNIX SY STEM 
 

Starting the Unix system requires more than just turning on the power. You must perform 

a series of steps to initialize the system for operation. This involves something called 

Booting the system, clearing the file system (if the system was improperly shutdown), 

entering into System Operation Mode to check the system operation and making sure that 

every thing is OK before allowing the other users to login to the system, etc. 
 

Booting the system is nothing but reading the kernel from the disk into the systemôs 

Main Memory. Some systems prompt you for some input to boot the system and some 

systems boot automatically when you power on. You should check the Manual that came 

with your system for a section on óStarting the Systemô or óBooting the Systemô. 



For example the SCO Unix displays the following message when you power on 
 

Boot 
 

: 
 

Hit <CR> key to load the kernel. 
 

After loading the kernel into the Systems Main Memory, the kernel checks the root 

file system to see that it is in order and not corrupted. If the root file system is corrupted 

(this usually happens when you STOP the system improperly or occasionally due to 

hardware failure or system crash), you have to clean the System to enable the Operating 

System work properly. If you get message of something like the following: 
 

Proceed with clearing (y or n)? 
 

Then the system was not properly stopped. You give óyô to clean the file system. If 

you donôt get the above message then your file system is clean and ready for use. 

When your file system is clean and ready for use, you get a message type Ctrl ïd to 

continue with normal startup (or) give the root password for System Maintenance. 
 

You can choose either Multi user mode (by pressing Ctrl ïd) or single user mode 

(by giving the root password). 



Multi User Mode 
 

In this mode (or) level, the Unix system allows more than one user to login to the 

system by running ógettyô processes. 
 

Single User Mode 
 

In this mode the Unix system allows only the super user to use the system. No ógettyô 

processes running, no other users and the only processes are óinitô óswapperô and those 

run by the System Administrator from the console. 
 

The óinitô Process 
 

óinitô is the process that control the level (or) mode the system is in. When you type 

óinit nô at the ó#ô prompt, the Unix system goes into level ónô, where ónô ranges from 0 

to 6 and the letter ósô. ósô is for single user mode and ózô is for multi-user mode. When 

the System changes initialization state, óinitô reads the file /etc/inittabô for instructions 

that apply to new mode (or) level. 
 

The ó/etc/inittabô is made up of entries that contain the following four fields 

separated by colon (:). 
 

Id : level : action : process 
 

Id : To uniquely identify each line 

Level  :  One (or) more numbers (o through 6) or the letter ósô that 

determine what level(s) óactionô is to take place. 

Action  :  One of the following represent action that takes place. 

óinit defaultô :  When óinitô starts it will enter ólevelô. The process 

  filed for this óaction has no meaningô. 

ósystem initô  : runs process before óinitô sends anything to the 

  system console. 

órespawnô  :  if process doesnôt exists, starts it, waits for it to finish 

  and then starts another. Eg. Getty ï login ï shell ï log off ï respawn 

  getty.   

ówaitô  :  When it changes ólevelô, it starts process and waits until its 

  finished.   

óoffô  : when it changes ólevelô it kills process. 
 

The ócronô Process 



Cron is a process that runs when the Unix system is in multi-user mode. 
 

It runs commands at specified dates and times. Once in every minute it checks the 

file ócrontabô to see if something is supposed to be run. If it finds something, it runs 

the corresponding command, other wise it sleeps for another minute. Since ócronô 

never exits, it should be executed only once. This is done through ó/etc/rcô file at 

system boot time. 
 

The óCrontabô file 
 

A ócrontabô file consists of lines of six fields each. The fields are separated by 

spaces (or) tabs. The first five fields are: 
 

Minute (0 ï 59) 

Hour (0 ï 23) 

Day of the month (1 ï 31)  

Month of the year (1 ï 12)  

Day of the week (0 ï 6 with 0 ï Sunday) 
 

Each of the fields may be either an asterisk (ó*ô) (means all legal values) or list of 

element separated by commas (ó,ô). An element is either, a number (or) two numbers 

separated by minus (ó-ó) sign (indicates the range). 
 
 
 
 
 

 

The sixth field in ócrontabô file is the command that has to be executed by the shell 

at the specified times. A percent sign character in the filed (unless escaped by ó\ô) is 

translated to a new line character. Only the first line (upto a ó%ô (or) end of line) of the 

command field is executed by the shell. The other lines are made available to the 

command as standard input. 
 

The ócrontabô is generally used to run the programs on a regular basis throughout 

the day. As a super user you can edit this file with any text editor and keep the 

commands which you want to run on a regular basis. Let us look at a typical ócrontabô 

file (on some systems this file is stored in ó/usr/spool/cronô directory). 
 

$ cat / usr / spool /cron / crontabs 
 

08 13 * * 1 ï 5 / etc/wall  </bin /wallmsg 
 

10 13 * * 1 ï 5 /bin /bkup > /dev/null 
 

The óetc /motdô file 



This file contains the messages of the day that are to be displayed whenever a user 

logs into the system. The general messages include ómessages such as a reminder to 

clean up unwanted files/directoriesô, a notice of the next periodic back up, and so on. 
 

The ó/etc /motdô file is an ordinary text file, so you can edit the messages with any 

text editor. 
 

$ cat /etc /motd 
 

Output is : Hello welcome to Unix Multi-user System Wish you a 
 

happy day. 
 

The ó/etc /profileô 
 

This is a shell program (like your own profile) that is executed by the shell whenever a 

user logs in (before executing profile). This file is maintained globally by the system 

administrator. Some commands which you can mention in this are setting the terminal 

type, printing the messages of the ó/etc/motdô file, printing the date and time, system 

name, terminal number, number of users and other information of interest to various 

users logging in. 
 

As a super user you can edit this file and put messages in it to show to that you 

want all users. 
 

STOPPING THE UNIX SYSTEM  
 

When you want to turn off the Unix system, you shouldnôt simply turn off the 

computer. You must prepare the system by using the óshut downô command. The 

shutdown command must be run from the systems console and you must be logged in 

as órootô. If any users are logged in after you issued óshutdownô, it warns the users that 

the system is about to be stopped, gives them the opportunity to finish their work, and 

then goes about killing processes, and finally it unmounts all file systems. 
 

File System Maintenance 
 

Each Unix System has atleast one file system on the primary hard disk. This file 

system is called óroot file systemô. On small hard disks, this root file system contains 

user directories as well. The primary hard disk can also be divided into more than one 

file system, one of the most common file systems is the ó/uô file system, which 

contains user accounts. The Unix System may also contain other file systems that 

contain special directories and application programs. 
 
 

 

 ̧

 

 ̧

 

Advantages of having different file systems are: 
 

Protect the data 
 

Easier maintenance 



New file systems can be specifically created by the System Administrator, then 

attached (mounted) and detached (Unmounted), to the system when needed. 
 

The following commands must be run only by the System Administrator 
 

Creating File Systems 
 

The command used to create a file system is: 
 

/etc /mkfs 
 

ómkfsô stands for ómake file systemô. 
 

/etc /mkfs <special file> <size> <no of inodes> 
 

where 
 

Special file 
 

: 
 

Name of the special device on which to create 
 

Size 
 

: 
 

512 or 1024). 

 

Size of the file system in terms of blocks (block size is : 

 

No of inodes 
 

: 
 

Maximum number of inodes. 
 

If you donôt specify the maximum number of inodes, then the Unix system 

calculates it to be 
 

Maximum number of blocks /4. 
 

Mounting a File System 
 

Mounting a file system is nothing but attaching it to the overall tree structure. 
 

/etc /mount command 
 

The ó/etc /mountô command is used to attach a file system anywhere in the overall 

directory structure. e.g. 
 

/etc /mount <option><special><directory name> 
 

Options: 
 

-r 
 

: 
 

The file system is to be mounted read only 
 

-v 
 

: 
 

displays mount information verbosely 
 

-f fstyp 
 

: 
 

fstyp is the file system type to be mounted. 
 

óspecialô 
 

: 
 

on ódirectoryô. 

 

indicates the block special device that is to be mounted 

 

ódirectoryô 
 

: indicates directory mount point for special. The ódirectoryô 

must already exist and must be empty. 



Unmounting a File System 
 

To unmount (detach) a file system, you can use the command ó/etc /unmountô. This 

command is simply the reverse of the ó/etc /mountô command, it removes the file 

structure from the directory structure. 
 

Note the following things before unmounting any file system 
 

Ą 

 

first use ósyncô command to perform any pending I/o: 
 

Ą 

 

the órootô file system can not be unmounted. 
 

Ą 

 

Unmounting file systems is usually done only in single user mode. 
 

Ą ó/etc /umountô will not work if any file is in use in the file system you are trying to 

unmount. 
 

# /etc /unmount <special> 
 

where 
 

óspecialô : indicates the previously mounted special device 
 

that is to be made unavailable. 
 

The ósyncô Command 
 

The ósyncô command is used to perform any pending I/o before unmounting any file 

system. 
 

 sync 
 
 
 

Displaying Free Space 
 

The ódfô (disk free) command displays the number of blocks and inodes available on 

the specific file system. A block is generally 512 (or) 1024 bytes of data. 
 

You can find the percentage of free space to total space on your system with the 

command: 
 

$ df ïv 
 

Mount dis  Filesystem blocks  used free  % used 
 

/ 
 

/dev /disk/35root 70000 4688 65312 6.6% 
 

/usr 
 

/dev/dsh /353 100000 93158 6832 93% 
 

Displaying Disk Usage 
 

You can display the number of blocks used within a directory by using the command 



óduô. This command is used for finding excessively large directories and its 

subdirectories. The óduô prints a list of each directory in a file system along with the 

number of blocks used by the files in that directory and its subdirectories. The óduô 

command with ó-aô option prints out the sizes of the ordinary files as well as the totals 

for each directory. 
 

$ du ïa 
 

38 /u1.txt 1./t1.4 
 

22 /ufchap2 
 

47 /ufchap3 

 

The ówallô Command 
 

To broadcast a message to all users on the system ówallô (write to all) command 

can be used. 
 

# wall 
 

Body of the text 
 

<Ctrl + d> 
 

This command copies the messages you enter at your terminal to the terminals of 

all users currently logged in. 
 

Locating Files 
 

You can locate all files with a specified name, date, owner, and/or last access date by 

using the ófindô command. 
 

$ find USER1 name ï memo2 ï print 
 

This finds the file ómemo2ô in the directory USER1 and all its subdirectories. If 

the file ómemo2ô is found, its path from directory USER1is printed else nothing will 

be printed on the screen. 
 

Saving and Restoring File System 
 

Unix System provides several mechanisms for backing up file systems and a 

corresponding method for restoring file system. Simple backups can be done by using 

ótarô command. Though the ótarô command is not sufficiently sophisticated to perform 

Scheduled backups, it is better suited to archive groups of files. The key to efficient 

backup is to save only what has changed from day to day (incremented backups). 
 

The óTarô Command 



ótarô stands for tape archiver. The ótarô command is useful for making a backup copy 

of entire directories. It takes as its arguments a command and a directory to be 

archived onto a tape or another disk. 
 

E.g. $ tar cv2* 
 

It copies all files in the current directory into a high capacity/DSHD floppy diskette. 
 

Accounts Management 
 

Add /delete Users 
 

Use can add users by directly modifying, óetc/passwordô file. The ó/etc/passwordô file 

is an ordinary text file that contains information about all users on the system. Each 

line in the file corresponds to one user on the system. This line contains information 

about that particular user. 
 

The general format of each line in the file is: 
 

Login id : password : uid : gid : userinfo : HOME : shell 
 

Where   

login id : users login name 

password : encrypted password 

uid : numerical userid that be associated with login id. 

gid : group id that is used to distinguish members of various groups. 

userinfo : other details about the user. 

HOME : Usersô Home directory. It must be a valid directory and 

 cannot  already  exist  on  the  system.  Typically  the  userôs  HOME 

 directory matches the login name. For example, the login óuser1ô might 

 have HOME directory of /usr/user1. 

shell : Specifies óshellô for the user (Bourne or C) 
 

Let us now see how to add a new user, user15. 
 

First open ó/etc /passwordô with any text editor and add the following line to the 

end of the file. 
 

User15:: 120 :: 17 : D.K Dhingra :/trng/user15: /bin/sh here, 
 

login id : User15 

uid : 120 

gid : 17 



userinfo : D.K. Dhingra 
 

Home : /trng /user15 
 

shell : /bin/sh (Bourne Shell) 
 
 
 

 mkdir /usr /user15 || create directory 
 

 chown user15 /usr /user15 || assign owner 
 

 chgrp 17 /usr /user15 || assign group 
 
 
 

# password user15 
 

New password : <New password> 
 

Reenter new password : <new password> 

 
 
 
 
 
 
 
 

|| for confirmation. 
 

# 
 

Now óuser15ô account has been created and is allowed to use the system. 
 

Adding users with óadd userô command 
 

Syntax : 
 

Adduser <login ï id> <name> <user ï id> , <home ï directory> 
 

So in the above case it will be: 
 

 adduser user15 D.K. Dhingra /70 /usr/user15 

The above command adds óuser15ô to the system. 
 

Removing Users 
 

Removing users is simply the opposite of adding them. 
 

Removing users by directly modifying /etc/passwd ófile: 
 

First, open ó/etc/passwdô file with any text editor and delete the line corresponding to 

the user. Next, remove the users HOME directory and all of the files by the command: 
 

# rm ïr/usr/user15 
 

Removing users with ódeluserô command: 
 

Deluser <login ï id> <yes/no> <home ï

directory> Yes /no is for confirmation 



Eg. # deluser user15 y/usr/user15 
 

System Security 
 

System security is one of the primary important features for multi-user systems. Two 

major areas where security should be ensured are: 
 

Password Security: to keep unauthorized people from gaining access to a 

computer system. 
 

File Security: To keep unauthorized people from tampering with the userôs files 

and to allow some users certain privileges that otherôs arenôt allowed. 
 

UNIX UTILITIES  
 

UNIX includes and supports several utilities, which allow communication from one 

system to another. When an entire network of interconnected Unix system is available; 

the users can use it for mail service between different machines apart from other 

services. The services may be: 
 

Remote login(TELNET) 
 

Electronic mail(SMTP) 
 

File transfer (FTP) 
 

Trivial File Transfer (TFTP) 
 

R-Series Applications 
 

Printing On A Remote Printer, Etc. 
 

REVISION EXERCISES 
 

 Define an operating system? 
 
 What are the components of an operating system? 
 
 Differentiate between the three types of translators. 
 
 Enter your login name at the login: prompt and log onto the system. 
 
 Display the system date. 
 
 Display the terminal address of all the persons working on the Unix system. 
 
 Using the echo command, dial ñI AM LEARNING UNIXò. 
 
 Give a brief idea about the Unix scheduler. 
 
 Which are the commonly used shells used in Unix? 
 
 Display your current working directory. 



 Create a file with a name of your choice and write the names of your friends in it 

(use cat command). 
 
 Display the above file (use cat command). 
 
 Create a subdirectory of your name and create 3 files of your choice. Put any 

dummy data into it. Now list all the files present in that directory. 
 
 Rename a file from the subdirectory to a name of your choice. 
 
 Delete the subdirectory you just created using the rm option. 
 
 Give a brief idea about the hierarchical file system of Unix. 
 
 Explain the different editors used in Unix. Which is widely used and why? 
 
 Create a file containing your bio-data using vi editor and try out all the options 

given to you in this session. 
 
 How to find out the number of users logged into the system. 
 
 Define the different operational modes of the vi editor. 
 
 Explain the concept of filters in the Unix operating system. 
 
 Create a file of your own name. Enter a short story into it. Now using óweô and its 

options count the characters, words and lines in the given file.  
 Using grep see if a particular word is there in the above file you made. 
 
 In the above file also find all the lines which 
 

 begin with a vowel. 
 

 do not begin with a vowel. 
 

 lines that end with a pattern of your choice. 
 
 Why is shell an important part of Unix operating system? 
 
 Create an interactive shell script, which will ask the name and age of the user and 

print it on the screen. (the user should enter his age and name)  
 Describe the various loops, case statement and conditional statements used in Unix. 
 
 Create a directory and make some files into it. Using the tar command create a 

backup of that directory.  
 What is the difference between Round Robin scheduling and Swapping? Explain in 

detail.  
 Explain the structure of a typical Unix file system. 



 ñCommunication in Unix Operating system plays a very important roleò. How can 

one user communicate with the other users on the Unix perform. 
 
 Explain the concept of Redirection and Pipes with the help of appropriate 

examples.  
 Why is the shell environment important to Unix Operating system. 
 
 Highlight the difference between: 
 

 Common environment variables and system shell variables 
 

 Local and Global shell variables 
 

 Interactive and Batch modes of command interpretation. 
 
 With an example, explain briefly how can words be separated from each other. 
 
 How can a person become a super user on the Unix platform? 
 
 What is the difference between the regular file and the device file? How does the 

kernel distinguishes between them? 
 
 Explain the difference between the multi-user mode and single user mode. 
 
 What use can the crontab file be to a Unix user? 
 
 Explain the stops in creating, mounting and unmounting a file system? 
 
 What is the importance of sync command in the unmounting of the file system? 
 
 Add a user ñuser 20ò to the system. Assign it a password. Explain each step 

involved in the above process.  
 Remove the user created in Q. 42. 
 
 Explain the concept of default attributes. 



Chapter 12: WINDOWS 95/98 
 

Windows 95 Operating System was developed by Microsoft, by integrating the DOS 

and Windows features in order to give a user-friendly environment. All applications 

running under this environment essentially use similar operations thereby ensuring 

that the user is comfortable in the basic handling of all applications. The productivity, 

thus, goes up appreciably and the ease to master and use features of the Operating 

System leads to lesser reliance on technicians. 
 

STARTING WINDOWS 95/98 
 

 Windows 95 or 98 is first loaded on to the hard disk of your computer using either 

floppies or CDôs. The loading is achieved by using the SETUP command and the 

user can easily perform the consequent actions by following the instructions that 

appear on the screen.  
 Windows 95 requires atleast 8 MB of RAM while Windows 98 requires 16 MB 

RAM. 
 
 For starting operations, switch on your computer and Windows will be loaded and 

you will see a taskbar as shown below. By default this taskbar appears at the 

bottom of the screen. Above that the icons (graphical representations of tasks that 

can be executed by point and click of the mouse) appear. 
 

 

Note the Start button on the left corner. In order to start our Windows session, click on 

this button. A menu as shown in the screen on next page will appear. The groups as 

indicated in the menu will do the following tasks: 
 

 Programs: Displays a list of programs you can start. 
 
 Documents: Displays a list of documents you have opened previously. 
 
 Settings: Displays a list of system components for which you can change the 

settings.  
 Find: Enables you to find a folder, file, shared computer or mail message. 



 
 
 
 
 
 
 
 
 
 
 
 

 Help: Starts Help. You can then use the help contents, index or other tabs to find 

out how to do a task in windows.  
 Shut down: Shuts down or restarts your computer or logs you off. 
 

Each part of the start menu is discussed briefly in the chapter. Depending on your 

computer and options you have chosen, you may see additional items on your menu. 
 

The part of the taskbar where you see a clock and some other symbols is known as 

the notification area. If you want to change the time or date of the computer take the 

cursor over the clock and double click. You will get a menu from which you can 

perform these tasks. 
 

MOVING IN MENUS  
 

When you move your cursor to the programs icon from the start menu you, will see 

another pop-up menu opening up. This menu is known as the sub menu of the start 

menu. You can have any number of sub menus in this menu or any menu. You will 

notice a black arrow directed towards the right of any folder that contains another 

menu of folders or programs. 
 

Any icon on these menus without a right arrow indicates that the program is 

executable i.e., it can run by itself or under an application installed in the computer or 

that is a part of the program. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Whenever you open a program it starts under a window. On the top right corner of 

this window you will see a óïô sign, a óxô sign and another sign showing one or two 



windows. 
 

The óïô sign minimizes the window to a button on the taskbar. This does not mean 

that the program is closed, it is just not being seen on the main screen. The program 

can be restored back by clicking on the button on the taskbar. The second button on 

this menu maximizes the window running the program. If the program window is 

already maximized it shifts the window to custom size (which can be adjusted). 
 

The óxô sign when pressed exits the program and returns to the previous screen.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

One of the main features of windows is that you can start any number of programs 

at one time which depends on the RAM (Random Access Memory) of the computer. 

You can switch between the programs by just pressing on the buttons the program on 

the taskbar. The clicked program window appears over the previous window. You can 

work on only one program at a time. The active window is represented by a colored 

top bar and the nonactive programs by discolored top bar. If the nonactive program is 

visible on the screen as shown in figure it can be made active by simply clicking on 

any part of it; its window comes over the previously active window.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Working with documents or files. 
 

1. To make a new file go on the file menu and press new. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 To open a file in a program go to the file menu and click on the open button. This 

opens a menu.  
 Look in shows the folder whose files are being shown currently. You can change 

the folder by clicking on the menu of look in. 
 
 To the right of look in is an icon showing a folder and a bent arrow facing upwards. 

This button moves the folder where the files are to be looked up by one level i.e., 

to its main folder.  
 Files of type menu on the bottom indicate what all the files with respective 

extensions which can be opened by that particular application. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 To save a file go to the file menu and press save as. The computer will indicate you 

to give a name to the file and then save it. If some changes are made to a saved file 

you can save them again by just clicking on save from the file menu.  
 To print a file go to the file menu and click on print. Only if the printer is properly 

configured with the computer software will it start printing the document 

otherwise it will show an error. 



 In the edit menu cut, copy and paste options allow you to cut and paste or copy and 

paste any part of the document selected with the mouse. To select a portion under 

a document, at move the cursor to the start of the portion and by clicking the left 

button drag the mouse over the portion to be selected which will then be 

highlighted. Then you can perform various tasks such as cut, copy, delete, change 

fonts etc., with it. 
 
 To close a file press close from the file menu.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

UNDERSTANDING THE START MENUS  
 

Program Menu 
 

Program menu contains a list of folders and applications, which are installed on your 

computer. As previously discussed, a program menu has a lot of folders which open 

further sub menus. The executable programs are usually represented by a symbol 

alongwith their names and can be started by clicking on it once. 
 

To rename or delete an icon on the menu take your cursor to the icon and right 

click the mouse you will see a menu from which you can do so. 
 



Documents Menu 
 

It contains a list of documents that run under window application packages. It shows a 

maximum of fifteen previously opened documents. The documents in the list can be 

started by clicking on them once. Thus the document menu can saves a lot of time by 

making it easy for you to open some of the unfinished documents you want to work on 

again or make changes in them later.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

To remove the complete list from the documents menu go on the taskbar and start 

menu icon from the settings icon. When the window is opened go on the start menu 

tab. In the start menu tab in documents menu press the clear button. This removes the 

list of documents in the documents menu.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Setting Menu 
 

The setting menu displays a list of system properties whose settings you can change. 

The settings menu consists mainly of Control Panel, Printers & taskbar and Start menu 

programs. 
 

Control Panel 



To start control panel just click on it from the settings menu.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Using control panel you can change the way windows looks and works. It contains 

a list of icons through which you can change your screen colors, install or change 

settings of hardware and software setup or change settings for networks, printers, mail, 

fax and modems etc. 
 

The icons that appear in control panel varies depending on the hardware and 

software installed on your computer. 
 

Some of the important icons of the control panel are discussed below. 
 

 Add new hardware: Helps you in installing any new hardware you wish to include 

in addition to existing hardware in the computer. Just follow the instructions the 

appear on the screen to install the hardware properly. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

If the hardware is not detected by windows automatically you can also select 

it manually from a list of hardware devices, which appear on the screen. You can 

also do the installation by using the disc provided by the manufacturer by pressing 

have disk column on the screen. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Add/Remove programs: Sets up programs, i.e., it helps in adding or removing any 

program in Windows. In the add/remove properties there is a list of all the 

applications and programs installed in Windows on the machine. You can install 

more programs from here or remove the programs already installed on the computer. 
 

It is very important to uninstall programs installed in Windows. Simply by 

deleting the files of the folder in which the program is installed does not remove 

all components of the program. Thus proper uninstallation should be performed to 

completely remove the application. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 Display: Through this you can adjust the display settings of your computer. It also 

helps in changing the way window looks on the screen. You can add backgrounds 

to your desktop, put screensavers which start if the computer is left idle for a given 

time and change the appearance of windows using various options. The settings 

tab in the display menu helps you in adjusting the color scheme, the screen size, 

monitor properties, display card and other advanced settings. 
 
 System: It provides system information and changes advanced settings. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Sounds: Changes system and program sounds.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Date/Time settings: Changes date, time and time zone settings.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Internet settings: Changes settings of Internet to work with the Internet Explorer 

browser. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Users (not in win95): Helps you manage multiple users.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

9. Mail and Fax: Set up or make changes to your computer mail and fax accounts.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Modems: Allows you to setup a new modem or change various simple and 

advanced properties of an already installed modem. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Mouse: Changes settings for mouse.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 Power management: Helps in managing implementing various power schemes on 

your computer. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 Fonts: Shows the user various font schemes available under windows. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Printers 
 

To install a printer click on printers from the setting menu. The screen shows list of 

printers already attached to the computer. To install a new printer double click on 

column add printer and follow the instructions on the screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Find Menu 
 

It helps in finding any files or folders located in the computer or a network. Other 

options also allow you to find any users on a network or search the Internet for 

information. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Run 
 

Its main purpose is to open an executable program located in the computer or a 

network by giving its exact location on the open line. Old programs running on MS-

DOS can be started properly using the Run command. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Help 
 

Starts help manual for windows. It helps the user by explaining in detail how a task is 

to be performed under windows. To look for a specific topic the user can use utilities 

like contents index and find under the help program. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Shut Down 
 

It shuts down the computer i.e. it closes all programs running currently, does a system 

check and then displays a message to the user to shut down the computer. 
 

It is very important to perform a proper shut down before turning off your 

computer otherwise files or system resources could be affected. 
 

The shut down menu also allows you to restart the computer or log off your 

computer from a network if present. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Explorer  
 

To manage all the files and folders in your computer windows has a program called 

windows explorer. It can be started from the program menu or by right clicking on the 

start menu and then clicking on explore on the menu that appears. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Folder 
 

A folder also known as a directory contains files and other sub folders in an order. It 

helps in keeping things organized on your computer. 
 

On the left screen is a list of folders you can explore. The ó+ô sign before any 

folder indicates that the folder is expandable i.e. it has more sub folders under it. When 

you click on a specific folder its contents i.e. files and sub folders under it are 

displayed on the right of the screen. 
 

You can change the way icons look by going to the view menu and clicking on the 

various options available. 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

To open a specific menu for a file or folder right click on the item. A menu 

appears which helps you in performing various tasks on the file or folder. We will 

look in detail on how to go about various tasks in explorer. 
 

 Cutting files or folders removes them from their original location and moves all of 

its contents to the new location specified. 
 
 Copying files or folders keeps them in their original location and makes a copy of 

its contents on the new location specified.  
 Deleting files or folders removes them from windows explorer. Note that in 

windows the deleted files go into the recycle bin. This means that the files are not 

really removed from the hard disk but just are not being seen. The main purpose of 

this is that the user can restore the files accidentally deleted by him from the 

recycle bin. To completely remove the files you have to empty the recycle bin 

whose icon is visible on the desktop. Another easy method to delete the files or 

folders directly is to press shift + delete. Now the files do not go to the recycle bin 

but are erased completely from the computer. 
 
 Select the file or folder by simply clicking on it. To select multiple files press shift 

and move the cursor over the name of the files. To select all files under a folder 

press ctrl + A. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 When the file(s) is selected right click on the mouse button to see a menu from 

which you can select if you want to cut, copy or delete the file(s) or folder. You 

can also perform the task by going to the edit menu and selecting any of the task 

you want to perform on the file(s) or folder. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 To paste the file(s) or folder select the location where they are to be placed and then 

press paste from the edit menu.  
 The menu that appears on right clicking the selected file(s) or folders also allows 

the user to send the selected file(s) or folders to various places on the computer 

like floppy (A:), desktop (creates a shortcut to the program on the desktop) or in 

the mail program directly. 
 
 To create a new folder first select the drive or folder in which you want to place the 

folder. Then go to the file menu, point to new and then click folder. Type the name 

of the folder and press enter key. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 To move files or folder directly from one place to another simply left click on it and 

keeping the mouse button clicked move it to the new location visible on the screen 

and then leave the mouse button. This is known as drag and drop method. In this 

all files or folders are moved to a new location on the same drive and are now not 

available in its previous place. The limitations of this is that both the locations, i.e., 

old and new must be visible on the screen or could be reached without leaving the 

mouse button. Note that dragging a file between two drives copies it to the new 

drive instead of moving it.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 To rename a file or folder first select it. Then go to the file menu and click on rename. 

Enter the new name and press enter. The user can also select the rename option under 

the Right click menu of the selected file or folder and change the name. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

CREATE PICTURES USING PAINT  
 

You can create your own free hand drawing and fill colors in it using Microsoft 

Windows paint program. It can be started from the accessories menu in the program 

menu. You can cut & paste these pictures under documents or on the background of 

your computer. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

WRITING DOCUMENTS USING WORDPAD  
 

You can write all you letters, documents, etc., using the wordpad program. It can be 

started from the accessories menu in the program menu. It includes features such as 

cut, copy, paste, find and fonts to make your work easier and more presentable. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

MS-DOS PROMPT  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Old die hard DOS fans would not be disappointed in using windows. Windows 

provides a fully compatible DOS interface. You can run all your DOS programs from 

here as well and execute most of the DOS commands for performing various tasks. To 

get out from the DOS environment and return to windows just type exit from wherever 

you are. 
 

REVISION EXERCISES 
 

 Describe the functions performed by an Operating System? 
 
 What is the function of a Task Bar? 
 
 What are: 
 

 Screen Savers 
 

 Recycle Bin? 
 
 What is meant by accessories? 



 Explain the functions of Windows Explorer in detail. 
 
 Describe the functions of the Control Panel. 



Chapter 13: MICROSOFT OFFICE 
 

MS WORD 
 

MS Word is Microsoftôs solution to meet the word processing needs of everyone. Like 

any other word processor, this package also contains necessary typing, editing and 

aesthetic features. In addition to these features, MS Word also provides great tools for 

specialized word processing applications. 
 

We will now cover the important features of MS Word in the following 

sections/paragraphs: 
 

Creating Word Documents 
 

Primarily a document is created by using either the File>New command or by 

choosing New Document in the Programs menu. This will present us with a screen 

stating that Document1 has been opened and is ready to be written into. The File menu 

alongwith the Word window will look as under:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You can start entering text in the blank window presented, keeping in mind not to 

press the Enter key before the paragraph ends. Once the typing is over, the next step 

obviously is to ascertain if any typing mistakes have crept in. If there are, editing 

(correction of the text in this case) involves the placement of the cursor at the affected 

letter/word through either clicking the mouse at that location or using the arrow keys 

to bring the cursor at the required place. 
 

After having positioned the cursor, pressing the del key and retyping (if required) 

will make the correction. 



Keep in mind that the Office Assistant feature in Word 2000 keeps track of what 

you are doing and keeps on offering suggestions. The Auto Correct 

feature automatically corrects certain misspelled words and the spelling and grammar 

feature reviews your text to determine spelling and/or grammatical mistakes. 
 

Also note that by pressing Ctrl+Backspace and Ctrl+del complete words would be 

deleted. 
 

Editing Text (Advanced Features) 
 

The screen below shows the Edit menu which can be invoked and has several features 

which demand that the text you wish to edit should be selected 

first. Selection normally is indicated by the text being highlighted by a black 

background. 
 

Text can be highlighted (or selected) through various methods available: 
 

 Bring your cursor to the beginning of the text you wish to select. Right click and 

drag your mouse till the end of the text you have selected. 
 
 Through arrow keys bring your cursor to the beginning of the text. Hold the Shift 

key pressed down and at the same time, select the text through the use of the arrow 

keys. 
 
 A word can be selected by double clicking on it. 
 
 A sentence can be selected by holding the ctrl key and clicking anywhere in the 

sentence. 
 
 A paragraph can be selected by triple clicking anywhere in the paragraph. 
 
 An entire document can be selected by Edit> Select All from the menu bar or by 

holding the Ctrl key and clicking in the left margin. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Copying, Cutting and Pasting Text 
 

Many a times, in the course of document production, it becomes necessary to move 

portions of text from one location in the document to another. In order to achieve this, 

the text to be moved is selected (highlighted) and then copied to the windows 

clipboard by using the Edit > Cut command. 
 

In order to bring this cut portion to the location where it has to be moved, the 

cursor is first brought to that location and then the Edit > Paste command will paste 

the cut text from the clipboard. 
 

The Edit > Copy command differs from the Edit > Cut command in the sense that 

whereas in the Cut operation the text is removed, in the copy 

operation the text is copied to the clipboard but also remains where it was in the 

document. 
 

Formatting and Aligning Text 
 

It is important for a document to be presented to the reader in such a manner that he is 

attracted into read the contents. One major beautification component lies in formatting 

text: the selected portion of the text can be made to have a different font (remember 

Font consists of typeface, size, style, etc., amongst other qualities). The format menu 

reproduced below shows various formatting options: 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Pressing the Font command for the highlighted text gives rise to a dialog box 

asking for more information as shown under (note colour, underline, superscript, 

subscript, etc., are all decided and applied to the highlighted text here): 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

The next important feature required for the document to look good is the 

alignment of the left and right margins. This is achieved by selecting the paragraph 

and then applying, left aligned, right aligned, centered or justified feature through the 

Format>Paragraph command as shown in an earlier menu. This can also be applied by 

the shortcut icons as shown under: 
 
 
 
 
 
 
 
 

 

Indenting your paragraph and adding special properties to it is achieved by pressing 

Format> Paragraph and then setting the properties in the dialog box presented as shown 



under:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Special effects like bulleting your text, adding borders, giving a background shade 

to your documents is easily achievable by the Format> Bullets and Numbering or 

Format> Borders & Shadings features. Further features of small case/uppercase or 

drop a capital are also present in the Format menu. 



The Mail Merge Feature 
 

One of the very powerful feature of MS Word is its ability to send original letters to 

different people through the production of a single common document and the 

merging of this document with a data file containing data relevant to each recipient of 

the letter. For example if an interview letter has to be sent to various candidates asking 

them to appear on different dates and times for different positions, a single document 

will be typed in which the name of the candidate, address, time, date and position for 

which being interviewed will be left blank. 
 

As a second step, another document known as data document would be created 

using the Tools > Mail Merge command which will present us with the following 

dialog box: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Pressing the Get Data button will present us with another dialog box where we 

will be at liberty to choose amongst predefined fields, delete those fields and add our 

fields. Since we require first name, last name , position ,time and date of interview we 

will only create /select those fields in order to create our data entry form. The dialog 

box is as presented below: 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Pressing Edit Data Source will present us with a data entry screen in which the 

details of all candidates can be entered. 
 

The final step will be to insert relevant fields in the main document by choosing 

Insert Field from the main document window and inserting at appropriate places by 

clicking the mouse at that location where you want the data to be inserted from the 

data document. The main window screen and inserted fields will look as under: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

At this stage, go to Tools>Mail Merge and press the merge button in the dialog box. 



Individual copies of the letter for each candidate will be created/printed. 
 

Tables 
 

Another innovative feature of MS Word is its ability to create tables with user specified 

rows and columns. This is achieved through the Table menu which is shown as under: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 Click insert table on the standard toolbar and specify the number of rows and 

columns. 
 

 You can use the AutoFormat feature to give your table a variety of borders and 

fonts. 
 

 Columns to the Left and Columns to the Right will insert columns to the left and 

right in the table. Similarly Rows Above and Rows Below will insert rows above 

and below the Specified row. Using Cells feature you can add an entire row, 

column and shift a cell to the right and down. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Another facility under the Table menu is that you can delete the entire table or a 

particular cell, row, column or multiple rows and columns. 
 

MS EXCEL  
 

Creating Worksheets and Entering Data 
 

Excel is a spreadsheet program that you can use to enter, manipulate and work on data 

to your heartôs content. Excel is mainly used for large data and calculations, etc., as it 

is a program designed to work with numbers .You enter your data in cells arrayed into 

horizontal rows and vertical columns on a worksheet. 
 

Excel organizes worksheet by workbook on the basis that you may need more than 

one worksheet for any given project. Each new workbook you open contains three 

worksheets by default but you can add worksheets upto a maximum of 255. Each 

worksheet contains 65536 rows and 256 columns. Rows are numbered from 1 to 

65536 and columns are numbered from A to IV (the first 26 columns are numbered A 

to Z, the next 26 AA to AZ, the next 26 BA to BZ etc.). The worksheets are numbered 

from 1 to 256 but they can be also given names to suit the requirement. 
 

When you launch Excel, the Excel application window opens with a new Excel 

workbook. The title bar and command bar are at the top of the window. Below the 

command bars is a strip that contains the name box and formula bar. The status bar 

displays current selections, commands or operations. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

A cell is the interaction of a row and a column. Each cell has a unique address 

composed of the cellôs column and row. The cell in the top left corner of the worksheet is 

cell A1. The active cell is identified by a dark outline called the cell pointer and the 

headings in the active cell are out-dented or ñ lit-upò. When you enter data, it is always 

placed in the active cell. Application window of Excel consists of the following. 
 

Create/Open Workbook 
 

Select the New. Command from the File menu. The workbook is opened by the 

default name of Book1. 
 

To open an existing workbook, select Open option from the File menu.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Save Workbook 
 

To give a name and save the workbook: 
 

 Choose FileĄSave AsĄcommand 



To simply save the workbook 
 

 Choose FileĄSaveĄcommand 
 

Types of Data in Excel 
 

Excel recognizes five types of data: Numbers, Date, Time, Text and Formulas. 
 

Numbers 
 

Numbers are values that can be calculated. They can consist of the numerals 0 through 

9, with a decimal point as a separator for decimal places and with commas as 

separators for thousands. Numbers can start with a dollar sign ($), or with a + or ï 

sign. They can end with a % sign; they can also be enclosed in parenthesis. 
 

Dates 
 

Excel handles dates as serial numbers and represents them in the following four 

formats: 
 

Date Format Examples 
 

MM/DD/YY  07/10/01 
 

MMM -YY  Jul-01 
 

DD-MMM -YY  10-Jul-01 
 

DD-MMM  10 ïJul 
 

Times 
 

Excel uses serial numbers for times as well, representing the 24 hours of the day as 

values between 0 and 1. It represents time in the following four formats: 
 

Time Format Examples 
 

HH:MM  10:15 
 

HH:MM:SS 22:15:17 
 

HH: MMAM/PM 
 

10:15 PM 
 

HH:MM:SS AM/PM 
 

10:15:17 PM 
 

You can combine the date and time values to refer to a given time on a given day. 
 

Date and Time Format 
 

Example 
 

MM/DD/YY HH:MM  
 

10/07/01 10:15(AM/PM optional) 
 

HH:MM MM/DD/YY  
 

22:15 10-07-01 



Formulas 
 

Formulas are mathematical formulas telling Excel to perform calculations on data in 

cells. For example, to add the data in the cells A1, B1 and C3 and display the result in 

the cell D4, you would enter the formula +A1+B2+C3 in cell D4. 
 

Text 
 

Excel considers any data that it does not recognize as a number, date, time or formula 

to the text. It means that data containing letters will be treated as text. Text to long for 

the cell will be displayed in the cell to the right if empty; otherwise, only the part that 

fits in the cell will be displayed, though all of the text is stored. 
 

Entering Data 
 

To enter data in the active cell, first activate the cell and then begin typing the data. As 

soon as you begin entering characters from the keyboard, 

three things happen; an insertion part appears in the cell, the text you are entering 

appears in the cell and the formula bar and formula bar button are activated. 
 

Auto Fill  
 

Auto fill feature lets you quickly enter predefined series of data such as data, text or 

number. After you have made one or two entries in the table, let Excel know what you 

are trying to enter in cells, drag the auto fill handle unto the point the data is to be 

entered. 
 

For example for a series of numbers that increase by a given amount, enter the 

first two numbers in the first two cells like 1 in cell A1 and 2 in cell A2. 
 

 For a known text series such as month of the year enter the first text label. For 

example enter January in cell A1.  
 Select the cell or cells containing the information. 
 
 Click the auto fill handle in the lower right corner of the rightmost or lower cell and 

drop the resulting border across or down through the cells. 
 

The auto fill handle is in the small black square in the lower right corner of the 
 

cell. 
 

EDITING AND FORMATTING A WORKBOOK  
 

Editing Data 
 

For editing data in a worksheet, first make the cell you want to edit active by clicking 

on it. Then press F2 or double click in the cell to enter edit mode which Excel will 



indicate by displaying Edit at the left end of the status bar. Excel will display the data 

from the cell in the reference area and will display a blinking insertion point in the cell 

at the point where the edit will take effect. 
 

Copying and Moving Data 
 

You can copy and move data in Excel by using Cut, Copy, and Paste (as in MS Word) 

or drag and drop. There are two points to be noted. 
 

 When pasting a range of data, you need 
 

to only select the upper left anchor cell of the destination. 
 

 To use drag and drop, select the cell or range to move or copy and 

then move the mouse pointer to one of its borders where the pointer changes from 

fat cross to an arrow. You can then drag and drop as usual. Watch the information 

box identifying the range in which the selection will land. 



Delete 
 

Select the cell or range and press Delete. 
 

Working with Ranges 
 

A range is one cell or many cells. It can be a rectangular block of cells or an irregular 

block of cells. Ranges can be named and they give you a way to work with a number 

of cells at once. The name box on the left end of the formula bar displays the name of 

the currently selected range. 
 

Selecting a Range 
 

To select a range of cells 
 

 Click in the upper left cell of the range, hold down the shift and then click in the 

lower right cell of the range. 
 

Or 
 

 Click in the upper left cell of the range and drag to the lower right cell of the range. 



Naming a Range 

 

To name a range 
 

 ̧

 

 ̧

 

Select the cell or range. 
 

Click in the name, drop down list box at the end of the formula bar. 
 

 Enter the name of the range ï it can be upto 255 characters with no spaces and 

should start with a letter, a backslash or an underscore. 
 

 Press enter. 
 

Changing and Deleting Range Names 
 

 Select the range or cell. 
 
 Choose Insert ->Name -> Define to display the name dialog box (see fig.). You will 

find the names of ranges in the list box.  
 Add, change or delete the range name. 
 

 ̧ Type a new value for the range and click Add.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Reuse an existing range name by choosing it in the list box and click Add 

 

Select the range name from the names in the workbook list and click delete. 

 

Add, change or delete further range of names if necessary and click the OK button. 



 
 
 
 
 
 
 
 
 
 
 
 

 

Inserting or Deleting Rows and Columns  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Many times you may require adding a row of data or a column of data, which you 

forgot to enter earlier. Excel provides the facility to insert rows or columns into the 

existing worksheet. 
 

 Select the cell(s) where you wish to insert the cell(s), row or column. 
 
 From the Insert menu. 
 

 Choose Entire Column to insert the column. 
 

 Choose Entire Row to insert the row. 
 

Formatting  
 

Excel lets you present numbers in a variety of formats. You can format selected cells 

using the formatting toolbar from the Format Cells dialog box. 
 

Number Formatting 
 

Excel provides many different number formats like currency, percent and comma style 

for use with different kinds of data. 



Alignment 
 

Excel identifies any data item as a number, date, time, formula and text. By default, 

Excel applies the appropriate horizontal alignment to each of these. Numbers are right 

aligned and text is left aligned. 
 

Horizontal Alignment 
 

For horizontal alignment, use formatting toolbar. 
 

Merge and Center centers the contents of a cell across a number of columns. Enter 

the text in one of the cells; then select the horizontal range of cells across which you 

want to center the text and click the Merge and Center button. 
 

Setting Horizontal and Vertical Alignments 
 

 Choose Format -> Cells to display the Format Cells dialog box. 
 
 Click the Alignment tab to bring it to the front of the dialog box. (See fig) 
 
 In the Horizontal group box, choose the horizontal alignment option you want. 

Excelôs default option is left aligned for the text and right aligned for 

numbers. Justify aligns selected text to both the left or right margins. 
 

Center across the selection centers the text across the selected columns. 
 

In the vertical group box, specify the vertical alignment for the selected cells by 

choosing Top, Center, or Justify. 
 

Font Formatting 
 

Excel supports a wide range of font formatting that can be used in the worksheet. 
 

Choose Format -> Cells to display the Format Cells dialog box, click on the Font 

tab and make your choice on it and then click OK button. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Auto Formatting Worksheets 
 

 Choose format-> Auto format to display the Auto Format dialog box (see Figure). 
 
 Choose a format from the Table Format list box and click OK. 
 
 If you want to apply only some of the formatting characteristics, click the option 

button to display the six options in the formats to apply group box at the bottom of 

the AutoFormat dialog box. Clear the check box for the options you do not want to 

apply.  
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Formatting Rows and Columns 
 

Row Height 
 

To change the row height for one row quickly, click on the bottom border of a row 

heading and drag it up or down until the row is of the height you want. 



 
 
 
 
 
 
 
 
 

To change row height for several rows at once 
 

 Select the rows by dragging the row headings or through cells in the rows. 
 

2. Choose Format -> Row -> Height to display the Row Height dialog box. 
 

 Enter the new height in points for the rows in the row height text box. 
 
 Click the OK button to close the Row Height dialog box. 
 

Changing the Column Width 
 

To change column width for one column quickly click on the right hand border of the 

column height and drag it left or right until the column is of the width that you want. 
 

To change column width for several columns at once: 
 

 Select the columns by dragging through the column headings or through the cells in 

the columns.  
 Choose Format-> Columns-> Width to display the Columns Width dialog box. 
 
 Enter the new column width in the Column Width text box. 
 
 Click the OK button to choose the Column Width dialog box. 
 
 You can also set a default column width by choosing Formatting -> Column -> - 

Standard Width and set whatever column width you want. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Auto Fit (column width/row height) 
 

Auto fit feature automatically adjusts column width/row height to fit the widest in any 

selected column/row. To use Auto fit, select the column/row you want to adjust and 



choose 
 

Format -> Column -> Auto fit. 
 

Format -> Row -> Auto fit. 
 

Hide/Unhide of Row or Column 
 

To hide/unhide a column or row; first select the row or column: 
 

Choose FormatĄ Row/Column Ą Hide/Unhide 
 

Protection 
 

Excelôs protection is an invisible form of cell formatting. You can format selected 

cells as either locked or hidden. 
 

 Choose format cells to display the Format Cells dialog box. 
 
 Click the Protection tab. 
 
 Select the Locked or Hidden check box or both. 
 
 Click OK.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

To Protect Worksheet 
 

Choose ToolsĄProtectionĄProtect Sheet and choose following options 
 

CONTENTSĄProtects the user from changing locked cells or charts. 
 

OBJECTSĄProtects the user from changing graphic objects. 
 

SCENARIOSĄProtects the user from changing scenarios. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

To Protect Workbook 
 

Choose ToolsĄProtectionĄProtect Workbook and choose following options 
 

StructureĄPrevents the user from moving, deleting, hiding, inserting or renaming 

worksheets in the workbook. 
 

WindowsĄPrevents the user from moving, resizing, hiding, or closing the 

windows in the workbook. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Sorting Data 
 

Excel offers simple sorting for swiftly arranging the contents of a column and complex 

sorting for arranging the contents of a table using several Sort keys. 
 

Simple Sorting 
 

To sort data in a column or in selected cells quickly, click the Sort Ascending or Sort 

Descending button on the Standard toolbar. Sort Ascending sorts the cells in the 

column alphabetically or from lowest to highest value; Sort Descending sorts the cells 

into reverse alphabetical order or from highest to lowest value. Their first column sorts 



selected cells. 
 

Complex Sorting 
 

To perform a complex sort on the selected cells: 
 

Choose DataĄ Sort to display the sort dialog box  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

In the Sort dialog box choose up to three sort keys for your data. 
 

 First, if your data has a header row, make sure the header row option button is 

selected in My List Has group box. This will prevent Excel from sorting the 

headers. 
 

 Choose the first Sort key in the Sort by group box and then specify ascending or 

descending order. 
 

 Choose the second sort key in the first Then by group box. Again specify ascending 

or descending order. 
 

 Choose the third sort key in the second Then by group box. Again specify 

ascending or descending order. 
 

 If necessary choose sort options by clicking the options button to display the Sort 

Options dialog box in which you can choose a special First Key sort order, which 

will tell you whether to use case sensitive sorting and whether to sort top to 

bottom or left to right. 
 

 Click the OK button to close the Sort dialog box. 



Adding Comments 
 

Excelôs comments let you add text notes to any cell. Cell notes do not appear in the 

worksheet; they are indicated by a small red triangle in the upper right corner of the 

cell to which they are attached. 
 

To add a note to the active cell: 
 

 Choose InsertĄ Comment to display a comment box attached to the cell. 

 

 Type your note into the comment box. 

 

 Click in another cell to continue working.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

To edit a comment, right-click in the cell that contains it, and choose Edit 

Comment to display the comment box with the text ready for editing. 
 

 To resize a comment, move the insertion point over one of its sizing handles and 

drag inwards or outwards. 
 

 To move a comment so you can see both it and the cells it was covering, move the 

insertion point into one of its border so that it turns into a four-headed arrow, then 

click and drag the comment to where you want it to appear. 
 

 To delete a comment, right click in the cell that contains it, and choose Delete 

Comment from the context menu. 

 

Adding Headers and Footers 
 

To identify the work you print out, you will probably want to add a header or footer. 
 

 Choose ViewĄHeader and Footer to display the Header/Footer tab of the Pages 

Letup dialog box. 
 

 To use one of the automatically generated headers or footers, choose it from the 

Header drop-down list or Footer drop-down list. Choose (None) at the top of the 

list to remove the current header or footer. 



 To create a custom header or footer, click the Custom Header or Custom Footer 

button to display the Header dialog box or Footer dialog box, each of which offers 

Left Section, Centre Section and Right Section boxes. 
 

 To change a section, click in it and edit the contents using regular editing 

techniques. 
 

 To insert the page number, number of pages, current date or time, workbook name 

or worksheet name, position the insertion point in one of the section boxes and 

click the appropriate button to enter the code for the information. 
 

Getting Worksheet Printed 
 

To print your worksheet 
 

 Select the range of the worksheet to be printed. 

 

 You can see the preview of the hard copy you will get. 

 

 Choose File Ą Print command. 
 

 Select the appropriate options in the dialog box. 
 

 Click OK. 
 

CHARTS 
 

Introduction  
 

Charts are the graphic components of Excel. The data which is entered as tables can be 

viewed in the graphical form as charts which makes the figures of the data effective, 

interesting, easy to understand and easy to analyze and compare. Charts can be of two 

types: 
 

 Embedded charts: These charts are included in the worksheet and can be moved, 

copied and resized as any other graphical object. Their advantage is that they can 

be viewed alongwith the data and many charts can be inserted. 
 

 Chart sheet: Separate chart sheets are inserted when a chart is created. It contains only 

one chart. To create Chart Sheets, choose insert Ą Chart Ą As New Sheet. 
 

Two dimensional or three dimensional charts can be created with the help of 

Excel. After creating a chart, the information can be enhanced by adding chart items 

such as data labels, text and title. You can do formatting using patterns font, colours, 

alignment and other formatting attributes. Any change in data will update the changes 

in the chart which was made using that data. 
 

Chart Components 



Two-dimensional charts have an X-axis and Y-axis. Three-dimensional charts also 

have a z-axis. A typical chart such as one shown below has the following components. 
 
 
 
 
 
 
 
 
 
 
 

 

Chart Title  ï A title given to the whole chart. 
 

X-axis title ï A title given to the X-axis range. 
 

Y-axis title ï A title given to the Y-axis range. 
 

Legend ï It specifies the colour, symbol or pattern used to mark the data series. 
 

Data Series ï A data series is one of the sets of data from which the chart is drawn. 
 

Categories ï The items by which the data series is separated. For example ,if a 

chart shows the years 1992-1999, each year will be a category. 
 

Chart Types 
 

MS Excel offers 15 different chart types. You can choose the chart type to present 

your data most effectively and clearly. The various chart types are as discussed below: 
 

 Area Chart: This shows the magnitude of change over time. It is a stacked line 

chart, with the area between lines filled with colour and shading. The data series 

are plotted one on top of the other. They are good for showing how much the data 

series contribute to a whole. 
 
 
 
 
 
 
 
 
 
 
 
 

 Bar Chart: It consists of a series of horizontal bars that allow comparison of the 

relative size of two or more items. A horizontal bar that extends to the left or right 

of the baseline marks each data point. 



 
 
 
 
 
 
 
 
 

 

 Column Chart: This consists of a series of vertical columns that allow comparison 

of the relative size of two or more items. They are typical for showing sales, 

rainfall etc. 
 
 
 
 
 
 
 
 
 
 
 

 

 Line Chart: Each of the data series are plotted as lines of different colour and 

shading. The chart shows changes in data series over time like changes in prices. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Pie Chart: A single data series is divided up into pie-slices showing the relative 

contribution of the various data points. Market surveys are reflected well in pie 

charts. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 ̧ Doughnut Chart: It is similar to pie chart but it represents more than one data 

series. 



 
 
 
 
 
 
 
 
 

 Radar Chart: This shows the data values in relation to the center point and to each 

other. Data of the same data series are connected by lines. 
 
 
 
 
 
 
 
 
 
 

 

 XY (Scatter) Chart: An xy scatter chart either shows the relationships among the 

numeric values in several data series or plots two groups of no.ôs as one series of 

xy coordinates. This chart shows uneven interests or clusters of data and is 

commonly used for scientific data. 
 

When you arrange your data, place x values in one row or column and then enter 

the corresponding y values in adjacent rows and columns. 
 

Diagram  
 
 
 
 
 
 
 
 
 
 
 
 

 

Creating a Chart 
 

The easiest way to create a chart is to use Chart Wizard. 
 

The chart Wizard is a series of dialog boxes that guide the user through the steps 

required to create a new embedded chart or modify settings for an existing embedded 

chart. It displays either five steps or two steps, depending on what is selected .If 

worksheet data is selected, all five steps are displayed because youôre creating a new 

chart. If you have selected an existing chart to modify it, only two steps are displayed. 

To finish the Chart Wizard choose the finish button in any of the steps. 



 

 

 ̧

Following are the steps to create the chart through Chart wizard: 
 

To create a new chart, enter the data. 
 

 Click on Chart Wizard tool button from standard toolbar or choose InsertĄChart to 

start the chart wizard. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 Choose the chart type in the chart type list box. Excel will display a variety of 

available subtypes. Choose a sub type by clicking on it. 
 

 Excel will show a sample chart from the data you selected if you click on the óPress 

and Hold to View Sampleô button. 
 

 Click the Next button to display the second chart wizard ï the Chart Source Data.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 ̧

 

 ̧

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

On the Data Range tab, check / enter the data range. 
 

On the Series tab, adjust the data series as necessary. 



 Click the Next button to display the third chart wizard ï the Chart Options and 

select the options as per type of chart. 
 
 ̧

 

 ̧

 

 ̧

 

 ̧

 

 ̧

 

On the Titles tab enter chart, X-axis, Y-axis title. 
 

On the Axes tab, suppress the display of data on any axes if necessary. 
 

On the Gridlines tab, choose which gridlines to display. 
 

On the Legend tab, choose a legend and place it as per your choice. 
 

On the Data Labels tab, choose whether to show the data or not. 
 

 On the Data Tables tab, you can choose to show the data table alongwith the chart 

or not. 
 
 ̧

 

 ̧

 

 ̧

 

Click the Next button to display the forth chart wizard ï the Chart Location. 
 

Choose whether to display the chart (1) as new sheet or (2) as an embedded sheet. 
 

Click the finish button to have the Chart Wizard create the chart for you. 
 

Editing Charts 
 

Once you have created a chart, you may want to update it by adding or deleting more 

data series or data points from the worksheet, change the chart type, format a chart or 

draw inside a chart. 
 

Adding or Deleting Data 
 

Adding or deleting data automatically updates any existing legend. Using the chart 

Wizard, you can change the range that a chart is based on. If your chart was created 

from multi-level categories and series, you must use the Chart Wizard to reselect your 

data and recreate the chart. 
 

 To add data to an embedded chart on a worksheet, you can drag and drop data from 

that worksheet. Using copy and paste is the easiest way to add data to a chart 

sheet. Or you can use the New Data command for either embedded charts or chart 

sheets. 
 

 You can also delete data series from a chart by double clicking on that and pressing 

the Delete key. 
 

Change the Chart Type 
 

Excel lets you easily change a chart from one type to another till you really find a 

chart which suits your data. This can be done if you follow the given steps: 
 

 ̧ Select the chart by double clicking on it. It puts a border around the chart. 



 ̧ Choose Format à Chart Type and select the new chart. 
 

Or 
 

Click on Chart Wizard tool button (this will show only 2 steps out of 5) 
 

You can also change a chart quickly from one type to another by selecting the 

chart clicking the chart type drop down button on the chart toolbar and selecting the 

type of chart you want from the drop down list. 



Deleting a Chart 
 

To delete an embedded chart, either click on it and press Delete or right click in any 

open space inside it and choose cut from the context menu. 
 

To delete a chart sheet, right click the sheet tab and choose delete from the context 

menu. 
 

Editing an Element in a Chart 
 

To edit an element in a chart, click the element so that it displays handles and its name 

appears at the left end of the formula bar or on the Chart Objects box on Chart toolbar. 

Right click the element you want to edit and edit using normal editing techniques. 
 

Removing an Element from a Chart 
 

To remove an element from a chart, right click the element you want to delete and 

choose clear from the context menu. 
 

Formatting a Chart 
 

Once you create a chart and add chart items such as data labels or titles, you can then 

format many of the items in the chart. 
 
 ̧

 

 ̧

 

Chart area should be selected. 
 

Press right mouse button to get the short-cut menu and choose Format Chart Area. 
 

 Dialog box opens up where you can globally apply colours, patterns, borders, and 

text fonts. 
 

One-chart item at a time can be selected and formatted. 
 

There is an easy alternative to selecting and formatting individual chart items, i.e. 

you can use a built in chart auto format. Or you can create your own auto formats 

which you can apply to charts. Auto formats work much like templates or styles. Each 

auto format is based on a chart type. When you apply an auto format to an active chart, 

it changes the entire look of the chart but does not affect your data. 
 

How to Use a Built in Format 
 

 ̧

 

 ̧

 

 ̧

 

Select the chart. 
 

Choose Format -> Auto format. 
 

Select Built ïin, choose any of the charts from the galleries. 



How to Create a Custom Format 
 

 ̧

 

 ̧

 

 ̧

 

 ̧

 

 ̧

 

 ̧

 

 ̧

 

Create a chart having Chart type, font, pattern and other formats. 
 

Activate the chart. 
 

Choose Format -> Auto format. 
 

Select the user defined option and click on Customized button. 
 

Click on the Add button. 
 

Enter the name for the format. 
 

Click on OK. 
 

How to Draw in the Chart 
 

 ̧

 

 ̧

 

 ̧

 

 ̧

 

Select the chart. 
 

Activate the drawing tool bar. 
 

Click on the appropriate tool button of the toolbar. 
 

Draw on the chart. 
 

How to Print Charts 
 

 Embedded charts can be printed either with the data by selecting the range of 

worksheet including the data and the chart or without data also by: 
 

ï Select the chart 
 

ï Choose File -> Print. 
 

 To print the chart sheet 
 

ï Choose file -> page setup. 
 

ï After selecting the appropriate options for the chart size, page size, 
 

margins, header, and footer, click on print. 
 

FORMULAS AND FUNCTIONS  
 

Formulas and Functions are extremely easy to use. Formula is a recipe for performing 

calculations on numerical data. It can be anything from simple addition to complex 

additions. Function is a predefined formula built into Excel. Excel ships with enough 

functions to satisfy most computing needs-from Sum to DSTDEVP for calculating 

standard deviation based on all the entries in a database. You can also create your own 

powerful formulas as per your requirement. 



Parts of a Formula 
 

To create a formula in Excel, you need to indicate the data to be used in the computation 

and the operation or operations to be performed. Data can consist of constants (numbers) 

and references to cells. Operations use four categories of operators: arithmetic, logical, 

text and reference. A formula always starts with an (=) sign. 
 

Constants 
 

A constant is a number entered directly in the formula. It uses a constant value in 

every calculation, e.g. you could enter the following formula in a cell to add 5 in 13 
 

=13+5. 
 

When you press enter the cell will display 18. The initial ñ=ò sign tells excel that 

you are entering a formula in the cell, 13 and 5 are constants and the ó+ô sign is the 

operator for addition. 
 

References 
 

Reference indicates to Excel the location of the information you want to use in the 

formula. By using references instead of constants you could build formulas that you 

donôt need to change when the data in your worksheet changes, e.g. to perform the 

calculation 13+5 you could enter 13 in cell A1 and 5 in cell A2 and then enter this 

formula in A3 
 

= A1+A2. 
 

This tells excel to add the contents of cell A1 and A2 and show the result in cell 
 

A3. 
 

One of the easiest ways to enter references to the formula is to use range names. 
 

Operators 
 

The Operator is the way in which you tell Excel which operation to perform with the 

data you have supplied by using constants and references. Excel uses four types of 

operators: arithmetic, logical, text, and references. 
 

Arithmetic Operators 
 

Excelôs six arithmetic operators are: 
 

OPERATOR ACTION EXAM PLE 
 

+ Addition =A1+A2 
 

/ Division =20/D7 



^ Exponential =2^5 

*  M ultiplication =D5*2 

% Percent =90% 

- Subtraction =B4-B5 
 

Logical Operators 
 

Logical operators are also known as comparison operators 
 

 OPERATOR M EANING EXAM PLE 

= Equal to =AI=5  

> Greater than =D7>9  

< Less than =6 <5  
 

>= 
 

<= 
 

<> 

 
Greater than equal to =A3>=250 
 
Less than equal to =A5<=1000 
 
Not equal to =A5<>100 

 

True is represented as mathematical 1 and false as mathematical 0. This 

means that while the cell will display true or false and you are using the result in a 

formula, it will be treated as 1 or 0 respectively. 



Text Operator 
 

Excel uses one text operator the ampersand (&) for joining two levels together 

for e.g. if cell A1 contains the label 2000 and cell B2 contains the label profit you 

could use the formula = A1 & B2 to produce the result 2000 profit in another cell. 
 

Reference Operators 
 

Excel uses three reference operators for defining references.  
 
 
 
 
 
 
 
 
 
 

 

The range operator and the union operator are straight forward whereas the 

intersection operator needs a word or two of explanation .The intersection operator 

refers to the cells shared by two references ï in this example cells A4 and B4 because 

both are in the range A3: B10 and the range A4:D4. 
 

How Excel uses Operator 
 

Excel evaluates the operators in order of precedence as shown below. 
 

OPERATORS ACTION 
 

 Negation (negative numbers) 
 

 Percent 
 

 Exponentiation 
 

* And / M ultiplication and division 
 

+ And - Addition and subtraction 
 

=, >, <, >=, <>, <= Comparison 
 

When two operators have the same precedence, Excel evaluates them from left to 

right. 
 

Use parenthesis to change the order in which excel evaluates the operators in a 

formula. Excel evaluates the contents of the parenthesis first. 
 

For example if you wish to calculate 50*100-40 the result will be 4960 whereas if 

you wish to calculate 50*(100-4) then the result will be 3000. 
 

You can create a formula by typing it straight into the cell or reference area of the 



formula bar and then click the enter button. 
 

Copying and Moving Formulas 
 

Formulas can be copied about a workbook by using regular cut, copy, paste 

commands. But with formulas that contain cell reference, you need to consider the 

effect that copying or moving the formula will have on the references. 
 

Absolute, Relative and Mixed References 
 

By default, Excel uses relative references that work relative to the cell containing the 

formula. For example, suppose you have two column of numbers, A and B, and you 

want to subtract the value in each B cell from the value in the corresponding A cell. 

You could enter in cell C1 the formula =A1-B1, copy it and paste it in the remaining 

cells in column C. With relative references, Excel will adjust the formula it enters in 

each cell so that each performs the same relative operation. Relative references are 

useful in creating worksheets quickly. 
 

An absolute reference refers to the same cell in a worksheet no matter where you 

copy or paste it to. For example suppose you want to add sales tax to the previous 

example and the cell D10 held the current tax rate. If you use the relative reference for 

D10 in the first formula (=(A1-B1)*D10) and paste it to other cells in column D, 

Excel would change D10 to D11, D12 and so on and calculate the result accordingly. 

But when you use an absolute reference, Excel will not change the reference and will 

only use D10 as the reference. 
 

Excel uses the dollar sign ($) to denote absolute references so the absolute 

reference for the cell D10 would be $D$10. 
 

Mixed references are references in which either the column fixed and the row 

relative ($D10), or with the column relative and the row fixed (D$10). 
 

Functions 
 

A function is one of Excelôs built-in formulas. For example, the SUM formula adds 

the contents of the specified range. You can enter functions in your worksheets by 

simply typing them in. The functions perform the operation on the given  

values and return the result that is displayed in the same cell where function was 
entered. 
 

Some important functions are discussed below. 
 

SQRT() 
 

The SQRT function calculates the squareroot of any number. Let us take an example 

in which we want to find out the square root of the number 9. This can be done in the 



following way: 
 

 Choose Function from the Insert menu. 

 

 Choose Maths and Trigonometric from the Function category and SQRT from the 

function name. 
 

 Either type the cell address or point to the cell which contains the number for which 

square root has to be calculated. 
 

 The result would be displayed in the cell where you had initially placed the cursor. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

AVERAGE() 
 

The AVERAGE() function calculates the average of the series of specified number. In 

our present example, we have two numbers 9 and 81 for which we want to calculate 

the average . 
 

 Place the cursor where you want the function result to appear and choose the 

function from the insert menu. 
 

 Choose Statistical from the function category and Average from the function name. 

 

 Either type the range or point to the cells which contain the numbers for which 

average has to be calculated. 



The result would be displayed in the cell where you had initially placed the cursor.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

SUM() 
 

The SUM() function calculates the sum of entries in a specified range . Let us see how 

this can be done: 
 

 Place the cursor where you want the function result to appear and choose function 

from the insert menu. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 Choose Maths and Trig from the function category and SUM from the function 

name. 
 

 Either type the range or point to the cells which contains the numbers which you 

want to add up, you may even specify to discontinuous ranges using the second 

field. 
 

 The result would be displayed in the cell where you had initially placed the cursor. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

ABS() 
 

The ABS() function is used to get the absolute value of the number. The absolute 

value of a number means the number without plus and minus sign. In our present 

example we have a number ï45 in the cell A11 for which we want to get the absolute 

value. Let us see how this can be done. 
 

 Place the cursor where you want the function result to appear and choose function 

from the Insert menu. 
 

 Choose Maths & Trig from the Function category and ABS from the Function 

name. 



 Click once on the OK button.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

CELL () 
 

The CELL() function returns information about the formatting , location ,or contents 

of the upper left cell in a reference .This is a fairly useful command and it gives you 

all kinds of information about a cell or about the current file . 
 

 Place the cursor where you want the function result to appear and choose Function 

from the Insert menu. 
 
 ̧

 

 ̧

 

Choose Information from the Function category and CELL from the Function name. 
 

Type óFilenameô in the info_type field. 
 

 The result would be displayed in the cell where you had initially placed the cursor. 





TODAY() 
 

The TODAY() function is one of the few functions that do not require any user argument. 
 

It simply returns the current date. Let us see how this works. 
 

 Place the cursor where you want the function result to appear and choose Function 

from the Insert menu. 
 

 Choose Date & Time from the Function category and Today from the Function 

name. 
 

 The result would be displayed in the cell where you had initially placed the cursor. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Automating Worksheet 
 

MS Excel provides tools to automate our regular tasks. These tools are Macros and 

Templates. Excel supports VBA (Visual Basic Application) which is a language based 

on Visual Basic Programming language. 
 

Programmers can create custom applications using VBA or non-programmers can 

automate their routine work by creating macros. 



Templates are reusable models that standardize the look of the worksheet. They 

can be used to create periodic reports. 



What are Macros? 
 

Macros are actions created through the macro recorder by observing actions, 

converting those actions into visual basic code and sorting the code in a visual basic 

module. These recorded actions can be performed again more easily and quickly by 

simply clicking a button or a key combination. 
 

How to Record a Macro 
 

 ̧

 

 ̧

 

 ̧

 

 ̧

 

 ̧

 

 ̧

 

 ̧

 

Choose Tools-> Record Macro -> Record New Macro command. 
 

Type the name in the Macro name box. 
 

Type the description of the macro in the Description box. 
 

Choose the Options button to set options for the macro. 
 

Choose the OK button. 
 

Type the name of the months in cell range A1:A12 and make the entries bold. 
 

Click the Stop Macro button. 
 

Or 
 

Choose Tools-> Record Macro -> Stop Recording command.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

How to Run the Macro 
 

Running the Macro means to repeat the action recorded as a macro. To run the Months 

Name Macro follow the given steps. 
 

 Choose Tools->Macro command 
 
 In the Macro name/Reference box, type or select the macro name. 
 
 Click on the Run button. 



Or 
 

Choose Tools-> Months 
 

Or 
 

Press Ctrl+Shift+M key combination.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

How to Delete a Macro 
 

As the macro has been recorded in a separate sheet, deleting that sheet will delete the 

macro. Macro can also be deleted from the Tool menu. The necessary steps to carry 

out the above mentioned ways for deleting the macro are given below. 
 
 ̧

 

 ̧

 

Select the macro sheet or sheets, which you want to delete. 
 

Choose Edit-> Delete Sheet command. 
 

Or 
 

ï Choose Tools-> Macro command 
 

ï Select/type the Macro name 
 

ï Click on the Delete button 





How to Assign the Macro to Toolbar, Menu or Shortcut Key 
 

Once you record a macro, you can attach it to a menu item, button, or a shortcut key, 

making it as accessible and convenient as the built-in menu 

commands and buttons in MS Excel. A macro assigned to Tools menu or shortcut 
keys is always available and a macro assigned to a toolbar button is available when the 

toolbar is displayed. If you assign your macro to a build-in button that MS Excel 

already uses, you override the buttonôs normal function with that of your macro. 
 
 

 

 ̧

 

 ̧

 

 ̧

 

To assign the macro to the tool button, follow the given steps: 
 

Choose View-> Toolbars command. 
 

Click on the Customize button. 
 

Select Custom from the list of categories. 
 

 Drag the last tool button of the 3rd row and place it on the toolbar. This will open 

up the Assign Macro dialog box. 
 

 In the Macro name/Reference box, select/type the name of the macro and click on 

OK button. 
 

 Choose the Close button to close the Customize dialog box.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

How to Restore the Tool Button 
 

 ̧

 

 ̧

 

Choose View->Toolbars command. 
 

Click on Customize button. 



 Select Custom from the list of categories. 

 

 Drag the tool button from the toolbar back to its place in the Customize dialog box. 
 

 Click on Close button. 
 

What is a Template? 
 

A template is a special workbook which can be used as a pattern to create other 

workbooks of the same type. In addition to creating new workbooks based on 

templates, you can insert sheets from templates into your workbooks. 
 

Templates can contain text and graphics, formatting and page layout, formulas and 

macros. 
 

You can create special templates, called autotemplates, in your Startup or Alternate 
 

Startup directory. Auto templates can also be used as the basis for all new workbooks 

and all new sheets you insert in your workbooks. Auto templates are just templates 

saved with a specific name on a specific 
location. 
 

How to Create a Template 
 

To create a template, follow the given steps: 
 

 ̧

 

 ̧

 

 ̧

 

 ̧

 

 ̧

 

 ̧

 

Create a workbook with all the styles, formatting, text and formulas you want. 
 

Choose File-> Save As command. 
 

In the File Name box, type the name of the template. 
 

Select the directory and drive where you want to save the template. 
 

In the Save File As Type box, select Template. 
 

Click on OK button.  



How to Open a Template 
 

To open a template to create the worksheet based on it, follow the given steps: 
 

 Choose File-> New command. 
 

 Select the template on which you want to base a new workbook. 

 

How to Modify Original Template 
 

To edit the original templates, follow the given steps: 
 

 Click on the Open button on the standard toolbar or press Enter. 

 

 Select the template you want to open. 

 

 Hold down SHIFT key and click on OK button. MS Excel opens the original 

template for editing. 
 

 Make the needed modifications in it and click on Save button.  



POWERPOINT 
 

Introduction  
 

PowerPoint is a presentation tool that helps you create effective, audio-visual-

graphical presentations. Generally the presentations consist of a number of slides that 

are arranged in a sequential manner. One can put the animation effects to give the 

presentation a different and impressive look. Not only that, PowerPoint can also be 

used to prepare handouts and speaker notes automatically once the presentation is 

finally prepared. The slides prepared can be used either by taking out the printouts on 

the transparency slides or the computer can directly be attached to the LCD display 

panel that can enlarge the picture and present the output on the screen. 
 

PowerPoint has provided the user with lots of predesigned slide formats, clip art 

graphic libraries, autocontent wizards and design templates. The user can use any of 

the available options and design the presentation depending upon the time and the 

requirement. By using the predefined slide formats, one can prepare the presentation 

on standard formats and designs whereas by creating oneôs own slide formats, the user 

can give new creative looks as per the requirements. 
 

Other office components, like Word file, Excel spreadsheet or graph etc. can also 

be inserted in the presentation to make it more complete and attractive. 
 

We shall first have a look at all the menu items and then start working on a 

presentation as an example. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Menus 
 

File Menu 
 

 New: Creates a blank new file based on all default values. 
 
 Open: Opens an existing file. 



 Close: Closes the existing file (without exiting from the application). 
 
 Save: Saves the active file with the current file name, location and file format. 
 
 Save As: Saves the active file in a different file name, location and the file format. 
 

6. Save as Web Page: Saves the file in the format required for the Internet 

applications. 
 

7. Pack and Go: Starts the Pack and Go wizard. This helps you pack up a 

presentation so that it can be run on another computer. This wizard can be run 

again if some updation is required in the presentation. 
 

 Web Page Review: This allows you to preview the current file as a web page in 

your browser so that you can see how it actually looks like. 
 
 Page Setup: Sets the margins, paper source, paper size, page orientation and other 

layout options for active files.  
 Print: Prints the active file or the selected part to the selected printer. 
 
 Send To: Sends the document to the briefcase or the mail recipient as an e-mail. 
 
 Properties: Displays the property sheet for the active file. 
 
 Exit: Closes the application program after prompting you to save all the unsaved 

files. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Edit Menu 
 

 Undo Last command(s) reverses the last command i.e. undoes the effect of the last 

command you executed. 
 

2. Repeat Last Command(s) reverses the undo command i.e. restores the last 



command. 
 

3. Cut: Removes the selection from the active document and places it on the 

clipboard ï a special place in computerôs memory from where it can be retrieved 

again. 
 

 Copy: Copies the selection to the clipboard. 
 
 Paste: inserts the content of the clipboard at the insertion point and replaces any 

current selection block.  
 Paste Special: Pastes, links, or embeds the clipboard content in the current file in 

the format you specify. 
 
 Paste as Hyperlink: Inserts the content of the clipboard as a hyperlink at the 

insertion point, replacing any selection. 
 
 Clear: Deletes the selected object or text without putting it on the clipboard. 
 
 Select All: Selects all text and graphics in the active window, or selects all the text 

in the selected object. 
 
 Duplicate: Makes a quick copy of a selected object. To make additional copies of 

the same object, click duplicate again.  
 Delete Slide: Deletes the current slide in slide or notes view. Deletes the selected 

slides in slide sorter or normal view. 
 
 Find: Searches for specified text, formatting, symbols, comments, footnotes or 

endnotes in the active document. 
 
 Replace: Searches for and replaces specified text, formatting, footnotes, endnotes 

or comment mark in the active document.  
 Go to Property: Moves the insertion pointer to the item where you want to go. 
 
 Links: Displays or changes information for each link in the current file, including 

the name and location of the source file, the item, the type and whether the link 

updates automatically or manually.  
 Text Object: Activates the application in which the selected object was created so 

you can edit the object in place. 
 

View Menu 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Insert Menu  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Format Menu 
 

 Font: Modifies the font type, colour, format, character spacing etc. of the selected 

text 
 

 Bullets and Numbering: Adds/removes the bullets/numbers from the selected text. 

 

 Alignment: Aligns the selected text to the left, right, center or justifies. 

 

 Line Spacing: Sets the space between the lines. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 ̧

 
 
 
 ̧

 

 ̧

 

 ̧

 

 ̧

 

 ̧

 

 ̧

 

 

 ̧

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 ̧

Change Case: Changes the text to lower case, uppercase, 

sentence case, toggle case or title case. 
 

Replace Fonts: Replaces the existing font type with the another. 
 

Slide Layout: Changes the layout of the slides. 
 

Slide Colour Scheme: Modifies the existing colour scheme. 
 

Background: Modifies the background of the slide. 
 

Apply Design: Applies the design template to the presentation. 
 

Colours and Lines: Applies the different styles and colours to the lines and 

outlines. 
 

Autoshapes: Helps you change the colour, shape, fill, size and position of the 

objects. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Tools Menu 
 

Spelling: Checks the active document for possible spelling, grammar and writing 



style errors. 
 

 Language: Designates the language of the selected text in a file. 

 

 AutoCorrect: Sets the options to correct the text automatically as you type. 

 

 Look Up Reference: Inserts the cross references. 

 

 Meeting Minder: Here meeting minutes can be made and actions can be recorded at 

that time of presentation. 
 

 Macro: Here you can add, run, edit or delete a macro. 

 

 Add-Ins: Attaches a different template to the present slide. 

 

 Customize: Helps in customizing the toolbar buttons, menu commands etc. 
 

 Options: Modifies the settings for the MS Office programs. 

 

Slide Show 
 

 View Show: Runs the slide show of the presentation. 

 

 Rehearse Timings: Runs the slide show in the rehearsal mode. Here the timings can 

be set or modified. 
 

 Record Narration: Voice can be added here. 

 

 Set Up Show: Options are set here, in terms of type of presentation, transition and 

animation settings, sound effects and slide proceeding. 
 

 Action Buttons: Buttons are added for the action settings. 

 

 Action Settings: Assign actions to the action buttons. 
 

 Preset Animation: Different animation actions can be applied in 

the slides. 



 Custom Animation: Animation effects like sound, text, movements etc can be 

applied or modified by this option. 
 
 ̧

 

 ̧

 

 ̧

 

 ̧

 

Animation Preview: Runs all the animation effects in the current slide. 
 

Slide Transition: Adds or modifies the transition settings between the slides. 
 

Hide Slide: Hides the current or selected slide(s). 
 

Custom Shows: Sets the shows within the show. 
 

Window Menu 
 

 ̧ New Window: Opens a new window with the same contents 
 

as the active window which helps in viewing different parts of the same file at the 

same time. 
 

 ̧ Arrange All: Fits all the open files at the same time that makes formatting 
 

options easier among various presentations. 
 

 ̧ Fit to Page: Puts active presentation on the top of all the open presentations 
 

(opened) in different windows. 
 
 ̧

 

 ̧

 

 ̧

 

Cascade: Arranges all the open presentations overlapping each other. 
 

Next Pane: Moves clockwise to the next pane in the presentation. 
 

Presentation: Lists the current open presentation . 
 
 
 

 

Help Menu 
 

 Microsoft PowerPoint Help: Launches the MS Office Assistant that provides the 

help and tips to work with MS PowerPoint. 
 

 Show the Office Assistant: Displays/removes the Office Assistant from the view. 



 Whatôs This? Displays the particular topic on which help is required. 

 

 Office on the Web: Connects you to the MS Office web site from where the 

updated information can be downloaded. 
 

 Detect and Repair: Finds and fixes the errors automatically. 
 

 About Microsoft PowerPoint: Displays the PowerPointôs version details, copyright 

message and system information. 



Auto Content Wizard 
 

Generally preparing presentations is difficult because a lot of designing, inserting text 

boxes, clip arts, graphs etc are required. But just imagine that everything is prepared 

and now you just have to change the contents of the presentation. PowerPoint makes 

your job easy as it has all the things prepared and it keeps asking you questions about 

the slides you want to prepare and prepares the slides automatically. How does that 

sound? Easy? So let us try to prepare the presentation this way! 
 
 

 

 ̧
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 ̧

 

 ̧

 

Let us proceed step by step: 
 

Click on start button. 
 

Click on Microsoft PowerPoint from the programs menu. 
 

Click on AutoContent wizard button. 
 

Click on OK to continue. 
 

Click on next tab to select the type of presentation. 
 

Select ñRecommending a Strategyò from ògeneralò option as the presentation type. 
 

 Choose ñon-screen presentationò button to get the type of output you would like to 

use. 
 
 ̧

 

 ̧

 

Type presentation title here. 
 

Click on finish button to see the output. 
 

Here, in this example, there are a total of seven slides, each slide containing some 

sub information or headings. Now you can make changes or overwrite on either one of 

the parts. This means if you make changes that in the left frame or in the right frame, 

the other part will automatically be changed. 
 

Although these slides are predefined, you can add, delete or modify any of the 

parts present in the given content as per your requirement. The number of slides can 

also be increased or decreased as desired. You can change the text, the colour scheme, 

the clipart images etc on any of the slides. 
 

The AutoContent Wizard can help you focus on the key issues about any of the 

topics (that are already given) without thinking much about them and also saves a lot 

of your time in designing etc. 





 
 
 
 
 
 
 
 
 
 
 
 

 

Templates 
 

Similar to AutoContent wizard there is another option available to PowerPoint users 

which can help you make your presentation in very little time but giving it a 

professional touch. This sounds surprising but this option is also available in which 

you can choose your own layouts, backgrounds, images, colour schemes etc from the 

given library. This option is called Templates. 
 
 

 

 ̧

 

 ̧

 

 ̧

 

 ̧

 

Let us now see how it works 
 

Click on start button. 
 

Click on Microsoft PowerPoint from the programs menu. 
 

Click on Design Template button. 
 

Click on OK to continue. 
 

 Check the various template designs given one by one ï you can see the preview of 

the selected template in the right part of the window. 

 
 ̧

 

 ̧

 

 ̧

 

Select ñLock and Keyò template and press OK to continue. 
 

The following window would be displayed. 
 

You can choose any of the page layouts and press OK to continue. 
 

Now all the steps are same as in AutoContent Wizard for preparing a normal 

presentation. Here also you can make changes in the colour schemes, the clip art 

images or backgrounds and layouts etc. 







 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Applying Transitions, and Animation Effects 
 

An electronic presentation, or the slide show, is used to give the presentation on the 

computer screen or on the LCD projector. Now since these slides are changed by using 

the computer only and not manually, special effects can be added to the slide show to 

make it more effective. A transition is a special effect added to the slide show to 

change itôs initial appearance on screen like it can be made to appear from the top, 

fades in gradually, or the background changes. 
 

Not only this, animation effects can also be added to the slide show for e.g. 

different points in bulleted form appearing one by one from each of the four 

directions, or the objects having the animation effects etc. 
 

Adding Transitions 
 

Most of the templates include transition effects in them to make the presentation more 

effective and lively, but never mind, you can also put these effects in your slides to make 

them at par with the pre-designed templates. Add the transition in your slide click on the 

slide show menu and then select slide transition form the menu. You can chose the type 



of slide transition from the drop-down list. 
 

Most of the listed transitions differ only in directions. Once you apply any of the 

given transitions, a transition icon appears at the bottom of the slide. On clicking this 

icon, the transition reappears in the slide miniature. You can see the various types of 

available transitions and then select the best suited. 
 

Speed and Sound 
 

You can also give special effects like speed and sound to the slide show. Here each type 

of transition has a default speed but you can change it as you want it to. For that also you 

have to go to the slide show menu, select the transition type and the same window will 

appear. You can choose the effect from the drop-down list, select the type of transition 

and then specify its speed. Now in the advanced section you can enter the timings for 

automatic slide advances. There is another section in the window that contains the sounds 

drop-down menu and you can select the type of sound from that menu. 
 

Not only this you can assign the sound loop that will continue till new sound is 

assigned to it. 



Animation  
 

Transition is used between slides whereas animation effects are used within the slide. 

Various titles, bullets, the objects, graphs or tables can be added in the slide separately 

using animation effects. 
 

REVISION EXERCISES 
 

 Prepare a business letter to your customer promising to attend to his complaint 

immediately. Use page setup, formatting features, etc.  
 Prepare a table in which the budget comparison of three years is made. 
 
 Write a thank you note to be sent to all your friends who had greeted you on new 

year. 



Chapter 14: DATA BASE MANAGEMENT SYSTEMS  
 

In early day computing, data was kept in data files and programs were written to 

interact with these data files in order to produce reports. This type of environment lead 

to a situation in which every new application required the services of an experienced 

programmer, who usually took a fairly longtime  

to study, design, develop and test his application. Very often the number of programmers 

in an organization were limited and computing requests of various departments were 

many. This resulted in a long queue of undeveloped applications and a general feeling of 

dissatisfaction about the wisdom of the investment in computers. 
 

World over the computer professionals were aware of this problem and were busy 

researching to find ways and means of improving productivity. One obvious point, 

which came to the forefront was that a major portion of their programming effort 

involved file handling, in which lines of code for opening, closing, writing, deleting 

etc had to be written for every program. 
 

Apart from this, if computers were to deliver their full potential, it was essential 

that the actual user of application should become eager to accept the computer as a 

friend. 
 

All these factors along with several other considerations led to the development of 

file management systems, in which most of the common file management programs were 

incorporated, thereby eliminating the need of writing separate programs for them. 
 

This, translated into action, meant that with the help of easy and simple commands, 

the user is presented with a screen to create, edit, save a file or enter data into the file. 

This data in then retrieved for any condition specified through simple commands. 
 

File managers are useful when dealing with single files. However, as it will be 

discussed later, complex application require the data to be organized in more than one 

file. As such, in order to cope with this reality, file managerôs capability was extended 

leading to the creation of database management systems. 
 

A database management system can be thought of as a manager of the database 

consisting of different types of data organized into several files. 
 

The data model used by most available DBMS is one in which information is 

grouped into files. Each file contains records. Each record contains information about 

a particular instance of an event or an object, and all the records represent similar 

events or objects. The terminology used is as follows: 
 

Entity: It is a real world object or event which is of interest to us. For example, if 

we are interested in computing the Payroll of the company, one of the real word object 



of interest to us is the employee. 
 

Attributes: These are the characteristics or properties of the entity. For example 

the characteristics of employee for the payroll application will be staff number, name, 

designation, basic pay, allowances, number of leaves, advances/loans and so on. 
 

Practically speaking, in the RDBMS approach, each entity represents a table and 

each attribute comprises a field of the table. All fields combined for one particular 

instance of the entity is called a record or tuple. All records taken together constitutes 

the table. 



MORE ON FIELDS  
 

Field Names: every field must have a name so that data in the field can be accessed 

using that name. Usually field names are chosen represent as closely as possible that 

real word items they represent. Each DBMS has its rules for naming conventions to be 

used. 
 

Field Types: Data types: since the user may want to treat data in different ways, 

DBMS allows the user to define the data types as numeric, character, date, logical, 

memo, etc. A user has to be very careful in selecting the data type. For example a staff 

number of 001234 , at first instance tempts the user to jump to the conclusion that the 

data type should be numeric. However when you print this out, the staff number is 

printed as 1234. As a general rule always define character data type for any number on 

which no calculation has to be done now or in the future. 
 

DATABASE FEATURES 
 

Covered below are some of the features which differentiate database management 

from ordinary data processing. 



Operation Modes 
 

The interaction of the user with the database can occur through command driven 

mode, menu-driven mode and program driven mode. Some database systems have all 

the three capabilities while the others are built around only one. 
 

The Command Mode 
 

Here the user gives commands to the DBMS interactively. Due to this feature some 

technical experience is necessary and is therefore not popular with people who wish to 

use the database once in a while. 
 

Menu Driven Mode 
 

This mode of operation is generally used by user with small and clearly defined 

applications. The advantage of this method of operation is that it gives all necessary 

choices on the screen and as such the user need not have much technical expertise. 
 

Program Mode 
 

In case the users needs are very complex, then manipulation of the database has to be 

done through one or many application programs. In such a situation where a large 

amount of data processing is involved program mode is best suited. 
 

Data Access 
 

Database systems demands that data should be accessed easily. This includes 

modifying data, adding data, searching the database and generating reports. Usually 

these operations are easily accomplished in database systems. 
 

Help Facility 
 

This feature allows the user to obtain online help while interacting with the DBMS. 
 

ADVANTAGES OF THE DBMS APPROACH  
 

 Data Redundancy is reduced considerably thereby solving problems of excessive 

memory requirements and data inconsistencies. 
 

2. Programming effort is also reduced considerably because of the built-in 

capabilities of the DBMS. 
 

 Response time is much faster since the end-user can directly interact with the 

DBMS.  
 Data independence is achieved as the responsibility of knowing the physical 



details of data storage lies with the DBMS. The users concentrate on the logical 

contents of the data. 
 

 Most databases give the users the freedom to make database design changes very 

easily. In contrast, in a non DBMS environment, these changes would require 

considerable programming effort.  
 Due to the features discussed above, significant cost savings are achieved through 

the use of a DBMS. 
 
 DBMSôs offer a wide variety of security and privacy features which are essential 

for the success of the system. 
 

FILE  STRUCTURES 
 

Some of the commonly used files structures are discussed below: 
 

1. Sequential Files: The sequential file is distinguished by the following 

characteristics: 
 

 In this type of file the records should be accessed in this same order in 

which they were written. In other words, there is no method by which a 

particular record can be accessed by skipping other records.  
 If the file has to be updated and a record has to be modified, then the file 

has to be rewritten to another file. 
 

Sequential files are suited for applications which require all file records to be 

processed at the same time. The most common application is the Payroll system of 

any organization ,where salaries have to be computed once a month for all the 

employees. However, for other applications these characteristics of the sequential 

file may not be acceptable. 
 

 Random Access Files: Many applications require the records in a file to be 

accessed in a random manner rather than sequentially. The rail reservation system 

requires that the booking position should be available in a few seconds. Random 

access files have this characteristic. Two of the most commonly used random 

access files are indexed file and index-sequential files. In order to understand these 

files it is important to understand the concept of record keys. 
 

Consider the example of an employee file in which records of each employee 

comprising of staff number, name, designation, basic pay are stored. If we wish to find 

the record of particular employee, then an identifier for that record must exist. This 

identifier is called the record key. For instance in our example the staff number can be 

used as an identifier to locate the record of a particular employee. Usually a file must 

have at least one unique key whose value is taken as the name of the record. This is 



called the primary key of the file. 
 

It is also possible that one key may not uniquely identify the record. For example, 

two persons can have the same name as well as the same fathers name. In such a 

situation, the name, fathers name and the address may be jointly taken as the identifier 

key. A key thus formed by joining two or more fields is known as a concatenated key. 

Since this combination uniquely identifies the record it may be used as a primary key. 
 

All other fields which do not uniquely identify the record are termed as secondary 

keys. 



Indexed Files 
 

While using databases one of the method to obtain random access is to create one or 

more indexes on that file. Since the records of the file are scattered on the disk, an 

index should be created which will contain a table of values in which the first column 

contains record key values and the second column contains disk addresses. The keys 

are arranged sequentially in their column. 
 

Suppose we have an indexed file called EMPLOYEE which is indexed on field 

called staffno. Since the file is indexed on the primary key ,the index will be called 

primary key index. 
 

Adding Records to the File Employee 
 

When the file is first opened , the operating system will allocate a block of disk space 

to it. As records are added to the file , they are written to this block and on filling up of 

this block a new block is allocated. Whenever a record is written an entry is made in 

the staffno index which comprises of the key value and the block number into which 

the record is written (known as the relative address of the record). 
 

A file directory which gives the physical address corresponding to the relative 

address is also created. Whenever a search is made for the record which contains a 

specific value for staffno, the index table is read first and the physical address is then 

cross referenced. 
 

Indexed Sequential Files 
 

In this type of file records are physically stored on the disk in groups. Records are 

stored sequentially within each group. When each group corresponds to a physical 

subdivision of the disk such as a track, the file type is known as ISAM. (Indexed 

Sequential Access Method). In addition to this, with each track, a separate primary key 

index also maintained. In this arrangement, the ISAM file can be accessed in two 

ways. i.e. entire file can be read sequentially or alternatively records may be accessed 

via the index: the index is entered by key value, the address is located within the index 

and the record is retrieved. 
 

These files are used typically when: 
 

 Random access is needed to the records using the primary key. 
 
 Frequent access to the file in primary key sequence is also needed. 
 

LOGICAL DATABASE DESIGN  



Up to now we have been addressing data without considering the relationships 

between various data items. In designing for a database it is important to develop a 

conceptual model of the involved data which states the relationship between the data 

items. The purpose of this exercise is to group the data into a number of tables in order 

to reduce data redundancy and avoid addition, deletion and modification anomalies. 
 

ER Analysis 
 

A method called entity-relationship analysis has been used for obtaining the 

conceptual model of the data, which will finally help us in obtaining our relational 

database. In order to carry out ER analysis it is necessary to understand and use the 

following features: 
 

 Entities: these are the real word objects in an application. 
 

2. Attributes: these are the properties of importance of the entities and the 

relationships. 
 

3. Relationships: these connect different entities and represent dependencies between 

them. 
 

In order to understand these terms let us take an example. If a supplier supplies an 

item to a company, then the supplier is an entity. The item supplied is also an entity. 

The item and supplier are related with each other are in the sense that the supplier 

supplies an item. Supplying is thus the verb which specifies the relationship between 

item and supplier. A collection of similar entities is known as an entity set. Therefore 

each member of the entity set is described by its attributes. 
 

A supplier could be described by the following attributes: 
 

SUPPLIER [supplier code, supplier name, address] an item would have the 

following attributes 
 

ITEM [item Code, item name, rate] The Entity Relationship diagram shown in the 

Figure 14.1 represents entities by rectangles and relationships by a diamond. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 14.1: The Entity Relationship 
 

Now the problem, that we come across is of identifying entities, which can be in a 

set. An entity set can have only those items which have same property. To understand 

in better way, teachers form one entity set and lectures another. The relationship is 

ñtakeò. Teachers take lectures. Lectures are held in class rooms thus constituting 

another entity set and the relationship is held ñinò. 
 

It is easier to find out the relationships once the entities are identified. That could be 

made easier by saying that entities are generally ñnounsò and the relationships are the 

ñverbsò. One has to use one's commonsense to find out the entities and the relationships. 
 

A single entity can be related to more than one entity. Let us have better 

understanding by taking one more example- 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 14.2: The Entity Relationship ï An Example 
 

Once the entities and relationships are identified, the next step is to specify the 

attributes of entities and relationship. For example, the attributes of supplier, are 



supplier address. Similarly the attributes of entity orders would be order no., order 

date, whereas the attributes (identification) of both the entities (it connects both) i.e. 

the item code and the supplier code. Not only that but also the attributes like Order 

no., Qty. supplied, Date of Supply, Rate of item. 
 

The attributes of the entities and the relationships are shown in the Figure 14.3 also:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

The unique attribute from the set of each entity is underlined. One thing to be noted 

is the same supplier can supply a number of items and same item can be supplied by a 

number of suppliers. Thus we require both the identifications i.e. supplier code and item 

code to uniquely specify the quantities of item and the date of supply. Now the supplier 

may make mistakes in the supply of orders, so the order number is also required. 
 

Let us see all the distributes of all the entities to understand the relationships in a 

better way: 
 
 
 
 
 
 

 

Relationships Cardinality and Participation 
 

A relationship cardinality is the number of relationships in which an entity can appear. 

This cardinality is usually shown on E-R-diagram. An entity can have ï 
 

 One Relationship 
 

 Fixed number of relationships 
 
 Variable number of relationships. 
 

As we discussed a supplier may supply number of items and the same item may be 
supplied by number  of vendors. This  is  depicted in the  Figure  14.4. There  are  2 
suppliers say S and S . There are items I , I , I éé I . Supplies S 

1 
supplies items I , I , 

1 2 1 2 3 6 1 2 

I  and supplier S supplies items I , I , I , I and I .     
4 2 2 3 4 5 6 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 14.4 
 

Let us associate variables N and M with the entities supplier and items respectively. 
N varies from S  to S  and M = I  to I . 

1 2 1 6  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

The relationship  is illustrated  as N:M  relationship  when  one supplier S is 
1 

supplying 3 items then the relationship N:M becomes 1:3 and if an item is supplied by 

2 vendors then it becomes 2:1 relationship. 
 

Till now we have seen that each member in an entity set is participating. But this is true. 
 

There are conditions like: 
 

 It is necessary for each vendor to supply all the items, then it's participation is 

compulsory or mandatory. 
 
 It is also possible that each vendor is not required to supply all the items then it's 

participation is optional  
 If a condition is put like the supplier has to supply a particular item if the second 

vendor is not able to supply the quantity in time then this type of participation is 



conditional. 
 

RELATIONAL DATABASE SYSTEMS  
 

Usually, a conceptual design cannot be directly implemented on a particular database 

system. Rather, the design must first be translated into a physical database design or 

physical model, that conforms to the features of the particular DBMS being used. The 

reason for this is that each DBMS has its own particular set of data structures for 

storing and maintaining information and there is often no direct relationship between 

these structures and those of a particular conceptual model. Thus, a conceptual design, 

which is built up from entity-types, relationships, constraints and so on, must be recast 

into forms that can be directly implemented on the DBMS. In other words, they must 

be recast into a suitable physical database design. 



The Relational Database Model 
 

Basic Characteristics: Relational databases have certain characteristics that distinguish 

them from other types of databases. These are: 
 

 A relational database consists of one or more two-dimensional tables of data 

values, with very simple rules defining the construction of a tables of data values, 

with very simple rules defining the construction of a table. 
 

 Relationships between two or more tables is based on a common field, taken as a 

primary key in one table and foreign key in the other tables. 
 

Definitions: The basic structure of a relational design is the table, known as a 

relation. Each row of a table, is known as a tuple. Each column of a table contains 

some data corresponding to a particular row. The terms attributes and columns are 

used interchangeably. 
 

Rules for Table Construction 
 

 Each row must be unique. This means that no two row should have the same data 

for every column. 
 

 Each entry in a table in any particular column corresponding to any row should be a 

single entry. 
 
 ̧

 

 ̧

 

The order in which the rows are projected is immaterial. 
 

Each column should have a name which should closely reflects the entry made in 
 

it. 
 

Attributes and Domains 
 

An attribute of a table represents a particular characteristic of the set of facts 

represented by the table. A related concept that is very useful is the domain of an 

attribute, which is defined as all of the possible values that may be assumed by the 

attribute. 
 

Keys: The keys play a very important role in the construction of a complete 

database application. It is useful to have a primary key in each table which recognizes 

unique data in each column. There may be a case in which more than one column in 

the table is unique. In this case all these columns are known as candidate key. Out of 

this only one is taken as the table key and rest are called as alternate keys. 
 

Often there is a case when no single column in a table is unique. Then there is a 

possibility that there may be a combination of keys that are unique. So in that case a key 



has to be concatenated with other keys. In this case the columns are used in combination 

to represent the table key. This kind of table key is known as the concatenated key. 
 

Functional Dependency: An attribute B is functionally dependent on attribute A if 

every value of A uniquely determines the value of B. In this case, attribute A is called 

the determinant of B. 
 

As an example let us consider the following table for which the data is given 

below: 
 

EMPLOYEE (STAFFNO, NAME, SALARY)   
 
 
 
 
 
 
 

 

The table represents the data for each employee and the likely choice for the key is 

STAFFNO. If we look at the table it will be seen that if STAFFNO is known the 

NAME will be automatically determined. For instance if the STAFFNO is 1276 

corresponds to the NAME ASHISH. In such a situation NAME is said to be 

functionally dependent on STAFFNO. Similarly it can be observed that SALARY is 

also functionally dependent on STAFFNO. This can be represented as 
 

STAFFNO NAME  
 

SALARY 
 

Functional dependencies are not necessarily symmetric, in a way that B may be 

functionally dependent on A but this does not necessarily imply A is also functionally 

dependent on B. 
 

This means that in the EMPLOYEE table STAFFNO uniquely identifies the 

SALARY of an individual. However many individuals may have the same salary. 
 

A functional dependency can involve more than one attribute in which case a 

concatenation key is used to depict the functional dependency. For example if a table 

as shown below exists 
 

ORDER[ORDERNO,ITEMCODE,QTY] 
 

The functional dependency will be 
 

ORDERNO+ITEMCODE QTY.  
 

This is so since QTY is not dependent on ORDERNO or ITEMNO alone but on 

the combination of both the attributes. 
 

Table Normalization 



The tables should be properly designed. If the tables are not pre planned in design, the 

organization may face a lot of problems in terms of money and time. After the poorly 

database design, if the tables are implemented, it will be a costly affair to eliminate the 

problems since this will involve people time and large data storage. To help eliminate 

these problems, a systematic technique has been developed for translating a conceptual 

design into a set of well-designed tables. This technique is known as normalization. 
 

Normal Forms 
 

There are some characteristics of the tables, which can be identified. The different 

combinations of these characteristics are called as the Normal Forms. There are 

several Normal forms and each normal form has been designed to eliminate some 

problem associated with the relational tables. Each table undergoes a set of 

transformations and each transformation changes one normal form to the other. 
 

First Normal Form 
 

The starting point in the normalization process is to have the First Normal Form.  
 
 
 
 
 
 
 

 

E.g. DEALERS [Name, Dealerid, Location, Orderno, Orderunits, Dateoforder] 
 

The above table can be broken down to three tables in order to have no identical 

rows and each entry to be single-valued. The column name in bold & underline 

represent the primary key for that table. Itôs equivalent foreign key is shown in bold in 

the other table. 
 

DEALER_NAME [Name, ID, Location] 
 

ORDER [ID, Orderno] 
 

ORDER_DATE [Orderno, Orderunits, Dateoforder] 
 

The above transformation was achieved by 
 

 Identifying a unique key for each entity type, which is the first requirement of the 

First Normal Form. 
 

 Since the second requirement was that each attribute of the entity type should be 

single valued, the entity types which contained repeating groups have been 

removed into different tables. 
 

Second Normal Form 



Tables in First Normal Form have characteristics that render them difficult to use. These 

characteristics are recognized and they are eliminated leading to Second Normal Form. 
 



A partial functional dependency is said to exist between two tables attributes A and 

B if:  

 

 ̧

 

 ̧

 

B is functionally dependent on A, and 
 

A is only part of the table key. 
 

E.g. STUDENT [rollno, name, classno, GPA, Grade] 
 

In the above table suppose each row represents a student enrolled in a class. GPA 

represents his Grade point average obtained till now. Grade is filled up if the student 

has completed the class, otherwise it is left blank. Sample data contained in this table 

is shown below:  
 
 
 
 
 
 
 
 
 
 

 

By studying the above table it is seen that there are various problems associated. 

For instance, Roll no., Name and GPA for ñPragyaò are entered thrice. This has 

created a situation of Data Redundancy, which as a rule has to be minimized to the 

largest extent possible as 
 
 ̧

 

 ̧

 

This will increase data storage which is costly. 
 

Data entry will also increase by duplicating data. 
 

 ̧ Data inconsistencies can arise if any of the three entries of :pragyaò are incorrectly 

typed. 
 

Modification Anomalies 
 

Redundant data in a table will always pose various difficulties, that become apparent 

whenever the data is manipulated, i.e., during addition, deletion or updation. Let us 

study these with respect to our example. 
 

Deletion Anomaly 
 

Consider a student ,who was enrolled in the college drops out for some reasons from his 

classes but does not drop out of the college. In this instance we will have to find all rows 

pertaining to him and will have to delete these rows. However when we do this all basic 

information of this student will also be deleted from the table. This necessarily 



implies that as far as our table is concerned the student no longer exists in the college. 

However this is not so since the student has not dropped out of the college. This is 

known as deletion anomaly. 
 

Insertion Anomaly 
 

Consider that a new student enrolls in the college but does not join any classes 

immediately. Since the table has to contain a classno, it will not be possible to enter 

his name in the table. We could use some special notation in the classno. However this 

row will have to be removed when the student actually joins, thereby complicating the 

management of the database. This type of anomaly is known as insertion anomaly. 
 

Updation Anomaly 
 

While updating a particular field, which has changed in the table for a particular 

student, a search and change method comprising of several records of the student will 

have to be done. This exercise will be time consuming and prone to human errors, 

thereby leading to data inconsistencies. This anomaly is known as updation anomaly. 
 

In the above example rank is functionally dependent on the entire key. Name and 

marks are dependent on only part of the key, as shown below. 
 
 
 
 
 

So the partial dependencies are removed by splitting off these dependencies into 

separate new tables, thus finally the tables created are: 
 

STUDENT_NAME [rollno, name, marks] 
 

STUDENT_RANK [rollno, classno, rank] 

 

Third Normal Form 
 

Some of the tables in the second normal form exhibit problems of redundancy and 

anomalies. These problems can be removed by transforming the table in itôs Third 

Normal Form. 
 
 
 
 
 
 

 

A transitive functional dependency is set to exist between two table attributes A and B 

if:  
 

 ̧ One of the attributes is functionally dependent on the other, and 



 Neither of the attributes is part of the table key. 

 

E.g. STUDENT_INSTRUCTOR [rollno, classno, rank, instr, office] 
 

In the above example rank is functionally dependent on the combination rollno + 

classno. However, instr is functionally dependent on classno, because each class 

uniquely determines the instructor, regardless of the students enrolled in the class. 

Similarly, office is functionally dependent only on classno, because a particular class 

uniquely determines an office, namely that of the instructor teaching the class. Office 

is completely functionally dependent on instructor: 
 
 
 
 
 
 

 

The transitive dependency and its associated problems of data redundancy may be 

eliminated by the same technique used to remove partial dependencies ï by splitting 

off the dependency into a separate table, as follows: 
 

STUDENT_INSTR [rollno, classno, rank] 
 

CLASS_INSTR [classno, instr] 
 

INSTRUCTOR [instr, office] 
 

The Best Normal Form 
 

The normal forms discussed so far are ideal for the designer to bear in mind. However 

it is not necessary that a table in any of the above formats is useful. The best normal 

form can be any of the above given forms, depending on the situation. 
 

It is possible for the designer to make a decision not to convert into third normal 

form in case the actual situation so demands .i.e. storage considerations etc. Consider 

the table given below: 
 

FRIEND [NAME, CITY, STATE, PINCODE]. 
 

It will be noted that the above table is not in third normal form as transitive 

dependencies exist. This table could be transformed as follows 
 

PINCODE [CODE, CITY, STATE] 
 

However if this transformation is done , it would involve making a table which 

contains lakhs of entries. The designer may consider this unnecessary considering the 

'number of friends' that have to be dealt with in the application. This sort of trade off is 

sometimes termed as Best Normal Form. 
 

Boyce-Codd Normal form 



For most situation, tables in third normal form are usually free from the problems of 

data redundancy and anomalies. Occasionally, odd situations arise in which tables in 

third normal forms may nevertheless be problematical. Because of this, several still 

higher forms for tables have been defined in order to pin point the sources of the 

difficulties and to clarify the method of their elimination. 



Fourth Normal Form  
 
 
 
 
 
 
 
 
 

 

A multi-valued dependencies is said to exist between two attributes A and B if for 

each value of attribute A there is one or more associated values attribute B. 
 

INTRODUCING ORACLE 8 AND ITS FUNDAMENTALS  
 

Most typically, computers store and organize large amount of information within a 

database. A database, whether or not a computer manages it, is nothing more than an 

orderly collection of related information. A database safely stores information and 

organizes it for fast retrieval. Databases come in many varieties. Inverted list, 

hierarchic and network database models are older type of database systems that, in 

general, are inflexible and difficult to work with. Relational databases are easy to 

understand, design, and build. Relational databases store and present all information in 

tables, an easily understood concept. Furthermore relational databases hide the 

complexities of data access from the user, making application development relatively 

simple when compared to other type of database systems. Oracle 8 server adds many 

new features to extend the power of Oracle Server and make it suitable for even the 

most demanding and complex application environment. 
 

Every database application is built upon a set of related database objects that store 

the applicationôs data and allow the application to function. This section introduces 

Oracle 8 database objects such as tables and views. 
 

Features of Oracle 8 
 

 ̧

 

 ̧
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 ̧

 

Database Management Systems. 
 

New features of Oracle 8. 
 

Oracleôs Network Computing Architecture (NCA). 
 

Oracle 8 Database Management and security. 
 

Schemas. 
 

Tables. 
 

Datatypes. 



 
 ̧

 

 ̧

 

 ̧

 

 ̧

Data Integrity and integrity constraints. 
 

Views. 
 

Indexes. 
 

Data clusters. 
 

Database Management System 
 

A Database Management System (DBMS ) is a computer software that manages access to 

databases. A typical multi-user DBMS performs the following tasks and more: 
 

 A DBMS safely manages shared access to a single database among multiple 

concurrent users. For example, a DBMS locks data as users add and update 

information so that users do not destructively interfere with one anotherôs work. 
 

 A DBMS leverages computer resources wisely so that a large number of 

application users can perform work with fast response times and give maximum 

productivity. 
 

 A DBMS protects database information in such a way that it can reconstruct work lost 

due to everything from a simple power outage to catastrophic site disasters. 

 

Oracle 8 is an object-relational database management system (ORDBMS). That is, 

Oracle 8 is a database server that offers the capabilities of both relational and object-

oriented database systems. The goal of this course material is to teach you all about 

Oracle 8 and how it works. 
 

New Features of Oracle 8 
 

Partitioning Tables and Indexes 
 

Oracle 8ôs data partitioning feature help to minimize the problems specifically 

associated with very large tables and indexes. Data partition allows Oracle server to 

store a large table (and its indexes) in smaller, more manageable partitions (pieces) 

rather than as one large chunk of data. 
 

Management of Large User Populations 
 

Oracle provides its multithreaded server (MTS) process architecture that dramatically 

reduces the overhead associated with maintaining many concurrent database sessions. 

Introduced as part of Oracle 7, an MTS server configuration uses a small number of 

server-side processes to efficiently manage the requests of hundreds or even thousands 

of connected clients. 
 

Advanced Queueing 



Oracle 8ôs new advanced queueing feature is a database-centric alternative for 

applications that would like to defer the execution of database transactions. For 

example, demanding client/server systems might want to queue and defer the 

execution of low-priority transactions to less taxing off-peak hours. 
 

Parallel Processing Enhancements 
 

Parallel query processing allows Oracle 8 to take full advantage of all available server 

processors and provide excellent response times for even the most CPU and I/O 

intensive application queries. Oracle divides a SQL request into subtasks, then allow 

multiple processors to process subtasks in parallel. Oracle merges results from each 

subtasks and returns them quickly to the user. 
 

Oracleôs Network Computing Architecture 
 

To solve the dilemmas (how do you integrate, manage, and support the various system 

components originating from different vendors) associated with deploying network-

based application environments, Oracle has introduced its Network Computing 

Architecture (NCA). NCA incorporates the needs of both network-centric computing 

and object oriented development methods. 
 

Oracle 8 Database Management and Security 
 

Oracle 8 introduces several new features that make database administration easier and 

more manageable. 
 

Backup and Recovery: Oracle 8 and its companion management tool, Oracle 

Enterprise Manager, include several new features to make database backup and 

recovery more automated, easier to use and faster. 
 

Server-Managed Backup and Recovery: An Oracle 8 Server can now maintain 

detailed information about recent database backups. When a database recovery is 

necessary, Oracle 8 automatically analyses the state of the database, determines the 

actions necessary to repair the system and then automatically recovers the damaged 

database. 
 

Incremental Backups: An incremental database backup can minimize backup time 

and size because Oracle backs up only the data blocks that have changed since the 

most recent backup. 
 

Point-In-Time Recovery of Individual Tablespaces: With Oracle 8 administrators 

can now recover complete databases as well as individual tablespaces to specific point 

in time. 
 

Password Management: Oracle 8 introduces several new features that allow you to 



automatically enforce a database security policyôs guidelines for user password 

management. For example, an administrator can configure an Oracle database to 

automatically verify that a userôs new password has sufficient complexity and is not a 

recycled password. 
 

Schemas ï Organizing Database Objects 
 

Database organize related objects within a database schema. For example, itôs typical 

to organize all of the tables, views, and other database objects necessary to support an 

application within a single database schema. This way itôs clear that the purpose of a 

certain table, view, or other database object is to support the corresponding application 

system. 
 

Schemas, An Entirely Logical Concept: Itôs important to understand that schemas 

do not physically organize the storage of database objects. Rather, schemas logically 

organize related database objects. In other words, the logical organization of database 

objects within schemas has absolutely nothing to do with the physical storage of 

database objects. 
 

The logical organization that schemas offer can have practical benefits. For 

example, consider an Oracle database with two schemas, S1 and S2. Each schema can 

have a table called T1. Even though the two tables share the same name, they are 

uniquely identifiable because they are within different database schemas. Using 

standard dot notation, the complete names for the different tables would be S1.T1 and 

S2.T2. 
 

The Data Dictionary: Every Oracle database uses a number of system tables, 

views, and other database objects to keep track of metadata- data about the data itself 

in a database. This collection of system objects is called the Oracleôs databaseôs data 

dictionary or system catalog. Oracle organizes a databaseôs data dictionary within the 

SYS schema. 
 

Database Tables 
 

Tables are the basic data structure in any relational database. A table is nothing more 

than an organized collection of records or rows that all have the same attributes or 

columns. Figure below illustrates a typical STUDENT table in a relational database. 
 

Each student record in the example STUDENT table has the same attributes, 

including an ID, a first name, a last name, age, gender and so on. 
 



Tables: A table is a set of records with the same attributes. 
 

When you create tables, the two primary things that you must consider are the 

following. 
 

 The tableôs columns, which describe the tableôs structure. 

 

 The tableôs integrity constraints, which describe the data that is acceptable within 

the table. 
 

Columns and Datatypes 
 

When you create a table for oracle database, you establish the structure of the table by 

identifying the columns that describe the tableôs attributes. Furthermore every column 

in a table has a datatype. A columns datatype describes the basic type of data that is 

acceptable in the column. For example, the STUD_ID column in the STUDENT table 

uses the basic Oracle datatype NUMBER because the column stores ID numbers. 
 

Oracle supports many fundamental datatypes that you can use when creating a 

relational database table and its columns. The table below describe the most 

commonly used Oracle datatypes. 
 
 
 
 
 
 
 
 

 

CHAR and VARCHAR2 - Oracleôs Character Datatype 
 

Oracleôs CHAR and varchar2 are the two most commonly used datatype that a 

table uses for columns that store character strings. The Oracle datatype CHAR is 

appropriate for columns that store fixed-length character strings such as two-letter 

USA state codes. Alternatively, the Oracle datatype VARCHAR2 is useful for 

columns that store variable length character strings such as names and addresses. 
 

 When a string in a CHAR column is less than the columnôs size, Oracle pads 

(appends) the end of the string with blank spaces to create a string that matches the 

columnôs size. 
 

 When a string in a VARCHAR2 column is less than the columnôs maximum size, 

Oracle stores only the string and does not pad the string with the blanks. 
 

Number- Oracleôs Numeric datatype. 
 

Oracleôs NUMBER datatype supports the storage of all types of numbers, 

including integers, floating point numbers, real numbers etc. 



Date- Oracle Time-Related datatype. 
 

When you declare a table column with the DATE datatype, the column can store 

all type of time-related information, including dates and associated times. 
 

CLOBs, BLOBs, and More- Oracleôs Multimedia datatypes. 
 

To support content rich applications, Oracle 8 supports several large object (LOB) 

datatypes that can store unstructured information such as text documents, static 

images, video, audio and more. 
 

 A CLOB object stores character objects such as documents. 
 

 A BLOB column stores large binary objects such as graphics, video clips, or sound 

files. 
 

Default column values 
 

When you declare a column for a table, you can also declare a corresponding 

default column value. Oracle uses the default value of a column when an application 

inserts a new row in the encompassing table, but omits a value for the column. For 

example you might indicate that the default value for the ADMISSION_DATE 

column of the ADMISSION table be the current time when an application creates a 

entry for a new student. 
 

Unless, you indicate otherwise, the initial default value for a column is a null (an 

absence of value). 
 

Data Integrity and Integrity Constraints  
 

Data Integrity is a fundamental principle of the relational database mode. When a 

database has integrity, it is another way of saying that the database contains only 

accurate and acceptable information. 
 

For example a DATE column can contain valid dates and times, but not numbers 

or character strings. While simple column datatype are useful for enforcing a basic 

level of data integrity, there are typically more complex integrity rules that are 

necessary to enforce in a relational database. 
 

Domain integrity, Nulls and Complex Domains. 
 

Domain Integrity defines the domain of acceptable values for a column. For 

example in the age column which is defined as an integer, we cannot insert a character 

value. Besides using column datatype Oracle supports two types of Integrity 

constraints that allow you to further limit the domain of a column. 
 

 A column can have a NOT NULL constraint to eliminate the possibility of nulls ( 

absent values) in the column. 



 You can use a CHECK constraint to declare a complex domain integrity rule as 

part of a table. 
 

Entity Integrity, Primary keys and Alternate Keys 
 

Entity Integrity ensures that every row in a table is unique. As a result, entity 

integrity eliminates the possibility of duplicate records in the table and makes every 

row in the table uniquely identifiable. 
 

Primary Key: The primary key of the table ensures its entity integrity. A primary 

key is a column that uniquely identifies the rows in a table. Typically, tables in a 

relational database might include an ID column to uniquely identify the student 

records in a STUDENT table. 
 

A tableôs primary key is sometimes a composite key.: that is, it is composed of 

more than one column. 
 

Optionally, a table might require secondary levels of entity integrity. Alternate 

keys are columns or sets of columns that do not contain duplicate values within them. 

For example, the EMAIL column in an EMPLOYEE table might be an alternate key to 

guarantee that all employees have unique e-mail addresses. 
 

Referential Integrity and Foreign Keys 
 

Referential Integrity, sometimes called relation integrity, establishes the 

relationships among different columns and tables in a database. Referential integrity 

ensures that each column value in a foreign key of a child table matches a value in the 

primary key or an alternate key of a related parent table. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 14.6: Referential Integrity and Foreign Key 



Views- A Different Way of Looking at Table Data 
 

A View is a database object that presents table data. The following examples 

demonstrate the use of views in a database. 
 

 You can use a simple view to expose all rows and columns in a table. For example, 

you might create a view called STUD that presents all student records in the 

STUDENT table. 
 

 You can use view to protect the security of specific table data by exposing only a 

subset of the rows and/or columns in a table. For example you might create a view 

called STUD_PH that presents only the first name, last name and the phone 

number columns and not the age column. 
 

 You can use a view to present derived data that is not actually stored in a table. For 

example, you might create a view of the ITEMS table with a column called 

TOTAL that calculates the line total for each record. 
 

A view is a representation of table data. 
 

STUD_PH View.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

In fact, you can create a view of any data that you can represent with a SQL query. 

Thatôs because a view is really just a query that Oracle stores in a databaseôs data 

dictionary as a database objects. When an application uses a view to do something, 

Oracle derives the data of the view based on the viewôs defining query. 



Indexes-improving the Performance of Table Access 
 

With database applications, performance depends greatly on how fast an application 

can access table data. Typically, disk I/O is the primary performance determining 

factor for table access- the less disk I/O thatôs necessary to access table data, the better 

the dependent application will perform. 
 

The judicious use of table indexes is the principal method to reduce disk I/O and 

improve the performance of Table Access. Just like an index in a book, an index of a 

Table column (or set of columns) allows Oracle to quickly find specific table records. 

When an application queries a table and uses an indexed column in its selection 

criteria, oracle automatically uses the index to quickly find the target rows with 

minimal disk I/O. Without an index, Oracle has to read the entire table from disk to 

locate rows that match the selection criteria. 
 

The presence of an Index for a table is entirely optional and transparent to users and 

developers of database applications. For example: 
 

 Applications can access table data with or without associated indexes. 

 

 When an index is present and will help the performance of an application request, 

Oracle automatically uses the index; otherwise , Oracle ignores the index. 
 

 Oracle automatically updates an index to keep it in synch with its table. 

 

Indexes are meaningful only for the key columns that application requests 

specifically use to find rows of interest. Furthermore, index maintenance generates 

overhead- unnecessary indexes can actually slow down down your system rather that 

improve its performance. 
 

Data Clusters ï A Unique Way of Storing Table Data 
 

Oracle 8 also offers data clusters as an alternative to indexing, which can also decrease 

disk I/O for table access. A data cluster is a unique way of storing table data. In a data 

cluster, Oracle clusters the related rows of one or more tables together in the same data 

block. 
 

Each data block in a data cluster holds the related rows for one or more cluster 

keys. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

The motivation of using data cluster is to store on disk the rows that an application 

commonly uses together. When an application requests the set of rows, Oracle can 

retrieve the requested rows with perhaps one or a few disk I Oôs. 
 

For example, you might use a data cluster to ñprejoinò the STUDENT and 

COURSE table. When a application request historical information about a specific 

student and its courses, Oracle can read the data for a specific student with only one 

disc I/O. In contrast, when related rows are stored unclustered in random data block 

across a disk, several disk I/O are necessary to complete the applicationôs request. 
 

SUMMARY  
 

Oracle 8 is certainly a powerful product that you can use to manage information. The 

very weakness of earlier database systems are exactly why relational database systems 

now dominate newer information management systems. Oracle 8 builds on the strengths 

of its predecessor, Oracle 7 server and adds new features to extend its power. Oracle 8 

also introduces several new features that make database administration easier and more 

manageable. It is easier to solve most problems in life when you are organized and have a 

well defined plan to achieve your goal. Database organize related objects within a 

database schema. Tables are the basic data structure in any relational database. A table is 

nothing more than an organized collection of records, or rows, that all have the same 

attributes, or columns. Every column in a table has a datatype. A columns datatype 



describes the basic type of data that is acceptable in the column. Data Integrity is a 

fundamental principle of the relational database mode. When a database has integrity, 

it is another way of saying that the database contains only accurate and acceptable 

information. A view is a database object that presents table data. This chapter 

demonstrated the use of views in a database. 
 

The performance of an application is always critical. That is because the 

productivity of an application user directly relates to the amount of time that the users 

must sit idle, while the application tries to complete the work. The use of table indexes 

is the principal method to reduce the disk I/O and improve the performance of table 

access. 
 

Oracle 8 also offers data clusters as an alternative to indexing, which can also 

decrease disk I/O for table access. 
 

PROGRAMMING THE SERVER  
 

SQL is nothing more than a data access language that allows applications to put data 

into and get data out of an oracle database. In other words, SQL by itself is not a full-

featured programming language that you can use to develop powerful database 

applications. To build a database application, you must use a procedural language that 

encompasses SQL to interact with an Oracle database. 
 

PL/SQL is Oracleôs own procedural language that can be used to program a Oracle 

server. By no means is this chapter a complete guide to PL/SQL. However, this 

chapter does provide an intermediate-level overview of PL/SQLôs capabilities so that 

you can get started programming an Oracle server. 
 

Features 
 

 ̧

 

 ̧

 

 ̧

 

PL/SQL Language Basics. 
 

PL/SQL blocks. 
 

Program Declarations. 



PL/SQL Language Basics 
 

PL/SQL is a procedural programming language that is built into most Oracle products. 

With PL/SQL, you can build programs that combine PL/SQL procedural statements to 

control the program flow with SQL statements that access an Oracle database to 

process information. 
 

For Example, the following is a very simple PL/SQL program that updateôs a 

bookôs unit price given the bookôs ID number. 
 

PROCEDURE update_book_unitprice (book_id IN INTEGER, new_price 

IN NUMBER) 
 

IS 
 

Invalid_book EXCEPTION 
 

BEGIN 
 

ð AN UPDATE STATEMENT TO UPDATE A DATABASE 

RECORD. UPDATE sales.books 

SET unit_price = new_price 

WHERE id = book_id; 
 

ð AN ERROR-CHECKING STATEMENT 
 

IF SQL%NOTFOUND THEN 
 

RAISE invalid_part 
 

END IF; 
 

EXCEPTION 
 

ð AN ERROR HANDLING ROUTINE WHEN 

invalid_book THEN raise_application_error( -

20000, óInvalid Part IDô); END 

update_book_unitprice. 
 

The example above is a procedure. Using PL/SQL you can build many types of 

database access program units, including procedures, functions, and packages. 
 

The Basic Programming Constructs that PL/SQL Language Offers 
 

PL/SQL has  statements  that allow  you to  declare  variables  and  constants,  control 



program flow, assign and manipulate data, and more. A PL/SQL program is structured 

using distinct blocks that group related declarations and statements. Each block in a 

PL/SQL program has a specific task that solves a particular problem. Consequently 

you can organize a PL/SQL program so that it is easy to understand. 
 

Blocks 
 

A PL/SQL block can include three sections : declarations, the main program body and 

exception handlers. 

 ̧ The declaration section of a PL/SQL block is where the block declares all 

variables, constants, exceptions, etc., that are then accessible to all other parts of 

the block.  

 The main program body contains the executable statements for the block, in other 

words, the body is where the PL/SQL block defines its functionality. 

 The exception handling section contains the exception handlers (error handling 

routines) for the block. When a statement in the blockôs body raises an exception 

(detects an error), it transfers program control to a corresponding exception 

handler in the exception section for further processing. 



Program Declaration 
 

A block in a PL/SQL program can declare many types of constructs. 
 
 ̧

 
 ̧

 

Variables and Constants. 
 

User defined Subtypes. 
 

 User defined composite types, including records, nested tables, and varying arrays. 

 Cursors and cursor variables. 

 

Variables and Constants 
 

The following program segment declares a variable and constant using the ANSI 

datatype INTEGER. 

DECLARE 
 

student_id INTEGER 
 

standard_fees CONSTANT INTEGER := 7600 

; é. 
 

User-defined Subtypes 
 

PL/SQL supports many common subtypes of its base types. A block in a PL/SQL 

program can also declare user-defined subtypes to customize the acceptable domain of 

values for a variable or constant. 
 

For example, the following program segment declares a user-defined subtype and 

corresponding variable for book description. 
 

DECLARE 
 

Varchar2_50 VARCHAR2(50); 
 

SUBTYPE description IS Varchar2_50; 
 

Current_description Description DEFAULT óUnknownô; 
 

This example demonstrates that a program cannot define constrained subtypes 

directly. Instead, a program must first declare a constrained variable and then a 

subsequent subtype declaration in order to create the constrained subtype. 
 

User-defined Composite Types 
 

Records 
 

PL/SQL allows a program to create user-defined composite types and then declare 



variables and constants using the new types. A variable declared with a composite 

type has distinct components that a program can manipulate individually. 
 

For Example a program can update a particular field in a record variable without 

updating other fields . 
 

Nested Tables 
 

A program can declare a nested table type to create variables that have one or more 

columns and an unlimited number of rows, just like tables in database. 
 

FOXPRO 
 

A Brief Overview of FOXPRO 
 

FOXPRO is a relational database in which data is organized into tables. The data can be 

added, edited and manipulated through a set of simple commands provided with the 

package. ANSI SQL commands also work on the tables. In the succeeding pages a brief 

description of the usage of these commands and the rules governing them are described. 
 

As we know that if we have to get results/ answers to our queries, data has to exist 

and stored in tables. In order to create a table the following command is entered in the 

command window: 
 

CREATE [ Table name] 
 

This means if we have to create a table named Results our command will be 
 

CREATE RESULTS 
 

FOXPRO will present us a screen to enter Field names, Data type and Field size. 

Field names should not be more than 8 characters long and should follow the DOS 

conventions of not containing any blank spaces ,special characters like comma ,slashes 

etc. However underscore is allowed. The figure below depicts the screen of FOXPRO 

that will be presented: 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Main data types are discussed in brief as given below: 
 

Character: If the data contained in this field will not undergo any computation then 

define this field as character. 
 

Numeric: The data contained in this field has to be numeric and can undergo any 

mathematical operation 
 

Date: All dates in the MM/DD/YY format are contained 
 

Logical: Boolean true or False flags are in this type of a field 
 

Memo: If data to entered is more than 254 characters make the field as memo type. 
 

Field size implies the maximum width you want to reserve for any data entered in 

the field. Note upto 254 characters are allowed. 
 

Once the above have been entered ,then in FOXPRO terminology ,the structure of 

the table has been created. Pressing CTRL & W together will automatically save the 

structure. FOXPRO will prompt ñenter data y/n. Pressing y will present you with a 

screen for data entry of all your records. Pressing n will bring you back to the 

command window. 
 

Modifying the Structure of a Database File 
 

When you create a database file, you may not consider all aspects of the data to be 

stored. That is, you may forget to include some field or may consolidate information 

for two fields into one field. We can use modify structure command to amend the 

structure of the file, at a later stage also. 
 

The modify structure command is used to modify the structure of a database file, it 

must be open (in use). First of all we open the database file. Then we shall try modify 

structure. 
 

Use <file name> 



Modi struc 
 

Adding More Records with Append 
 

You can add more records at the end of any database file. The command to add 

records to a database file is append. Before you can add records to a database file with 

append, the database file must be in use (or open).  

Use <file name> 
 

Use student 
 

Append 
 

Foxpro will present a blank form for you to enter a record as under:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

SEARCHING FOR SPECIFIC RECORDS WITH LIST  
 

LIST 
 

Continuously displays all/specified fields (and expression) of records of the 

current database file. 
 

Use <file name> 
 

Use Student 
 

List 
 

This will give a list of all the records of file 'Student' in the table. Note all fields 

will be displayed. If selective fields have to be displayed the following command 

should be used: 
 

Use Student 
 

List rollno,name 
 

This will give a list of roll number & name of all the records in this file. 



EDITING MULTIPLE RECORDS WITH BROWSE  
 

Browse is a different form of Edit (or Change). It displays several records in the form 

of a horizontal table. Each record occupies one row of the table. You can move the 

cursor to any field of any record & carry out editing. 
 

Syntax: 
 

Use <file name> 
 

Browse 
 

The browse window will appear as under:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

For browsing specific commands use the following command: 
 

BROWSE FIELDS Rollno, Name 
 

REPLACING FIELD CONTENTS W ITH REPLACE  
 

The process of making changes with the above commands is very slow as you need to 

physically select each record, before you can make changes. With the Replace 

command these changes on all or selected records can be carried out easily. 
 

Syntax: 
 

Use <file name> 
 

Replace rate with rate-1 . 
 

This command will replace the rate field of the current record with a value of rate ï 
 

1. 
 

If we wish to replace the rate field of all the records with rate ï1, then the 

following command should be used: 
 

Replace all rate with rate-1 


